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Aa¨vq-1 

Z_¨ I †hvMv‡hvM cÖhyw³ Ges gvwëwgwWqv 

Information & Communication Technology and Multimedia 
 

Z_¨ cÖhyw³ (Information Technology) 

Z_¨ AvniY, msi¶Y, cÖwµqvKiY I weZi‡Yi mv‡_ mswk­ ó cÖwµqv I e¨e ’̄v‡K GK K_vq ejv 

nq Z_¨ cªhyw³ ev Bbdi‡gkb †UK‡bvjwR (Information Technology)| `ª“Z wm×všZ †bqvi Rb¨ 

A_ev ª̀“Z I `¶ e¨e ’̄vcbvi Rb¨ Z_¨ AvniY, msi¶Y, cÖwµqvKiY I Z_¨ weZi‡Yi ¸i“Z ¡ A‡bK| 

eZ©gv‡b Z_¨ cÖhyw³i ¸i“Z ¡ µgvMZ †e‡o P‡j‡Q| Z_¨ cÖhyw³ e¨e ’̄vi DbœwZi d‡j GKwU †QvU Kw¤cDUvi 

ev Uvwg©bv‡ji gva¨‡g `~‡ii Kw¤cDUv‡ii mv‡_ †hvMv‡hvM Kiv hvq| d‡j Lye mn‡R I `ª“Z Z_¨ Av`vb 

cÖ`vb Kiv m¤¢e|  

Z_¨ cÖhyw³ (Information Technology) Gi DcKvwiZv  

 e¨q ms‡KvPb| 

 mgq euv‡P| 

 Zvr¶wYK †hvMv‡hvM m¤¢e| 

 Kg©`¶Zv e„w× cvq| 

 Kv‡Ri MwZ e„w× cvq|  

 gbyl¨ kw³i AcPq †iva BZ¨vw`| 

Z_  ̈cÖhyw³ ‡hfv‡e mgvR‡K cÖfvweZ K‡i (Influence of Information Technology in the Society)  

B`vwbs me©Î Z_¨ cÖhyw³i Rq RqKvi| e¨emvq, e¨e ’̄vcbv, †hvMv‡hvM, wk¶v, weÁvb, Jla Ges wk‡í 

me©Î Z_¨ cÖhyw³i e¨envi j¶bxq| †Uwj‡dvb, †UwjwcÖ›Uvi, †U‡j·, †Uwjwfkb Ges me©‡kl Kw¤úDUvi Z_¨ 

cÖhyw³i †¶‡Î e¨eüZ n‡”Q| GB Z_¨ Qvov Avgiv †Kvb wKQyB Kíbv Ki‡Z cvwi bv| 

 †hvMv‡hvM (Communication) Z_¨ †hvMv‡hv‡Mi mKj †¶‡Î Z_¨ cÖhyw³ e¨vcK fv‡e 

e¨eüZ n‡q _v‡K, ZvB †Zv GwU Rxeb‡K K‡i‡Q mnR, mvejxj, `ª“Z I jvfRbK| †Uwj‡dvb, 

d¨v·, †UwjwcÖ›Uvi, Kw¤úDUvi, B-‡gBj †hvMv‡hvM-Gi †¶‡Î wec­e NwU‡q‡Q| 
 

 wk¶v (Education) Z_¨ cÖhyw³ wk¶vbxwZ‡K cwieZ©b K‡i‡Q| †h †Kvb RvqMv †_‡K GB 

cÖhyw³ e¨envi K‡i wk¶v jvf Kiv hvq| GLb hw` †Kvb e¨w³ evsjv‡`‡k e‡m hy³iv‡óªi †Kvb 

MÖš’vMvi †_‡K †Kvb Z_¨ Rvb‡Z Pvq Zvn‡j gyn~‡Z©B Zv †c‡Z cv‡i| GLb †h †Kvb L¨vZbvgv 

wek¦we`¨vjq jvB‡eªwii †_‡K Z_¨ I M‡elYv Kg© B›Uvi‡b‡U cvIqv hvq Ges GUv cÖwZwbqZ nvj 

bvMv` Kiv n‡”Q| d‡j †h †KD †h †Kvb Z_¨ we‡k¦i †h †Kvb RvqMv †_‡K †c‡Z cv‡i| 

 Jla (Medicine) GB †m±‡i Z_¨ cÖhyw³ e¨envi K‡i gvby‡li Mo Avqy e„w× Kiv m¤¢e n‡”Q| 

GLb Avgiv evox‡Z e‡mB †iv‡Mi wPwKrmv †c‡Z cvwi| wbZ¨ bZzb Avwe¯‹…Z Jla Ges wPwKrmv 

c×wZ m¤ú‡K© GB Z_¨ cÖhyw³ e¨envi K‡i Avgiv Zv Rvb‡Z cvwi| 
 

 mvwnZ¨ I we‡bv`b †¶‡Î (Literature and Entertainment) Z_¨ cÖhyw³ e¨env‡ii 

d‡j GB †m±iwU we¯—…Z n‡q‡Q Ges e¨vcK wec­ e mvwaZ n‡q‡Q| Avgiv mgMÖ we‡k¦i wUwf 

P¨v‡bj¸‡jv GKwU i“‡g e‡m †`LwQ| Z_¨ cÖhyw³ we‡bv`‡bi GB Pvwn`v¸‡jv wgwU‡q‡Q| 
 

 ‡Ljvayjv (Sports & Games) Avgiv GB cÖhyw³ e¨envi K‡i mn‡RB †Ljvayjvi Lei 

Rvb‡Z cvwi| 
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mgv‡R Gi Amyweav¸‡jv/AcKvwiZv (Disadvantages in the Society)   

Z_¨ cÖhyw³iI KZ¸‡jv AcKvwiZv i‡q‡Q| Ggb KZ¸‡jv Ak­xj I‡qe-mvBU i‡q‡Q hv A‡bK 

Aciv‡ai Rb¥ †`q Ges Gi d‡j gvbyl‡K Kz-cÖe„wËi w`‡K ZvwoZ K‡i| †h‡nZz Avgiv e¨vcK cwim‡i GUv 

e¨envi Kwi ZvB Gi wbqwš¿Z e¨envi, `ª“Z cÖmvi Ges Dbœqb c„w_ex‡K AviI my›`i Ges mg„× Ki‡e| 
 

Z_¨ cÖhyw³i µgweKvk  

AvaywbK mf¨Zvi DbœwZi g~‡j i‡q‡Q Z_¨ cÖhyw³i mdj weKvk| Kw¤úDUvi Avwe¯‹v‡ii ci †_‡K 

B‡jKUªwbK cÖhyw³i DrK‡l©i d‡j †Uwj‡dvb I †Uwjwfk‡bi mv‡_ G¸‡jvi ms‡hv‡Mi d‡j G†¶‡Î cÖf~Z 

DbœwZ mvwaZ nq| lv‡Ui `k‡K DcMÖn †hvMv‡hvM e¨e¯’vi ga¨ w`‡q †Uwj‡hvMv‡hv‡Mi †¶‡Î bZzb AMÖhvÎv 

ïi“ nq| Gi avivevwnKZvq dvBevi AcwUK¨vj †Ke‡ji ga¨ w`‡q B›Uvi‡bU ms‡hvM I wfwWI Kg‡cÖkb 

e¨e ’̄v G cÖhyw³‡K AviI DbœZ K‡i‡Q|    
 

Z_¨ cÖhyw³‡Z wec­e NwU‡q‡Q Ggb hš¿ I wm‡÷g¸‡jv   

d¨v· (Fax)   

d¨v· Ggb GKwU cÖhyw³ hv †cÖi‡Ki KvQ †_‡K 

KvM‡R †jLv Z_¨ ûeû Aci cÖv‡š—i cÖvc‡Ki wbKU †cuŠwQ‡q 

†`q| Avcwb d¨v· g‡Wg e¨envi K‡i GKB ai‡bi Kwc 

d¨v· MÖwnZvi Kv‡Q wKsev wbR cÖv‡š—I †ei Ki‡Z cv‡ib, 

wKš‘ GwU d¨v‡· XyKv‡bv Kwci †P‡q Kg wbf©i‡hvM¨ n‡e|  

†Uwj Kbdv‡iwÝs (Tele Conferencing)   

†Uwj‡hvMv‡hv‡Mi gva¨‡g mfv Abyôv‡bi cÖwµqv‡K 

†UwjKbdv‡iwÝs ejv nq| `yB ev Z‡ZvwaK MÖ“‡ci g‡a¨ 

†hvMv‡hvM ’̄vcb K‡i †UwjKbdv‡iwÝs| hviv wfbœ RvqMvq 

i‡q‡Q Zv‡`i g‡a¨ AwWI, AwWI MÖvd Ges Kw¤úDUvi 

wm‡÷g Gi gva¨‡g `jxq †hvMv‡hvM Kiv m¤¢e nq|  wewfbœ 

Ae¯’v‡bi gvbyl‡K Kw¤úDUvi I Z_¨ cÖhyw³ e¨envi K‡i 

wgwUs Gi e¨e ’̄v K‡i †`Iqv nq| †UwjKbdv‡iwÝs e¨e ’̄v 

mdUIq¨v‡ii gva¨‡g wbqš¿Y Kiv hvq|  

 

 

wfwWI Kbdv‡iwÝs (Video Conferencing)   

hviv GKB ’̄v‡b †bB Ggb e¨vw³i mv‡_ wfwWI I Kw¤úDUvi cÖhyw³ e¨envi K‡i msjvc KivB 

n‡jv wfwWI Kbdv‡iwÝs| `yB ev Z‡ZvwaK MÖ“‡ci mv‡_ Av‡jvPbv Kiv hvq Ggb wfbœ Ae¯’v‡bi gvby‡li 

mv‡_ B‡jKUªwb· †hvMv‡hvM e¨e ’̄v e¨envi K‡i Zv‡`i Qwe 

‡`Lv I K_v †kvbv hvq Ggb msjvcB wfwWI Kbdv‡iwÝs| GwU 

A‡bKUv †UwjKbdv‡iwÝs-Gi gZB| G‡Z cÖ‡qvRb nq 

gvwëwgwWqv Kw¤úDUvi, I‡qe K¨v‡giv, wfwWI K¨vcPvi KvW©, 

†Uwj‡dvb jvBb, g‡Wg I B›Uvi‡bU|  

‡Uwj‡hvMv‡hvM †bUIqv‡K©i mvnv‡h¨ Ggb Kbdv‡iÝ c„w_exi 

GK cÖvš— †_‡K Ab¨ cÖv‡š— n‡Z cv‡i|  
 

 

 

 

†iveU (Robot)   
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wesk kZvãxi Avwe¯‹v‡ii g‡a¨ GwU cÖhyw³MZfv‡e Avkvev` e¨³ Kivi gZ Avwe®‹vi| †iveU n‡jv 

gvbyl AvK…wZ gZ Ggb GKwU hš¿ hv gvby‡li K_v eyS‡Z 

cv‡i, wfRyqvj †m‡Ý †m¸‡jv Abyev` K‡i K…wÎg  eyw×gËv 

w`‡q †m¸‡jv wbqš¿Y K‡i| †ive‡Ui Kv‡Ri aviv c~e© †_‡K 

wVK K‡i †`qv _v‡K| GwU ïay wb‡`©wkZ Kv‡Ri aviv 

Abyhvqx mvov w`‡q _‡K| †iveU cÖwZKyj cwi‡e‡k wbLuyZ I 

K¬vwš—nxbfv‡e KvR Ki‡Z cv‡i| GwU GKwU ¯̂-wbqwš¿Z 

Kw¤úDUvi c×wZ| 
 

 

†Uwj-†U·U (Tele-text)  

†Uwj‡U·U n‡jv GKgyLx Z_¨ cÖevn mvwf©m| GB cÖwµqvq †K›`ªxq ‡WUv‡eR n‡Z GKwU wba©vwiZ 

msL¨K Z_¨ cvZv wUwf m¤cÖPv‡ii gva¨‡g e¨enviKvixi wbKU †cuuŠQv‡bv hvq| †cRmg~n wba©viY K‡i 

Dc ’̄vc‡bi Rb¨ wUwf wW‡KvWvi (Decoder) wUwf †m‡U e¨envi Kiv nq| RbwcÖq msw¶ß Z_¨ Rvbvi Rb¨ 

G e¨e ’̄v Lye Dc‡hvMx| †hgb- AvenvIqvi Lei I †kqvi evRv‡ii Lei BZ¨vw`|  
 

ey‡jwUb †evW© (Bulletine Board)  

 B›Uvi‡b‡U ey‡jwUb †evW© GKwU ev —̄e ey‡jwUb †ev‡W©i gZ| Avmj ey‡jwUb †ev‡W© RbM‡Yi †`Lvi 

Rb¨ wRwbm¸‡jv Avjv`v K‡i iv‡L| B-‡gBj †cÖi‡Yi gva¨‡g RbMb ey‡jwUb †evW© e¨envi K‡i| GwU 

†g‡mR‡K Ab¨‡`i †`Lvi Rb¨ Post K‡i †`q| GwU GKwU wekvj ¶gZv m¤úbœ Kw¤úDUvi e¨e ’̄v hv 

†Uwj‡dvb jvB‡bi gva¨‡g Kg-kw³i Kw¤úDUv‡ii mv‡_ hy³ _v‡K| 
 

wiRv‡f©kb wm‡÷g (Reservation System)   

msi¶Y (Reservation) GK ai‡bi eywKs c×wZ hvi gva¨‡g c„w_exi †h †Kvb cÖvš— †_‡K 

e¨enviKvix Zv‡`i wegv‡bi Avmb eyK Ki‡Z cv‡ib| GUv n‡Z cv‡i wegv‡bi, †nv‡÷‡j wKsev Ab¨ 

hvbevn‡bi| Avcwb cÖ‡qvRbxq eywKs Z‡_¨i GKwU mvwe©K wPÎ †h †Kvb mgq †`L‡Z cvi‡eb| 
 

wfwWI †U·U (Video-text)  

wfwWI-†UK÷ Ggb GK ai‡Yi Kvh© mvab c×wZ hv‡Z 

Bnv WvUv‡eR Gi mv‡_ ms‡hv‡Mi gva¨‡g Z_¨ D×vi K‡i| GwU 

†hvMv‡hvM †bUIqvK© e¨Ÿnvi K‡i †kqvi evRvi Ges Ab¨vb¨ 

Li‡Pi Z_¨ iv‡L| 

 

 
 

B‡jKUªwbK Dcv‡q A_© ¯’vbvš—i (Electronic Fund Transfer)  

B‡jKUªwbK dvÛ UªvÝdvi n‡jv †U·vm iv‡R¨i GKwU Avw_©K †bUIqvK© hv 1990 mv‡j ïi“ 
n‡q‡Q| GwU ˆe`y¨wZK A_© ’̄vbvš—‡ii Rb¨ wWRvBb Kiv n‡q‡Q Ki `vZv‡`i Rb¨| GB wm‡÷gwU wewjqb 

wewjqb Wjvi msMÖn K‡i‡Q cÖvq kZvwaK U¨v· I wd eve`| Avcwb hw` Gi Aš—f©~³ n‡Z Pvb Zvn‡j 

Avcbv‡K K¨vk †c‡g›U Ki‡Z n‡e| B‡jKUªwbK †WweU  I †µwWU Kivi Rb¨ Avcbv‡K †Kvb Kw¤úDUvi 

†bUIqv‡K©i gva¨‡g †jb‡`b Ki‡Z n‡e| †jb‡`b Kv‡h© myweav I wbivcËvi wbwg‡Ë A‡Uv‡gwUK †Ujvi 

Uvwg©bvj e¨envi Kiv nq| W‡Uv w`‡q e¨vs‡Ki †jb‡`b Kvh© m¤úv`‡bi Rb¨ †PŠ¤^K Kvwji †jLv wewkó KvW© 

e¨envi Kiv nq|  

 

G·cvU© wm‡÷g (Expert System)  
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mvaviYfv‡e GKRb AwfÁ gvby‡li gZ K…wÎg eyw×gËvi mnvqZvq Z_¨ I KviY AbymÜvbx 

Kw¤úDUvi mdUIq¨v‡ii gva¨‡g †QvU Lv‡Uv mgm¨v ¸”Q mgvavb Kiv hvq| gvbyl G·cv‡U©i gZ wKsev 

KvQvKvwQ †Kvb GKwU we‡kl †¶‡Î KvR K‡i Ggb GKwU Kw¤úDUvi wm‡÷gB n‡jv G·cvU© wm‡÷g| 
 

Kw¤úDUvi wfkb (Computer Vision)  

Kw¤úDUv‡ii gva¨‡g †Kvb cÖ`k©bxi Rb¨ wewfbœ is Gi mgš^q K‡i GwU‡K wPËvKl©Kfv‡e Dc ’̄vcb 

Kiv hvq| MÖvwd· I Gi web¨vm mwVK n‡Z n‡e| †Kvb wP‡Î wewfbœ is _vK‡j Kw¤úDUvi Zv mn‡R c‡o 

wb‡Z cv‡i| D¾j I Aby¾j is Gi cybi“×vi Gi gva¨‡g Kw¤úDUvi cÖK…Z wPÎ dzwU‡q Zzj‡Z cv‡i|  
 

K…wÎg eyw×gËv (Artificial Intelligence)  

GwU h‡š¿i Ggb GKwU ag© hv gvby‡li wPš—vi gZ K‡i cÖwµqvKiY K‡i| wewfbœ M‡elK K…wÎg 

eyw×gËv‡K †gwk‡bi gva¨‡g wk¶v Ges wm×vš— †bqvi mvg_© I cÖ‡qvRbxqZv Dcjwä Ki‡Qb| hv‡K 

gv‡Sgv‡S AI ev K…wÎg eyw×gËv e‡j| 
 

K…wÎg eyw×gËv Kw¤úDUvi weÁv‡bi Ggb GKwU kvLv hv gvby‡li gZ KvR K‡i cÖvq gvby‡li gZ 

djvdj cÖ`v‡bi †Póv K‡i| K…wÎg eyw×gËvi Kv‡Ri g‡a¨ i‡q‡Q G·cvU© wm‡÷g, cÖvK…wZK fvlv Abyaveb, 

K_v mbv³KiY, wfkb Ges †iv‡evwU· BZ¨vw`|  
 

gvwëwgwWqv (Multimedia)  

gvwë A_© eû Ges wgwWqv A_© gva¨g| †mB w`K †_‡K kãMZ A‡_© gvwëwgwWqv n‡jv eû gva¨g| 

eZ©gvb mg‡q Kw¤úDUvi cwigÛ‡j eûj Av‡jvwPZ bvg gvwëwgwWqv| K_v, `„„k¨, kã, BZ¨vw` mgš^‡q m„ó 

eûgvwÎK Dc ’̄vcbvi bvg gvwëwgwWqv| gvwëwgwWqv myweav AR©bi Rb¨ Kw¤cDUv‡ii mv‡_ KwZcq AwZwi³ 

nvW©Iq¨vi I mdUIq¨vi ms‡hvR‡bi cÖ‡qvRb nq| gvwëwgwWqv myweav m¤ŵjZ Kw¤úDUv‡i Qwe †`Lv, Mvb 

†kvbv, BZ¨vw` m¤¢e nq| gvwëwgwWqv myweav AR©‡bi Rb¨ Kw¤úDUv‡i wmwW ig WªvBf, mvDÛ KvW©, ¯úxKvi 

BZ¨vw` nvW©Iq¨vi miÄvg cÖ‡qvRb nq Ges Zrm‡½ cÖ‡qvRb nq gvwëwgwWqv md&UIqvi| †hgb- DB‡ÛvR 

wgwWqv †c­qvi, †RU AwWI, DBb wWwfwW BZ¨vw` GK GKwU gvwëwgwWqv md&UIq¨vi|   

 

gvwëwgwWqvi e¨envi   

  gvwëwgwWqv Kw¤úDUvi cÖhyw³i Ab¨Zg GKwU mvdj¨| wek¦Z_¨ fvÛvi Dc ’̄vcbvi Rb¨ 

eû wgwWqvi cÖPjb n‡q‡Q| Avi GB eû wgwWqvi Kvh©µg‡K †h wgwWqvi gva¨‡g Dc‡fvM Kiv hvq Zv‡K 

e‡j gvwëwgwWqv| GKwU gvwëwgwWqvhy³ Kw¤úDUv‡i ˆ`bw›`b KvR K‡g©i cvkvcvwk Qwe †`Lv, Mvb †kvbv, 

K_v ev Mvb †iKW© Kiv, wmwW †c­ Kiv, †Uwjwfkb †`Lv, B›Uvi‡b‡Ui gva¨‡g Z‡_¨i Av`vb-cÖ`vb Kiv 

BZ¨vw` KvR Kiv hvq| gvwëwgwWqvi e‡`Šj‡Z we‡k¦i mKj cÖKvi Mvb I we‡bv`b e¨e ’̄v GLb Avgv‡`i 

nv‡Zi gy‡Vvq aiv w`‡q‡Q| wk¶v †¶‡Î gvwëwgwWqv e¨env‡ii d‡j wk¶v_©xMY cvV¨ welq mn‡R eyS‡Z 

m¶g nq| gvwëwgwWqvi mvnvh¨ AwWI gva¨g I AwWI gva¨g e¨env‡ii d‡j wk¶vi welq‡K wbLuyZfv‡e 

dzwU‡q †Zvjv hvq| †Kvb wel‡qi Pjgvb Qwe D³ welq m¤c©‡K ¯có avibv †`q| gvwëwgwWqvi e¨env‡i 

†hvMv‡hvM e¨e ’̄vi Af~Zc~e© DbœwZ N‡U‡Q| GLb wfwWI †Uwj‡dvb e¨envi K‡i AvjvciZ `yÕRb e¨w³ G‡K 

Ab¨‡K w¯Œ‡b †`L‡Z cv‡i| gvwëwgwWqvi mvnv‡h¨ †µZv N‡i e‡m B›Uvi‡bU Gi gva¨‡g c‡Y¨i AW©vi w`‡Z 

cv‡i| g~j¨ cwi‡kva Ki‡Z cv‡i Ges †Wwjfvwi †c‡Z cv‡i|  gvwëwgwWqvi mvnv‡h¨ GKRb e¨w³ N‡i e‡m 

B›Uvi‡bU gva¨‡g we‡k¦i eo eo wUwKrmv †K›`ª ev nvmcvZv‡ji mv‡_ †hvMv‡hvM Ki‡Z cv‡i| wewfbœ 

Wv³v‡ii mv‡_ civg©k K‡i †iv‡Mi wPwKrmvcÎ msMÖn Ki‡Z cv‡i|  
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Aa¨vq-2 

Kw¤úDUvi cwiwPwZ 

Introduction to Computer  

fywgKv t  Kw¤úDUvi n‡”Q GKwU AvaywbK B‡jKUªwbK hš¿| A‡bK¸‡jv Kw¤úDUvi nvW©Iq¨vi 

hš¿vs‡ki mgš^‡q GKwU c~Y©vsM Kw¤úDUv‡i iƒc cvq| G hš¿vsk¸‡jv mPj Ki‡Z cÖ‡qvRb nq mdU&Iq¨vi| 

GKwU c~Y©vsM Kw¤úDUvi ˆZwii †¶‡Î D‡j­L‡hvM¨ Components n‡jv  BbcyU wWfvBm (Input 

Device), AvDUcyU wWfvBm (Output Device) I wm‡÷g BDwbU (System Unit)|  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

BbcyU wWfvBm (Input Device)  

Kw¤úDUv‡ii †h mg —̄ wWfvB‡mi gva¨‡g ‡WUv (Data) BbcyU Kiv nq ‡m¸‡jv‡K BbcyU wWfvBm 

e‡j|  †hgb t- Mouse, Keyboard, Scanner, OMR, OCR BZ¨vw`| 

gvDm (Mouse) t gvDm GKwU BbcyU wWfvBm| Bnvi mvnv‡h¨ 

‡WUv BbcyU I wb‡`©k cÖ`vb Kiv nq|  

Kx-†evW© (Keyboard)  
Kx-†evW© GKwU 

BbcyU wWfvBm| Kx-

†ev‡W© wewfbœ ai‡bi Kx 

i‡q‡Q| Kx-†ev‡W©i Kx-

¸‡jv Øviv †WUv UvBc 

K‡i Kw¤úDUv‡i BbcyU 

Kiv nq|  

 

gvDm 

wm‡÷g BDwbU 

(CPU) 

Kx‡evW©© 

 

wcÖ›Uvi 
 

w¯úKvi 

gwbUi 
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¯‹¨vbvi (Scanner)    

¯‹¨vbvi GKwU BbcyU wWfvBm| Bnvi gva¨‡g K¨v‡givq 

†Zvjv Qwe, gyw`ªZ †Kvb Qwe ev †jLv ûeû Kw¤úDUv‡ii BbcyU 

Kivi Kv‡R e¨eüZ n‡q _v‡K|   

 

IGgAvi (Optical Mark Reader)  
Bnv †Kvb welq ïay gvK© Kiv Ask Kw¤úDUvi‡K Rvbvq| A_©vr 

c~‡e© †mU Kiv †Kvb 

‡cÖvMÖv‡gi wfwË‡Z Bnv 

djvdj cÖKvk K‡i _v‡K| †hgb ˆbwgwËK cÖ‡kœi DËi c‡Îi djvdj 

`ª“Z cvIqvi Rb¨ IGgAvi e¨envi Kiv n‡q _v‡K| 

IwmAvi (Optical Character Reader)  

mvaviY KvMR I Kvwj‡Z Qvcv K¨v‡i±vi (eY©,msL¨v I wKQy 

we‡kl wPý) eySvi Rb¨ GB IwmAvi e¨envi Kiv nq| AvRKvj Bnv 

†cvó Awdm, e¨vsK BZ¨vw` cÖwZôv‡b e¨envi Kiv n‡”Q| 

wm‡÷g BDwbU/cÖ‡mm BDwbU (System Unit/Process Unit)  

wm‡÷g BDwbU Kw¤úDUvi †m‡Ui †Kwms AskwU‡K eySvq| myZivs 

Kw¤úDUv‡i †h As‡k BbcyUK…Z ‡WUv cÖ‡mm K‡i Zv‡K wm‡÷g 

BDwbU/cÖ‡mm BDwbU e‡j| ‡WUv¸‡jv cÖ‡mm Kivi †¶‡Î D‡j­ L‡hvM¨ 

Ask n‡jv  CPU (Central Processing Unit)|  

CPU (Central Processing Unit) Gi wZbwU Ask i‡q‡Q|  

1. wbqš¿Y Ask (Control Unit) 

2. MvwYwZK I hyw³ Ask (Arithmetic and Logic 

Unit) 

3. ¯§„wZ/‡iwR÷vi Ask (Memory/Register Unit) 

wbqš¿Y Ask (Control Unit)  

wbqš¿Y As‡ki KvR n‡jv cÖwZwU wb‡`©k‡K mwVKfv‡e cix¶v K‡i Kvh©Ki Kivi Rb¨ cÖ‡qvRbxq 

ms‡KZ ˆZwi Kiv| wbqš¿Y Ask †cÖvMÖv‡gi wb‡`©kmg~n‡K GKwUi c‡i GKwU mwVKfv‡e Abyave‡bi ci 

Kvh©Ki K‡i|   

MvwYwZK I hyw³ Ask (Arithmetic and Logic Unit)  

wewfbœ cÖKvi jwRK mvwK©U Gi mgš^‡q MvwYwZK I hyw³ Ask MwVZ| GB As‡k hveZxq MvwYwZK 

(†hgb †hvM, we‡qvM, ¸Y, fvM BZ¨vw`) I hyw³gyjK mgm¨vi mgvavb K‡i| KvR †k‡l djvdj cÖavb 

¯§„wZ‡Z Rgv nq Ges AvDUcyU wWfvB‡m (gwbUi) †cÖwiZ nq| 

¯§„wZ/‡iwR÷vi Ask (Memory/Register Unit)   

‡Kvb †cÖvMÖvg wba©vi‡Yi mgq GB Af¨š—ixY †iwR÷ªvi¸‡jv ¯̂í¶Y ‡WUv msi¶Y Ges MvwYwZK 

hyw³ As‡k Z_¨ cÖwµqvKi‡Yi Kv‡R †iwR÷vi¸wj e¨eüZ nq|  GB mKj †iwR÷v‡i `ª“Z wjLb I cVb 

m¤¢e|  

 

AvDUcyU wWfvBm (Output Device)   
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Kw¤úDUv‡ii †h As‡ki gva¨‡g cÖ‡mmK…Z †WUv AvDUcyU wnmv‡e †`L‡Z cvB Zv AvDUcyU wWfvBm 

e‡j| †hgb t Monitor, Printer, Plotter BZ¨vw`| 

gwbUi (Monitor)  

Kw¤úDUv‡ii hveZxq Kvh©µg‡K cÖ`k©‡bi Rb¨ †h c`©v e¨envi 

Kiv nq Zv‡K mnR fvlvq gwbUi e‡j|  

wcÖ›Uvi (Printer)   
wcÖ›Uvi GKwU AvDUcyU wWfvBm, Kw¤úDUv‡i 

Z_¨ cÖwµqvKi‡Yi djvdj‡K wjwLZ AvKv‡i cvIqvi 

Rb¨ wc›Uvi e¨envi Kiv nh| wcÖ›Uvi `Õyai‡bi n‡q 

_v‡K|  

‡g‡gvwii avib ¶gZv t 

 Kw¤úDUv‡ii †g‡gvwi avib ¶gZv ej‡Z eySvq Kw¤úDUvi Zvi ¯§„wZ ’̄v‡b 

KZK¸‡jv weU ev evBU msi¶Y Ki‡Z cv‡i| †g‡gvwii avib ¶gZv cwigv‡ci 

GKK¸‡jv g‡a¨ m¤úK© wb‡gœ †`qv n‡jv|  

 8  weU   =  1 evBU 

 1024   evBU  =  1 wK‡jvevBU 

 1024   wK‡jvevBU =  1 †gMvevBU 

 1024   †gMvevBU =  1 wMMvevBU 

 1024   wMMvevBU =  1 †UivevBU  

weU (Bit) : Kw¤úDUv‡ii mg —̄ Af¨š—ixY Kvh©cÖYvjx evBbvwi (Binary) msL¨v c×wZ‡Z msMwVZ| A_©vr 

evBbvwi msL¨v c×wZ Kw¤úDUv‡ii Kvh© wbe©v‡ni gyj wfwË| GB evBbvwi msL¨v c×wZi †gŠwjK ỳwU AsK 0 

(kyb¨) Ges 1 (GK) †K weU e‡j| evBbvwi As‡Ki msw¶ß iƒc weU| 

evBU (Byte) t AvUwU weU wb‡q MwVZ nq GKwU evBU| Kw¤úDUv‡i evB‡Ui Øviv eY©, AsK Ges we‡kl 

wPý‡K wbw`©ó Kiv nq| G†¶‡Î GKwU ¯§„wZ ’̄v‡b GKwU evBU msi¶‡Yi e¨e ’̄v _v‡K|  

‡÷v‡iR wWfvBm (Storage Device)   

Kw¤úDUv‡ii †h Ask¸‡jv‡Z ‡WUv msiw¶Z K‡i ivLv nq †mB Ask¸‡jv‡K ‡÷v‡iR wWfvBm 

e‡j| †hgb Hard Disk, Floppy Disk, CD-ROM, DVD-ROM BZ¨vw`| BbcyU wWfvB‡mi 

gva¨‡g ‡WUv Kw¤úDUv‡i BbcyU K‡i ‡÷vi wWfvB‡m msi¶Y K‡i ivLv hvq| cÖ‡qvR‡b ‡÷v‡iR wWfvBm 

†_‡K msiw¶Z ‡WUv wb‡q KvR Kiv hvq| 

nvW© wW¯‹ (Hard Disk)  

Bnv Kw¤úDUv‡ii GKwU eo †÷v‡iR wWfvBm| 

Bnvi g‡a¨ A‡bK ‡WUv ivLv hvq| Kw¤úDUv‡i KvR 

Kivi ci Save (msi¶Y) Ki‡j mvaviYZt nvW©wW‡¯‹ 

’̄vqxfv‡e Rgv _v‡K| Kw¤úDUvi Ad Ki‡jI nvW©wW‡¯‹ 

Rgv _vKv Z_¨ gy‡Q hvq bv|  

wmwW (Compact Disk)  

wmwW Kw¤úDUv‡ii BbcyU I AvDUcyU wWfvB‡mi KvR K‡i _v‡K| Bnvi gva¨‡g ‡WUv/Qwe GK 

Kw¤úDUvi †_‡K Ab¨ Kw¤úDUv‡i †bqv hvq|  
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wWwfwW (DVD) 

 wWwfwW Gi c~Y© bvg wWwRUvj fvm©vUvBj wW¯‹ (Digital Versatile Disk)| wmwWi g‡Zv 

wWwfwWI Kw¤úDUv‡ii GKwU BbcyU/AvDUcyU wWfvBm| Z‡e wmwWi †P‡q wWwfwW †ekx aviY ¶gZv m¤úbœ|  

‡cb WªvBf (Pen Drive) 

 ‡cb WªvBf (Pen Drive) Kw¤úDUv‡ii GKwU mnvqK 

†g‡gvwi wnmv‡e e¨envi Kiv nq| †cb WªvB‡fi gva¨‡g ‡WUv, 

Z_¨vw`, †cÖvMÖvg ev Ab¨vb¨ mdU&Iq¨vi GK Kw¤úDUvi n‡Z Ab¨ 

Kw¤úDUv‡i ¯’vbvš—i Kiv hvq|  

‡g‡gvwi (Memory) m¤ú‡K© Av‡jvPbv 

‡g‡gvwi k‡ãi A_© n‡”Q ¯§„wZ|  KwgDUv‡ii †h As‡k 

wewfbœ Z_¨ I wb‡`©kvejx msi¶Y K‡i ivLv nq †mB Ask‡K 

†g‡gvwi e‡j| †g‡gvwi cÖavbZ wZb cÖKvi  

1. cÖavb †g‡gvwi (Main Memory/Primary 

Memory) 

2. mnvqK †g‡gvwi (Auxiliary Memory/Secondary Memory) 

3. K¨vk †g‡gvwi (Cache Memory) 

Q‡Ki gva¨‡g wewfbœ cÖKvi †g‡gvwii †kªYx wefvM †`Lv‡bv n‡jv t 

 

 

 

 

 

 

 

 

 

 

cÖavb †g‡gvwi (Main Memory/Primary Memory)  

Kw¤úDUv‡ii wmwcBD Gi mv‡_ mshy³ Af¨š—wiY †g‡gvwi‡K cÖavb †g‡gvwi e‡j| cÖavb †g‡gvwi 

`yB cÖKvi  

(1) RAM (Random Access Memory) 

(2) ROM (Read Only Memory) 

i¨vg (RAM)   

i¨vg GKwU A ’̄vqx ‡g‡gvwi| i¨vg‡K KwgDUv‡ii 

IqvK© †¯úm ejv nq| i¨v‡g †h †Kvb mgq †h †Kvb Z_¨ 

†jLv hvq,cov hvq, cÖ‡qvR‡b gyQv hvq| Kw¤úDUvi Ad 

Ki‡j/we`~¨Z P‡j †M‡j mKj ‡WUv i¨vg †_‡K gy‡Q hvq|  

‡g‡gvwi (Memory) 

cÖavb †g‡gvwi 

i¨vg ig 

mnvqK †g‡gvwi K¨vk †g‡gvwi 

 nvW©wW¯‹ 

  wmwW 

 wWwfwW 

 †cb WªvBf 

 ‡d¬vwc wW¯‹ 

÷¨wUK 

†g‡gvwi 

WvB‡bwgK 

†g‡gvwi 

 PROM 

 EPROM 

 EEPROM 

  
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ig (ROM)  

ig (ROM) Gi c~Y A_© n‡jv Read Only Memory| GB †g‡gvwi‡Z Z_¨ ïay cov hvq wKš‘ 

‡jLv ev ms‡kvab Kiv hvq bv| ig GKwU ¯’vqx †g‡gvwi|  

mnvqK †g‡gvwi (Auxiliary Memory/Secondary Memory)  

Kw¤úDUv‡ii †h ¯§„wZ‡Z ‡WUv ’̄vqxfv‡e ivLv hvq †mB ¯§„wZ‡K mnvqK ¯§„wZ e‡j|  GB †g‡gvwi‡Z 

Kw¤úDUv‡ii AwaK cwigvb Z_¨ ’̄vqxfv‡e msi¶Y K‡i ivLv hvq| eZ©gv‡b Kw¤úDUv‡ii ms‡M eûj 

e¨eüZ K‡qKwU mnvqK †g‡gvwi  nÕj Hard Disk, Floppy Disk, DVD, Pen Drive BZ¨vw`| 

K¨vk †g‡gvwi (Cache Memory)  

cÖavb †g‡gvwi Kv‡Ri MwZ e„w×i Rb¨ cÖ‡mmi I cÖavb †g‡gvwi Aš—e©Z©x ’̄v‡b ’̄vwcZ we‡kl ai‡bi 

¯§„wZ‡K K¨vk †g‡gvwi e‡j| K¨vk †g‡gvwi cÖavb †g‡gvwi A‡c¶v `ª“Z MwZ‡Z KvR Ki‡Z cv‡i| wmwcBD 

†h MwZ‡Z Ki‡Z cv‡i cÖavb †g‡gvwi †mB MwZ‡Z KvR Ki‡Z cv‡i bv| GB Amyweavi `yi Kivi Rb¨ cÖavb 

‡g‡gvwi I wmwcBD Gi gv‡S K¨vk †g‡gvwi e¨eüZ nq|  

fviPz¨qvj †g‡gvwi (Virtual Memory)  

 fviPy¨qvj †g‡gvwi n‡jv Ggb GK ai‡bi wm‡÷g hvi mvnv‡h¨ Kw¤úDUv‡ii mnvqK †g‡gvwii Ask 

we‡kl‡K cÖavb †g‡gvwi wn‡m‡e e¨envi Ki‡Z cv‡i| mvaviYZ cÖavb †g‡gvwii avib ¶gZv mxwgZ _v‡K| 

Kw¤úDUvi hLb cÖavb †g‡gvwii avib ¶gZvi †P‡q †ewk KvR Kivi cÖ‡qvRb nq ZLb nvW©wW‡·i wbw`©ó 

duvKv Ask‡K cÖavb †g‡gvwi wnmv‡e e¨envi Ki‡Z cv‡i| GB e¨e ’̄v‡K fviPz¨qvj †g‡gvwi ejv nq| 

nvW©wW‡·i †h AskUzKz‡K cÖavb ‡g‡gvwi wnmv‡e e¨envi Kiv n‡e †mLv‡b †Kvb Z_¨ msi¶Y Kiv hv‡e bv|  
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Aa¨vq-3 

Kw¤úDUv‡ii BwZnvm 

History of Computer 

Kw¤úDUv‡ii BwZnvm (History of Computer)  

 gvbyl cÖ_‡g bywo, cv_i, wSbyK, nv‡Zi Av½yj, `woi wMU BZ¨vw`i gva¨‡g MYbv Ki‡Zv| Kv‡ji 

weeZ©‡b gvby‡li wPš—vkw³ cweeZ©‡bi Kvi‡Y µgvMZ M‡elYv I D™¢ve‡bi dmj n‡jv Kw¤úDUvi| 

Kw¤úDUvi GKwU MYbvKvix 

hš¿| MYbvKvix hš¿ wnmv‡e 

cÖ_g A¨vevKvm bvgK 

Kw¤úDUvi Pxb †`‡k ˆZwi 

Kiv nq| Zvici Kv‡ji 

weeZ©‡bi cvkvcvwk Kw¤úDUvi 

Gi e¨vcK cwieZ©b mvwaZ 

nq| AvaywbK Kw¤úDUvi Gi 

iƒc‡iLv ˆZwi K‡ib e„wUk 

MwYZ wekvi` Pvj©m e¨v‡eR| 

wZwb 1833 mv‡j 

A¨vbvwjwUK¨vj bvgK MYbv 

KviK hš¿ ˆZwii cwiKíbv 

K‡ib| GB h‡š¿ hv‡Z ¯§„wZ  

a‡i ivLv hvq Zvi cwiKíbv K‡ib| wKš‘ mvsmvwiK Afv‡ei  Kvi‡Y Zvi G cÖ‡Póv mvdj¨ AR©b Ki‡Z 

cv‡ib bvB| Z‡e Zvi GB cwiKíbvi Dci wfwË K‡i ˆZwi n‡q‡Q AvR‡Ki AvaywbK Kw¤úDUvi|  

 

ZvB Pvj©m e¨v‡eR‡K AvaywbK Kw¤úDUv‡ii 

RbK ejv nq| cieZ©x‡Z Zvi GB cwiKíbvi 

Dci M‡elYv Pj‡Z _v‡K|  jÛb †_‡K Pwj­k 

gvBj `~‡i †e­Pwj cv‡K©i †KvW GÛ mvBdvi 

¯‹z‡j ïi“ nq `ª“ZMwZ‡Z ms‡KZ wjwci A_© 

D×v‡i m¶g Ggb hš¿ D™¢ve‡bi cÖ‡Póv| Uwg 

d¬vDqvm©, A¨v‡jb Uvwis cÖgyL M‡elK‡`i 

AK¬vš— cwikª‡gi dj n‡”Q 1943 mv‡j wbwg©Z 

Colossus Kw¤úDUvi| f¨vKzqvg wUDe w`‡q 

wbwg©Z GwU n‡”Q me©cÖ_g m¤ú~Y© B‡j±ªwbK  

 

wWwRUvj Kw¤úDUvi| Ab¨w`‡K AvUjvw›UK 

gnvmvM‡ii Icv‡i hy³iv‡óªi mk ¿̄ evwnbx 

†¶cbv‡¯¿i c_ cwigv‡ci Rb¨ `ª“ZMwZi wnmve 

h‡š¿i cÖ‡qvRb Dcjwä K‡i| j¶¨ ’̄v‡bi `~i‡Z¡i 

Dci wbf©i K‡i  †¶cbv ¿̄ wb‡¶c‡bi †KvY 

cwieZ©b Ki‡Z nq| Gi Rb¨ `~i‡Z¡i ms‡M †Kv‡Yi 

m¤ú‡K©i mviYx ˆZwii cÖ‡qvRb| †gixj¨v‡Ûi 

A¨vevKvm (Abacus) 

GbvjvBwUK¨vj BwÄb (Analytical Engine) 
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e¨vjvw÷K wimvP© j¨ve 1943 mv‡j BDwbf©vwmwU Ad c¨vbm¨vjwfwbqvi gyi ¯‹zj Ad B‡jKwUªK¨vj 

BwÄwbqvwis Gi Aa¨vcK Rb gkjx (John Mauchly) Ges Zvi cÖ‡KŠkjx †cÖmcvi BKvU© (J. Presper 

Eckert) ‡K GB Kv‡Ri Rb¨ wb‡qvwRZ K‡i| GB cÖKí †_‡KB Rb¥ †bq ENIAC   (Electrical 

Numerical Integrator And Calculator) Kw¤úDUvi| GB ENIAC Kw¤úDUvi wbg©vY KvR †kl nq 

1945 mv‡ji b‡f¤^i gv‡m| wÎkUb IR‡bi  ENIAC Kw¤úDUviwU cÖwZ †m‡K‡Û 5000wU †hvM, 357wU 

¸Y Ki‡Z m¶g wQj| GK nvRvi eM©dzU RvqMv `LjKvix GB Kw¤úDUvi Pvjv‡bvi Rb¨ 130 †_‡K 140 

wK‡jvIqvU we ỳ¨r kw³i cÖ‡qvRb nZ|  1944 mv‡j Av‡gwiKvi PviRb cÖ‡KŠkjxi mn‡hvwMZvq Mark-1 

bv‡g GKwU ¯q̂swµq wWwRUvj Kw¤úDUvi ˆZwi nq| Bnv wQj 51 dzU j¤v̂ Ges 8 dzU DPz|  

 1946 mv‡j †KgweªR wek¦we`¨vj‡qi cÖ‡dmi gwim DBjKk EDSAC (Electronic Delay 

Storage Automatic Computer) bvgK ¯̂qswµq B‡KUªwbK wWwRUvj Kw¤úDUvi cÖ ‘̄Z K‡ib| 

‡iwgsUb e¨vÛ bv‡g †Kv¤úvbx 1951 mv‡j 

BDwbf¨vK-1 bv‡g Kw¤úDUvi ˆZwi K‡ib| 

Bnv cÖ_g evwYwR¨K wfwË‡Z Drcvw`Z nq| 

GB Kw¤úDUv‡i wµ÷vj Wv‡qv‡Wi myBP I 

f¨vwKDqvg wUDe mvwK©U e¨envi Kiv nq| 

Bnv GKB ms‡M Z_¨ cov, MYbv I †jLvi 

KvR Ki‡Z cvi‡Zv| UªvbwR÷i Avwe¯‹…Z 

nIqvi ci Kw¤úDUvi AvKv‡i †QvU n‡q †h‡Z 

ïi“ K‡i| IC e¨env‡i Kw¤úDUvi Gi 

AvKvi Av‡iv †QvU n‡Z _v‡K|  

 

 

Kw¤úDUv‡ii me‡P‡q eo wec­ e N‡U gvB‡µvcÖ‡mmi Avwe®‹v‡ii d‡j| 1971 mv‡j me©cÖ_g 

Av‡gwiKvi Bb‡Uj †Kv¤úvbx gvB‡µvcÖ‡mmi ˆZwi K‡i| Bnv Avwe®‹v‡ii d‡j Kw¤úDUvi GKwU e‡·i gZ 

†QvU AvKvi avib K‡i| Z‡e Kv‡Ri MwZ e„w× cvq| eZ©gv‡b evRv‡i 3.0 GHz Gi AwaK ¶gZv m¤úbœ 

gvB‡µvcÖ‡mmi cvIqv hvq| GB High Speed cÖ‡mmi m¤ŵjZ Kw¤úDUv‡ii mvnv‡h¨ `ª“Z B›Uvi‡bU I 

†bUIqv‡K©i KvR AwZ mn‡R Kiv hv‡”Q| 

Kw¤úDUvi cÖRb¥ (Computer Generations)  
 

 Kw¤úDUvi Avwe¯‹vi nIqvi ci †_‡K Gi cÖhyw³MZ DbœwZ, Kv‡Ri MwZ Ges AvK…wZMZ cwieZ©b 

ev weeZ©b NU‡Z _v‡K| GB weeZ©b I weKv‡ki GK GKwU avc‡K cÖRb¥ e‡j| Kw¤úDUvi wk‡íi 

µgweKv‡ki j‡¶ GwU wbg©vY KvVv‡gviƒ‡c KvR K‡i| weeZ©‡bi A‡bK¸‡jv avc AwZµg K‡i Kw¤úDUvi 

AvR eZ©gvb Ae¯’vq G‡m‡Q| cÖhyw³MZ Dbœqb Kw¤úDUvi‡K DbœZ †_‡K DbœZZi K‡i‡Q| GKwU cÖRb¥ 

†_‡K Avi GKwU cÖR‡b¥i cwieZ©‡bi mgq mgm¨v¸‡jvi mgvavb K‡i bZzb wKQy ˆewk‡ó¨i mgš^q NwU‡q GK 

GKwU cÖR‡b¥i AvZœcÖKvk NUv‡bv nq| Z‡e bZzb ˆewk‡ó¨i cvkvcvwk cyi‡bv ˆewkó¨¸‡jv †_‡K hvq|  

cÖ_g cÖR‡b¥i Kw¤úDUvi (First Generation Computer) [1940-1956]   

cÖ_g cÖR‡b¥i Kw¤úDUv‡i 

f¨vKzqvg wUDe e¨envi Kiv nZ| nvRvi 

nvRvi Wv‡qvW fvj&f, †iwR÷vi, 

K¨vcvwmUi BZ¨vw` w`‡q ˆZwi n‡Zv e‡j 

Giv AvKv‡i A‡bK eo wQj| K‡qKUv 

Ni Ry‡o _vKZ H me Kw¤úDUvi, hv 

eZ©gv‡b AKíbxq| Pvjy Ae¯’vq 

BDwbf¨vK-1 (Univac-1) 
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Kw¤úDUvi fxlY Mig n‡q †hZ| ZvB bv cy‡o hvevi Rb¨ gv‡S gv‡S VvÛv cvwb e¨envi Ki‡Z n‡Zv| G 

¸‡jv wQj mxwgZ Z_¨ aviY ¶gZv m¤úbœ Ges cwiPvjbvi  R‡b¨ AZ¨vwaK we`y¨r kw³ cÖ‡qvRb n‡Zv| 

fvj‡fi Kvh©KvjI Lye Kg| G Kw¤úDUvi¸‡jv e¨q eûj n‡jI Kg wbf©i‡hvM¨ wQj| Kv‡Ri MwZ wQj 

gš’i| 1943 mv‡j wbwg©Z me©cÖ_g m¤ú~Y© B‡j±ªwbK wWwRUvj Kw¤úDUvi n‡jv ENIAC (Electronic 

Numerical Integrator and Calculator) Kw¤úDUvi | Bnv ˆZwi K‡ib BDwbf©vwmwU Ad 

‡cbwmjwfwbqvi gyi ¯‹zj Ad B‡jKwUªK¨vj BwÄwbqvwis Gi Aa¨vcK Rb gDmjx   (John Mauchly) 

Ges Zvi cÖ‡KŠkjx †cÖmcvi BKvU© (J. Presper Eckert)| 1943 mv‡j GB Kw¤úDUvi KvR ïi“ nq 

Ges 1945 mv‡j GB Kw¤úDUv‡ii KvR †kl nq| AvUjvw›UK gnvmvM‡ii Icv‡i hy³iv‡óªi mk ¿̄ evwnbx 

†¶cbv‡¯¿i c_ cwigv‡ci Rb¨ `ª“ZMwZi wnmve h‡š¿i cÖ‡qvRb Dcjwä K‡i| j¶¨ ’̄v‡bi `~i‡Z¡i Dci 

wbf©i K‡i †¶cYv¯¿ wb‡¶c‡Yi †KvY cwieZ©b Ki‡Z nq| GB Rb¨ ENIAC (Electronic Numerical 

Integrator and Calculator) Kw¤úDUv‡ii Rb¥ nq|  

1944 mv‡j Av‡gwiKvi PviRb cÖ‡KŠkjxi mn‡hvwMZvq Mark-1 bv‡g GKwU ¯̂qswµq wWwRUvj Kw¤úDUvi 

ˆZwi nq| Bnv wQj 51 dzU j¤^v Ges 8 dzU DPz| 1954 mv‡ji †k‡l †ev÷‡b cÖ_g Avwef©~Z nq IBM-

650| GwU wQj G cÖR‡b¥i e¨vcKfv‡e mgv`„Z Kw¤úDUvi|  

cÖ_g cÖR‡b¥i Kw¤úDUv‡ii g‡a¨ IBM-650, MARK-I, ENIAC, EDVAC EDSAC  

BZ¨vw` D‡j­ L‡hvM¨| G me Kw¤úDUv‡i cÖ_‡g †gwk‡bi fvlvq Ges c‡i 1952-53 mv‡j A¨v‡m¤^jx fvlvq 

†cÖvMÖvg ˆZwi Kiv nq|  

cÖ_g cÖR‡b¥i Kw¤úDUv‡ii ‰ewkó¨ 

1| f¨vKzqvg wUDe I wewfbœ ai‡bi ˆe`y¨wZK eZ©bxi e¨envi | 

2| axi MwZ m¤úbœ MYbvKvix hš¿|  

3| AvKv‡i A‡bK eo |   

4| cvÂKv‡W©i gva¨‡g BbcyU-AvDUcyU e¨e ’̄v Kiv nq| 

5| ‡gwkb fvlvi wb‡`©k cÖ`vb|  

6| ‡ggwi wnmv‡e g¨vM‡bwUK Wªv‡gi e¨envi|  
 

wØZxq cÖR‡b¥i Kw¤úDUvi (Second 

Generation Computer) [1957-1963]  

1948 mv‡j Av‡gwiKvi †ej j¨ve‡iUwi‡Z 

DBwjqvg kKwj (Wiliam B. Shokly), Rb 

evwW©b (John Berdeen) Ges GBP e„‡Ub (H. 

Bratain) mw¤§wjZfv‡e UªvbwR÷i ˆZwi K‡ib| G 

UªvbwR÷i Kw¤úDUv‡ii DbœwZ‡Z wec­ e G‡b †`q| 

GB cÖR‡b¥i f¨vKzqvg wUDe Gi cwie‡Z© UªvbwR÷i e¨envi Kiv nZ| UªvbwR÷i Avwe®‹vi nIqvi ci 

Kw¤úDUvi cÖhyw³i Rb¨ GK bZzb m¤¢vebvi Øvi D‡¤§vwPZ nq| GB cÖR‡b¥i Kw¤úDUvi Mig n‡Zv bv| 1g 

cÖR‡b¥i Kw¤úDUvi †_‡K Bnv AvKv‡i †QvU Ges Kg we`y¨r LiP nq| GB cÖR‡b¥i Kw¤úDUv‡i cÖ_g nvB 

†j‡fj cÖvMÖvwgs j¨vs¸‡q‡Ri e¨envi ïi“ nq| †hgb t FORTAN (1956), ALGOL (1958), 

COBOL (1959) | GB cÖR‡b¥i GKwU Kw¤úDUvi IBM 1620 w`‡q 1964 mv‡j evsjv‡`‡k Kw¤úDUvi 

e¨envi m~Pbv Kiv nq| GB Kw¤úDUviwU XvKvi cigvby kw³ †K‡›`ª ’̄vcb Kiv nq|  

 

D`vnibt IBM-1401,CDC 1604,RCA-301,RCA 501,BCR 300,GE 200 Honey 

Well 200,1600,IBM 1620 BZ¨vw`| 

wØZxq cÖR‡b¥i Kw¤úDUv‡ii ‰ewkó¨  

1| UªvbwR÷‡ii e¨venvi ïi“ nq|  

gvK©-1 (Mark-1) 

AvB we Gg-1620 (IBM 1620) 

gvK©-1 (Mark-1) 
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2| g¨vM‡bwUK †Kvi †g‡gvwii e¨envi I mnvqK †g‡gvwi wnmv‡e g¨vM‡bwUK wW‡¯‹i D™¢veb| 

3| D”PMwZ m¤úbœ I DbœZgv‡bi BbcyU-AvDUcyU e¨e ’̄vi cÖPjb|  

4| ‡gwkb fvlvi cwie‡Z© D”P¯—‡ii fvlvi (†hgb- COBOL, FORTRAN, ALGOL BZ¨vw`) 

e¨venvi|  

5| ‡Uwj‡dvb jvBb e¨envi K‡i †WUv †cÖi‡Yi e¨e ’̄v|  

6| AwaK wbf©i‡hvM¨Zv|  

7| ev¯—weK †¶‡Î Kw¤úDUvi e¨env‡ii ïi“|  

Z„Zxq cÖR‡b¥i Kw¤úDUvi (Third Generation Computer) [1964-1970]  

ievU© b‡qm (Robert Noyce) I 

R¨vK wKjwe (Jack Kilby) cÖvq GKB mgq 

c„_Kfv‡e eo mvwK©U ¶z`ª Kivi c×wZ 

Awe®‹vi K‡ib|  GB c×wZ‡Z cÖvß †QvU 

mvwK©U‡K AvBwm(IC) ev Bw›U‡MÖ‡UW mvwK©U 

(Integrated Circuit)  ejv nq| GB 

cÖR‡b¥i Kw¤úDUv‡i IC e¨envi ïi“ Kiv nq| d‡j Kw¤úDUv‡ii AvKvi I `vg K‡g hvq| Z‡e MwZ †e‡o 

hvq| GB cÖR‡b¥ wgwb Kw¤úDUv‡ii e¨envi e„w× cvq| G cÖRb¥ †_‡KB Kw¤úDUv‡ii mv‡_ gwbUi e¨envi 

ïi“ nq| mv‡_ mv‡_ Kw¤úDUvi‡i ¯§„wZ e¨e ’̄viI DbœwZ N‡U| 3q cÖR‡b¥i Kw¤úDUv‡i fvlvi DbœwZ‡Z 

†cÖvMÖv‡g `¶Zv AR©b mnRZi Acv‡iwUs wm‡÷g GB cÖR‡b¥i Kw¤úDUv‡i e¨envi Kiv nq| GB cÖR‡b¥i 

Kw¤úDUv‡i wcÖ›Uv‡ii cÖPjb ïi“ nq| 

D`vnibt IBM 360, IBM 370, PDP-8, PDP-II  BZ¨vw`| 

Z…Zxq cÖR‡b¥i Kw¤úDUv‡ii ‰ewkó¨ 

1| Kw¤úDUv‡i GKxf~Z eZ©bxi (IC) cÖPjb| 

2| AvK…wZ‡Z †QvU, `vg Kg Ges ¶gZv e„w×|  

3| gyw`ªZ AvKv‡i jvBb wcÖ›Uv‡ii e¨envi|   

4| AvDUcyU wn‡m‡e wfwWI wWm‡c­  BDwb‡Ui cÖPjb|  

5| D”PZi fvlvi eûj e¨envi|  

6| wgwb Kw¤úDUv‡ii D™¢e|  

7| Aa©cwievnx ¯§„wZi e¨envi|  

4_© cÖR‡b¥i Kw¤úDUvi (Fourth Generation Computer) [1971-eZ©gvb]  

1971 mvj †_‡K PZz_© cÖRb¥ ïi“ n‡q‡Q e‡j aiv nq| LSI (Large Scale Integration) I 

VLSI (Very Large Scale Integration) gvB‡µvcÖ‡mmi Ges Semi Conductor Memory w`‡q 

GB cÖR‡b¥i Kw¤úDUvi ˆZwi nq| VLSI Gi gvB‡µvcÖ‡mmi 

wb‡q MwVZ †QvU Kw¤úDUvi‡K gvB‡µvKw¤úDUvi e‡j| 

Av‡gwiKvi Rb e­ ¨vs‡Kb †eKvi 1971 mv‡j †Kbe¨vK 

(Kenbak) bvgK cÖ_g gvB‡µvKw¤úDUvi ˆZwi K‡ib| c‡i 

1977 mv‡j gvB‡µvKw¤úDUvi c~Y©v½ i“c jvf K‡i| 1981 

mv‡j AvBweGg ‡Kv¤úvbx e¨emvwqK D‡Ï‡k¨ cÖ_g 

gvB‡µvKw¤úDUvi ˆZwi ïi“ K‡i| 4_© cÖRb¥ †_‡K 

gvB‡µvKw¤úDUvi Pvjy nq| d‡j Kw¤úDUv‡ii AvKvi †QvU 

nq| Z‡e Kw¤úDUv‡ii MwZ AZ¨vwaK †e‡o hvq| GB cÖR‡b¥ 

Kw¤úDUv‡ii ¯§„wZ D™¢vweZ n‡Z _v‡K| †hgb ROM 

AvB wm (IC) 
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(Read Only Memory), PROM, EPROM.  Kw¤úDUv‡i C Programming language Ges 

DOS, Window, Unix Operating System GB cÖR‡b¥i Kw¤úDUv‡i e¨envi ïi“ n‡q‡Q|  

D`vnvib t  IBM 3033, IBM 4300, IBM S/36, Sharp PC-1211, Apple II, Pentium 1-4,  

BZ¨vw`| 

PZz_© cÖR‡b¥i Kw¤úDUv‡ii ‰ewkó¨ 

1| K…wÎg eyw×gËvi (Artificial Intelligence) e¨envi|  

2| eû gvB‡µvcÖ‡mmi Ges B‡jKUªwbK hš¿vsk wewkó GKxf~Z eZ©bxi e¨envi|  

3| UªvbwR÷i¸‡jv‡Z AcwUK¨vj dvBev‡ii e¨envi|  

4| DbœZ †ggwii Z_v g¨vM‡bwUK evej †ggwii e¨envi|  

5| gvby‡li KÚ¯̂‡ii gva¨‡g cÖ`Ë wb‡`©‡ki Abyaveb|  

6| ‡WUv aviY ¶gZvi e¨vcK DbœwZ|  

7| AZ¨š— kw³kvjx I D”PMwZ m¤úbœ gvB‡µvcÖ‡mm‡ii e¨envi|  

8| mycvi Kw¤úDUv‡ii Dbœqb|  

cÂg cÖR‡b¥i Kw¤úDUvi (Fifth Generation Computer)  

GB cÖR‡b¥i Kw¤úDUvi 4_© cÖR‡b¥i Kw¤úDUvi n‡Z AwaK kw³kvjx| Super VLSI  (Very 

Large Scale Integration) wPc I AcwUK¨vj dvBev‡ii mgš^‡q GB cÖR‡b¥i Kw¤úDUvi ˆZwi| GB 

ai‡bi Kw¤úDUv‡i AZ¨š— kw³kvjx gvB‡µvcÖ‡mmi I cÖPzi cwigvb ‡WUv avib ¶gZv m¤ú~Y© Kivi 

M‡elYv Pj‡Q|  eZ©gv‡b 4_© cÖR‡b¥i Kw¤úDUvi QvovI 5g cÖR‡b¥i Kw¤úDUvi e¨envi Kiv nq| 5g 

cÖR‡b¥i Kw¤úDUv‡i gvby‡li KÚ¯̂i mbv³ Kivi ¶gZv I  K‡Ú †`qv wb‡`©k eyS‡Z †c‡i KvR Kivi  

¶gZv _vK‡e| 5g cÖR‡b¥i Kw¤úDUv‡i †bUIqvwK©s e¨e ’̄vi DbœwZ mvwaZ n‡q‡Q|  

cÂg cÖR‡b¥i Kw¤úDUv‡ii ‰ewkó¨ 

1| K„wÎg eyw×m¤úbœ _vK‡e|  

2| Z_¨ avib ¶gZvi e¨vcK DbœwZ|  

3| AwaK mg„×kvjx gvB‡µvcÖ‡mmi|  

4| ¯̂qswµq Abyev`, MÖnY‡hvM¨ kã w`‡q Kw¤úDUv‡ii mv‡_ ms‡hvM| 

5| wecyj kw³m¤úbœ mycvi Kw¤úDUv‡ii Dbœqb|  

6| Pz¤K̂ †Kvi ¯§„wZi e¨envi|  

7| ‡cÖvMÖvg mvgMÖxi DbœwZ BZ¨vw`|   

Kw¤úDUv‡ii weeZ©b BwZnv‡mi D‡j­ L‡hvM¨ NUbvcwÄi KvjvbyµwgK eY©bv t 

wLªóc~e© 3000 t   Mbbv hš¿ A¨vevKv‡mi (Abacus ) Avwe¯‹vi | 

1612 †_‡K 1614 t Rb †bwcqvi KZ…©K jMvwi`g Avwe¯‹vi | 

1642 †_‡K 1643 t  Ò c¨vmK¨vjÓ- cÖ_g hvwš¿K ‡hvMhš¿ (†eªBR c¨vm‡Kj ) Avwe¯‹vi | 

1801 t    e ¿̄wk‡í cÖ_g cvÂ Kv‡W©i e¨envi ( †h Kv‡W©i ZvuZ ) | 

1820 t    A¨vwi‡_vwgUvi me©cÖ_g evwYwR¨K K¨vjKz‡jU‡ii cÖeZ©b (Ugvm `¨  

Kjgvi ) | 

1822 t   wWdv‡iÝ BwÄ‡bi bKkv ( Pvj©m e¨v‡eR ) Avwe¯‹vi | 

1834 †_‡K 1835 t  A¨vbvwjwUK¨vj BwÄ‡bi cwiKíbv (Pvj©m e¨v‡eR ) | 

1834 †_‡K 1843 t  me©cÖ_g †cÖvMÖv‡gi aviYv ( AMvóv GWv evqib ) | 

1854 t   cÖZxwK hyw³i Dci M‡elYvg~jK iPbv cÖKvk (RR© eyj ) 

1889 t   Av`gïgvwii wn‡m‡ei   Rb¨ cvÂ KvW© e¨envix wnmvehš¿ ( nvig¨vb  

nwjwi_ ) 
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1896 t  nwjwi_ KZ…©K †Uey‡jwUs †gwkb †Kv¤úvwb ( Tabulating Machine Co. MVb 1904 

†_‡K 1906 t evh~k~b¨ wUDe ev fvKzqvg wUD‡ei Avwe¯‹vi (Rb †d¬wgs I wj `¨ d‡i÷ ) 

1911 t   B‡jKwUªK †Uey‡jwUs wm‡÷g I Avi I `y‡Uv †Kv¤úvwb wg‡j K¨vjKz‡jwUs,  

†Uey‡iwUs GÛ †iKwWs †Kv¤úvwb ev ms‡¶‡c wmwUAvi (CTR) MVb | 

1924t   wm.wU Avi Gi bvg B›Uvib¨vkbvj weR‡bm ‡gwkbm K‡cv©‡ikb ev ms‡¶‡c  

AvB. we Gg (IBM ) G cwieZ©b| 

1937 t  eywjqvb exRMwYZ wfwËK evBbvwi mvwK©‡Ui D™¢veb ( RR© w÷weR ) |  

1943 †_‡K  - ENIAC Kw¤úDUv‡ii wbg©vb KvR ïi“ ( gkjx I BKvU© ) | 

1945 t   

1944 t   Mark I Kwg¤úDUvi ( nvIqvW© AvB‡Kb ) Gi Avwe¯‹vi | 

1947 t  ‡ej j¨ve‡iUix G UªvbwR÷i Avwe¯‹vi ( Dwjqvg kKwj) Mark II |  

Kw¤úDUv‡ii wbg©vY Kv‡Ri mgvwß ( nvIqvW© AvB‡Kb) | 

1949 t   Short Order Code cÖ_g D”P ch©v‡qi †cÖvMÖvwgs fvlv (Rb gkjx )  

EDSAC Kw¤úDUvi (gwim DBjK& ) | 

1952 t   IBM 701 Gi cÖeZ©b( AvB we Gg )| 

1953 t   IBM 650 me©cÖ_g evwbwR¨K wfwË‡Z Kw¤úDUvi ‰Zwi ïi“ nq (AvBweGg) 

1965 t   PDP-8  UªvbwR÷vi wfwËK cÖ_g wgwbKw¤úDUvi(W¨vK) | 

1970 t  UNIX Acv‡iwUs wm‡÷‡gi cÖeZ©vb(†ej j¨ve-Gi †Wwbm wiwP I †K‡b_  

Ugmb)- d¬wc wW¯‹ I †WBRx ûBj wcÖ›Uv‡ii Avwef©vi | 

1971 t   4004 bvgK cÖ_g gvB‡µvcÖ‡mmi Gi cÖeZ©b ( B‡›Uj ) | 

1977 t  wej‡MBUm I cjA¨v‡jb wg‡j gvB‡µvmdU Gi cÖwZôv | 

1980 t  AvB we Gg KZ©„K Acv‡iwUs wm‡÷g wn‡m‡e gvB‡µvmdU Gi PC-DOS e¨env‡ii  

  wm×vš— nq | 

1981 t   PC Gi cÖeZ©b ( AvB we Gg)| 

1982 t  Intel 80286-16 weU gvB‡µvcÖ‡mmi (B‡›Uj)me©cÖ_g AvBweGg K¤úvwUej  

(Kjw¤q̂v †WUv †cÖvWv±m ) | 

1983t   C++ fvlvi cÖeZ©b ( GwU GÛ wU †ej j¨v‡ei weqvb© ÷ªvD÷ªvc ) | 

1984 t  wmwW ig (mwb I wdwjc&m ) Gi Avwe¯‹vi | 

1985 t   gvB‡µvmdU KZ…©K Windows 1.0 Gi Avwef©ve Ges 80386 - 32 weU  

   gvB‡µvcÖ‡mmi (B‡›Uj ) | 

1990 t   Windows –3.0 Gi Avwef©ve ( gvB‡µvmdU )-World wide web (WWW)  

Gi  ev¯—evqb ( wUg evY©vim-wj )| 

1993 t   Intel gvB‡µvcÖ‡mmi (B‡›Uj )| 

1995 t   Windows 95 ( gvB‡µvmdU ), Java fvlvi cÖeZ©b ( mvb gvB‡µv wm‡÷gm )  

Toy stoty bvgK me©cÖ_g m¤úyY©fv‡e  Kw¤úDUv‡i wbwg©Z c~Y©‰`N©¨ QvqvQwe | 

 1996 t   Intel Pentium Pro  gvB‡µvcÖ‡mmi (B‡›Uj)| 

1997 t   Intel Pentium mmx gvB‡µvcÖ‡mmi (B‡›Uj)| 

1998 t  Windows 98 ( gvB‡µvmdU ), Intel celeron gvB‡µvcÖ‡mmi (B‡›Uj) Imac  

  Kw¤úDUvi (A¨vcj ) | 

1999 t   Intel pentium III gvB‡µvcÖ‡mmi (B‡›Uj)  Intel xeon gvB‡µvcÖ‡mmi  

(B‡›Uj) MicroSoft windows 2000. office 2000  

2001 t  Intel Pentium IV gvB‡µvcÖ‡mmi (B‡›Uj) I Windows XP( gvB‡µvmdU ) 

cÖPjb  

2004  t  Linux Gi RbwcÖqZv e„w× | 
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Aa¨vq-4 

gvB‡µvmdU IqvW© 

Microsoft Word 
 

Awa‡ekb-: Gg Gm Awd‡mi cÖv_wgK aviYv Ges Gg Gm IqvW© Gi cÖv_©wgK Kvh©vejx I Gi e¨envi 

 

Awa‡ekb cÖZ¨vwkZ wkLbdj (Intended Outcomes of the Session) 

1. cÖwkÿYv_©xMY GgGm Awd‡mi †gŠwjK welqmg~n m¤ú‡K© aviYv jvf Ki‡eb I GwU e¨envi Ki‡Z 

mÿg n‡eb| 

Awa‡ek‡bi iƒc‡iLv 

 

GgGm Awdm I Gg Gm IqvW© Gi ‡gŠwjK welqmg~n m¤ú‡K© AskMÖnbKvix‡`i we`¨vgvb aviYv †R‡b Zvi 

Dci wfwË K‡i Gg Gm IqvW© Gi Dci Av‡jvPbv I nv‡Z Kj‡g Abykxjb Kiv‡bv n‡e| me‡k‡l GKwU 

mswÿß g~j¨vqb n‡e| 

KvR-1 : Gg Gm Awd‡mi cÖv_©wgK aviYv 

gvB‡µvmdU Awdm 

gvB‡µvmdU Awdm gvB‡µvmdU DB‡ÛvR Ges Acv‡iwUs wm‡ó‡gi Rb¨ cvi¯úwiK †W¯‹Uc 

Avwcø‡Kkb,mvf©vi I cwi‡mev Gi GKwU Awdm c¨v‡KR| †hgb- gvB‡µvmdU G‡·j, gvB‡µvmdU IqvW©, 

gvB‡µvmdU cvIqvi c‡q›U BZ¨vw`| Gme Gwcø‡Kkb mdUIq¨vi e¨envi K‡i Dc ’̄vcbv , †jLv. wPwV Ges 

WvUv Gw›Uª ˆZwimn wewfbœ ai‡Yi Awdwmqvj KvR Kiv nq| 

gvB‡µvmdU Awd‡mi wewfbœ fvm©b †hgb: gvB‡µvmdU Awdm 2013, gvB‡µvmdU Awdm 2010, 

gvB‡µvmdU Awdm 2007, gvB‡µvmdU Awdm 2003, gvB‡µvmdU Awdm mvf©vi, gvB‡µvmdU Awdm 

2001 BZ¨vw` cvIqv hvq | 

 

KvR-2 :  GgGm IqvW© Gi e¨envi  

GgGmIqvW©  

gvB‡µvmdU IqvW© GKwU DbœZ gv‡bi WvUv cÖ‡mmi †cÖvMÖvg | wewfbœ mg‡q os Gi wewfbœ ms¯‹vi‡Yi Rb¨ 

MS Word Gi wewfbœ fvm©b ‰Zix Kiv n‡q‡Q| eZ©gv‡b gvB‡µvmdU Awdm 2013, gvB‡µvmdU Awdm 

2010 fvm©b eûj e¨eüZ n‡”Q| G¸‡jv eZ©gvb mg‡q Windows 7, Windows 8 Operating 

system G KvR K‡i| 
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gvB‡µvmdU IqvW©: GKwU IqvW© cÖ‡mwms mdUIq¨vi 

gvB‡µvmdU IqvW©-Gi e¨envi 

 gvB‡µvmdU IqvW©. †hgb Aÿi, cyw Í̄Kv, wkÿv Kvh©µg, cwiÿv, evwoi KvR eivÏKiY wnmve bw_ wbg©v‡Yi 

Rb¨ cÖv_©wgKfv‡e e¨eüZ GKwU RbwcÖq kã cÖwµqvKiY ‡cÖvMÖvg| GwU mnR M‡elYv I Kv‡Ri Rb¨ Ki‡Z 

gvB‡µvmdU IqvW© A‡bK mnR| 

1. evbvb Ges e¨vKviY µzwUi Rb¨ ` Í̄v‡eR †PKKiY 

IqvW© dvBjwUi g‡a¨ welqe¯‘y UvBc Kivi ci †Kvb kã ev ev‡K¨i µzwU _vK‡j Zvi Dci 

Kvm©i †i‡L gvDm Gi Wvb evU‡b wK¬K Ki‡j GK ev GKvwaK kã wb‡q wb‡Pi WvqvjM 

e·wU †`L‡Z cv‡eb (wP‡Î-6.7)| 

 

Dc‡ii mwVK k‡ãi Dci () wK¬K Ki‡j µzwU k‡ãi cwie‡Z© GwU cÖwZ ’̄vwcZ n‡e| 

2. gvB‡µvmdU Iqv‡W© †nWvi GÛ dzWvi Ges †cR bv¤v̂i insert  KiY- 

MS Word Gi Insert Tab ‡_‡K Header & Footer Group G wM‡q †cBR Gi Header & 

Footer Ges Page number Insert Kiv hvq| Avgiv Page number  ‡K wewfbœ Insert 

Ki‡Z cvwi| †hgb- Page Gi Dc‡i, wb‡P, Wv‡b, ev‡g BZ¨vw`| cÖwkÿvb_x‡`i‡K nv‡Z Kj‡g Insert 

Kivi c×wZ †kLv‡eb| 

3. dvBj wmwKDwiwU cvmIqvW© e¨envi- 

     MS Word Gi mKj dvBj g‡a¨ welqe ‘̄y UvBc Kivi c‡i Avcwb cvmIqvW© e¨envi K‡i mKj 

dvBj‡K iÿv Ki‡Z cv‡ib| cÖwkÿK n‡Z Kj‡g wmwKDwiwU cvmIqvW© Kivi c×wZ †kLv‡eb| 

 

gvB‡µvmdU IqvW© Gi wKQz weKí: 

Google Doc: GUv GKwU AbjvBb IqvW© cÖ‡mwms †mev| webvg~‡j¨ ¸Mj G GKvD›U K‡i Avcwb mn‡RB 

GKwU Awdm-IqvW© Gi gZ bw_ ‰Zwi Ki‡Z cv‡ib| 

kã Ges Ab¨vb¨ dig¨v‡Ui g‡a¨ iæcvšÍi: 

wcwWGd wn‡m‡e kã msiÿY: KLbI KLbI Avcwb Ab¨vb¨ e¨enviKvix‡`i mv‡_ Z_¨ fvM K‡i †bIqvi 

Rb¨ mn‡R Ki‡Z wcwWGd G Avcbvi Word bw_ msiÿY Ki‡Z cvi‡Z cvi‡eb| 
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gvB‡µvmdU IqvW© †Kgb K‡i Pvjy Ki‡eb ? 

Kw¤úDUvi Open Kivi c‡i ¯‹xb Gi wb‡P evg cv‡ki KY©v‡ii Start Button G Click Ki‡Z n‡e| 

Start > All Programs > Microsoft Office > Microsoft Office Word 2013  

 
wPÎ - MS Word Open Kiv| 

 

wPÎ- gvB‡µvmdU IqvW© Gi cwiwPwZ 

*cÖwkÿbv_©x‡`i bZzb WKz‡g›U Open Kivi c×wZ nv‡Z Kj‡g †kLv‡eb| 

 

Document  Save Kivi c×wZ: 

 

New document  open Kivi ci Microsoft Word Windows Gi evg cv‡k Dc‡ii 

KY©v‡i File Tab G Click K‡i browse G wK¬K Ki‡Z n‡e; Zvn‡j (Save As Dialog Box) 

‡`Lv hv‡e| Gi ci cÖwkÿbv_x©‡`i wewfbœ †jv‡Kk‡b I bv‡g Save Kiv †kLv‡eb I n‡Z Kj‡g 

Abykxjb Kiv‡eb| 

 

File > Save > Browse > (Save As Dialog Box ‡`Lv hv‡e ) >(File Name & 

Location Select Ki‡Z n‡e)> Save 
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GwU wb‡Pi wP‡Îi gZ †`Lv‡e| 

 

 

wPÎ: 6.10 

 

GLb cÖwkÿbv_x©‡`i Microsoft  Word Gi Menu Bar,Tool Bar, Ribbons/Tab, 

Groups BZ¨vw` m¤ú‡K© aviYv w`‡eb Ges Gi cÖ‡qvMI n‡Z Kj‡g †kLv‡eb| 

 

File, Home, Insert, Picture Format BZ¨vw`| 

 

‡Kvb Text ‡K †h †Kvb cwieZ©b Ki‡Z n‡j Aek¨B †mUv‡K cÖ_‡g Select K‡i wb‡Z n‡e| Mouse 

w`‡q wKfv‡e Select Ki‡Z nq Zv cÖwkÿbv_x©‡`i n‡Z Kj‡g wkLv‡Z n‡e| 

 

Text document wewfbœ Kvjvi, mvBR eo-‡QvU, Copy, paste Kivi c×wZ| 

 

‡h Text document  Kjvi Ki‡ev †mUv‡K cÖ_‡g wm‡j± K‡i Home Tab G wM‡q Font Color 

Gi Down arrow ‡Z wK¬K K‡i Color Select Ki‡Z n‡e| wVK GKB fv‡e Home Tab Gi 

Font size Gi Down arrow ‡Z wK¬K K‡i Text Gi mvBR eo-‡QvU K‡i cÖwkÿbv_x©‡`i nv‡Z 

Kj‡g Abykxjb Kiv‡Z n‡e| 

 

Select Text > Home > Font Color Gi Down arrow > Select any color 
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wPÎ : 6.11 

 

wb‡P Text Format Kivi K‡qKwU Command  ‡`qv nj : 

 

Copy and Paste Text: 

Select Text > Right Click on the Selected area > Clik on copy put the 

cursor where you paste the text > right click on cursor > click on paste  

Inserting Table : 

Insert > Table > Select row & column > click 

GwU wb‡Pi wP‡Îi (wPÎ : 6.12) gZ †`Lv‡e| 

 

 

 

 

wPÎ : 6.12 

 

 

 

 

Inserting Picture : 
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Insert > Picture form Illustrations > select a picture from file > insert  

GwU wb‡Pi wP‡Îi (wPÎ 6.13) gZ †`Lv‡e| 

 

 

 

 

wPÎ : 6.13 

 

Picture, Clip art Inserting cÖwkÿYv_©x‡`i n‡Z Kj‡g †kLv‡eb| 

 

 

Abykxjb : Gg Gm IqvW© Gi e¨envi Abykxjb Kiæb| Gg Gm Awdm Gi e¨envi Abykxjb Kiæb| 

GKwU Blank Document  G mevB‡K wb‡Ri Information UvBc Ki‡Z ej‡eb 

 

AskMÖnYKvix‡`i g~j¨vqb : AskMÖnbKvix‡`i wb‡¤œi cÖkœgvjvwU c~iY Ki‡Z ejyb|  

 

1. Gg Gm IqvW© Gi KvR:        

 1 

K) WKz‡g›U †jLv L) †cÖ‡R›Ukb Kiv  M) wnmve wbKvk Kiv| 

 2.  WKz‡g›U †mf Gi KvR :        

 1 

  K) WKz‡g›U msiÿY Kiv L) WKz‡g›U gy‡Q †djv M) WKz‡g›U Open Kiv 

 

3.  Gg Gm Awdm Gi wZbwU myweavRbK Kv‡Ri bvg wjLyb:     

 3 

 K) ..................................................................... 

 L) ...................................................................... 

 M) ..................................................................... 
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Awa‡ekb-: †dvìvi I dvBj Gi e¨envi, Kwc I †cómn WKz‡g›U, dvBj BZ¨vw` †mf Kiv Ges Bs‡iRx 

Kx †evW©  I BDwb‡KvW evsjv d›U (Nikosh Ban) Gi e¨envi| 

 

Awa‡ek‡bi cÖZ¨vwkZ wkLbdj (Intended Outcome of the Session) 

 

1| ‡dvÛvi I dvBj Kx Zv ej‡Z I cv_©K¨ Ki‡Z mÿg n‡eb| 

2| Kwc I †cómn WKz‡g›U dvBj BZ¨vw` I‡cb I †mBf Ges msiÿY Ki‡Z cvi‡eb| 

3| Bs‡iRx Kx †evW© I BDwb‡KvW© evsjv d›U (Nikosh Ban) UvBc Kivi `ÿZv AR©b Ki‡Z cvi‡eb| 

 

 

Awa‡ek‡bi iƒc‡iLv 

 

‡dvìvi I dvBj m¤ú‡K© AskMÖnYKvix‡`i we`¨vgvb aviYv †R‡b Zvi Dci wfwË K‡i †dvìvi I dvBj Gi 

Dci Av‡jvPbv I n‡Z Kj‡g Abykxjb Kiv‡bv n‡e| Kwc I ‡có WKz‡g›U , dvBj BZ¨vw` Ges Bs‡iwR Kx 

†evW© I BDwb‡KvW evsjv d›U (Nikosh Ban) e¨envi K‡i UvBwcs Abykxjb Kiv‡bv n‡e| 

 

KvR-1: †dvìvi ˆZix Kiv 

 

‡Kvb WªvBf G wM‡q dvBj †_‡K new ‡Z Click K‡i Folder  G wK¬K Ki‡j bZzb ‡dvìvi ‰Zix n‡e| 

GwU wb‡Pi ¯ŒxbkU Gi gZ n‡e| 

 

 

 

wPÎ : bZzb †dvìvi ˆZix Kiv| 

 

 

KvR 2 : Kwc I †cómn WKz‡g›U, dvBj BZ¨vw` †mf Kiv 

gvB‡µvmdU IqvW© 2013 e¨envi K‡i, wbev©wPZ †U·U Kwc Kiæb Ges bw_ Ab¨ As‡k †có Kiv hv‡e| 

 

‡U·U Kwc Ges †có Kiæb Ges bx‡Pi avc¸‡jvi wb‡`©kvejx AbymiY Kiæb| 



24 

wkÿK‡`i AvBwmwU cÖwkÿY g¨vby‡qj 

 

avc 1 : GKwU we`¨vgvb IqvW© dvBjwU Lyjyb A_ev GKwU bZzb bw_ ïiæ Ges Avcbvi †U·U UvBc Kiæb| 

avc 1 : †U·U Kwc Kivi Rb¨ GwU cÖ_g gvBm w`‡q wbev©Pb ev nvBjvBU Kiv cÖ‡qvRb n‡e| 

 

 

 

wPÎ: Copy I Paste Kivi c×wZ| 
 

avc-3: Copy Kivi Rb¨ Ctrl Kx †ev‡W©i Ges Zvici Kx †ev‡W©i C eY© Pvcyb, †có Kivi Rb¨ Ctrl 

‡P‡c a‡i ivLyb Ges Zvici V Pvcyb| 

 

KvR-3: evsjv mdUIq¨vi e¨envi K‡i evsjv kã UvBwcs I dig¨vwUs : 
 

evsjv mdUIq¨vi e¨envi Ki‡Z n‡j Kw¤úDUvi G Aek¨B evsjv mdUIq¨vi Bbój Kiv _vK‡Z n‡e| 

†m‡ÿ‡Z Aå I  BDwb‡KvW evsjv d›U (NikoshBAN) Install K‡i wb‡Z n‡e| 
 

Gici Microsoft Word open Kivi c‡i Dc‡ii Wvbcv‡k Aå Gi Uzjevi †`Lv hv‡e | †`Lv bv 

†M‡j wb‡Pi Command Abyhvqx wK¬K K‡i  A_ev F12 ‡P‡c evsjv Avb‡Z n‡e| GLb Home Tab 

G Font Gi Down arrow ‡Z wM‡q NikoshBAN G wK¬K K‡i Avb‡eb Ges cÖwkÿbv_©x‡`i nv‡Z 

Kj‡g Abykxjb Kiv‡eb| 
 

 

wPÎ- 6.17 
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Gevi  blank ldocument  G wK¬K K‡i Kvm©i G‡b UvBc ïiæ Ki‡Z n‡e, G‡ÿ‡Î Aå Uzjev‡ii 3q 

evU‡b wK¬K K‡i UvB‡ci wbqg ‡`‡L wb‡eb I cÖwkÿYv_©x‡`i nv‡Z Kj‡g Abykxjb Kiv‡eb| 

 

 

 

wPÎ: 6.18 

 

Abykxjbt dvBj I †dvìvi Gi e¨envi Abykxjb Kiæb| Kwc I †cómn WKz‡g›U, dvBj BZ¨vw`i e¨envi 

Abykxjb Kiæb| Bs‡iRx Kx †evW© I BDwb‡KvW evsiv d›U (wbKk evsjv) e¨envi Abykxjb Kiæb|  

 

AskMÖnbKvix‡`i g~j¨vqb: AskMÖnbKvix‡`i wb‡¤œi cÖkœgvjvwU c~iY Ki‡Z ejyb| 5 b¤î 

 

1. ‡dvìvi Gi KvR wK : 

K) dvBj msiÿb Kiv L) ¯Œxb wcÖ›U Kiv  M) GgGm G‡·j Gi KvR Kiv 

2. dvBj Gi KvR : 

 K) †dvìvi msiÿb Kiv L) Gg Gm Iqv‡Wi cvIqvi c‡q›U †cB›U Kiv M) WKz‡g‡›Ui bvg 

‡`qv| 

3. Kwc Gi KvR wK : 

 K) WKz‡g›U ¯’vbvšÍi Kiv L) †jLv gy‡Q †djv M) †jLv gyf Kiv 

4. ‡có wK: 

 K) WKz‡g›U ¯’vbvšÍi Kiv L) WKz‡g›U KvU Kiv  M) WKz‡g›U gy‡Q †djv 

5. BDwb‡KvW evsjv d›U Gi KvR wK: 

 K) Bs‡iRx‡Z WKz‡g›U cÖ ‘̄Z Kiv L) WKz‡g›U evsjvq †jLv M) WKz‡g›U gy‡Q †djv   
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Microsoft® Word 2010 
Quick Reference Card 

Quick Access Toolbar   Title bar       
          
 Minimize Ribbon         Close 

button 

 

The Fundamentals 
The File tab menu and Backstage view contain commands for working with a 
program’s files, such as Open, Save, Close, New, and Print. 
 

 

 To Create a New Document: Click the File tab, click 
the New tab, and click the Create button. Or, press 
<Ctrl> + <N>. 

 To Open a Document: Click the File tab and click the 
Open button, or press <Ctrl> + <O>. 

 To Save a Document: Click the Save button on the 
Quick Access Toolbar, or press <Ctrl> + <S>. 

 To Save a Document with a Different Name: Click 
the File tab, click the Save As button, and enter a new 
name for the document. 

 To Preview a Document: Click the File tab and click 
the Print tab, or press <Ctrl> + <P>. 

 To Print a Document: Click the File tab and click the 
Print tab, or press <Ctrl> +<P>. 

 To View Advanced Printing Options: Click the File 
tab and click the Print tab. Select from the options 
under Settings. 

 To Undo: Click the Undo button on the Quick Access 
Toolbar, or press <Ctrl> + <Z>. 

 To Move Text with the Mouse: Select the text you 
want to move, drag the text to a new location, and 
release the mouse button. 
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 To Replace Text: Click the Replace button in the 
Editing group on the Home tab. Or, press <Ctrl> + 
<H>. 

 To Close a Document: Click the Close button, or 
press <Ctrl> + <W>. 

 To Correct a Spelling Error: Right-click the error 

and select a correction from the contextual menu. Or, 
press <F7> to run the Spell Checker. 

 To Use the Thesaurus: Right-click the word you 
want to look up and select Synonyms from the 
contextual menu. Select a word or select Thesaurus 

to search the Thesaurus. 

 To Minimize the Ribbon: Click the Minimize 
Ribbon button on the Ribbon. Or, press <Ctrl> + 
<F1>. Or, double-click a tab. Or, right-click a tab and 
select Minimize the Ribbon from the contextual 
menu. 

 To Change Program Settings: Click the File tab and 
click the Options button. 

 To Get Help: Press <F1> to open the Help window. 
Type your question and press <Enter>. 

Na 
 Navigation: 
 

 To Open the Navigation Pane: Click the Find button 

in the Editing group on the Home tab. Or, press 
<Ctrl> + <F>. 

 To Search for a Word or Phrase: Click the Search 
box, type the word or phrase, and press <Enter>. 

 To Search for Graphics, Tables, Equations, or 
Comments: Click the Magnifying Glass and select 
an option from the list. Click the Search box, enter 

the information you are searching for, and press 
<Enter>. 

 To View Search Results: Click the Browse the 
results from your current search tab of the 

Navigation Pane. 

 To View a Document’s Headings: Click the Browse 
the headings in your document tab. 

 To View a Document’s Pages: Click the Browse the 
pages in your document tab. 

 

Editing: 
 To Cut or Copy Text: Select the text you want to cut 

or copy and click the Cut or Copy button in the 

Clipboard group on the Home tab. 

 To Paste Text: Place the insertion point where you 
want to paste and click the Paste button in the 

Clipboard group on the Home tab. 

 To Preview an Item Before Pasting: Place the 

insertion point where you want to paste, click the 
Paste button list arrow in the Clipboard group on the 
Home tab, and select a preview option to view the 
item. 

 To Insert a Comment: Select the text where you want 
to insert a comment and click the Review tab on the 
Ribbon. Click the New Comment button in the 

Comments group. Type a comment, then click outside 
the comment text 

 box. 

 To Delete a Comment: Select the comment, click the 
Review tab on the 

 Ribbon, and click the Delete Comment button in the 

Comments group. 

Keyboard Shortcuts 
 

General 
 

Open a Document <Ctrl> + <O> 
Create New <Ctrl> + <N> 
Save a Document <Ctrl> + <S> 
Print a Document <Ctrl> + <P> 
Close a Document <Ctrl> + <W> 
Help <F1> 
 

Navigation: 
 
Up One Screen <Page Up> 
Down One Screen <Page Down> 
Beginning of Line <Home> 
End of Line <End> 

Beginning of Document <Ctrl> + <Home> 

End of Document <Ctrl> + <End> 
Open the Go To <F5> 
dialog box 
 
Editing 
 
Cut <Ctrl> + <X> 
Copy <Ctrl> + <C> 
Paste <Ctrl> + <V> 
Undo <Ctrl> + <Z> 
Redo or Repeat <Ctrl> + <Y> 
 

Formatting 
 
Bold <Ctrl> + <B> 
Italics <Ctrl> + <I> 
Underline <Ctrl> + <U> 
Align Left <Ctrl> + <L> 
Center <Ctrl> + <E> 
Align Right <Ctrl> + <R> 
Justify <Ctrl> + <J> 

 
Text Selection 
 
To Select: Do This: 
A Word Double-click the word 
A Sentence Press and hold <Ctrl> and 
click anywhere in the sentence 
A Line Click in the selection bar 
next to the line 
A Paragraph Triple-click the paragraph 
Everything <Ctrl> + <A> 



28 

wkÿK‡`i AvBwmwU cÖwkÿY g¨vby‡qj 

 

Formatting: 
 

 To Format Text: Use the commands in the Font group on the Home 
tab, or click the Dialog Box Launcher in the Font group to open the 

Font dialog box. 

 To Copy Formatting with the Format Painter: Select the text with 
the formatting you want to copy and click the Format Painter button 

in the Clipboard group on the Home tab. Then, select the text you 
want to apply the copied formatting to. 

 To Indent a Paragraph: Click the Increase Indent button in the 
Paragraph group on the Home tab. 

 To Decrease an Indent: Click the Decrease Indent button in the 
Paragraph group on the Home tab. 

 To Create a Bulleted or Numbered List: Select the paragraphs you 
want to bullet or number and click the Bullets or Numbering button 

in the Paragraph group on the Home tab. 

 To Change Page Orientation: Click the Page Layout tab on the 
Ribbon, click the Orientation button in the Page Setup group, and 

select an option from the list. 

 To Insert a Header or Footer: Click the Insert tab on the Ribbon and 
click the Header or Footer button in the Header & Footer group. 

 To Insert a Manual Page Break: Click the Insert tab on the Ribbon 
and click the Page Break button in the Pages group. 

 

Tables: 
 

 To Insert a Table: Click the Insert tab on the Ribbon, click the Table 
button in the Tables group, and select Insert Table from the menu. 

 To Insert a Column or Row: Click the Layout tab under Table Tools 

on the Ribbon and use the commands located in the Rows & 
Columns group. 

 To Delete a Column or Row: Select the column or row you want to 
delete, click the Layout tab under Table Tools on the Ribbon, click 
the Delete button in the Rows & Columns group, and select an 

appropriate option from the menu. 

 To Adjust Column Width or Row Height: Select the column or row 
you want to adjust, click the Layout tab under Table Tools on the 

Ribbon, and use the commands located in the Cell Size group. 

 

Styles: 
 

 To Apply a Style: Select the text to which you want to apply the style 

and select the style you want to use from the Styles Gallery in the 
Styles group on the Home tab. 

 To Apply a Document Theme: Click the Themes button in the 

Themes group on the Page Layout tab of the Ribbon and select a 
theme. 

 To View All Available Styles: Click the Dialog Box Launcher in the 

Styles group on the Home tab. 

 To Change a Style Set: Click the Change Styles button in the Styles 
group on the Home tab and select Style Set from the menu. Select 

the Style Set you wish to use. 

 To Create a Style: Select the text that contains the formatting of the 
new style, right-click the text, and select Styles from the contextual 
menu. Select Save Selection as a New Quick Style from the 
contextual menu, enter a name for the style, and click OK. 

 To Check Your Styles: Select the text you wish to check. Click the 
Dialog Box Launcher in the Styles group on the Home tab of the 
Ribbon. Click the Style Inspector button in the Styles task pane. 

Drawing and Graphics: 
 

 To Insert a Clip Art Graphic: Click the 
Insert tab on the Ribbon and click the Clip 
Art button in the Illustrations group. Type 
the name of what you’re 

 looking for in the “Search for” box and 
press <Enter>. 

 To Insert a Picture: Click the Insert tab on 
the Ribbon and click the Picture button in 
the Illustrations group. Find and select the 
picture you want to insert 

 and click Insert. 

 To Insert a Screenshot: Click the Insert 
tab on the Ribbon and click the 
Screenshot button in the Illustrations 
group. Select an available window from 

 the list, or select the Screen Clipping 
option to take a screen clip. 

 To Draw a Shape: Click the Insert tab on 
the Ribbon, click the Shapes button in the 
Shapes group, and select the shape you 
want to insert. Then, 

 click where you want to draw the shape 
and drag until the shape reaches the 
desired size. Hold down the <Shift> key 
while you drag to draw a perfectly 

 proportioned shape or straight line. 

 To Insert WordArt: Click the Insert tab on 
the Ribbon, click the WordArt button in the 
Text group, and select a design from the 
WordArt Gallery. Click 

 the text box and enter your text. If 
necessary, click the text box and drag it to 
the desired position. 

 To Insert SmartArt: Click the Insert tab on 
the Ribbon, click the SmartArt button in 
the Illustrations group, select a layout, and 
click OK. 

 To Adjust Text Wrapping: Double-click 
the object, click the Wrap Text button in 
the Arrange group on the Format tab, and 
select an option from the 

 list. 

 To Resize an Object: Click the object to 
select it, click and drag one of its sizing 
handles ( ), and release the mouse button 
when the object reaches 

 the desired size. Hold down the <Shift> 
key while dragging to maintain the object’s 
proportions while resizing it. 

 To Format an Object: Double-click the 
object and use the commands located on 
the Format tab. 

 To Delete an Object: Select the object and 
press the <Delete> key 
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Aa¨vq-5 

Z_¨ †hvMv‡hvM, Kw¤úDUvi †bUIqvK© I B›Uvi‡bU 

Data Communication, Computer Network & Internet 
 

Z_¨ †hvMv‡hvM (Data Communication)  

 cÖwµqvK…Z DcvË ev Z_¨ cÖ‡qvR‡b ’̄vbvš—i Kiv nq| Z_¨ ’̄vbvš—‡ii Rb¨ wewfbœ gva¨g e¨eüZ 

nq| wewfbœ gva¨g w`‡q Z_¨ ’̄vbvš—i‡K †WUv KwgDwb‡Kkb ev Z_¨ †hvMv‡hvM ejv nq| Z_¨ hZB g~j¨evb 

†nvK bv †Kb Zv hw` Ab¨‡`i Kv‡Q ¯̂v”Q‡›`¨i mv‡_ †cuuŠQv‡bv bv hvq Z‡e Lye GKUv dj †`q bv| 

 B›Uvi‡bU nj DcvË †hvMv‡hv‡Mi mdj gva¨g| B›Uvi‡b‡Ui gva¨‡g ¯̂í mg‡q I ¯̂í e¨‡q we‡k¦i 

GK cÖvš— †_‡K Ab¨ cÖv‡š— DcvË ’̄vbvš—i Kiv hvq| B›Uvi‡b‡U Z_¨ †hvMv‡hv‡Mi cÖavb DcKiY¸‡jv nj 

t Kw¤úDUvi, †Uwj‡dvb jvBb, g‡Wg, †bUIqvK© KvW©, K¨vej, nve, myBP, wiwmfvi, m¨v‡UjvBU, UÖvÝwgUvi, 

wfm¨vU BZ¨vw`|  

Kw¤úDUvi †bUIqvK©  (Computer Network) wK  

 Kw¤úDUvi ‡bUIqvK© n‡jv Zvi (Cable) Gi gva¨‡g A_ev Zvi (Cable) wenxbfv‡e  `yB ev 

Z‡ZvwaK Kw¤úDUv‡ii g‡a¨ ms‡hvM e¨e¯’v|  

 †bUIqvK©-Gi Aš—f©~³ Kw¤úDUvi¸‡jvi g‡a¨ †WUv Ges Z_¨ Av`vb-cÖ`vb (Share) Kiv hvq| 

 GK Kw¤úDUv‡i iw¶Z dvBj †bUIqvK©f~³ Ab¨ †h ‡Kvb Kw¤úDUvi n‡Z m¤úv`b, di‡gwUs A_ev 

Qvcv‡bv m¤¢e| 

 wewfbœ ai‡bi wbivcËv  e¨e ’̄vi gva¨‡g †bUIqvK©f~³ Kw¤úDUvi e¨enviKvixi Z‡_¨i wbivcËv 

e¨e ’̄v Kiv hvq| †bUIqvK©fy³ Kw¤úDUvi e¨enviKvixMb  Aby‡gv`‡bi wfwË‡Z wewfbœ WKz‡g‡›U ev 

†cÖvMÖv‡g KvR Ki‡Z mg_© nq|  

Kw¤úDUvi †bUIqvK©-Gi j¶¨ (Goal of Computer Network)  

GKwU Kw¤úDUvi †bUIqv‡K©i j¶¨ wbgœiƒct 
 

 wi‡mvm© †kqvi Kiv (Resource Sharing)  †bUIqvK©fy³ ‡h †Kvb GKwU  Kw¤úDUv‡ii 

‡WUv, †cÖvMÖvg,hš¿cvwZ, †bUIqvK©fy³ Ab¨ †h †Kvb Kw¤úDUvi n‡Z mn‡RB e¨envi Kiv hvq| 
 

 D”P wek¦vm †hvM¨Zv (High Reliability)  wi‡mvm© mg~‡ni weKí Drm¸‡jvi wek¦vm †hvM¨Zv 

†ekx| †hgb dvBj mg~n †bUIqvK©fy³ `yB ev wZbwU Kw¤úDUv‡i ivLv m¤¢e| nvW©Iqvi weKj 

nIqvi d‡j GKwU Kw¤úDUvi bó n‡jI Ab¨ Kw¤úDUv‡i iw¶Z dvB‡ji Kwc¸‡jv e¨envi Kiv 

hv‡e| 
 

 A‡_©i mvkªq (Saving Money)  wi‡mvm© fvMvfvwMi d‡j A‡_©i mvkªq nq| 

‡hvMv‡hv‡Mi gva¨g (Communication Medium)  

Kw¤úDUvi †bUIqvK© †hvMv‡hv‡Mi GKwU kw³kvjx gva¨g hv we —̄…Z cwim‡i Avjv`v Avjv`v e¨w³i 

g‡a¨ †hvMv‡hv‡Mi e¨ve ’̄v K‡i _v‡K|  aiv hvK `~‡i Ae ’̄vbKvix K‡qKwU G¨vcvU©‡g‡›Ui `yB ev Z‡ZvwaK 

e¨w³ GKwU Kw¤úDUvi †bUIqvK© e¨envi K‡i mn‡R GKwU wi‡cvU© ˆZwi Ki‡Z cv‡i|  
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†bUIqvK© óªvKPvi/aib (Structure/Types)  

†bUIqvK© t wZb ai‡bi 

 †jvKvj Gwiqv †bUIqvK©  (LAN) t Local Area Network 

 ‡gUªcwjUb Gwiqv †bUIqvK© (MAN) t Metropolitan Area Network  

 IqvBW Gwiqv †bUIqvK  (WAN) t Wide Area Networks  

†jvKvj Gwiqv †bUIqvK© ( Local Area Network)  

  †jvKvj Gwiqv †bUIqvK© (Local Area Network) : KvQvKvwQ `~i‡Z¡ Aew ’̄Z Kw¤úDUvi 

mg~n‡K ci¯ú‡ii g‡a¨ m¤ú„³ Kivi e¨e ’̄v‡K (LAN) ‡jvKvj Gwiqv †bUIqvK© e‡j| mvaviYZt GKwU 

cÖwZôvb ev Awd‡mi wewfbœ †mKkb ev wefv‡Mi KvR mg~n †h †Kvb GKwU wefv‡M e‡m Z`viKx Kiv , 

mgš^q mvab Kiv wKsev m¤úv`b Kivi myweav‡_© †mB Awd‡mi wewfbœ wefv‡Mi Kw¤úDUvi¸‡jv‡K j¨v‡bi 

AvIZvq m¤ú„³ Kiv nq|   

‡g‡UªvcwjUb Gwiqv †bUIqvK© ( Metropolitan Area Network)  

GKwU eo ‡g‡UªvcwjUb kn‡ii wewfbœ ’̄v‡b Aew ’̄Z Kw¤úDUvimg~n‡K ci¯úi mshy³ Kivi 

cÖwµqv‡K e‡j MAN (†g‡UªvcwjUb Gwiqv †bUIqvK©)| †hgb t XvKv kn‡ii kvnevM, gwZwSj, kvwš—

bMi, gvwjevM, gMevRvi, ¸jkvb, ebvbx BZ¨vw`i GjvKvq Aew ’̄Z Kw¤úDUvimg~n ci¯úi m¤ú„³ Kivi 

Rb¨ e¨e ’̄v‡K MAN e‡j| MAN  ’̄vc‡b mvaviYZt LAN Gi Abyiƒc †UK‡bvjwR e¨envi Kiv nq| 

IqvBW Gwiqv †bUIqvK© (Wide Area Network)   
we¯—…Z †fŠMwjK GjvKv e¨vcx Kw¤úDUvi 

†bUIqvK©‡K WAN (IqvBW Gwiqv †bUIqvK©) e‡j| 

‡`‡ki wewfbœ kn‡i Aew ’̄Z Kw¤úDUvi  Ges evsjv‡`‡ki 

mv‡_ c„w_exi wewfbœ ‡`‡k Aew ’̄Z Kw¤úDUvimg~n‡K 

ci¯úi mshy³ Ki‡Z n‡j Zv n‡e IqvBW Gwiqv 

†bUIqvK©| B›Uvi‡bU e¨e ’̄vq we`¨gvb †bUIqvK©‡K IqvBW 

Gwiqv †bUIqvK© (Iqvb) e‡j| Iqvb †bUIqv‡K©i Rb¨ 

cÖ‡qvRb nq wdwRK¨vj jvBb, dvBevi AcwUK K¨vej, 

g‡Wg, †Uwj‡dvb jvBb, m¨v‡UjvBU UªvÝwgkb, 

gvB‡µvI‡qf UªvÝwgkb BZ¨vw`| B›Uvi‡bU mviv we‡k¦ 

me©e„nr I ¯̂í e¨q m¤úbœ Iqvb wnmv‡e myL¨vwZ AR©b 

K‡i‡Q|  

‡bUIqvK© IfviwfD (Network Overview)  

mvaviYfv‡e mKj †bUIqv‡K© KZ¸‡jv Dcv`vb, dvskb Ges wdPvi _v‡K| wb‡gœ K‡qKwU weeiY †`qv 

n‡jv  t 
 

 mvf©vi (Server) t mvf©vi n‡jv †bUIqv‡K©i g~j Kw¤úDUvi| mvf©vi Kw¤úDUvi Gi gva¨‡g 

‡bUIqv‡K©i mKj Kg©KvÛ Ges e¨enviKvix  wbqš¿Y Kiv n‡q _v‡K| 

 K¬v‡q›U (Client) t †h mKj Kw¤úDUvi mvf©vi KZ©„K cÖ`Ë wi‡mvm©mg~n e¨envi K‡i Ges mvf©vi 

KZ©„K wbqwš¿Z n‡q _v‡K| 

 wgwWqv (Media) t  †h cš’vq Kw¤úDUvi¸‡jv ci¯ú‡ii mv‡_ mshy³ _v‡K| 
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 ‡kqvi WvUv (Share Data) t †bUIqv‡K© mvf©vi KZ©„K cÖ`Ë dvBjmg~n| 

 ‡kqvi wcÖ›Uvi I Ab¨vb¨ †cwid¨vivjm t mvf©vi cÖ`Ë Ab¨vb¨ wi‡mvm©mg~n| 

 wi‡mv‡m©m t †bUIqvK© e¨enviKvixi Rb¨ dvBj, wcÖ›Uvi I Ab¨vb¨ Dcv`vbmg~n| 
 

Dc‡iv³ mvgÄ‡m¨i wfwË‡Z †bUIqvK©‡K `yÕwU e„nËi fv‡M fvM Kiv †h‡Z cv‡i| 
 

K) wcqvi Uz wcqvi ( Peer-to-Peer Network)   

L) mvf©vi †eBRW© (Server-Based Network) 

mvf©vi †eBRW I †cqvi Uz †cqvi †bUIqv‡K©i cv_©K¨ ¸i“Z¡c~Y ©| cÖ‡qv‡Mi wfwË‡Z ‡bUIqv‡K©i 

aib wbgœwjwLZ wel‡qi Dci wbf©i K‡i|  
 

wcqvi Uz wcqvi †bUIqvK© ( Peer-to-Peer Network)  
 

 wcqvi Uz wcqvi †bUIqv‡K© †Kvb †WwW‡K‡UW mvf©vi _v‡K bv| G QvovI Kw¤úDUvi ¸‡jvi g‡a¨ 

†Kvb Hierarchy _v‡K bv| me Kw¤úDUviB mgvb, d‡j G ¸‡jv wcqvi| Kw¤úDUvi¸‡jv GKB mv‡_ 

mvf©vi I K¬v‡q›U wnmv‡e KvR K‡i| e¨enviKvixB wVK K‡i †Kvb WvUv †kqvi Ki‡e ev Ki‡Z n‡e| 
 

mvf©vi †eRW †bUIqvK© (Server-Based Network)  
 

mvf©vi †eRW †bUIqv‡K© GK ev GKvwaK mvfv©i emv‡bv _v‡K| GwU g~jZ GKwU kw³kvjx 

Kw¤úDUvi hv †K›`ªxqfv‡e ’̄vwcZ n‡q †bUIqvK©f~³ Kw¤úDUvi (ev IqvK©‡÷kb) mg~‡ni g‡a¨ cvi¯úvwiK 

†hvMv‡hvM I WvUv wewbg‡qi e¨e ’̄v 

K‡i _v‡K| mvf©vi‡eRW †bUIqv‡K© 

GKwU mvf©vi Kw¤úDUvi †bUIqvK©f~K 

mKj Kw¤úDUvi‡K wbqš¿Y Ki‡Z 

cv‡i|  †hgb WvUv †kqvwis, mdUIq¨vi 

†kqvwis, BZ¨vw` wel‡q wbqš¿Y Ki‡Z 

cv‡i| †h‡nZz mvf©vi‡eRW †bUIqv‡K© 

mvf©vi Kw¤úDUvi mKj IqvK©‡÷kb‡K 

wbqš¿Y Ki‡Z cv‡i ZvB G ‡bUIqv‡K© 

Kw¤úDUv‡ii wmwKDwiwU e¨e ’̄v e„w× 

cvq| 

 

eªvDwRs (Browsing) Kiv   

‡bUIqv‡K© Gi ms†hvM Ki“b|  

ms‡hv‡Mi Rb¨ wb‡Pi avc¸‡jv Abymib Ki“Y t 

 cÖ_‡g Avcvbvi ISP mv‡_  Dial-Up †bUIq©vK  Gi ms‡hvM Ki“b| 

 Zvici wb‡Pi †h †Kvb GKwU mdUIq¨vi †e‡Q wbb 

 Netscape Navigator 

 Internet Explorer 
 

I‡qe mvBU eªvDwRs Kiv (Browsing  web site)  
 

1. GKwU eªvDRvi Pvjy Ki‡Z n‡e (Run  browser) 
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              ‡bU‡¯‹c ( Netscape browser ) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2|    I‡qe †c‡R cÖ‡ek K‡i B›Uvi‡b‡Ui wVKvbv (To go to a web page type the internet 

address) UvBc Ki“b| D`vniY t http://www.virtualbangladesh-G¨v‡Wªm ev‡i wVKvbv wj‡L  

Go button wK¬K Ki‡Z n‡e| 

wUKv (Short Note)  

‡bUIqvK© (Network)  

hLb `yB ev Z‡ZvwaK Kw¤úDUvi G‡K Ac‡ii mv‡_ hy³ nq ZLb †bUIqvK© nq| †bUIqv‡K©i 

D‡Ïk¨ n‡jv eû Kw¤úDUvi wm‡÷‡gi g‡a¨, †WUv I Z_¨ fvMvfvwM K‡i e¨envi Kiv| B›Uvi‡bU‡K ejv 

hvq wek¦ e¨vcx †bUIqv‡K©i †bUIqvK©| Kw¤úDUvi †bUIqvK©¸‡jv ‡Kej (Cable) w`‡q hy³ _vK‡Z cv‡i 

†hgb B_vi‡bU †Kej, †dvb jvBb A_ev Zvi wenxbfv‡e hv Iqvi‡jm †bUIqvwK©s Kv‡W©i mvnv‡h¨ evqy 

gva¨g e¨envi K‡i| 

eªvDRvi (Browser)  

AvBGmwcÕi mvf©v‡i jM-Bb Kivi ci Iqvì© IqvBW I‡q‡e Ny‡i †eov‡bvi Rb¨ GKwU we‡kl 

ai‡bi G¨vwc­ ‡Kkb †cÖvMÖvg e¨envi Kiv nq| GB G¨vwc­ ‡Kkb †cÖvMÖvg‡K I‡qe eªvDRvi ejv nq| I‡qe 

eªvDRvi‡KB eªvDRvi ejv nq hv w`‡q e¨enviKvix World Wide Web Aceess K‡i| GUv HTML 

†Kv‡Wi gva¨‡g †U·U B‡gR, nvBcvi-†U·U wjém Rvfv w¯ŒÞ I Rvfv Gc‡j‡Ui gva¨‡g co‡Z cv‡i| 

HTML †Kv‡Wi gva¨‡g eªvDRvi¸‡jv my›`i di‡g‡Ui †cR ¸‡jv wWm‡c­  K‡i| KZ¸‡jv 

D‡j­ L‡hvM¨ eªvDRvi n‡jv gvB‡µvmdU B›Uvi‡bU G·‡c­ vivi, †bU¯‹¨vc †bwf‡MUi, Kgywb‡KUi Ges 

A¨vcj mvdvix| 

B›Uvi‡bU (Internet)   

B›Uvi‡bU n‡jv Af¨š—ixYfv‡e mshy³ KZK¸wj Kw¤úDUvi  †bUIqvK©| †h †Kvb ‡WUv †hgb K_v, 

wfwWI, Qwe, MÖvd I †U·U B›Uvi‡b‡Ui mv‡_ mshy³ GK Kw¤úDUvi †_‡K Ab¨ Kw¤úDUv‡i mÂvj‡bi Rb¨ 

GwU e¨eüZ nq|  

Web Site Address Bar 

Go button  
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BbUªv‡bU (Intranet)  

  BbUªv‡bU n‡jv B›Uvi‡b‡Ui GKwU fvm©b| GKwU eo †Kv¤úvbx ev ms¯’vi wewfbœ kvLv Awdm mg~‡ni 

g‡a¨ Af¨š—ixb †hvMv‡hv‡Mi Rb¨ cÖwZwôZ Kw¤úDUvi †bUIqvK©‡K BbUªv‡bU e‡j|  BbUªv‡bU Gi 

e¨env‡ii g‡a¨ i‡q‡Q WKz‡g›U weZiY, mdUIqvi weZiY, ‡WUv‡e‡R G‡·m Kiv Ges cÖwk¶Y mvwf©m| 

I‡qe †cR, I‡qe eªvDRvi, FTP dvBj, B-‡gBj, wbDR MÖ“c, †gBwjs wj÷ BZ¨vw` ms ’̄vi  wbR¯̂ Ges 

kvLv Awdmmg~n Af¨š—ixYfv‡e e¨envi Ki‡Z cv‡i| 

eªWe¨vÛ †bUIqvK© (Broadband Network)   

evDÛ I AvDU evDÛ P¨v‡b‡ji ga¨ w`‡q c„_K Kiv †iwWI wd«‡Kv‡qÝx wmMbvjmg~n mÂvjb K‡i 

ˆZwi †jvKvj Gwiqv †bUIqvK©‡K eªWe¨vÛ †bUIqvK© e‡j| eªWe¨vÛ †bUIqvK© †÷kb †Kv-Aw·qvj †Kej 

wKsev dvBevi AcwUK †Kej Øviv mshy³ _v‡K| hv ‡WUv, f‡qm I wfwWI hyMcrfv‡e eûgyLx UvÝwgkb 

P¨v‡b‡ji gva¨‡g djcÖm~ fv‡e cwienb K‡i| eªWe¨vÛ †bUIqvK© D”P ¶gZv m¤úbœ wKš‘ GUv †em e¨vÛ 

‡bUIqv‡K©i †P‡q e¨q eûj Ges Bb÷j Kiv KwVb| Gai‡bi †bUIqvK© cÖhyw³ †Kej-†Uwjwfk‡bi †¶‡Î 

e¨eüZ nq| GUv‡K IqvBWe¨vÛ UªvÝwgkbI e‡j|  

B-‡gBj (E-Mail)   

B›Uvi‡bU e¨env‡ii gva¨‡g GK Kw¤úDUvi n‡Z Ab¨ Kw¤úDUv‡i WvK †hvMv‡hv‡Mi e¨e ’̄v‡K B-

‡gBj ev B‡jKUªwbK †gBj e‡j| B-‡gBj AvRKvj †hvMv‡hv‡Mi GKwU Av`k© gva¨g| cÖwZ eQi wewjqb 

wewjqb evZ©v B-‡gBj Gi gva¨‡g cvVv‡bv nq|  

B-Kgvm© (E-Commerce)  

B-Kgvm© ev B‡jKUªwb· Kgvm© n‡jv B›Uv‡b‡Ui gva¨‡g e¨emv cwiPvjbv Kiv| AvgvRvb WUKg, 

evBKg, B-evB G ¸‡jv B-Kgvm© I‡qe mvBW| B-Kgv‡m©i cÖavb `yBwU Kg© n‡jv Business to 

Consuner (B2C) I Business to Business (B2B) | 
 

B-Mf‡b©Ý (E-Governance)   

 

B‡jKUªwb· Mf‡b©Ý‡K ms‡¶‡c ejv nq| B-Mf‡b©Ý c×wZ‡Z miKv‡ii Kg©KvÛ B‡jKUªwbK ev 

wWwRUvBRW AvKv‡i iƒcvš—i K‡i `ª“Z I wbf©yj AvKv‡i msi¶Y, cÖ`k©b I Av`vb cÖ`vb Kiv hvq| G 

cÖwµqv miKv‡ii mv‡_ RbM‡Yi mivmwi †hvMm~Î ’̄vcb K‡i Ges miKvix I †emiKvixmn mKj Kg©Kv‡Û 

¯̂”QZv Avbqb K‡i| wWwRUvjvBRW ev WKz‡g‡›UW Z_¨ cÖhyw³i wewfbœ gva¨‡gi mv‡_ †kqvi Kiv nq| B-

Mf‡Y©Ý Kg©Kv‡Ûi gva¨‡g `wjj `¯—v‡em I ¸i“Z¡c~Y© bw_cÎ msi¶Y, †WUv‡em Gi gva¨‡g Z_¨ msMÖn, 

cÖwµqvKiY Ges cÖ‡qvR‡b Zv Rbmvavi‡Yi g‡a¨ weZiY, I‡qe ev B›Uvi‡b‡Ui gva¨‡g Z_¨ msMÖn I 

weZiY, I‡qe wfwËK mvwf©m cÖ`vb, †hgb- Av‡e`bcÎ, `icÎ MÖnY (WvDb‡jvW), c~iY I Rgv`vb, M¨vm, 

we`y¨r, †Uwj‡dvb I †gvevBj wej, f¨vU U¨v·, AvqKi cÖf„wZ BDwUwjwU wej cwi‡kva Kiv †h‡Z cv‡i| 
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How to create a Gmail account 

'Google mail' or ‘Gmail‘ is a web-based email account in which emails are stored on the internet 

rather than on your computer. Internet email can be a flexible option as you can access emails from 

any computer that has internet access – for example, at internet cafés – anywhere in the world. 

In this guide, we’re going to show you how to get started with email by creating an account in 

Gmail. 

  

NB. We are using Chrome as our browser, however other browsers such as Internet Explorer and 

Firefox will look similar.  

  

You’ll need: 
  

 A computer with internet access. 

Follow these step-by-step instructions to create a Gmail account 
  

Step 1: Open up your internet browser and go to the Google home page: http://www.google.com 

  

Step 2: Click on Gmail at the top right corner of the page. 

  

 

 Step 3: You’ll now be in the ‘Sign in’ section. As you don’t have a Google account yet, you need 

to create one. Click Create an account 

 

 

 

 

 

 

 

http://googlemail.com/
http://www.google.com/


35 

wkÿK‡`i AvBwmwU cÖwkÿY g¨vby‡qj 

Step 4: To set up your new account, Google needs some information about you – first, your first 

and last names. The ‘choose your username’ is the unique email address that you wish to use, 

which will be placed before ‘@gmail.com’. Because it needs to be unique, Google may have to 

check the availability of any name that you decide on to make sure that no one already has it. Type 

an email name into the ‘choose your username’ box and then fill out the rest of your information. 

You will need to ensure that the ‘I agree to the Google terms of service and Privacy Policy’ is 

ticked. Then click next step. 
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 Step 5: If the email name that you requested in is not available, you’ll get a message saying that 

somebody already has that username and offering you some alternatives. You can decide to accept 

one of the alternatives or type in another name and check its availability once more. You will have 

to complete some of the other boxes again. You may have to do this a few times. Once you 

finalize your email address, it’s a good idea to make a note of it so that you can refer to it until you 

remember it. 

 

Step 6: You’ll need to come up with a password so that you can log in securely to your account. 

Google may explain that you should try one with at least 8 characters long to be secure. Use letters 

and numbers to make the password more secure and difficult to guess. You’ll need to re-enter your 

password to ensure that it’s you choosing it and not a hacker’s (ro)bot. This is why it also asks you 

to insert two random words at the bottom of the page – this is a CAPTCHA code. You can skip 

this step if you don’t want to type in the CAPTCHA code but you will need to verify via a mobile 

phone if you don’t. 

  

Step 7: Once you have completed this page fully, clicking Next Step will take you to the Create 

Profile Page. If you don’t wish to have a picture on the web, click Next Step to complete setting up 

your email. If you do, Click on Add Profile Photo and find a photo to add. Then click Next Step. 

  

Step 8: You will now have set up your account. You can go straight to your inbox and get started, 

or you can set up a photo to show as your profile picture. 

Click on Add a photo to upload a photo and select a photo. 
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 Or click on Next Step to go to your inbox and get started. 
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Step 1: Log in to your Gmail account so that you are on the dashboard (main page) of your mail 

account. 

  

 

  

  

 How to send an email 
Follow these step-by-step instructions to send an email 

  

  

Step 2: Click Compose. 
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Step 3: A new blank email window will open up. In the ‘To’ box, type in the email address of the 

recipient. 

  

 

  

 Step 4: You might want to include someone else in your email to ‘keep them in the loop’. You 

can do this by clicking Cc or Bcc, which will open another field. ‘Cc’ means ‘carbon copy’ and 

‘Bcc’ means ‘blind carbon copy’. Adding an email address to the ‘Cc’ field means that that person 

will receive a copy of the email and all the other recipients will see their email address. If an email 

address is put into the 'Bcc’ field, the person will get a copy of the email but no other recipient will 

see that address. 
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If you are sending the same email to lots of different people, it’s a good idea to put all the email 

addresses in the ‘Bcc’ field to keep your ‘mailing list’ confidential. That way, there’s no chance 

that it could fall into the hands of a spammer or hacker. 

  

 

  

 Step 5: The subject field allows you to give the recipient an idea of the topic of your email, like a 

heading. You don’t have to put anything in the subject box, but it can help when viewing and 

sorting email. 

  

Step 6: Email text can be formatted in a similar way to text in a word document. You can change 

the font style, colour and size using the formatting icons. You can also create bullet points and 

check the spelling of your email. Choose your formatting from the menu shown. 

  

  

 

  

Step 7: Type your message in the main body field of your email. 
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Step 8: When you’re happy with your email, click the blue Send button at the bottom of the 

compose window. 

   

 

  

Step 9: The email you’ve sent will now be stored in the ‘Sent Mail’ folder on your Gmail 

dashboard. You may have to run your mouse pointer over the Inbox folder link to see the other 

folders. 
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 Step 10: You may start an email but then decide to come back to it later rather then sending it 

straightaway. Gmail saves your drafts automatically. So you can simply close the email and the 

unfinished email will be saved to your ‘Drafts’ folder.  When you decide that you’re ready to send 

it, you can retrieve it from the ‘Drafts’ folder by clicking Drafts and then clicking the correct item 

in the ‘Drafts’ folder list. Finish the email and click Send as normal. 

  

How to send an email to multiple people  

 

 Follow these step-by-step instructions to send an email to multiple people 

 Step 1: Log in to your email account so that you are on the dashboard (main page) of your mail 

account. 

 Step 2: Click COMPOSE. 
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 Step 3: A new email window will open. In the ‘To’ address box, type in the first recipient’s email 

address. Then type a comma and make a space, to separate this address from the next email 

address. Type in the second address and continue, inserting a comma and a space between each 

subsequent address. 

  

 

You may find that other email applications, such as Microsoft Outlook, use a semi-colon (;) 

instead of a comma to separate each email address. 

 Step 4: You might want to include someone else in your email just to ‘keep them in the loop’. 

You can do this by clicking Cc or Bcc, which will open another field. ‘Cc’ means ‘carbon copy’ 

and ‘Bcc’ means ‘blind carbon copy’. Adding an email address to the ‘Cc’ field means that that 

person will receive a copy of the email and all other recipients will see their email address. If an 

email address is put into the ‘Bcc’ field, the person will get a copy of the email but no other 

recipient will see that address. 

 If you are sending the same email to lots of different people, it’s a good idea to put all the email 

addresses in the ‘Bcc’ field to keep your ‘mailing list’ confidential. That way, there’s no chance 

that it could fall into the hands of a spammer or hacker. 

 Step 5: Now type in the subject of your email and the text of your message. 

  

 

  

Step 6: Click the blue Send button when you're ready.  
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Step 7: If you want to reply to an email but add more recipients to the ‘To’ box, follow Steps 3 to 

6 above once you have clicked on Reply and the email has been opened. 

Google Drive 

Google Drive is a service offered by Google that allows you to store and share files online. The 

service was launched on April 24, 2012 and provides 5 GB of free storage. Additional storage can 

be purchased for a monthly fee. 

 
 

The goal of Google Drive is to provide a central place to store your files online so that you can 

access them from anywhere. Additionally, you can access your Google Drive from multiple 

devices, since the software is available for Windows, Mac OS X, Android, and iOS platforms. The 

service also provides a web-based interface that allows you to organize your files and search for 

documents by filename or content. 

 

Besides online file storage, Google Drive provides tools for sharing files and collaborating on 

projects with other users over the Web. For example, instead of emailing large attachments, you 

can send links to the files from your Google Drive to one or more users. You can also use the web-

based Google Docs applications to create or edit documents online. When you share a document 

with other Google Drive users, everyone can view and edit the document at the same time. 

 

Google Drive allows you to view over 30 file types directly in your web browser. These include 

Google's proprietary formats, as well as other popular file types, such as Adobe Photoshop and 

Illustrator documents. For more information about Google Drive's proprietary file types, view 

the Google Drive File Types article at FileInfo.com 

 

 

 

http://techterms.com/definition/google
http://techterms.com/definition/file
http://techterms.com/definition/online
http://techterms.com/definition/windows
http://techterms.com/definition/os_x
http://techterms.com/definition/android
http://techterms.com/definition/ios
http://techterms.com/definition/filename
http://techterms.com/definition/www
http://techterms.com/definition/application
http://techterms.com/definition/document
http://techterms.com/definition/file_type
http://www.fileinfo.com/help/google_drive_file_types
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Drop box 

 
 

Drop box is a personal cloud storage service (sometimes referred to as an online backup service) 

that is frequently used for file sharing and collaboration.  The Drop box application is available 

for Windows, Macintosh and Linux desktop operating systems. There are also apps for 

 iPhone, iPad, Android, and BlackBerry devices. As policy around BYOD has become more 

common in the work place, mobile devices still pose a grave threat to an enterprise’s sound 

security. Access this exclusive resource to discover best practices to ensure that your enterprise has 

an optimal mobile device management solution, in order to avoid risks from both outside and 

within. 

 

 

 

 

 

 

 

 

The service provides 2 gigabytes (GB) of storage for free and up to 100 GB on various for-fee 

plans. Another option, Drop box for Teams, provides 350 GB storage. The user data is stored 

on Amazon’s Simple Storage Service (S3) and protected with Secure Sockets Layer (SSL) and 

Advanced Encryption System (AES) 256-bit encryption. 

After installation of the associated application, a Drop box folder appears with the user’s other 

folders. Users can save files to the folder, add new folders, and drag and drop files among folders 

just as if they were all local. Files in the Drop box folder can be accessed from anywhere with an 

Internet connection – the user just has to log in to his account to upload, download and share files. 

To share a file, the user can generate a URL for it from the Drop box website and send it out so 

that others can view it. Folders can be shared by sending an invitation from the Drop box website. 

Recipients that don’t have Drop box accounts will have to sign up to access the folder. Once a 

folder is shared, it will appear in the folder system for everyone who has access to it and all 

members will be able to make changes to files. All versions of files are saved.  

Drop box has usually been considered a consumer market service. However, it is increasingly 

being used within the enterprise and as such is an example of the IT consumerization trend. 

The service is named for the repositories used by banks, post offices, video stores and libraries to 

allow people to drop items off securely. 

 

http://searchcloudstorage.techtarget.com/definition/personal-cloud-storage
http://searchconsumerization.techtarget.com/definition/Online-file-sharing-service
http://searchmobilecomputing.techtarget.com/definition/iPhone
http://searchmobilecomputing.techtarget.com/definition/iPad
http://searchenterpriselinux.techtarget.com/definition/Android
http://searchmobilecomputing.techtarget.com/definition/BlackBerry
http://searchcloudcomputing.techtarget.com/definition/Amazon-Simple-Storage-Service
http://searchsecurity.techtarget.com/definition/Secure-Sockets-Layer-SSL
http://searchsecurity.techtarget.com/definition/Advanced-Encryption-Standard
http://searchsecurity.techtarget.com/definition/encryption
http://searchconsumerization.techtarget.com/definition/IT-consumerization-information-technology-consumerization
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Google Calendar  

Description 

Organize your life with the help of Google Calendar. You can schedule your social and academic 

life, create personal calendars, share calendars with others, and invite friends to events. 

This article will help you complete the following: 

 How to log in and view your calendar. 

 Schedule a meeting and Invite guests. 

 Book a room or resource for your meeting. 

 Set meeting reminders. 

 Set up recurring events.  

 Add an attachment or Google Hangout to a meeting. 

 Create a new calendar.   

 Edit your calendar’s privacy and sharing settings. 

 View another user’s calendar.  

Set meeting reminders  

1. Open the meeting  

 

2. Under Reminders, choose the type of reminder you want (pop-up or email message) and 

when you want to recieve it.   

 

 

3. To add more reminders, click Add a reminder. 

  

4. Remember to click the Save button.   

By default, you receieve an email and a pop-up reminder 10 minutes before each event on your 

calendar. To change your default reminder settings, follow these steps:  
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1. Open Google Calendar 

 

2. In the My calendars section, click the down arrow that appears when you hover over your 

calendar, and select Reminders and notifications from the drop-down. 

 

 

3. In the Event reminders section, select either Email or Pop-up from the drop-down  

 

4. Enter the corresponding reminder time (between one minute and four weeks.) 

 

5. Optionally, click Add reminder to create a new reminder, or remove to delete an existing 

reminder.  

 

6. Click Save. 

 Set up recurring events  

1. Go to the event details page.  

 

2. Check the box to the left of Repeat. 
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3.  In the Repeat pop-up, select an option from the Repeats drop-down.  

 

4. Depending on your selection from the Repeats drop-down, further define how the metting 

recurs, including specifying start and end dates (if applicible).  

 

 

5. Finish creating your meeting as usual.  

  

Add a document or Google Hangout to a meeting 

To attach a document to a meeting: 

1. Click on the name of your meeting to open the event details page. 

 

2. In the Attachment section, click Add attachment. 

 

 
3. Check the box next to one or more Google Drive files, and click Select.  You can also 

upload files from your computer my clicking Upload and following the prompts to upload 
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files from your computer. 

 
4. After you've attached all of your files, remember to click the Save button.  

  

To add a Google Hang out to a meeting: 

1. Open event details page of your meeting.  

 

2. In the Video call section, click on Add video call. 

 

3. Click the Save button.  

 Edit your calendar’s privacy and sharing settings 

By Default, your "free/busy" calendar information is shared with everyone in your domain. You 

can share additional information with everyone or just specific people, or stop sharing all calendar 

information.  

1. Open Google Calendar.  

 

2. In the My calendars section, click the down arrow that appears when you hover over your 

calendar, and then select Share this calendar.  

 
 

3. Select the sharing options you want for your calendar.  

 

By default your "free/busy" calendar information is shared with everyone at the University. 

You have the option to change this so that everyone at the University can see all event details, 

no one can see anything (uncheck share this calendar with others), or make the entire calendar 

public (check make this calendar public)  

 

You can also change the sharing settings for specific people. Under the Share with specific 

people section, enter the email address of the person you want to share your calendar with, 

select the appropriate permission setting, and click Add person.  

 

4. Once you have finished setting your Calendars sharing settings, remember to click Save. 
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Google Classroom 

Classroom helps teachers save time, keep classes organized, and improve communication 

with students. 

 

Classroom is a new tool in Google Apps for Education that helps teachers create and organize 

assignments quickly, provide feedback efficiently, and easily communicate with their classes. 

Classroom helps students organize their work in Google Drive, complete and turn it in, and 

communicate directly with their teachers and peers. 

 

Create and collect assignments:  Classroom weaves together Google Docs, Drive and Gmail to 

help teachers create and collect assignments paperless. They can quickly see who has or hasn't 

completed the work, and provide direct, real-time feedback to individual students. 

 

Improve class communications:  Teachers can make announcements, ask questions and comment 

with students in real time—improving communication inside and outside of class. 

 

Stay organized:  Classroom automatically creates Drive folders for each assignment and for each 

student. Students can easily see what’s due on their Assignments page. 
 

How to enable Google Classroom 

 

The Google Classroom  
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Google Classroom makes organizing and managing all of your Google Apps activities 

streamlined and  

easy. Set it up in minutes. Thousands of teachers are certainly finding their way to Google 

Classroom. It has been as billed by Google: less focus on tech, more focus on teaching. It has 

made managing Google Apps files in schools more streamlined and communicating with classes 

easier. 

This guide will show how to set Classroom up in a matter of minutes and perform the main 

tasks. It will even address a few things Classroom will NOT do, as it’s not a fully featured 

learning management system. Consider keeping this post open in one tab in your browser and 

Classroom in another so you can refer back. Feel free to click on the screenshots below to see the 

full-sized versions. 

 

In addition, you can check out 12 great ways to start using Google Classroom 

now and10 ways Google Classroom will make learning better (which I wrote before 

Classroom was released). 

Set up your class in Classroom 

Use the “+” button to create your first class. 

 

1. Go to: classroom.google.com. You can use Classroom if you log in using a Google Apps for 

Education account (i.e. if your Google log-in is your school e-mail address, you’re probably good). 

2. Click on the “+” button in the top right to create your first class. (It’s next to your e-mail 

address you used to logged in.) Then click “Create class.” 

3. Add a class name and a section. The class name should be the title of the class 

 

 

Add a class name and section. 

(“Mrs. Hamida “8th Grade Social Studies”). The section should identify which of those classes it 

is (for me, mine say “2nd period” for the section). Then click “Create.” 

 

http://ditchthattextbook.com/2014/08/21/12-great-ways-to-start-using-google-classroom-now/
http://ditchthattextbook.com/2014/08/21/12-great-ways-to-start-using-google-classroom-now/
http://ditchthattextbook.com/2014/05/15/10-ways-google-classroom-will-make-learning-better/
http://classroom.google.com/
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4. Once your class is created, students can start joining it. But, chances are there won’t be any 

students around the moment you create the class. This is the time to get creative and have some 

fun with it! Click “Change class theme” on the right side of the header. It will open a gallery of 

header images you can use to spice up your classroom. 

 

Enter class details in the “About” tab. 

5. Also before your students join your class, you can add details to your “About” tab. This 

provides some basic information, such as the name of the course, a description of the course, the 

room where it meets and the teacher e-mail. You can also add materials (like a syllabus, classroom 

management plan or anything else students might need to refer to during the year) by attaching 

them. 

6. The time has arrived … your students are ready to sign up for Classroom! This is really one 

of the easiest parts. Have them log in to Classroom with their school 

 

 

Give students the class code. 

Google account and click the “+” just like you did. It will prompt them for a class code, which you 

can give them (write it on the board, show it on a projector, etc.). Once they enter it, they’re in — 

like magic! 

Using Classroom in everyday class 
 
After your class is set up and students join, you have a fully functioning Google Classroom. 

Congratulations! 

But you don’t want to stop there. Here are some things you can do in your Classroom: 

 

Communicate with announcements. 
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ADD AN ANNOUNCEMENT: This is a good way to communicate with your class and give 

them up-to-date information. Click the “Announcement” button to display a message to your class. 

You can even attach files (from Google Drive and otherwise), add YouTube videos and provide 

links. Tip: If you assign an activity outside of Classroom (i.e. a blog post on Kidblog), you can link 

to it in an announcement so there’s a record of it in your class. 

 

Add assignments with details. 

ADD AN ASSIGNMENT: Creating a new assignment is almost the same as an announcement, 

but it has a due date. Write the title of the assignment, a description of it and attach files (if 

necessary. Then specify when it’s due. In student accounts, it will put extra notifications on 

assignments in your class to remind students when something is due — or when it’s late. 

 

Manage details of students in class. 

MANAGE STUDENTS: From the “Students” tab, there are several actions you can take to 

interact with student accounts. You can manage permissions, giving students the ability to post and 

comment, only comment, or give only the teacher the ability to post and comment. The envelope 

icons let you send e-mails to individual students (if Gmail is available through their school Google 

accounts). By checking individual or multiple students, you can remove them from the class, e-

mail them or mute them from commenting. 

GRADE AN ASSIGNMENT: After you’ve added an assignment and students have turned work 

in, it’s time to grade it. 

 

 

Grade and return work. 
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Click the title of the assignment to open it. Click on a student’s name to show any files attached 

that you need to view and to reveal a text field where you can type a comment to the student. 

Classroom flags every assignment as “not done,” “done,” “late” or “done late”. Classroom doesn’t 

change student grades if assignments are late, but you can. 

Once you’ve viewed assignments, you can assign a grade by clicking where it says “No Grade.” If 

you want to change the number of points an assignment is worth, find the “Points” section at the 

top of the page and change it. Use the button at the top of the assignment screen to download 

student work to your Google Drive or to view the Google Drive folder where the student work is 

being stored. Be sure to click the blue “Return” button to finalize all of the grading you’ve just 

done. 

Note: Once students turn work in using Classroom, they won’t be able to make changes to those 

files until you return them to the students after grading them. 

 

What Classroom doesn’t do 

Classroom is not a full-fledged LMS (learning management system) like Schoology, My Big 

Campus, Canvas and others. It’s Google’s foray into the education world and strives to help 

teachers with very specific, basic functions. Here are some things that Classroom will NOT do: 

 Provide tests and quizzes. Those can be created using Google Forms and a link to that 

form can be added to an assignment or announcement in Classroom. Google Forms can be 

graded automatically using the Flubaroo add-on. But all of this happens outside of Google 

Classroom. 

 Chat. There are no chat features within Classroom itself. If enabled by the administrator, 

students can chat with each other and the teacher within various Google Apps, but not in 

Classroom. 

 Calendar. There is no connection to Google Calendar to display due dates. You can do 

that separately in Calendar, but Classroom won’t do it itself. 

 Full-featured forums. If you want a forum or discussion board, an announcement can 

serve that purpose in a limited way. You would need another option for more complete 

nested discussions, though. 

 Tips and tricks 

1. There are lots of places to provide feedback (which is great!). You’ll want to think about 

where you want to provide it. It can be left in a comment in a file attached to an assignment. It 

can be left on each student’s assignment (only visible to that student). It can be left on the 

assignment when you click “Return” (visible to all students). 
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2. Adding descriptions to assignments is a good thing to do. The assignments in Classroom become 

good points of reference for absent students and kids that see their grades and wonder why they are as 

they are. Spelling out all of the details makes for easy reference later. 

3. Student work lives in a Google Drive folder in your Google account while it’s turned in to you in 

Classroom. You have access to that folder, but it’s not a good idea to make many changes to those 

folders in Google Drive. Make all of your changes directly through Classroom. 

What are your opinions about Classroom? Is there anything you’re unclear about after this 

guide? How are you using it in your class? Share with us in a comment below! 

(For notifications of new Ditch That Textbook content and helpful links, “like” Ditch That Textbook on 

Face book and follow @jmattmiller on Twitter!) 

Interested in having Matt present at your event or school? Contact him by e-mail! 

Related 

 
10 ways Google Classroom will make learning better 

In "Ed Tech" 

 
Ditch That Textbook's Best of 2014 

In "Ed Tech" 

 
5 practical ways to connect your classroom to the world 

In "Ed Tech" 

http://www.facebook.com/ditchthattextbook
http://www.facebook.com/ditchthattextbook
http://twitter.com/jmattmiller
mailto:matt@ditchthattextbook.com
http://ditchthattextbook.com/2014/05/15/10-ways-google-classroom-will-make-learning-better/
http://ditchthattextbook.com/2014/12/29/ditch-that-textbooks-best-of-2014/
http://ditchthattextbook.com/2013/09/02/5-practical-ways-to-connect-your-classroom-to-the-world/
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Aa¨vq-6 

gvB‡µvmdU cvIqvi c‡q›U Ges e¨envwiK cÖ‡qvM K‡i gvwëwgwWqv K‡›U›U cÖYqb 

Microsoft PowerPoint and Multimedia Content Development 
 

 

Awa‡ekb: Power Point Gi cÖv_wgK aviYv 

 

cÖZ¨vwkZ wkLbdj 

GB Awa‡ekb †k‡l cÖwkÿYv_x©MY-- 

 Presentation File Create Ki‡Z cvi‡eb 

 File G bZzb slide ms‡hvRb Ki‡Z cvi‡eb 

 welq Abymv‡i cÖ‡qvRbxq Slide selection Ki‡Z cvi‡eb 

 File ‡mf Ki‡Z cvi‡eb 

 Presentation Software e¨envwiK cÖ‡qvM Ki‡Z cvi‡eb| 

Awa‡ek‡bi iƒc‡iLv 

 

Presentation Software I Power Point m¤ú‡K© wkÿv_x©‡`i we`¨gvb aviYv †R‡b Zvi Dci wfwË 

K‡i avivevwnK fv‡e Av‡jvPbv, File create, Folder ‡_‡K File open Kiv Ges bZzb Slide ¯’vcb I 

welq Abymv‡i cÖ‡qvRbxq Slide selection BZ¨vw` m¤ú‡K© Av‡jvPbv Kiv n‡e| nv‡Z-Kj‡g Abykxjb 

Kiv‡bv n‡e Ges me‡k‡l g~j¨vqb Kiv n‡e| 

 

Awa‡ek‡bi we¯ÍvwiZ I avivevwnK weeiY 

 

Presentation Software I Power Point Gi Dci Av‡jvPbvi gva¨‡g AskMÖnYKvix‡`i c~e© aviYv 

†R‡b wbb| †hgb: Presentation Software wK? Power Point, Slide wK Ges G¸‡jv Avgiv †Kb 

e¨envi Kie; BZ¨vw`| mv‡_ mv‡_ wb‡Pi Av‡jvPbvUv Kiæb| 

 

Presentation Software: 
gvwëwgwWqv cÖ‡R±i, gwbUi BZ¨vw`i mvnv‡h¨ †Kvb welq‡K wkÿv_x© ev `k©‡Ki Kv‡Q †h mdUIq¨vi w`‡q 

ø̄vBW ˆZwi K‡i ø̄vBW †kv Kiv nq Zv‡K Presentation Software e‡j| †hgb- Power Point GKwU 

Presentation Software| 

 

eZ©gv‡b K¬vmiæg G e¨vcKfv‡e †cÖ‡R‡›Ukvb mdUIqvi e¨envi Kiv nq| K¬vmiæg G †cÖ‡R‡›Ukvb 

mdUIq¨vi e¨envi w`‡q gvwëwgwWqv K‡›U›U (AwWI, wfwWI, B‡gR, †U·U, Gwb‡gkb BZ¨vw`) ms‡hvM K‡i 

LyeB AvKl©Yxq fv‡e Dc ’̄vcb Kiv hvq| 

 

Microsoft Power Point   

Microsoft Power Point nj GKwU Presentation Software hv w`‡q †Kvb welq †K AvKl©Yxq I 

cÖvYešÍ K‡i Dc ’̄vcb Kiv hvq| †Kvb †cÖ‡R›Ukv‡b A‡bK¸‡jv ¯øvBW ev c„ôv _v‡K| GK GKwU c„ôv‡K GK 

GKwU ø̄vBW e‡j| Power Point w`‡q my›`i my›`i ø̄vBW ˆZwi K‡i K¬vmiæg G Dc ’̄vcb Ki‡j wkÿv_x©iv 

K¬v‡m Av‡iv †ewk gb‡hvMx nq A_©vr c~e©-cwiKíbv gvwdK gvbm¤§Z Dcv‡q †kÖwYKÿ cwiPvjbv Kiv hvq| 
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KvR-1: Kw¤úDUvi G Microsoft Power Point Pvjy ev Open Kivi c×wZ  

 

Kw¤úDUvi Pvjy Kivi ci †W·Uc G wb‡Pi evg Corner Gi Start button G Click Ki‡j GKwU †gby 

Avm‡e (wPÎ 17.1)| †hLv‡b All Programs bv‡g GKwU option _vK‡e| GwU wb‡Pi Qwei Gi gZ n‡e| 

 

 Gevi (wPÎ-17.1) All Programs option wU Gi Dci gvDm ai‡j ev Click Ki‡j Avi GKwU 

mve-‡gby Avm‡e †hLv‡b Microsoft Office 2013 bv‡g GKwU Option _vK‡e| 

 H option wU‡Z Click Ki‡j Avi GKwU mve-‡gby Avm‡e †hLv‡b Power Point 2013 bv‡g 

GKwU option _vK‡e| 

 Gevi Power Point 2013 option wU‡Z click Ki‡j Power Point 2013 Gi GKwU 

option ‡cBR Avm‡e Ges †mLvb †_‡K Blank Presentation G double click K‡i 

Power Point open Kiv hvq| 

 cÖwkÿYv_x©‡`i Power Point open Kivi c×wZ ej‡eb Ges cÖ¨vKwUK¨vjx †kLv‡eb (wPÎ-2) 

Ges evi evi Abykxjb Kiv‡eb| 

KvR-2: Microsoft Power Point G Folder ‡_‡K File open Kivi c×wZ 

 

 Microsoft Power Point Gi File ‡gby‡Z Click K‡i Open G Click Ki‡Z n‡e (wPÎ-3)| 

 Gevi Computer G  Click Ki‡j GKwU Window show Ki‡e †hLv‡b Browse bv‡g GKwU 

†dvìvi AvBKb †`Lv hv‡e| †mB AvBKb wU‡Z Click Ki‡j GKwU Open dialog box Show 

Ki‡e| 

 Gevi Computer G msiwÿZ †h dvBjwU Open Kie †m dvBjwU Select K‡i Open G 

Click Ki‡jB cÖ`Ë File wU Open n‡e| 

cÖwkÿYv_x©‡`i Power Point G Folder ‡_‡K File open Kivi G c×wZwU nv‡Z-Kj‡g †kLv‡eb Ges 

evi evi Abykxjb Kiv‡eb| GwU wb‡Pi ¯ŒxbkU Gi gZ n‡e| 
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KvR-3: Microsoft Power Point G bZzb Slide ’̄vcb I cÖ‡qvRbxq Slide selection Kivi 

c×wZ 

 Microsoft Power Point Pvjy Ki‡j automatically GKwU Slide open n‡e| 

 Click to add title Ges Click to add subtitle Gi Dci wK¬K K‡i Avgiv UvBc K‡i Slide 

‰Zwi Ki‡Z cvwi| 

 A_ev Home Tab G wM‡q Slide Group Gi New Slide Ribbon G Click K‡i bZzb Slide 

create Ki‡Z cvwi| 

GwU wb‡Pi ¯ŒxbkU Gi gZ n‡e, wPÎ-17.4| 

 

GLv‡b Avgv‡`i cÖ‡qvRb Abymv‡i Avgiv †h †Kv‡bv Slide ’̄vcb Ki‡Z cvwi| aiv hvK, Avgv‡`i UvB‡Uj 

wjL‡Z n‡e| Zvn‡j Avgiv Title Slide wm‡j± Kie| Avi hw` K‡›U›U ˆZwi Ki‡Z PvB Zvn‡j Avgiv 

Title and Content Slide wU wm‡j± Kie| Gfv‡eB cÖ‡qvRbxq Slide selection Kivi c×wZwU evi 

evi Abykxjb Ki‡Z n‡e (wPÎ-17.4)| 
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KvR-4: Microsoft Power Point G bZzb File Save Kivi c×wZ 

 

Microsoft Power Point 2013 Gi File ‡gby‡Z Click K‡i Save G Click Ki‡j GKwU 

Window show Ki‡e †hLv‡b Browse bv‡g GKwU †dvìvi AvBKb †`Lv hv‡e| †mB AvBKbwU‡Z 

Click Ki‡j GKwU Save As dialog box show Ki‡e (wPÎ-17.5)| GLv‡b File Name Box 

Gi Presentation1.pptx  wm‡j± K‡i A_ev Delete K‡i †h †Kvb bvg wjL‡Z n‡e| G‡ÿ‡Î 

wbw`©ó dvBj Gi bvg ivLvB fvj| GwU wb‡Pi ¯ŒxbkU Gi gZ n‡e| 

 

Abykxjb: Power Point G bZzb File Create, Folder ‡_‡K File open Kiv, cÖ‡qvRbxq Slide 

selection BZ¨vw` Ki‡Z ejyb| 

 

AskMÖnYKvix‡`i g~j¨vqb: mgq: 7 wgwbU, 

1|  wb‡Pi †KvbwU Presentation Software? 

K)  Windows 7 Gi     L)  a Tube Catcher     M)  Microsoft Power Point 

2|  bZzb dvBj I‡cb Kivi Rb¨ †Kvb †gby‡Z †h‡Z n‡e? 

K)  Insert            L)  Image          M)  File 

3|  K‡›U›U cÖYq‡b Power Point Software e¨envi Kivi mydj wK n‡Z cv‡i? 

K)  eyS‡Z myweav nq            L) eyS‡Z Amyweav nq            M)  eyS‡Z myweav I AvKl©Yxq nq 

4|  wb‡Pi †KvbwU K‡›U›U †jLvi Slide? 

K)  Title Slide       L)  Title and Content Slide   M)  Selection Header 

5|  Power Point G †Kvb dvBj Save Ki‡Z n‡j wK bv‡g I K_vq Save Ki‡j fvj nq| Avcbvi 

gZvgZ w`b| 

 

cybiv‡jvPbv I Awa‡ek‡bi mgvwß: 

AskMÖnYKvix‡`i ga¨ †_‡K GK ev GKvwaK Rb‡K wbe©vPb K‡i Awa‡ek‡b wK wK Av‡jvPbv I KvR n‡q‡Q 

Zv Dc ’̄vcb Ki‡Z ejyb| Awa‡ek‡bi mgvwß Uvbyb| 

 

 



60 

wkÿK‡`i AvBwmwU cÖwkÿY g¨vby‡qj 

Awa‡ekb: Power Point G Slide ’̄vcb, Data insert I Data Format KiY 

 

cÖZ¨vwkZ wkLbdj 

GB Awa‡ekb †k‡l cÖwkÿYv_x©MY--- 

 Power Point G bZzb Slide ms‡hvRb Ki‡Z cvi‡eb| 

 bZzb Slide G image Ki‡Z cvi‡eb| 

 Slide G data table, chart I equation insert Ki‡Z cvi‡eb| 

Awa‡ek‡bi iƒc‡iLv 
 

Power Point m¤ú‡K© AskMÖnYKvix‡`i we`¨gvb aviYv †R‡b Zvi Dci wfwË K‡i avivevwnK fv‡e bZzb 

File Create, bZzb Slide ’̄vcb I welq Abymv‡i cÖ‡qvRbxq Slide G image, table, chart 

equation ms‡hvRb, BZ¨vw` m¤ú‡K© Av‡jvPbv I nv‡Z Kj‡g Abykxjb Kiv‡bv| Awa‡ek‡bi we Í̄vwiZ I 

avivevwnK weeiY 
 

Power Point G Slide G image, table, chart, equation insert m¤ú‡K© Av‡jvPbv K‡i 

AskMÖnYKvix‡`i c~e© aviYv †R‡b wbb| 
 

‡hgb: Power Point Slide G Avgiv wKfv‡e image ev chart ms‡hvRb Ki‡Z cvwi? 

mv‡_ mv‡_ wb‡Pi Av‡jvPbvUv Kiæb| 
 

Power Point G wewfbœ data GiRb¨ wewfbœ Slide _v‡K| †hgb-Title ‡jLvi Rb¨ Title Slide, 

Content ‡jLvi Rb¨ Content Slide BZ¨vw`| Content Slide e¨envi K‡i Data table, PvU© I 

equation ms‡hvR‡bi Gi gva¨‡g AvKl©Yxq K‡›U›U cÖYqb K‡i †kÖwYK‡ÿ wkÿv_x©‡`i cvVPµ‡K mnR I 

†evaMg¨ Kiv hvq| 

 

KvR-1: bZzb Slide ‰Zwi Kivi c×wZ 

Power Point G blank presentation open Ki‡j automatically GKwU Title Slide 

open n‡e| Power Point 2013 g‡b K‡i †h Avcwb Avcbvi †cÖ‡R‡›UkbwUi GKwU h_v‡hvM¨ 

Title w`‡q ïiæ Ki‡Z Pvb| ZvB Microsoft ‡Kv¤úvwb by default GB Title Slide w`‡q 

†cÖ‡R‡›Ukb ïiæ K‡i‡Q| 

 

Slide Open Kivi Command: 

Open Microsoft Power Point>double click on Blank presentation GwU wb‡Pi 

¯ŒxbkU Gi gZ n‡e| 



61 

wkÿK‡`i AvBwmwU cÖwkÿY g¨vby‡qj 

 

wPÎ-18.1 bs G †`Lv hv‡”Q †h, Power Point Gi GKwU Title Slide Open n‡q‡Q| GLv‡b click to 

add title Ges click to add subtitle bv‡g `ywU e· †`Lv hv‡”Q| Click to add title ‡jLvi Dci 

mouse Gi cursor ‡i‡L click K‡i Title wjL‡Z cviv hvq| Abyiƒcfv‡e Subtitle ‡jLv hvq| wb‡Pi 

wPÎ-18.2 Gi gZ †jLv hvq|  

 

KvR-2: bZzb Slide ms‡hvRb Kivi c×wZ 

 ‡h Slide Gi c‡i bZzb Slide ms‡hvRb Kiv `iKvi, †mB SlidewU select K‡i Home Tab 

‡_‡K Slide group ‡_‡K New Slide evUb G Click Ki‡j ø̄vBW Choice Gi option 

Avm‡e (wPÎ-3)| 

 Gevi cÖ‡qvRb Abymv‡i Slide select K‡i click Ki‡jB bZzb Slide ms‡hvRb n‡e| 

cÖwkÿYv_x©‡`i Kivi bZzb Slide ms‡hvRb c×wZ ej‡eb Ges nv‡Z-Kj‡g †kLv‡eb (wPÎ-18.3) Ges evi 

evi Abykxjb Kiv‡eb| GwU wb‡Pi ¯ŒxbkU Gi gZ n‡e| 

 

KvR-3: Slide Gi K‡›U›U Kvjvi Kivi c×wZ 
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 Text Color Kivi c×wZ 

 ‡Kvb text color Ki‡Z PvB‡j Av‡M †mB textwU‡K mouse w`‡q select Ki‡Z n‡e| 

 Gevi Home U¨ve Gi Font group ‡_‡K Font Color wbe©vPb K‡i cQ›`gZ Color 

Select K‡i Click Ki‡jB †U·U color n‡e (wPÎ-18.4)| 

 

 

 GKBfv‡e †Kvb Shape ‡K Select K‡i Format menu/tab G wM‡q Shape styles ‡_‡K 

Shape Gi color Kiv hvq| 

 ‡Kvb slide ‡K design Ki‡Z PvB‡j H slide ‡K select K‡i design tabb ‡_‡K wewfbœ 

design Kiv hvq| 

 wkÿv_x©‡`i Power Point G color Kivi G c×wZwU nv‡Z-Kj‡g †kLv‡eb Ges evi evi 

Abykxjb Kiv‡eb| 

KvR-4: Slide G Data Table Insert Kivi c×wZ 

 Microsoft Power Point Gi †h †Uwej insert Kie †mB Slide G cursor ‡i‡L insert 

tab ‡_‡K Table Button G Click Ki‡j insert table option Avm‡e| H option ‡_‡K 

wb‡¤œv³ 4wU Dcv‡q †Uwej insert Kiv hvq| 

 Row-column Gi box ¸‡jv highlight K‡i| 

 Insert table ‡_‡K| 

 Drow Table ‡_‡K 

 Excel Spreadsheet ‡_‡K 
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GwU wb‡Pi ¯Œxbk&U Gi gZ n‡e (wPÎ-18.5)| 

 

 

KvR-5: Slide G Chart Insert Kivi c×wZ 

 Power Point 2013 Gi insert tab ‡_‡K Illustration group Gi Chart Button G 

click Ki‡j chart option Avm‡e, †mLvb †_‡K cÖ‡qvRbxq chart select K‡i ok ‡Z Click 

Ki‡Z n‡e, (wPÎ-18.6)| 

GwU wb‡Pi ¯ŒxbkU Gi gZ n‡e| 

Gevi Chart Title Ges Chart in Microsoft Power Point bv‡g `ywU Window Avm‡e| Chart 

in Microsoftt Power Point bv‡gi window ‡Z data insert K‡i ‰Zwi Kiv hvq (wPÎ-18.7), GwU 

wb‡Pi ¯ŒxbkU Gi gZ n‡e| 
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KvR-6: Slide G Smart Art insert Kivi c×wZ 

Smart Art e¨envi K‡i †Kvb office Gi organogram AvKl©Yxqfv‡e ˆZwi Kiv hvq| 

 Power Point 2013 Gi insert tab ‡_‡K Illustration group Gi Smart Art Button 

G click Ki‡j Smart Art option Avm‡e, †mLvb †_‡K cÖ‡qvRbxq Graphics select K‡i 

ok ‡Z click Ki‡Z n‡e (wPÎ-8)| 

 Gici Smart Art Gi text Gi Dci cursor ‡i‡L data entry Ki‡Z n‡e|  

GwU wb‡Pi ¯ŒxbkU Gi gZ n‡e, wPÎ-18.8| 

 

 

KvR-7: Power Point G equation insert Kivi c×wZ 

 Power Point 2013 Gi insert tabe ‡_‡K text Ribbon G Click K‡i π Gi wb‡P 

Equation G wK¬K K‡i †mLvb †_‡K cÖ‡qvRbxq equation select K‡i data entry Ki‡Z 

n‡e (wPÎ-18.9)| GwU wb‡Pi ¯ŒxbkU Gi gZ n‡e| 

insert Gi Short Cut command: 

Insert>Equation>select Equation 
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KvR-8: mgxKiY cÖwZcv`b I wjLb 

KgvÛ: Insert        Equation         Insert New equation          Click Type equation here. 

 
 

KvR-9: Internet ‡_‡K Mathematical ‡Kvb Z_¨ ev graph ev †Kvb Theorem ev ‡Kvb Image 

Avbv 

Internet ‡_‡K Mathematical ‡Kvb Z_¨ ev graph ev †Kvb Theorem ev ‡Kvb Image Avbv‡Z 

n‡j wb‡Pi Command wU AbymiY Ki‡Z n‡e| 
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KgvÛ: Mozila firefox           Address bar G www.google.com wj‡L Enter           Image 

search box G parabola graph/equation/Mathematical loop/Taylors Theorem/Avcwb hv 

Pvb Zv wj‡L Enter w`b cQ›`xq Qwei Dci Single Click           view image             Qwei Dci 

right click save image as             Show folder           Save 

 

 

 

* Integration Gi Rb¨- 

KgvÛ: Insert            Equation           Insert new equation             Click Type equation 

here            

            Select functions 

Select expected function              Type what you want. 
 

 

Abykxjb: Power Point G bZzb Slide create, table I Chart G data insert, equation insert, 

cÖ‡qvRbxq Slide selection BZ¨vw` Ki‡Z ejyb| 
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AskMÖnYKvix‡`i g~j¨vqb: AskMÖnYKvix‡`i g~j¨vqb Gi Rb¨ cÖ`Ë cÖkœgvjvwU c~iY Ki‡Z ejyb|  

1|  wb‡Pi †KvbwU Table ‰Zwi‡Z †ewk ¸iæZ¡c~Y© e‡j Avcwb g‡b K‡ib? 

     K)  Data     L)  Row Column    M)   Table Design 

2|  Chart ‰Zwi Kivi Rb¨ †Kvb g¨vby‡Z †h‡Z n‡e? 

     K)   Insert           L)  Image         M)  File 

3|  K‡›U›U cÖYq‡b Power Point Software e¨envi Kivi mydj wK n‡Z cv‡i? 

     K)  eyS‡Z myweav nq    L) eyS‡Z Amyweav nq    M)  eyS‡Z myweav I AvKl©Yx nq 

4|  wb‡Pi †KvbwU K‡›U›U †jLvi Slide? 

     K)  Title Slide    L)  Title and Content slide    M)  Selection Header 

5|  Power Point e¨envi K‡i K‡›U›U ˆZwi‡Z Slide Selection Gi e¨vcv‡i Avcbvi gZvgZ wjLyb| 

 

cybiv‡jvPbv I Awa‡ek‡bi mgvwß 

AskMÖnYKvix‡`i ga¨ †_‡K GK ev GKvwaK Rb‡K wbe©vPb K‡i Awa‡ek‡b wK wK Av‡jvPbv I KvR n‡q‡Q 

Zv Dc ’̄vcb Ki‡Z ejyb| Awa‡ek‡bi mgvwß Uvbyb| 

 

Awa‡ekb: Power Point G welqwfwËK Picture drawing, Slide Transition I Slide G 

Animation KiY 

 

cÖZ¨vwkZ wkLbdj 

GB Awa‡ekb †k‡l cÖwkÿYv_x©MY-- 

 GgGm cvIqvi c‡q›U e¨envi K‡i welqe Í̄i mv‡_ mswkøó Shape ‰Zwi Ki‡Z cvi‡eb 

 wewfbœ Shape ø̄vB‡W mshy³ K‡i Zv A¨vwb‡gkb Ki‡Z cvi‡eb 

 GgGm cvIqvi c‡q‡›U Slide Transition I Motion Path, UvBwgs B‡d±mn A¨vwb‡gkb 

cÖ‡qvRb Ki‡Z cvi‡eb| 

Awa‡ek‡bi iƒc‡iLv 

Microsoft Power Point 2013 G Shape draw K‡i Slide G insert K‡i Zvi Dci 

Animation cÖ`vb I nv‡Z Kj‡g Abykxjb Kiv‡bv| Slide Transition I Motion path, UvBwgs 

B‡d±mn Animation Gi cÖ‡qvM nv‡Z-Kj‡g Abykxjb Kiv‡Z n‡e| 

 

Awa‡ek‡bi we¯ÍvwiZ I avivevwnK weeiY 

 

Image  ev picture wK; Power Point G ¸‡jv Avgiv †Kb e¨envi Kie; BZ¨vw` cÖkœ Kiæb| K‡›U›U 

cÖYq‡b Slide Transition I Animation Gi e¨envi I ¸iæZ¡ m¤ú‡K© cÖwkÿYv_x©‡`i ejyb mv‡_ mv‡_ 

wb‡Pi Av‡jvPbvUv Kiæb| 

 

Image Gi Picture e¨envi K‡i †Kvb †cÖ‡R›Uvkvb‡K wkÿv_x©i Kv‡R Dc ’̄vcb Ki‡j †cÖ‡R‡›UkvbwU 

wkÿv_x©‡`i eyS‡Z AZ¨šÍ mnR nq| K‡›U›U cÖYq‡b Slide Transition I Animation cÖ‡qvM K‡i 

†Kvb ‡cÖ‡R‡›Ukvb †K LyeB AvKl©Yxq fv‡e Dc ’̄vcb Kiv hvq| eZ©gv‡b K¬vmiæ‡g e¨vcKfv‡e †cÖ‡R‡›Ukvb 

mdUIq¨vi e¨envi K‡i gvwëwgwWqv K‡›U›U (AwWI, wfwWI, B‡gR, †U·U, Gwb‡gkb BZ¨vw`) ms‡hvM K‡i 

LyeB AvKl©Yxqfv‡e Dc ’̄vcb Kiv nq| †ewkifvM mg‡q B›Uvi‡bU †_‡K  Picture ‡bqv nq| Avevi Clip 

Art ‡_‡KI wKQz Qwe †bqv hvq| Z‡e we‡kl †ÿ‡Î wb‡RB wKQz Image Draw Ki‡Z nq| 
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KvR-1: Power Point G Shape Draw Kivi c×wZ 

 Power Point G by default KZ¸‡jv †`qv _v‡K †hgb- line, basic shape, rectangle, 

block arrow, equation shapoe, flowchart BZ¨vw`| 

 Power Piint 2013 Gi insert tab ‡_‡K Illustration group Gi Shapes Button G 

Click Ki‡j Shape select Kivi option Avm‡e, †mLvb †_‡K cÖ‡qvRbxq Shape select 

K‡i ok ‡Z Click Ki‡Z n‡e| (wPÎ-19.1)| 

GwU wb‡Pi ¯ŒxbkU Gi gZ n‡e| 

 

Gevi (wPÎ-19.1) G cÖ`Ë Shape select Kivi option ¸‡jvi Dci gvDm a‡i Click K‡i Shape 

draw Kiv hvq| cÖwkÿYv_x©‡`i Power Point G Shape draw Kivi c×wZ cÖvKwUK¨vjx †kLv‡eb Ges 

evi evi Abykxjb Kiv‡eb| 

 

KvR-2: Custom Shape draw Kivi c×wZ 

 Freehand Drawing tool ‡hgb Curve, Freeform, Scribble BZ¨vw` e¨envi K‡i wb‡RB 

Image draw Kiv hvq| insert Tab ‡_‡K Shape Button G Click K‡i line group 

‡_‡K Curve AvBKb G Click Ki‡Z n‡e| (wPÎ-19.2)| 

 

 Gici mouse icon slide Gi Dci †i‡L Drag Ki‡Z n‡e| 
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KvR-3: Photosynthesis Gi Av‡jv‡K ch©vq Draw Kivi c×wZ 

Insert tab Gi Shapes ‡_‡K sun, arrow, cloud, Rectange G¸‡jv wb‡q ch©vqµ‡g (wPÎ-3) 

Abyhvqx draw Ki‡Z n‡e| GwU wb‡Pi ¯ŒxbkU Gi gZ n‡e| 

 

 

KvR-4: Slide Transition 

 Transition tab ‡_‡K Transition to this slide Ges Timing group ‡_‡K †h †Kvb 

option select K‡i Slide G Transition ‡`qv hvq| 

 ‡Kvb Slide ‡K AwaK AvKl©Yxq Kivi Rb¨ Ges Slide transition wKiƒc n‡e †mwU wbY©q KivB 

nj Transition Gi KvR| 

 Timing group ‡_‡K Sound, on mouse click, Apply to all BZ¨vw` select K‡i  Slide 

K‡›Uvj Kiv hvq| (wPÎ-19.4) 

 

 

KvR-5: Slide G Animation cÖ‡qv‡Mi c×wZ 

 Slide G Animation ‡`qvi Rb¨ cÖ_‡g †h object ev Picture G Animation ‡`qv n‡e 

†mwU wm‡j± Ki‡Z n‡e| 

 Gici Animation tab ‡_‡K †h †Kvb Animation select Ki‡Z n‡e| 
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 Gevi Advance Animation group ‡_‡K Animation pane evUb G Click Ki‡j ¯Œxb Gi 

Wvb cv‡k Animation Pane WvqvjM e· Avm‡e| †mLvb †_‡K Gwb‡gkb Gi wewfbœ Effect 

‡`qv hvq| (wPÎ-19.5) 

GwU wb‡Pi ¯ŒxbkU Gi gZ n‡e| 

 

cÖwkÿYv_x©‡`i Power Point G Animation cÖ‡qvM Kivi c×wZ cÖvKwUK¨vjx †kLv‡eb Ges evi evi 

Abykxjb Kiv‡eb| 

 

KvR-6: Slide G Motion Path cÖ‡qv‡Mi c×wZ 

 ‡h object ev Picture G Motion Path ‡`qv n‡e †mwU wm‡j± Ki‡Z n‡e| 

 Gevi Advance Animation group ‡_‡K Add Animation evUb G Click K‡i More 

Motion Paths G wK¬K Ki‡j Add Motion Path WvqvjM e· Avm‡e| †mLvb †_‡K 

cÖ‡qvRbxq Motion Paths wm‡j± K‡i Ok evUb G Click K‡i picture ev object G 

Motion Patyh ‡`qv hvq (wPÎ-19.6)| 

 

 Gevi Advance Animation group ‡_‡K Animation Pane evUb G Click Ki‡j ¯Œxb Gi 

Wvb cv‡k Animation Pane WvqvjM e· Avm‡e| †mLvb †_‡K Gwb‡gkb Gi wewfbœ Effect  

†`qv hvq| 
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 cÖwkÿYv_x©‡`i Power Point G Motion Path cÖ‡qvM Kivi c×wZ cÖvKwUK¨vjx †kLv‡eb Ges 

evi evi Abykxjb Kiv‡eb| 

Practice ..... Practice ....  Practice ...... Practice ......... Practice ........... Practice ....... 

Practice .... Practice ......Practice 

 

Abykxjb: Power Point G Image Draw Kiv, cÖ‡qvRbxq Animation, Motion path BZ¨vw` 

Effect w`‡Z ejyb| Mathematical Functions, Equations ø̄vB‡W insert Kiæb| 

AskMÖnYKvix‡`i g~j¨vqb: AskMÖnYKvix‡`i g~j¨vqb Gi Rb¨ cÖ`Ë cÖkœgvjvwU c~iY Ki‡Z ejyb|  

(mgq: 7 wgwbU), b¤^i-05| 

1|   wb‡Pi †KvbwU Image File? 

     K)  .mpg       L)  jpg      M) File 

 

2|  bZzb Image ‰Zwi Kivi Rb¨ †KvbwUi cÖ‡qvM †ewk e‡j Avcwb g‡b K‡ib? 

     K)  Shape          L)  New Photo Album         M)  File 

3|  Power Point G Motion Picture Gi ¸iæZ¡ m¤ú‡K© Avcbvi gZvgZ w`b| 

4|   Power Point G Functions e¨envi K‡i Kxfv‡e Equation Kiv nq Zvi avc¸‡jv D‡jøL 

Kiæb| 

 

cybiv‡jvPbv I Awa‡ek‡bi mgvwß 

AskMÖnYKvix‡`i ga¨ †_‡K GK ev GKvwaK Rb‡K wbe©vPb K‡i Awa‡ek‡b Kx Kx Av‡jvPbv I KvR n‡q‡Q 

Zv Dc ’̄vcb Ki‡Z ejyb| Awa‡ek‡bi mgvwß Uvbyb| 

 

Awa‡ekb: Power Point G Image, Video Editing Kiv Ges Slide G Audio I Video 

ms‡hvRb 

 

cÖZ¨vwkZ wkLbdj 

GB Aa¨vq †k‡l cÖwkÿYv_x©MY--- 

 cvIqvi c‡q›U e¨envi K‡i Image Edit Ki‡Z cvi‡eb 

 Audio I Video Edit Ki‡Z cvi‡eb 

 Slide G Audio I Video ms‡hvRb Ki‡Z cvi‡eb 

Awa‡ek‡bi iƒc‡iLv 
 

Microsoft Power Point 2013 G Picture editing, audio Ges Video Gi Dci cÖkœ K‡i 

cÖwkÿYv_x©‡`i c~e© aviYv †R‡b Zvi Dci wfwË K‡i avivevwnKfv‡e Av‡jvPbv I nv‡Z-Kj‡g Abykxjb 

Kiv‡bv| wewfbœ wel‡q K‡›U›U cÖYq‡b Picture e¨envi I Picture editing Kivi wbqg avivevwnKfv‡e 

Av‡jvPbv I nv‡Z Kj‡g Abykxjb Kiv‡bv| Slide G Audio I Video ms‡hvRb I Gi e¨envi nv‡Z 

Kj‡g Abykxjb Kiv‡bv| 

 

Awa‡ek‡bi we¯ÍvwiZ I avivevwnK weeiY 

K‡›U›U cÖYq‡b Image editing; Power Point G Audio, Video Insert Avgiv †Kb e¨envi Kie; 

G¸‡jvi cÖ‡qvRbxqZv BZ¨vw` m¤ú‡K© cÖwkÿYv_x©‡`i cÖkœ Ki‡eb Ges avivevwnKfv‡e we Í̄vwiZ Av‡jvPbv 

Ki‡eb| 

Image ev Picture e¨envi K‡i †Kvb †cÖ‡R›Ukvb‡K wkÿv_x© ev `k©‡Ki Kv‡Q Dc ’̄vcb Ki‡j 

†cÖ‡R‡›UkvbwU wkÿv_x©‡`i eyS‡Z AZ¨šÍ mnR nq| K‡›U›U cÖYq‡b Audio, Video cÖ‡qvM K‡i †Kvb 

†cÖ‡R›Ukvb †K LyeB AvKl©Yxq fv‡e Dc ’̄vcb Kiv hvq| eZ©gv‡b K¬vmiæ‡g e¨vcKfv‡e †cÖ‡R‡›Ukvb 



72 

wkÿK‡`i AvBwmwU cÖwkÿY g¨vby‡qj 

mdUIq¨vi e¨envi K‡i gvwëwgwWqv K‡›U›U (AwWI, wfwWI, B‡gR, †U·U, Gwb‡gkb BZ¨vw`) ms‡hvM K‡i 

LyeB AvKl©Yxqfv‡e Dc¯’vcb Kiv nq| 
 

Power Point G Image I Video Editing Kivi c×wZ 

 

KvR-1: Image Insert Kivi c×wZ 

 Power Point 2013 Gi cÖ_‡g Insert Tab ‡_‡K Image group Gi Picture Button G 

Click Ki‡Z n‡e| 

 Insert Picture bv‡g GKwU Dialog box Avm‡e; †mLvb †_‡K cÖ‡qvRbxq Image select K‡i 

Picture Insert Ki‡Z n‡e| 

      

KvR-2: Image Bright Kivi c×wZ 

 Slide G Image Avbvi c‡i Image wU‡K Select Kivi ci Format bv‡g GKwU Picture 

Tool Tab Avm‡e| 

 Picture wU Mouse w`‡q Select Ki‡j Format Tab wU automatically wU Avm‡e| 

 Gevi Format tab wU Select K‡i evg cv‡ki adjust group ‡_‡K Correctness G wK¬K 

Ki‡j Brightness/contrast bv‡g GKwU WvqvjM e· Avm‡e| 

 Gevi H Dialog e· †_‡K cÖ‡qvRbxq brightness select Kiv hvq, A_ev 

 

 

 H dialog e· Gi wb‡P Picture Correction Option G wK¬K K‡i Image G manually 

brightness w`‡Z cviv hvq| 
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KvR-3: Image G border ‡`qvi c×wZ 

 Slide Gi Image wU select K‡i Picture Style group ‡_‡K Picture Border G wK¬K 

Ki‡Z n‡e| 

 Picture Border Gi color select K‡i weight ‡_‡K cÖ‡qvRbxq Border size wb‡q 

Picture G Border ‡`qv hvq| 

Avevi †Kvb Image ‡K Picture Effect wKsev Picture Layout ‡_‡K wewfbœ fv‡e Editing Ki‡Z 

cviv hvq| cÖwkÿYv_x©‡`i Power Point G Image Edit Kivi c×wZ cÖvKwUK¨vjx †kLv‡eb Ges evi 

evi Abykxjb Kiv‡eb| 

KvR-4: Image Gi cÖ‡qvRbxq Ask †K‡U †bqv 

 Slide Gi ImagewU select K‡i Size group ‡_‡K Crop Button G wK¬K Ki‡Z n‡e| 

 

 

Gevi Mouse w`‡q Ges Ctrl key ‡P‡c wPÎ-20.4 Abyhvqx cÖ‡qvRbxq Ask select K‡i Avevi Crop 

Button G wK¬K Ki‡Z n‡e| Zvn‡jB Image Gi cÖ‡qvRbxq Ask Slide G insert  
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cÖwkÿYv_x©‡`i Power Point G Imaghe Editing Kivi c×wZ cÖvKwUK¨vjx †kLv‡eb Ges evi evi 

Abykxjb Kiv‡eb|  

 

 

 

KvR-5: Video Gi cÖ‡qvRbxq Ask †K‡U Slide G insert KiY: 

Bideo Editing wewfbœ software w`‡q Kiv hvq| Z‡e a Tube Catcher w`‡q Lye mn‡R †Kvb 

Video Gi cÖ‡qvRbxq Ask †K‡U Video Clip ‰Zix Kiv hvq|  

 cÖ_‡g A Tube Catcher open K‡i Video Conerter G wK¬K Ki‡Z n‡e| 

 Gevi a Tube Catcher Gi Tool Menu ‡_‡K Video & audio Crop Tool Click Ki‡j 

wb‡Pi wP‡Îi (wPÎ-20.6) gZ GKwU Dialog box Avm‡e| 

 

Gevi source File Gi cv‡ki button G wK¬K K‡i †h †Kvb GKwU video select Ki‡j video wUi 

`yBwU window ‡`Lv hv‡e| GKwU Start window I Ab¨wU End window | 

GLb †_‡K cÖ‡qvRbxq Ask Select K‡i Video Clip ‰Zwi Kiv hvq| cÖwkÿYv_x©‡`i Power Point G 

Video Editing Kivi c×wZ cÖvKwUK¨vjx †kLv‡eb Ges evi evi Abykxjb Kiv‡eb| 

Power Point G Video Ges Audio Tag Kivi c×wZ 
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KvR-6: Slide G video file insert Kiv 

 Power Point 2013 Gi cÖ_‡g insert Tab ‡_‡K object G Click Ki‡Z n‡e| 

 Gici create from file G click K‡i browse G click Ki‡Z n‡e| 

 cQ›`bxq wfwWI wU wm‡j± K‡i open Ki‡Z n‡e| 

 AZtci Display as icon G wK¬K K‡i Ok ‡Z wK¬K Ki‡Z n‡e| 

 Slide G icon wU Avm‡j Action Button G wK¬K K‡i Object Action G click Ki‡Z n‡e| 

 AZtci slide show ‡Z wM‡q †`L‡Z n‡e| GKB fv‡e AwWI dvBj I ms‡hvRb Kiv hv‡e| 

Insert>Object>Create from file>Browse>select video>open>Display as 

icon>Ok>Action> 

Object Action>Ok 

 

Abykxjb: Power Point G Image Editing Kiv, cÖ‡qvRbxq Audio, Video BZ¨vw` Insert Ki‡Z 

ejyb| cÖwkÿYv_x©‡`i Power Point G Audio Ges Video tag Kivi c×wZ cÖvKwUK¨vjx †kLv‡eb 

Ges evi evi Abykxjb Kiv‡eb| 

 

AskMÖnYKvix‡`i g~j¨vqb:  

AskMÖnYKvix‡`i g~j¨vqb Gi Rb¨ cÖ`Ë cÖkœgvjvwU c~iY Ki‡Z ejyb|  

(mgq: 7 wgwbU) 

1|  wb‡Pi †KvbwU Audio Extension File? 

     K)  .mp3     L)  jpg     M)   .avi 

2|  wb‡Pi †KvbwU Video File? 

     K)   .mp3        L)  jpg         M)  .mpg 

3|  K‡›U›U cÖYq‡b Power Point G Audio/Video Clip e¨envi Kivi mydj wK n‡Z cv‡i? 

     K)  eyS‡Z myweav nq    L) eyS‡Z Amyweav nq    M)  eyS‡Z myweav I AvKl©Yx nq 

4|  Power point G video Clip Insert Gi ¸iæZ¡ m¤ú‡K© Avcbvi gZvgZ w`b| 

 

cybiv‡jvPbv I Awa‡ek‡bi mgvwß 

AskMÖnYKvix‡`i ga¨ †_‡K GK ev GKvwaK Rb‡K wbe©vPb K‡i Awa‡ek‡b wK wK Av‡jvPbv I KvR n‡q‡Q 

Zv Dc ’̄vcb Ki‡Z ejyb| Awa‡ek‡bi mgvwß Uvbyb| 
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Awa‡ekb: Power Point G Slide Show Kiv Ges Multimedia Projector e¨envi K‡i  

 

Digital Content Gi Classroom Delivery Process KiY 

 

cÖZ¨vwkZ wkLbdj: 

GB Awa‡ekb †k‡l cÖwkÿYv_x©MY-- 

 Presentation Softare G wewfbœ Dcv‡q Slide Show Kivi `ÿZv AR©‡b mÿg 

n‡eb| 

 ‡kÖwYK‡ÿ Digital Content Dc ’̄vcb Kivi `ÿZv AR©b Ki‡eb| 

 Z_¨ cÖhyw³i mnvqZvq wkÿvi gvb Dbœq‡bi j‡ÿ Multimedia Classroom e¨envi 

K‡i presentation ‡K cÖvYešÍ K‡i †Zvjvi `ÿZv AR©‡b mÿg n‡eb| 

Awa‡ek‡bi iƒc‡iLv: 
 

Microsoft Power Point 2013 G GKwU Presentation wKfv‡e Present Ki‡Z nq, Gi Dci cÖkœ 

K‡i cÖwkÿYv_x©‡`i c~e© aviYv †R‡b Zvi Dci wfwË K‡i avivevwnK fv‡e Av‡jvPbv I cÖvKwUK¨vjx 

Abykxjb Kiv‡bv| wewfbœ wel‡q K‡›U›U Dc ’̄vcb Kivi wbqg avivevwnK fv‡e Av‡jvPbv I cÖvKwUK¨vjx 

Abykxjb Kiv‡bv| Multimedia Classroom G Computer/Laptop Gi mv‡_ Projector 

Connection ‡`qvi c×wZ avivevwnK fv‡e Av‡jvPbv I cÖvKwUK¨vjx Abykxjb Kiv‡bv| 

 

Awa‡ek‡bi we¯ÍvwiZ I avivevwnK weeiY: 

Classroom Delivery Gi Rb¨ Digital Content cÖYq‡bi ¸iæZ¡, †Kb Projector e¨envi Kie; 

G¸‡jvi cÖ‡qvRbxqZv BZ¨vw` m¤ú‡K© cÖwkÿYv_x©‡`i cÖkœ Ki‡eb Ges avivevwnKfv‡e we Í̄vwiZ Av‡jvPbv 

Ki‡eb| 

Slide Show Gi wewfbœ ÷vBj e¨envi K‡i †Kvb †cÖ‡R‡›Ukvb‡K wkÿv_x© ev `k©‡Ki Kv‡Q Dc ’̄vcb 

Ki‡j †cÖ‡R›UkvbwU wkÿv_x©‡`i eyS‡Z AZ¨šÍ mnR nq| K¬vmiæ‡g †cÖ‡R‡›Ukvb mdUIq¨vi e¨envi K‡i 

gvwëwgwWqv K‡›U›U (AwWI, wfwWI, B‡gR, †U·U, Gwb‡gkb BZ¨vw`) ms‡hvM K‡i LyeB AvKl©Yxqfv‡e 

Dc ’̄vcb Kiv nq| Projector e¨envi K‡i A‡bK QvÎ/QvÎx‡`i GK mv‡_ AZ¨šÍ mnR I †evaMg¨ Dcv‡q 

Classroom Delivery Kiv hvq| 

 

Power Point G Slide Show Kivi c×wZ: 

KvR-1: cÖ_g Slide ‡_‡K Slide Show ïiæ Kivi c×wZ: 

 Power Point 2013 Gi cÖ_‡g †Kvb K‡›U›U open Kivi c‡i Slide Show Tab G Click 

Ki‡Z n‡e| 

 Start Slide Show group Gi From beginning Button G Click Ki‡Z n‡e A_ev F5 

key ‡Z Pvc w`‡Z n‡e (wPÎ-21.1)| 

KvR-2: Current Slide A_ev †h †Kvb ø̄vBW †_‡K ø̄vBW Show Kivi c×wZ: 

 g‡b Kwi Avgiv †h Presentation Gi †h Slide G AvwQ †mB †_‡K ø̄vBW Show 

Ki‡Z PvB; Zvn‡j, cÖ_‡g Power Point 2013 Gi †Kvb K‡›U›U open Kivi c‡i 

Slide Show Tab G Click Ki‡Z n‡e| 

 Start Slide Show group Gi From Current Slide Button G Click Ki‡Z 

n‡e| 
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 Slide Show nIqvi ci mv‡_ mv‡_ Slide Show eÜ Ki‡Z PvB‡j ¯Œxb Gi Dci 

gvDm Gi right button click K‡i End Show ‡Z wK¬K Ki‡Z n‡e A_ev Esc Key 

Pvc‡Z n‡e (wPÎ-21.2)| GwU wb‡Pi ¯ŒxbkU Gi gZ n‡e| 

 Gevi B‡”Q gZ †h †Kvb Slide Show Ki‡Z n‡j Start Slide Show group Gi 

Custom Slide show button G click Ki‡Z n‡e| †mLvb †_‡K †h †Kv‡bv ø̄vBW 

add K‡i slide show Kiv hvq (wPÎ-21.3)| GwU wb‡Pi ¯ŒxbkU Gi gZ n‡e| 

KvR-3: Mouse Click A_ev keyboard Gi mvnvh¨ QvovB ø̄vBW show Kivi c×wZ: 

 cÖ_‡g Power Point 2013 Gi †Kvb K‡›U›U open Kivi c‡i Transition Tab G 

click Ki‡Z n‡e| 

 Gevi Timing group Gi wfZi wKQz KvR Ki‡Z n‡e| 

 Timing group Gi Advance Slide Gi On Mouse Click ‡_‡K wUK wPýwU wK¬K 

K‡i DwV‡q w`‡Z n‡e| 

 Gevi after Gi ev‡g wK¬K K‡i wUK wPý w`‡q timing set Ki‡Z n‡e| KZÿY ci ci 

ø̄vBW Transition n‡e Zv GB timing w`‡q wba©viY Kiv hvq (wPÎ-21.4)| 

Gici apply to all button G wK¬K Ki‡j mKj ø̄vBW automatically Transition n‡e| 

cÖwkÿYv_x©‡`i Power Point G Slide show Kivi c×wZ¸‡jv cÖvKwUK¨vjx †kLv‡eb Ges evi evi 

Abykxjb Kiv‡eb| 

 

KvR-4: Multimedia Project ms‡hvM Kivi c×wZ: 

Multimedia Projector e¨envi K‡i †h †Kvb Display ‡K eo AvKv‡i ¯Œxb G Dc ’̄vcb Kiv hvq| 

d‡j K¬v‡m GK mv‡_ A‡bK QvÎ/QvÎxi eyS‡Z myweav nq| 
 

 Laptop/PC Gi mv‡_ ms‡hvM w`‡Z n‡j cÖ_‡g cÖ‡R±i Gi power Cable ms‡hvM 

w`‡Z n‡e| 

 VGA output cable cÖ‡R±i Gi output port G ms‡hvM w`‡Z n‡e| 

 VGA input cable cÖ‡R±i Gi input port G ms‡hvM w`‡Z n‡e| 

cÖ‡R±i Gi mvg‡bi `ywU Scroll Øviv Zoom I †iRy‡jkb evov‡bv/Kgv‡bv hvq| cÖwkÿYv_x©‡`i 

Computer Gi mv‡_ †cÖv‡R±i connect Kivi c×wZ cÖvKwUK¨vjx †kLv‡eb Ges evievi Abykxjb 

Kiv‡eb| G m¤úwK©Z GKwU Video ‡`Lvb nj: Connect with projector video 

cÖwkÿYv_x©‡`i Power Point G Image Editing Kivi c×wZ cÖvKwUK¨vjx †kLv‡eb Ges evi evi 

Abykxjb Kiv‡eb| 
 

KvR-5: ¯Œxb ’̄vcb: 

Display Gi Rb¨ mv`v c`©v ’̄vcb Ki‡Z n‡e| ‡cÖv‡R±i Gi 3/4 dzU mvg‡b ¯Œxb Ggbfv‡e ’̄vcb Ki‡Z 

n‡e hv‡Z QvÎ/QvÎxiv myweavgZ ¯ŒxbwU †`L‡Z cvq| GRb¨ Avgiv mv`v Wall wKsev White Board 

e¨envi Ki‡Z cvwi  

wb‡Pi G m¤úwK©Z GKwU video ‡`Lv nj: 

¯Œxb video 

cÖwkÿYv_x©‡`i Screen ’̄vcb Kivi c×wZ cÖvKwUK¨vjx †kLv‡eb Ges evi evi Abykxjb Kiv‡eb| 
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Abykxjb: Power Point G Image Editing Kiv, cÖ‡qvRbxq Audio, Video BZ¨vw` Insert 

Ki‡Z ejyb| 

 

AskMÖnYKvix‡`i g~j¨vqb: AskMÖnYKvix‡`i g~j¨vqb Gi Rb¨ cÖ`Ë cÖkœgvjvwU c~iY Ki‡Z ejyb|  

(mgq: 7 wgwbU) 

1|  Automatically Slide Show Gi Rb¨ wb‡Pi †Kvb Tab G †h‡Z n‡e? 

     K)  Insert     L)  Transition    M)   Slide Show 

2|  wb‡Pi †KvbwU Video File? 

     K)   .mp3           L)  jpg         M)  .Mp4 

3|  K‡›U›U cÖYq‡b Power Point  G Audio/Video Clip e¨envi Kivi mydj wK n‡Z cv‡i? 

     K)  eyS‡Z myweav nq    L) eyS‡Z Amyweav nq    M)  eyS‡Z myweav I AvKl©Yx nq 

4|  gwbUi Ges ‡cÖv‡R±i G Slide show Gi Zzjbv m¤ú‡K© Avcbvi gZvgZ w`b| 

 

cybiv‡jvPbv I Awa‡ek‡bi mgvwß 

AskMÖnYKvix‡`i ga¨ †_‡K GK ev GKvwaK Rb‡K wbe©vPb K‡i Awa‡ek‡b wK wK Av‡jvPbv I KvR n‡q‡Q 

Zv Dc ’̄vcb Ki‡Z ejyb| Awa‡ek‡bi mgvwß Uvbyb| 
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Aa¨vq-7 

শিক্ষক বাতায়ন 
 

শিক্ষক বাতায়নন একাউন্ট খ ালার পদ্ধশতিঃ 
বর্ত মানে শিক্ষার উৎকর্ত সাধনে শিক্ষকনের জেয রনেনে শিক্ষক বার্ােে যার এনেস হন া 
www.teachers.gov.bdউপনরাক্ত ওনেবসাইনে  গ ইে করার জেয শেজ একাউন্ট 

খু নর্ হন  উক্ত শিক্ষক বার্ােনের  ককাে সেনসযর কাে কেনক প্রেমর্ ই-কমইন  একটি 

আমন্ত্রণ কপনর্ হনব। প্রশিক্ষে চ াকা ীে সমনে প্রশিক্ষণরর্ সক  শিক্ষকনকই আমন্ত্রণ 

পাঠানো হনব। অর্ঃপর আমন্ত্রণ প্রাশির পর করণীে হন াঃ 
 আপোর ই-কমই  কচক করুে। যারা yahoo, gmail, hotmailপ্রভৃশর্ বযবহার 

কনরে র্ারা কমই  ওনপে কনরinboxএঢুকুে। যারাGmail বযবহার কনরের্ারা 
েীনচর ধাপ অেসুরণ করুে। 

 Internet Browser -এর এনেস বানরwww.gmail.com োইপ কনর এন্টার 

কপ্রস করুে। Gmail এর কপজ ওনপে হনব। 

 

 
 বৃত্তাকার অংনির Username বনে শেনজর ই-কমই  আইশি কযমে আপোর ই-

কমই  এনেস jahangirhasanttc@gmail.comহন  আপশে শুধু 
jahangirhasanttcোইপ করুে। Password বনে একাউন্ট কখা ার ফরনম কয 

পাসওোিত  োইপ কনরশেন ে র্া োইপ কনর র্ীর শচশির্ Sign In বােনে শিক 

করুে। 

http://www.teachers.gov.bd/
http://www.gmail.com/
mailto:jahangirhasanttc@gmail.com
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 আপোর Gmail একাউন্ট ওনপে হনব। Inbox এ েরু্ে একটি কমই  কেখনর্ 

পানবে। 

 

Invitation From Education Portal এ শিক করন  শেনচর ওনেব কপজটি আসনব । 

 
 

এই কপনজ একটি শ ঙ্ক োকনব শ ঙ্কটির উপর শিক করন  শেনচর  শেনচর ওনেব কপজটি 

আসনব । 

 



81 

wkÿK‡`i AvBwmwU cÖwkÿY g¨vby‡qj 
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উপনরর কপজ গুন ানর্ বযবহারকারীর োম ও ই-কমই  কেওো োকনব।  আপশে আপোর 

ইনে মর্ কম পনক্ষ ৮ সঙ্খ্যা/অক্ষর শেনে পাসওোিত  শেনবে। একই পাসওোিত  আবার 

শেনবে র্ারপরআপোর োম,শপর্ার োম, মার্ার োম,জন্ম র্াশরখ, জন্ম স্থাে, ধমত,  
জার্ীে পশরচে েং,জন্ম শেবন্ধে েং ,কপিা, শিক্ষক ককাি, প্রশর্ষ্ঠানের োম, বর্ত মাে 

ঠিকাো, স্থােী ঠিকাো প্রভৃশর্ ঘর গুন া পূরণ করুে ।শেনজর েশব  আপন াি করার জেয 
Browseএ শিক কনর কয কফাল্ডানর আপোর েশব আনে কসই কফাল্ডানর শগনে েশবর উপর 

িাব  শিক করুে। র্ারপর েরু্ে একাউন্ট ততরী করুন বােে-এ শিক কনর সেসয 
হবার জেয অনপক্ষা করনর্ হনব। 
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Address Bar এ www.teachers.gov.bd শ নখ Enter চাপুে।  

 

 

র্াহন  শেনচর ওনেব কপজটি আসনব। 

 

র্ারপর শেনচর ওনেব কপজটি আসনব। এখানে বযবহারকারীর োম ও পাসওোিত  শ নখ 

প্রনবি এ শিক করুে।  

http://www.teachers.gov.bd/
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র্ারপর শেনচর ওনেব কপজটি আসনব। 
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কনন্টন্ট খে া ও ডাউননলাড করার শনয়মিঃ 
কনন্টন্ট এ শিক কনর কপ্রনজনন্টিে এ শিক করুে। র্ারপর শেনচর ওনেব কপজটি আসনব। 

 
পেনের কপ্রনজনন্টিেটি কেনখ এর শেনচ Download এ শিক করুে।  

 

 
িাউেন ািকৃর্ ফাই টি কেখার জেযrepair এ শিক করন  ফাই  টি ওনপে হনব। 



86 

wkÿK‡`i AvBwmwU cÖwkÿY g¨vby‡qj 

 
ফাই  টি কেখুে। 

 
 

খরাফাইল সম্পােন করার শনয়মিঃ 
আমার পার্া কেনক কপ্রাফাই  সম্পােে এ শিক করুে। 
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র্ারপর শেনচর ওনেব কপজটি আসনব। 
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উপনরাক্ত শফল্ডগুন া পূরে কনর সংরক্ষণ এ শিক করুে।র্াহন  আপোর কপ্রাফাই  তর্শর 

হনে যানব। পাসওোিত  পশরবর্ত ে করার জেয বর্ত মাে পাসওোিত  এর স্থন  ই-কমই  এ 

প্রাি পাসওোিত  শেেএবং েরু্ে পাসওোিত  আপোর ইো মর্ শেে। আপোর েশব 

কেওোর জেয ব্রাউজ এ শিক কনর কয কফাল্ডানর আপোর েশব আনে কসখানে শগনে েশবর 

উপর িাব   শিক করুে -র্ারপর সংরক্ষণ করুে।   

 

ব্লগ ততশরর শনয়মিঃ 
শেনচর ধাপ গুন া কেখুে 
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Title এ ব্লগ এর োম শ খনর্ হনব। শবর্েবস্তুনর্ আপোর কো শ খেু। র্ারপর সংরক্ষণ 

করুে। 

 

কনন্টন্ট আপনলাড করার পদ্ধশতিঃ 

 
কনন্টন্ট আপন াি এ শিক কনর কপ্রনজনন্টিে এ শিক করন  শেনচর কপজটি আসনব। 
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Title:  এখানে  পানঠর োম শ খেু (কযমে  কশম্পউোনরর প্রজন্ম) র্ারপর  

কয শবর্নে কনন্টন্ট শেনবে  র্ার শিক্ষার ধরে, কেণী, শবর্ে, অধযাে এগুন া শসন ক্ট করুে 

।   

েযাগসঃ এখানে  পানঠর োম শ খেু (কযমে  কশম্পউোনরর প্রজন্ম) 

শবর্েবস্তুঃ এখানে কনন্টন্ট তর্শরকারীর োম ও কনন্টন্ট টির শিক্ষেফ গুন া শ খনর্ হনব।  

কযমে কশম্পউোনরর প্রজন্ম গুন া সম্পনকত  ব নর্ পারনব। 

 

 
Browse এ শিক কনর আপশে কয ফাই টি শেনবে র্া শসন ক্ট কনর আপন াি এ শিক 

করুে। র্াহন  আপন াি শুরু হনব। ১০০% আপন াি হনর্ হনব। 
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শফচার এ শিক ো করাই ভা । এবার কু্ষদ্র শচনের অংনি Browse এ শিক কনর আপশে কয 

েশবটি শেনবে র্া শসন ক্ট কনর আপন াি এ শিক করুে। র্াহন  আপন াি শুরু হনব। 

১০০% আপন াি হনর্ হনব।  র্াহন  েশব আপন াি হনে যানব। শকন্তু অনেক সমে 

১০০% আপন াি হনে ো। যর্ক্ষণ ১০০ % আপন াি হনব ো। র্র্ক্ষণ কচষ্টা 
করুে।১০০% আপন াি হন   শেনচর কপজটি আসনব । 

 
সংরক্ষনণ শিক করন  কনন্টন্টটি আপন াি হনে যানব। এবং ক খা শেনব presentation 

has been created.  

অনয শিক্ষকনক শিক্ষক বাতায়ন ওনয়ব সাইট আমন্ত্রণ করার উপায়িঃ 
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আমন্ত্রনণ শিক করন  শেনচর কপজটি আসনব। 

 
আপশে যানক আমন্ত্রণ করনবে র্ার ই-কমই  শ নখ পাঠাে এ শিক করুে । invitation 

has been sent শ খা আসন  আপশে শেশির্ হনবে কয আমন্ত্রণ পাঠানো হনে কগনে। 
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অনয জননর খরাফাইল খে া ও খরটিং করার শনয়মিঃ 

 
 

বৃত্তাকার অংনির শেনক  ক্ষয করুে। র্ারপর শেনচর ওনেব কপজটি আসনব। এখাে কেনক 

ইউজার কেম এ শিক করন  র্ারপর শেনচর ওনেব কপজটি আসনব। 
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করটিং করার জেয শেনের ওনেব কপজ এর বৃত্তাকার অংনি ১ কেনক ৫ পযতন্ত করটিং কে  

অেুযােী কযনকাে বযবহারকারী কভাটিং করনর্ পারনবে (একটি কনন্টন্ট একবার)। 

 

কনন্টন্ট Edit করার শনয়মিঃ 
আমার পার্াে শিক কনর কনন্টন্ট এ শিক কনর কনন্টন্ট এর িাে শেনকDrop Down 

Menu কর্ সম্পােে-এ শিক কনর কনন্টন্ট সম্পাোে করনর্ হে। শেনচ কেখেু। 
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র্ারপর শেনচর ওনেব কপজটি আসনব। 
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এরপর সংরক্ষণ করুে । 
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wkÿv welqK ¸iæZ¡c~Y© I‡qemvBUmg~‡ni ZvwjKv 

(Kb‡U›U, cvV cwiKíbv, Z_¨, bZzb aviYv, †Mg I Ab¨vb¨ wkÿv DcKiY) 

‡`kxq ¸iæZ¡c~Y© I‡qemvBmg~n: 
 

wkÿK evZvqb www.teachers.gov.bd 

GbwmwUwe Aby‡gvw`Z cvV¨cy¯ÍKmg~‡ni I‡qemvBU www.ebook.gov.bd 

wkÿvg~jK Z_¨, wkÿK‡`i ˆZwi wWwRUvj Kb‡U›U I wfwWI wK¬c www.infokosh.gov.bd 

evsjv‡`‡ki Z_¨-mg„× Ávb‡Kvl www.banglapedia.org 

wWwRUvj Kb‡U›U ˆZwii cÖwkÿYcÖvß wkÿK‡`i eøM www.ictinedubd.ning.com 

‡`‡k I †`‡ki evB‡i Aew¯’Z evOvjx weÁvbx I weÁvb †cÖgx‡`i †jLv, 

cÖeÜ, wbeÜ 

 

 

 

¸iæZ¡c~Y© I‡qemvBmg~n: 
 

wewfbœ wkÿvg~jK Uzj&‡mi wekvj fvÛvi http://www.educatorstechnology.com/ 

we‡k¦i †h †Kvb Z_¨, Dcv‡Ëi Rb¨ www.indexmundi.com 

we‡k¦i wewfbœ Z_¨, Dcv‡Ëi wj½ http://www.globaldashboard.org/ 

¯‹zj Ab jvBb (weªwUk KvDwÝj Gi wkÿv welqK mvBU) schoolsonline.britishcouncil.org 

Lvb GKv‡Wwg (wewfbœ wel‡qi Rb¨) https://www.khanacademy.org/ 

cvIqvic‡q›U Ges wkï‡`i B›Uv‡iKwUf wkÿv DcKi‡Yi wekvj fvÛvi www.pppst.com 

wkÿK, cÖwkÿK I wkÿvwe`‡`i Rb¨ Kb‡U›U, cvV cwiKíbv I aviYv www.teachersdomain.org 

weÁvb, MwYZ, BwÄwbqvwis, mvwnZ¨ wel‡qi Z_¨, Kb‡U›U, †Mg, cÖKí www.bestedsites.com 

cÖv_wgK/gva¨wgK ch©v‡qi wkÿv DcKiY, msev`, cÖeÜ/wbeÜ, LeivLei http://www.channel4learning.com/ 

wkÿv welqK I‡qemvB‡Ui Kv‡jKkb www.ictliteracy.info/K12-Resources.html 

wkÿv welqK Kb‡U›U, Av‡jvPbv, wb‡ ©̀kbv, cÖKí BZ¨vw` http://www.oercommons.org/oer 

AbjvBb Z_¨ †Kvl www.wikipedia.org 

we‡k¦i wewfbœ †`‡ki ev ’̄v‡bi m¨v‡UjvBU B‡gR I g¨vc www.maps.google.com 

wkÿv welqK Qwe http://edupic.net/ 

wkÿK‡`i Rb¨ wewfbœ welq http://www.discoveryeducation.com/teachers/ 

wewfbœ †U¤ú‡jU, cvV cwiKíbv I Ab¨vb¨ wi‡mv‡m©i Rb¨ www.microsoft.com/education/educators.mspx 

mv‡qÝ Gwb‡gkb, gy¨wf, B›Uv‡iw±f Uzj wKU http://science.nhmccd.edu/bio1/animatio.htm 

Apple Gi wkÿv welqK mvBU http://www.apple.com/education/ 

GKwU AvKl©Yxq I‡qemvBU nv‡Z Kj‡g Kv‡Ri aviYv, cvV cwiKíbv, 

evwoi Kv‡Ri aviYv, ¸iæZ¡c~Y© wjsK, wkÿK wb‡ ©̀wkKv 

http://www.thinkfinity.org/ 

6ô †_‡K 10g †kÖwYi weÁv‡bi cÖKí, cixÿv-wbixÿv/G·‡cwi‡g›U, 

ch©‡eÿY, AbymÜvb m¤ú‡K© MVbg~jK wb‡ ©̀kbv BZ¨vw` 

http://www.sciencenetlinks.com/lessons.php? 

we‡k¦i wewfbœ †`‡ki ev ’̄v‡bi m¨v‡UjvBU B‡gR QvovI bvbv ¯’v‡bi 

w_ªwWwfD, f‚wgK¤ú, Av‡MœqwMwi cÖf…wZi Ae¯’vb m¤ú‡K© Rvbv hvq 

www.earth.google.com 
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weÁvb 

weÁvb welqK AbjvBb cvV DcKiYmg~n: 

 RxeweÁvb : 

http://www.biology-online.org/dictionary/Main_Page 

http://biology.about.com/ 

http://www.dmoz.org/Kids_and_Teens/School_Time/Science/Living_Things/ 

http://www.emc.maricopa.edu/faculty/farabee/BIOBK/BioBookTOC.html 

http://www.biology4kids.com/ 

http://www.phschool.com/science/biology_place/glossary/index.html 

http://www.kidsbiology.com 

http://www.biologyinmotion.com 

http://www.sparknotes.com/biology/ 

http://www.ibo-info.org/ 

 

 

 

 

 c`v_©weÁvb: 
 

http://www.animations.physics.unsw.edu.au http://scienceworld.wolfram.com/physics/ 

http://scienceworld.wolfram.com/physics/ http://www.alcyone.com/max/physcis/index.html 

http://www.sparknotes.com/physics/ http://www.jyu.fi/tdk/kastdk/olympiads/ 

http://physics.about.com/ http://aapt.org/ 

 

 imvqb: 
 

http://scienceworld.wolfram.com/chemistry/ http://www.icho.sk/ 

http://www.rsc.org/ http://www.schoolphysics.co.uk/ 

http://www.sparknotes.com/chemistry http://webbook.nist.gov/chemistry/ 

http://antoine.frostburg.edu/chem/senese/101/index.shtml  

 

 MwYZ: 
 

MwY‡Zi mnvqK MvBW http://www.sparknotes.com/math/ 

MwY‡Zi †ek eo msMÖn http://mathworld.wolfram.com/ 

MwY‡Zi wUDUwiqvj http://math.about.com/ 

GLv‡bI i‡q‡Q A‡bK eo msMÖn http://www.sosmath.com/ 

MwYZ †Kvl, Bs‡iRx eY© w`‡q Kvw•LZ welq LyuR‡Z http://www.mathacademy.com/pr/prime/ 

MwY‡Zi AvK©vBf, welqwfwËK, cÖwZ‡hvwMZvi Z_¨, cÖ¯‘ywZ, wkÿv 

DcKiY 

http://archives.math.utk.edu/ 

AvšÍR©vwZK MwYZ Awjw¤úqvW http://imo.math.ca/ 

evsjv‡`k MwYZ Awjw¤úqvW (K‡g©i gva¨‡g wkÿv) http://www.matholympiad.org.bd 

MwYZ dvb-Gi cvkvcvwk Kz¨BR, IqvK©kxU, exRMwYZ, R¨vwgwZ 

wkÿv 

http://www.mathsisfun.com/ 

MwY‡Z wkÿK mnvwqKv, auvav, exRMwYZ, R¨vwgwZ, †Ljv BZ¨vw` http://illuminations.nctm.org/ 

MwY‡Zi wewfbœ w¯‹jm& Abykxj‡bi Rb¨ www.brainetcs.com/ 

MÖvd ˆZwii Rb¨ http://nces.ed.gov/nceskids/createagraph/default.aspx 

MwY‡Zi wewfbœ md&UIq¨vi I M‡elYvi Rb¨ http://mathforum.org/mathtools/ 
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 mgvRweÁvb: 
 

mgvRweÁv‡bi bvbv kvLvi eB http://en.wikibooks.org/wiki/Wikibooks:Social_sciences_bookshelf 

ivóªweÁv‡bi aªæc`x I Ab¨vb¨ eB http://www.lib.umich.edu/govdocs/polisci.html 

evsjv‡`‡ki mgvRZË¡ Rvb©vj http://www.bangladeshsociology.org/index.htm 

weª‡UwbKvi mgvRZË¡ Rvb©vj http://www.sociology.org/ 
 

 BwZnvm: 
 

mgq, AÂj I welqwfwËK BwZnv‡mi bvbv eB http://en.wikibooks.org/wiki/History 

BwZnvm mswkøó cÖ‡qvRbxq mvB‡Ui wW‡i±wi http://www.bcsthistorysites.net/ 
 

 evsjv‡`‡ki BwZnvm: 
 

evsjv‡`‡ki BwZnvm, HwZn¨ I AviI bvbv welq wb‡q http://www.muktadhara.net/ 

evsjv‡`‡ki KvjvbyµwgK BwZnvm, gyw³hy× cÖf…wZ http://www.profile-bengal.com/ 
 

 f‚‡Mvj: 
 

AvenvIqv, Rjevqy, †`k, gvbwPÎ, cZvKv, f‚ZË¡ http://www.geographic.org/geopgraphy/geography.html 

gvbwPÎ, †`k I f‚‡Mv‡ji bvbv wel‡q mg„× http://geography.about.com/ 

‡QvU‡`i f‚‡Mvj http://www/geography4kids.com/ 

evsjv‡`‡ki HwZnvwmK, ivR‰bwZK BZ¨vw` gvbwPÎ http://commons.wikimedia.org/wiki/Atlas_of_Bangladesh 

c„w_exi bvbv ai‡Yi I wewfbœ mg‡qi gvbwPÎ, wewfbœ 

†kÖYxwefvM, †`k BZ¨vw` Abymv‡i cvIqv hv‡e 

http://commons.wikimedia.org/wiki/Atlas 

evsjv‡`‡ki bvbv gvbwPÎ Ly‡R †c‡Z http://www.nayerdak.com/homeland/maps.html 
 

 ag©: 
 

wewfbœ ag© m¤^‡Ü Rvb‡Z http://www.religionfacts.com/ 

Bmjvg Gi BwZnvm, HwZn¨ http://islam.about.com/ 

KziAvb I nvwm‡`i welqwfwËK †kÖwYweb¨vm http://www.al-islam.com/eng/ 

wn›`y a‡g©i Ici mvaviY aviYv http://hinduism.about.com/ 

¯‹z‡ji Dc‡hvMx wn› ỳ ag© wkÿv DcKiY http://www.hindaism.fsnet.co.uk/ 

kÖxg™¢Mer MxZv http://www.bhagavad-gita.org/ 

wLª÷vb a‡g©i mvaviY aviYv http://christianity.about.com/ 

wLª÷vb ag© m¤̂‡Ü we¯ÍvwiZ  http://www.christianity.co.nz/ 

evB‡ej http://net.bible.org/bible.php 

‡eŠ× a‡g©i mvaviY aviYv http://webspace.ship.edu/cgboer/buddhaintro.html 

wÎwcUK http://www.accesstoinsight.org/tipitaka/index.html 

 

 Mvn© ’̄¨ A_©bxwZ: 
 

mnvqK I‡qemvBU http://homeschooling.about.com/od/homeeconomics 
 

 K…wl weÁvb: 
 

K…wl‡Kvl http://www.ca.uky.edu/agripedia/subjectindex/ 

 

 gyw³hy× welqK: 
 

gyw³hy×wfwËK DDwK mvBU http://muktijuddho.wikia.com 

gyw³hy× Rv`yN‡ii wbR¯̂ I‡qemvBU http://www.liberationwarmuseum.org 

GKvË‡ii MYnZ¨vi Ici http://www.genocidebangladesh.org/ 

‡m±i KgvÛvi †dviv‡gi I‡qemvBU http://www.sectorcommandersforum.org/ 

gyw³hy× m¤úwK©Z †ek eo Av‡qvRb http://jonmojuddho.org/home2.html 
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 ‡R¨vwZwe`¨v: 
 

bvmvi †R¨vwZwe©`¨v msµvšÍ Av‡qvRb http://science.nasa.gov/Astronomy.htm 

wkï‡`i wewfbœ welq http://www.kidsastronomy.com/ 

M¨vÛvi GKv‡Wwgi Av‡qvRb http://www.cdli.ca/CITE/astronomy.htm 

‡R¨vwZwe©`¨v‡Kvl http://www.enchantedlearning.com/subjects/astronomy/glossary/ 

evsjv‡`k A¨v‡÷ªvbwgK¨vj G‡mvwm‡qkb http://astronomybangla.com/index.php 

AvšÍR©vwZK †R¨vwZwe©`¨v Awjw¤úqvW http://www.issp.ac.ru/iao/ 

 

 evsjv fvlv I mvwnZ¨: 
 

mgmvgwqK evsjv eB‡qi Rb¨ http://www.boi-mela.com/ 

evsjv jvB‡eªix http://banglalibrary.evergreenbangla.com/ 

evsjv GKv‡Wgx http://www.banglaacademy.org.bd 

cwðge½ evsjv AvKv‡`wg http://paschimbanglabanglaakademi.org/ 

AbjvBb evsjv Awfavb www.ovidhan.org 

http://dsal.uchicago.edu/dictionaries/biswas-bengali 

http://dictionary.evergreenbangla.com 

http://www.bangladict.org 

Bs‡iRx fvlv, e¨vKiY, BwZnvm BZ¨vw` http://www.englishlanguageguide.com/ 

Bs‡iRxi wewfbœ `ÿZvi Rb¨ http://englishteststore.net/ 

Bs‡iRx fvlvi wewfbœ †Kvm© http://www.english-online.org.uk/ 

mnR Dcv‡q Bs‡iRx e¨vKiY http://www.english-the-easy-way.com/ 

B›Uvi‡bU Bs‡iRx e¨vKiY http://www.ucl.ac.uk/internet-grammar/home-htm 

Bs‡iRx mvwn‡Z¨i m¤¢vi http://etext.virginia.edu/colections/languages/english/ 

Mí, cÖeÜ, Dcb¨vm BZ¨vw` http://eserver.org/ 

ayªc`x mvwnZ¨ http://www.classicreader.com/ 

DcK_v I †jvKKvwnbx http://www.pitt.edu/-dash/folktexts.html 

 

 Bs‡iwR welqK AbjvBb cvV DcKiYmg~n: 

English Games, puzzles,activities  

learnenglishteens.britishcouncil.org/ www.fisher-price.com/us/playtime 

learnenglishkids.britishcouncil.org/ www.bbc.co.uk/schools/4_11/literacy.shtml 

www.teachingenglish.org.uk/ www.bbc.co.uk/skillswise/words/grammer/ 

www.learnenglish.org.uk/kids/ www.funbrain.com 

www.primarygames.com/ www.enchantedlearning.com/Home.html 

 www.learnenglish.org.uk/magazine_current_frame.html 

  
 

Dictionary 
www.dictionary.cambridge.org/ www.ovidhan.org 

www.wordcentral.com  

  

 

Reading 
www2.actden.com/writ_den/ www.chanel4.com/learning/microsites/b/bookbox/home.htm 

www.realbooks.co.uk www.readingrollercoaster.org.uk/ 

www.wordpool.co.uk www.penguindossiers.com/audio-frameset.asp 

  

 

Listening 
www.elllo.org www.esl-lab.com 

www.wordcentral.com  
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Vocabulary 
http://a4esl.org/g/h/vocabulary.html  

  

  

 

Grammer 
http://www.a4esl.org/g/h/grammar.html  

  

 

wfwWI mvBUmg~n 

http://www.khanacademy.org/ http://videolectures.net/ 

http://www.yovisto.com/ http://www.schooltube.com 

http://www.teachertube.com http://www.teachingchannel.org/ 

http://sciencestage.com/ http://www.ted.com/ 

http://www.pbs.org/wgbh/nova/education/ www.explore.org/Educational-Videos 
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Aa¨vq-8 

gvB‡µvmdU G‡·j  

Microsoft Excel 

gvB‡µvmdU G‡·j (Microsoft Excel) Ges Gi ¸i“Z ¡  

gvB‡µvmdU G‡·j n‡”Q †¯cÖWkxU G¨vbvjvBwmm †cÖvMÖvg| ˆ`bw›`b wnmve-wbKvk Kiv †_‡K ïi“ 
K‡i hveZxq e¨emv evwY‡R¨i wewfbœ iK‡gi Avw_©K wnmve wbKvk ˆZwi‡Z †cÖvMÖvgwUi Rywo †bB| GB 

†cÖvMÖv‡gi mvnv‡h¨ ev‡R‡Ui wnmvemn †Kvb WvUv‡K Pv‡U©i gva¨‡g my›`ifv‡e Dc ’̄vcb Kiv hvq| ‡gvU K_v 

G‡·j Øviv ev‡RU ˆZixmn mKj cÖKvi wnmve-wbKv‡ki KvR Kivi †¶‡Î LyeB ¸i“Z¡c~Y©| 

 

Awa‡ekb: gvB‡µvmdU G‡·j (Microsoft Excel) -Gi IqvK© kx‡U †WUv Gw›Uª, †hvM, we‡qvM, ¸Y, 

fvM I kZKiv wbY©q I wewfbœ dvskb-Gi e¨envi 

cÖZ¨vwkZ wkLbdj 

GB Awa‡ekb †k‡l cÖwkÿYv_x©MY-- 

 gvB‡µvmdU G‡·j (Microsoft Excel) Gi IqvK©kx‡U WvUv Gw›Uª, †hvM, we‡qvM,¸Y, 

fvM I kZKiv wbY©q Ki‡Z cvi‡eb| 

 gvB‡µvmdU G‡·j (Microsoft Excel) Gi wewfbœ dvskb Gi e¨envi Ki‡Z cvi‡eb| 

Awa‡ek‡bi iƒc‡iLv 

Microsoft Excel m¤ú‡K© AskMÖnYKvix‡`i Ávb hvPvB K‡i Zvi Dci wfwË K‡i avivevwnKfv‡e 

Microsoft Excel m¤ú‡K© mvaviY aviYv w`‡eb| Gici IqvK©kx‡U ‡WUv Gw›Uª, †hvM, we‡qvM, ¸Y, fvM 

I kZKiv wbY©‡q cÖwkÿYv_x©‡`i nv‡Z Kj‡g Abykxjb Kiv‡eb| 
 

 

Awa‡ek‡bi we¯ÍvwiZ I avivevwnK weeiY 
 

KvR-1:  gvB‡µvmdU G‡·j (Microsoft Excel) PvjyKiY 

Start ‡_‡K Programs Gi Wvb cvk †_‡K Microsoft Excel wK¬K Ki‡j Microsoft Excel Pvjy 

n‡e| 

A_ev 

Shortcut Bar ‡_‡K MS Excel Gi Symbol wK¬K Ki‡j Microsoft Excel Pvjy n‡e| Gici 

avivevwnKfv‡e Microsoft Excel m¤ú‡K© mvaviY aviYv w`‡eb| 

KvR-2: Microsoft Excel m¤ú‡K© mvaviY aviYv 
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IqvK© (Work Book) 

 

gvB‡µvmdU G‡·j WKz‡g›U‡K ejv nq IqvK©eyK| hLb †cÖvMÖvg ivb Kiv nq ZLb GKwU Lvwj IqvK©eyK 

Kv‡Ri Rb¨ ˆZwi _v‡K| GKwU IqvK©ey‡K GK ev GKvwaK IqvK©mxU _vK‡Z cv‡i| †cÖvMÖvg Pvjy Ki‡j 

mvaviYZ 3wU IqvK©mxU †`Lv hvq| Gi msL¨v cieZx©‡Z evov‡bv ev Kgv‡bv hvq| 

 

IqvK©mxU (Worksheet) 
 

G‡·‡ji IqvK©mxU n‡jv Column I Row  Gi mgš^‡q MwVZ mxU| IqvK©mx‡Ui Kjvg¸‡jv A, B, C, 

D, E...... Gi †iv ¸‡jv 1,2,3,4,5 ........ cªf…wZ bv‡g wPwýZ _v‡K| IqvK©mx‡U 16,384wU Column I 

10,48,576wU Row i‡q‡Q| IqvK©mx‡U Aew ’̄Z Kvimi‡K †mj c‡q›Uvi Ges †iv I Kjv‡gi wgwjZ 

’̄vb‡K †mj-G‡Wªm e‡j| IqvK©mx‡U †Kvb †m‡j †Kvb m~Î cÖ‡qvM Kivi ci m~‡Î DËi hw` †mj Gwiqvi 

†ewk msL¨v nq †m‡ÿ‡Î ######### wPý Avm‡Z cv‡i| G‡ÿ‡Î Kjvg‡K eo K‡i wb‡j c~Y© msL¨v †`Lv 

hv‡e| 

 

KvR-3: gvB‡µvmdU G‡·j (Microsoft Excel) eÜKiY 

‡Kvb KvR Kivi ci †cÖvMÖvg †_‡K ‡ei n‡Z PvB‡j 

 Office Button  ‡_‡ K Exit Excel A_ev Close  evUb wK¬K Ki‡j wb‡¤œi b¨vq GKwU 

WvqvjM e· Avm‡e| 

 

GLb dvBjwU †mf K‡i †ei n‡Z PvB‡j Yes evUb Ges †mf bv Ki‡Z PvB‡j No evU‡b wK¬K K‡i †ei 

n‡Z n‡e| 

KvR-4: dvBj †mf ev msiÿY (File Save) 

IqvK©mx‡U †Kvb †WUv Gw›Uª Kivi ci Zv Save (msiÿY) Kivi Rb¨ Office Button  n‡Z 

Save/Save as Ackb wK¬K Ki‡Z n‡e| 
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File Name: Box G †h bv‡g dvBjwU †mf Ki‡ev Zvi bvg UvBc Ki‡Z n‡e| Save evUb wK¬K Ki‡Z 

n‡e| 

KvR-5: dvBj †mf Kivi ci Ab¨ bv‡g †mf ev msiÿY 

Office Button  n‡Z Save as Ackb wK¬K Ki‡Z n‡e| 

File Name: Box G †h bv‡g dvBjwU †mf Ki‡ev Zvi bvg UvBc Ki‡Z n‡e| 

Save evUb wK¬K Ki‡Z n‡e| 

KvR-6: msiwÿZ dvBj Open 

Save Kiv †Kvb dvBj Open Kivi Rb¨ Office Button   n‡Z Open wK¬K Ki‡Z n‡e| dvB‡ji 

ZvwjKv †_‡K cÖ‡qvRbxq dvBj Select Ki‡Z n‡e| Open evUb wK¬K Ki‡Z n‡e| 

 

 

KvR-7: bZzb Work Book G hvIqv 

‡Kvb wKQz UvBc Kivi ci H †jLv‡K †mf K‡i A_ev †mf bv K‡iB hw` Ab¨ GKwU bZzb Work Book 

G hvIqvi cÖ‡qvRb nq Zvn‡j  

 Office Button       ‡_‡K New Ackb wK¬K Ki‡Z n‡e| 

 Create evUb wK¬K Ki‡Z n‡e| 

 bZzb Work Book ev bZzb dvBj cvIqv hv‡e| 

KvR-8: GKB Work Book G bZzb Sheet G hvIqv 

GKB Work Book G bZzb Sheet G hvIqvi Rb¨ Work book Gi wb‡Pi w`‡K Sheet1, Sheet2, 

Sheet3... ‡h †KvbwU‡Z wK¬K Ki‡Z n‡e| 
 

KvR-9: gvB‡µvmdU G‡·‡ji Acv‡iUi (Operator of Microsoft Excel) Gi aviYv 

G ch©v‡q cÖwkÿK Microsoft Excel Gi Acv‡iUi m¤ú‡K© cÖwkÿYv_x©‡`i aviYv †`‡eb| gvB‡µvmdU 

G‡·‡j †WUv Gw›Uªi ci G †WUv wb‡q A‡bK KvR Ki‡Z nq| MvwYwZK KvR †hgb †hvM, we‡qvM, ¸Y, fvM 

BZ¨vw` QvovI GKwU †WUvi mv‡_ Ab¨ †WUvi Zzjbv Ki‡Z hyw³MZ wm×všÍ MÖnY Ki‡Z wfbœ wPý ev 

K¨v‡i±vi e¨eüZ nq| G me wPý ev K¨v‡i±vi‡K Acv‡iUi e‡j| gvB‡µvmdU G‡·‡ji K‡qKwU Acv‡iUi 

e¨envi Kiv nq| 

h_v: 

 MvwYwZK Acv‡iUi (Arithmetic Operator) 

 wi‡jkbvj Acv‡iUi (Relational Operator) 

 jwR‡Kj Acv‡iUi (Logical Operator) 
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MvwYwZK Acv‡iUi (Artithmetic Operator) 

MvwYwZK KvR Kivi Rb¨ e¨eüZ G Acv‡iUi‡K wbD‡gwiK Acv‡iUi wnmv‡e AwfwnZ Kiv nq| G 

Acv‡iUi¸‡jvi mvnv‡h¨ MvwYwZK cwiMYbv Kiv hvq| A_©vr †hvM, we‡qvM, ¸Y, fvM BZ¨vw` KvR Kiv hvq| 

wb‡Pi Artithmetic Acv‡iUi¸‡jvi ZvwjKv I KvR Zz‡j aiv n‡jv| 

 Acv‡iUi bvg KvR 

 + ‡hvM wPý ‡hvM Kivi Kv‡R 

 Ñ we‡qvM wPý we‡qvM Kivi Kv‡R 

 / fvM wPý fvM Kivi Kv‡R 

 * ¸Y wPý ¸Yb Kivi Kv‡R 

 ^ m~PK wPý G·‡cv‡bbwkqvj ev msL¨vi 

Dci cvIqv‡ii Kv‡R 

 () MÖæc G·‡cÖkb eÜwbi Kv‡R 

 

wi‡jkbvj Acv‡iUi (Relational Operator) 

‡cÖvMÖv‡g GK ev GKvwaK ‡WUvi g‡a¨ Zzjbv Kivi Rb¨ G ai‡Yi Acv‡iU‡ii e¨envi Kiv nq| wb‡¤œi 

mviYx‡Z G Acv‡iUi¸‡jvi eY©bv †`Iqv n‡jv| 

Acv‡iUi bvg KvR 

= mgvb wPý wP‡ýi `yB cv‡ki Ask mgvb †evSv‡Z 

< ÿz`ªZg wPý evg cv‡ki Ask Wvb cv‡ki †P‡q †QvU †evSv‡Z 

> e„nËg wPý evg cv‡ki Ask Wvb cv‡ki †P‡q eo †evSv‡Z 

<= ÿz`ªZi mgvb wPý evg cv‡ki Ask Wvb cv‡ki †P‡q †QvU ev mgvb †evSv‡Z 

>= e„nËi mgvb wPý evg cv‡ki Ask Wvb cv‡ki †P‡q eo ev mgvb †evSv‡Z 

 

jwRK¨vj Acv‡iUi (Logical Operator) 

wewfbœ cÖKvi †hŠw³K KvR Kivi Rb¨ jwRK¨vj Acv‡iUi e¨envi Kiv nq| G Acv‡iUi djvdj wnmv‡e 

True ev False cÖ`vb K‡i| wb‡¤œ ỳBwU jwRK¨vj Acv‡iU‡ii eY©bv †`Iqv n‡jv: 

Acv‡iUi eY©bv 

AND `ywU G·‡cÖk‡bi g‡a¨ †hŠw³K wm×všÍ MÖnY K‡i| ïay me¸‡jv G·‡cÖk‡bi 

gvb True n‡j cy‡iv G·‡cÖkbwUi gvb True cÖ`vb K‡i| 

OR `ywU G·‡cÖk‡bi g‡a¨ †hŠw³K wm×všÍ MÖnY K‡i| Kgc‡ÿ GKwU G·‡cÖk‡bi 

gvb True n‡j cy‡iv G·‡cÖkbwUi gvb True cÖ`vb K‡i| 

 

KvR-10: †iv wm‡jKkb (Row Selection) 

‡Kvb GKwU Row Select Ki‡Z n‡j (awi 3bs †iv wm‡j± Ki‡Z PvB) gvDm c‡q›Uvi Row Gi 3 

msL¨vi Dci wK¬K Ki‡j m¤ú~Y© †iv wm‡j± n‡q hv‡e| Ab¨w`‡K GK ev GKvwaK Row wm‡j± Ki‡Z PvB‡j 

D³ Row ¸‡jvi Dci gvDm c‡q›Uvi wb‡q WªvM Ki‡Z n‡e| 
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KvR-11: Kjvg wm‡jKkb (Column Selection) 

‡Kvb GKwU Column Select Ki‡Z n‡j (awi C bs †iv wm‡j± Ki‡Z PvB) gvDm c‡q›Uvi C Gi Dci 

wb‡q wK¬K Ki‡j m¤ú~Y© Kjvg wm‡j± n‡q hv‡e| Ab¨w`‡K GK ev GKvwaK Column wm‡j± Ki‡Z PvB‡j 

D³ Column ¸‡jvi Dci gvDm c‡q›Uvi wb‡q WªvM Ki‡Z n‡e| 

 

 

KvR-12: †mj/‡iÄ wm‡jKkb (Cell/Range/Selection) 

IqvK©mx‡Ui †Kvb Z_¨vejxi g‡a¨ AvswkK †Kvb Z_¨ wb‡q KvR Ki‡Z n‡j ev AvswkK †Kvb Z_¨ wm‡j± 

Ki‡Z PvB‡j †h †mj †_‡K wm‡j± Ki‡Z PvB †mB †mj †_‡K gvDm c‡q›Uvi †P‡c a‡i hZUzKz cÖ‡qvRb 

ZZUzKz wm‡j± K‡i †Q‡o w`‡Z n‡e| 

Kx †ev‡W©i gva¨‡g Ki‡Z PvB‡j †h †mj †_‡K wm‡j± Ki‡Z PvB †mB †m‡j †mj c‡q›Uvi †i‡L Shift 

‡P‡c a‡i G¨v‡iv Øviv cÖ‡qvRbxq Abyhvqx wewfbœ w`‡K wm‡j± Ki‡Z n‡e| 

KvR-13: GK ev GKvwaK †iv jyKv‡bv (Hide) 

‡Kvb †iv Gi †WUv †Mvcb (Hide) K‡i ivL‡Z PvB‡j Row ev Row ¸wj Select Ki‡Z n‡e| 

Home menu ->Format Ack‡bi Row Hide wK¬K Ki‡Z n‡e| 

 

KvR-14: jyKv‡bv †iv wdwi‡q Avbv (Unhide) 

jyKv‡bv Row wdwi‡q Avb‡Z n‡j Row ¸‡jvi Dc‡ii I wb‡Pi Row Select Ki‡Z n‡e| 

Home menu ->Format Ack‡bi Row unhide wK¬K Ki‡Z n‡e| 

KvR-15: GK ev GKvwaK Kjvg (Column) jyKv‡bv 

‡Kvb Kjv‡gi †Mvcbxq †WUv †Kn hv‡Z bv †`L‡Z cv‡i †m Rb¨ †WUv ¸‡jv Hide K‡i ivL‡Z PvB‡j  

 Column ev Column ¸wj  Select Ki‡Z n‡e| 

 Home menu->Format Ack‡bi Column Hide wK¬K Ki‡Z n‡e| 

KvR-16: jyKv‡bv Column wdwi‡q Avbvi wbqg 

jyKv‡bv Column wdwi‡q Avb‡P PvB‡j 

 Column ev Column ¸wji ev‡g I Wv‡bi  Column Select Ki‡Z n‡e| 

 Home menu->Format Ack‡bi Column unhide wK¬K Ki‡Z n‡e| 

KvR-17: mvwi ms‡hvRb (Row Insertion) 

KvR Kivi gv‡S †Kvb GKwU Row ms‡hvR‡bi cÖ‡qvRb n‡j 

 ‡h ’̄v‡b Row Insert (ms‡hvRb) Ki‡ev †mB ¯’v‡b †mj c‡q›Uvi ivL‡Z n‡e| 

 Home menu->Insert Ackb †_‡K Insert Sheet Row Ackb wK¬K Ki‡Z n‡e| 
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KvR-18: ỳB ev Z‡ZvwaK †mj GKwÎZKiY (Merge) 

Kv‡Ri cÖ‡qvR‡b `yB ev Z‡ZvwaK †mj GKwÎZ Ki‡Z n‡j- 

 ‡mj¸‡jv wm‡j± Ki‡Z n‡e| 

 Home menu ->Alignment Click Ki‡Z n‡e| 

 Alignment U¨ve wm‡j± K‡i Merge Cells Ack‡b wUK wPý ( ) w`‡Z n‡e| 

 Ok evUb wK¬K Ki‡Z n‡e| GQvovI †mj¸‡jv wm‡j± K‡i Home menu->Alignment Uzjevi 

†_‡K Merge and Center ..... evUb wK¬K Ki‡jI †mj¸‡jv gvR© n‡q hv‡e| 

KvR-19: Merge Kiv †mj‡K Split Kiv 

gvR© Kiv †mj‡K Split Ki‡Z n‡j 

 cÖ_‡g †mj ¸‡jv‡K select Ki‡Z n‡e 

 Home menu->Alignment Uzjevi †_‡K Merge and Center     evUb wK¬K Ki‡j 

†mj¸‡jv Split n‡q hv‡e| 

KvR-20: Kjvg ms‡hvRb (Column Insertion) 

KvR Kivi gv‡S †Kvb GKwU Column ms‡hvR‡bi cÖ‡qvRb n‡j 

 ‡h ’̄v‡b Column Insert (ms‡hvRb) Ki‡ev †mB ¯’v‡b †mj c‡q›Uvi ivL‡Z n‡e| 

 Home menu->Insert Ackb †_‡K Insert Sheet Column Ackb wK¬K Ki‡Z n‡e| 

KvR-21: †hvM 

G‡·‡j m~‡Îi mvnv‡h¨ †hvM Kivi Rb¨ D`vniY wnmv‡e wb‡¤œi b¨vq GKwU IqvK©eyK ˆZwi Kwi Ges B2 

‡_‡K E2 ‡iÄ ch©šÍ †WUvi †hvMdj F2 ‡m‡j †ei Kivi Rb¨ F2 ‡m‡j Kvimi ivL‡Z n‡e| 
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 =Sum(B2:E2) UvBc K‡i Enter w`‡j F2 Cell G ‡hvMdj †ei n‡q hv‡e| 

 Tool bar n‡Z summation symbol G wK¬K K‡i G›Uvi Pvc‡Z n‡e| 

 

KvR-22: Ab¨fv‡e †mj¸‡jvi †hvMdj †ei Kiv 

 F2 ‡m‡j Kvimi ivL‡Z n‡e| 

 =b2+c2+d2+e2 UvBc K‡i Enter w`‡j F2 Cell G †hvMdj †ei n‡q hv‡e| 

 

 cieZx© †mj¸‡jv‡Z djvdj †ei Kivi Rb¨ Kvimi F2 ‡m‡j †i‡L gvDm c‡q›Uvi F3 n‡Z F4 

ch©šÍ WªvM Ki‡Z n‡e| 

 

KvR-23: we‡qvM 

G‡·‡j we‡qvM Kivi Rb¨ D`vniY wnmv‡e wb‡¤œi b¨vq GKwU IqvK©eyK ˆZwi Kwi Ges C2 †m‡ji ‡WUv 

†_‡K D2  †m‡ji ‡WUv we‡qvM K‡i F2 †m‡j djvdj †ei Kivi Rb¨ Kvimi E2 †m‡j †i‡L gvDm 

c‡q›Uvi E3 n‡Z E6 ch©šÍ WªvM Ki‡Z n‡e| 

KvR-24: ¸Yb 

¸Y Kivi Rb¨ D`vniY wnmv‡e wb‡¤œi b¨vq GKwU IqvK©eyK ˆZwi Kwi Ges B2 I C2 ‡m‡ji †WUv ¸Y K‡i 

D2†m‡j djvdj †ei Kivi Rb¨- 
 

 D2 ‡m‡j Kvimi ivL‡Z n‡e| 

 = B2*C2 UvBc K‡i G›Uvi Pvc‡j D2 †m‡j ¸Ydj †ei n‡q hv‡e| cieZx© †mj¸‡jv WªvM 

Ki‡Z n‡e| 

KvR-25: fvM 

 fvMdj †ei Kivi Rb¨ D2 †m‡j Kvimi ivL‡Z n‡e, 

 = C2/B2 UvBc K‡i G›Uvi Pvc‡j D2 ‡m‡j fvMdj †ei n‡q hv‡e| cieZx© †mj¸‡jv WªvM 

Ki‡Z n‡e| 

 

 



109 

wkÿK‡`i AvBwmwU cÖwkÿY g¨vby‡qj 

KvR-26: KZK¸‡jv msL¨vi g‡a¨ †_‡K me‡P‡q †QvU msL¨v, eo msL¨v Ges G‡`i Mo BZ¨vw` †ei Kiv 

 msL¨v¸‡jvi g‡a¨ †_‡K Mo (Average) msL¨v †ei Kivi Rb¨ G2 ‡m‡j Kvimi †i‡L 

Average(C2.E2) wj‡L G›Uvi Pvc‡Z n‡e| 

 msL¨v¸‡jvi g‡a¨ †_‡K eo (Maximum) msL¨v †ei Kivi Rb¨ H2 ‡m‡j Kvimi †i‡L 

=Maxverage(C2.E2) wj‡L G›Uvi Pvc‡Z n‡e| 

 

 msL¨v¸‡jvi g‡a¨ †_‡K ‡QvU (Minimum) msL¨v †ei Kivi Rb¨ I2 ‡m‡j Kvimi †i‡L 

=Min(axverage(C2.E2) wj‡L G›Uvi Pvc‡Z n‡e| 

 msL¨v¸‡jvi g‡a¨ †_‡K Condition w`‡q †hvMdj †ei Kivi Rb¨ J2 ‡m‡j Kvimi †i‡L 

=Sumif(Cell range,"<60",sum range) 

 

KvR-27: G‡·‡ji DB‡Ûv‡K fvM Kiv 

DB‡Ûv‡K `yÕfv‡M fvM Kiv hvq| G‡ÿ‡Î GKB †WUv `yB DB‡Ûv‡Z †`Lv hv‡e| IqvK©eyK‡K `yÕfv‡M fvM 

Ki‡Z n‡j- 

 View g¨vby †_‡K Split wK¬K Ki‡Z n‡e| 

 Kvimi cÖ‡qvRbxq ’̄v‡b †i‡L wK¬K Ki‡Z n‡e| 

 

KvR-28: fvM Kiv DB‡Ûv dWgMiW Kiv 

 View  †gby †_‡K Split wK¬K Ki‡Z n‡e| 

 

Abykxjb: 

cÖwkÿYv_x©‡`i gvB‡µvmdU G‡·j (Microsoft Excel) Gi IqvK©kx‡U †hvM, we‡qvM, ¸Y I fvM 

Abykxjb Kivb| 

Practice ... Practice... Practice ... Practice... Practice ... Practice... 
g~j¨vqb: cÖwkÿK Awa‡ekb mgvwßi c~‡e© GwUi Dci cÖwkÿYv_x©‡`i GKwU mswÿß g~j¨vqb Ki‡eb| b¤^i-5 

cybiv‡jvPbv I Awa‡ek‡bi mgvwß: 

AskMÖnYKvix‡`i ga¨ †_‡K GK ev GKvwaK Rb‡K wbe©vPb K‡i Awa‡ek‡b Kx Kx Av‡jvPbv I KvR n‡q‡Q 

Zv Dc ’̄vcb Ki‡Z ejyb| Awa‡ek‡bi mgvwß Uvbyb| 
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Awa‡ekb: gvB‡µvmdU G‡·j (Microsoft Excel) Gi IqvK©kxU dig¨vU, d›U cwieZ©b, †cR 

†mUAvc, wcÖ›U wcÖwfD, †WUv mU© Gi e¨envi 

 

cÖZ¨vwkZ wkLbdj 

G Awa‡ekb †k‡l cÖwkÿYv_x©MY- 

1|  gvB‡µvmdU G‡·j (Microsoft Excel) Gi IqvK©kxU dig¨vU, †cR †mUAvc, wcÖ›U wcÖwfD, †WUv 

mU© Ki‡Z cvi‡eb| 

Awa‡ek‡bi iƒc‡iLv 

cÖ_g Awa‡ek‡bi Dci AskMÖnYKvix‡`i we`¨gvb aviYv †R‡b Zvi Dci wfwË K‡i avivevwnKfv‡e wØZxq 

Awa‡ekb m¤ú‡K© mvaviY aviYv w`‡eb| Gici IqvK©kxU dig¨vU, †cR †mUAvc, wcÖ›U wcÖwfD, WvUv mU© 

BZ¨vw` KvR cÖwkÿYv_x©‡`i nv‡Z Kj‡g Abykxjb Kiv‡eb| 

KvR-1: †mj di‡gU Cell Formation 

 Worksheet Gi †Kvb †m‡j msL¨vi mv‡_ Currency wPý †c‡Z n‡j †h mg Í̄ †mj‡K Kv‡iwÝ 

Ki‡Z PvB Zv Select Ki‡Z n‡e| 

 Home menu->Alignment Click Ki‡j wb‡¤œi b¨vq WvqvjM e· Avm‡e| 

 

  Number U¨ve wK¬K Ki‡Z n‡e| 

 Category e· n‡Z Currency wbe©vPb K‡i Ok evUb wK¬K Ki‡Z n‡e| 

G‡·‡j mvaviYZ Default Currency wnmv‡e Wjvi wPý $ _v‡K| GB wPý cwieZ©b Ki‡Z n‡j 

Control Panel ‡_‡K cwieZ©b Ki‡Z n‡e| 
 

KvR-2: †mj‡K `kwgK di‡g‡U (Decimal Format) iƒcvšÍwiZKiY 

Worksheet Gi †Kvb †m‡ji msL¨vi mv‡_ `kwgK wPý †c‡Z n‡j- 

‡h mg Í̄ †mj‡K `kwgK wPý Ki‡Z PvB Zv Select Ki‡Z n‡e| 

 Home menu->Alignment Click Ki‡j wb‡¤œi b¨vq WvqvjM e· Avm‡e| 
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  Number U¨ve wK¬K Ki‡Z n‡e| 

 Category e· n‡Z Number wbe©vPb K‡i Ok evUb wK¬K Ki‡Z n‡e| 

 `kwg‡Ki ci `yB msL¨v wb‡Z PvB‡j Decimal places Gi cv‡ki N‡i 2 wj‡L w`‡Z n‡e| 

KvR-3: †mj‡K cvi‡m‡›UR di‡gU (Percentage Format) iƒcvšÍwiZKiY 

Worksheet Gi †Kvb †m‡ji msL¨vi mv‡_ kZKiv wPý †c‡Z n‡j- 

‡h mg Í̄ †mj‡K kZKiv wPý Ki‡Z PvB Zv Select Ki‡Z n‡e| 

 Home menu->Alignment Click   

  Number U¨ve wK¬K Ki‡Z n‡e| 

 Category e· n‡Z Percentage wbe©vPb K‡i Ok evUb wK¬K Ki‡Z n‡e| 

KvR-4: IqvK©mx‡Ui wbw`©ó †mj¸‡jv‡K eW©vi (Border) ‡`qv 

IqvK©mx‡U †mj¸‡jv‡Z †h nvjKv AvKv‡i eW©vi †`Lv hvq Zv wcÖ›U w`‡j wcÖ›U n‡e bv| d‡j †Uwe‡ji g‡Zv 

KvR¸‡jv wcÖ›U Ki‡j my›`i †`Lv hvq bv| GRb¨ †mj¸‡jv‡K eW©vi †`qvi cÖ‡qvRb n‡q c‡o| GRb¨- 

 ‡mj¸‡jv wm‡j± Ki‡Z n‡e| 

 Home menu->Alignment Click K‡i  

 Border U¨ve wK¬K Ki‡Z n‡e| 

 Inside I Outline wK¬K Ki‡Z n‡e| 

 G‡Z K‡i eW©v‡ii wfD †`Lv hv‡e| 

 OK evUb wK¬K Ki‡Z n‡e| 

 

KvR-5: Font cwieZ©b 

d›U (Font) m¤ú‡K© aviYv 

 Avgiv †h mKj KvR Kw¤úDUv‡i UvBc K‡i _vwK Zv †Kvb bv †Kvb Font G UvBc K‡i _vwK| 

KvR Kivi Rb¨ Kw¤úDUv‡i wewfbœ ai‡Yi Font Av‡Q| Z‡e Bs‡iwR †jLvi Rb¨ Times New 

Roman/Arial Ges evsjv †jLvi Rb¨ Nikosh/Nikosh Ban/Solaiman 

lipi/SutonnyMJ/SulekhaT/SutonnyII d›U¸‡jv mPivPi e¨envi n‡q _v‡K| 

 Bs‡iwR †_‡K evsjv Ges evsjv †_‡K Bs‡iwR Font cwieZ©b Ki‡Z n‡j `yBwU Option-G 

cwieZ©b Ki‡Z n‡e| 

 Font Select (‡hgb-Bs‡iwR †jLvi Rb¨ Times New Roman Ges evsjv †jLvi Rb¨ 

Nikosh) 

 

 Avro evsjv mdUIq¨v‡ii Rb¨ Interface cwieZ©b A_©vr, Kx †evW© B›Uvi‡dm cwieZ©b F12 

‡P‡c A_ev English/Bangla Gi Dci wK¬K K‡i cwieZ©b Ki‡Z n‡e| 

 

 English n‡Z evsjv Ki‡Z n‡j 
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 Home menu->Alignment Click K‡i  

 

 Font Tab wK¬K Ki‡Z n‡e| 

 Font wj÷ n‡Z Nikosh Select Ki‡Z n‡e| 

 F12 ‡P‡c A_ev Bangla/English wK¬K K‡i Keyboard cwieZ©b Ki‡Z n‡e| Gici 

wjL‡j evsjv wjLv Avm‡e| 

KvR-6: wcÖ›U wcÖwfD (Print Preview) 

‡Kvb †jLv wcÖ›U Kivi c~‡e© c„ôvi gvwR©b, †nWvi, dzUvi, †cR bv¤^vi BZ¨vw` GK bR‡i †`Lvi Rb¨ 

 Office Button ‡_‡K Print-> Print Preview wK¬K Ki‡j GwU †`Lv hv‡e| cieZx©‡Z 

Close evUb wK¬K K‡i cybivq WKz‡g‡›U Avmv hv‡e| 

 

KvR-7: †cR †÷Avc (Page Setup) 

IqvK©ey‡K c„ôvi gvwR©b, KvM‡Ri mvBR Ges wcÖ‡›Ui aiY BZ¨vw` Default Kiv _v‡K| G †ÿ‡Î Zv 

cwieZ©b Ki‡Z n‡j-Page Layour Menu ‡_‡K Page Setup wK¬K Ki‡j wb‡¤œi WvqvjM e· Avm‡e| 

 
 

gvwR©b evov‡bv/Kgv‡bv 

GiRb¨ Margin U¨v‡e wK¬K K‡i cÖ‡qvRb Abymv‡i Left, Right, Top, Bottom Gi gvwR©b evov‡bv ev 

Kgv‡bv hv‡e| 
 

KvM‡Ri mvBR cwieZ©b 

IqvK©ey‡K wewfbœ ai‡Yi KvM‡Ri mvBR i‡q‡Q| †hgb-Letter Size, Legal Size, A4 BZ¨vw`| 

IqvK©ey‡Ki Z_¨¸‡jv †Kvb ai‡Yi KvM‡R wcÖ›U n‡e Zvi Dci wfwË K‡i Kw¤úDUv‡i KvM‡Ri mvBR 

cwieZ©b Kiv n‡q _v‡K| Gi Rb¨ Page U¨v‡e wK¬K Ki‡Z n‡e| 
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Paper Size e· n‡Z cÖ‡qvRbxq †ccvi mvBR wm‡j± K‡i OK evUb wK¬K Ki‡j KvM‡Ri mvBR cwieZ©b 

n‡e| 

 

KvR-8: wcÖ‡›Ui aiY wba©viY 

 

Page U¨v‡e wK¬K K‡i AvovAvwoi Rb¨ Landscape Ges j¤^vjw¤î Rb¨ Portrait wm‡j± K‡i wewfbœ 

fv‡e wcÖ›U Kiv hv‡e| 

 

KvR-9: dvB‡ji †Kvb c„ôv wcÖ›U (Print) Kiv 

 

Kw¤úDUv‡ii †Kvb KvR KvM‡Ri gva¨‡g †ei Kivi bvg wcÖ›U Kiv| Z‡e wcÖ›U Ki‡Z n‡j GKwU wcÖ›Uvi 

_vK‡Z n‡e Ges wcÖ›UviwU Kw¤úDUv‡i BÝUj Kiv _vK‡Z n‡e| GB me _vKv Ae¯’vq dvB‡ji †Kvb c„ôv 

wcÖ›U Ki‡Z n‡j wcÖ›UviwU Ab K‡i-Office Button  ‡_‡K Print wK¬K Ki‡Z n‡e| 

 

dvB‡ji mKj c„ôv wcÖ›U Ki‡Z n‡j Page range Gi All wm‡j± K‡i OK Ki‡j dvB‡ji mKj c„ôv wcÖ›U 

n‡e| dvB‡ji wbw`©ó †Kvb c„ôv ev 2bs c„ôv n‡Z 5bs c„ôv ch©šÍ a‡i wb‡q wcÖ›U Ki‡Z PvB‡j Page 

range Gi page(s):wm‡j± K‡i wbw`©ó c„ôv ev †Kvb c„ôv n‡Z †Kvb c„ôv ch©šÍ wcÖ›U w`e Zv wj‡L OK 

evUb wK¬K Ki‡j dvB‡ji wbw`©ó ev cÖ`Ë c„ôv¸‡jv wcÖ›U n‡e|  
 

dvB‡ji wm‡j± Kiv †Kvb Ask wcÖ›U Ki‡Z n‡j Page range Gi Selection wm‡j± K‡i OK Ki‡j 

wm‡j± Kiv Ask wcÖ›U n‡e| G‡·‡j Av‡iv GKwU myweav n‡jv c„ôvi wbw`©ó †Kvb Ask wcÖ›U w`‡Z n‡j 

AskUzKz wm‡j± Ki‡Z n‡e| 

 

Page Layout g¨vbyi Print Area Ack‡bi Set Print Area wK¬K Ki‡j wm‡j± Kiv AskUzKz Pviw`‡K 

Gwiqv n‡q hv‡e|  

Gici Office Button  ‡_‡K Print wK¬K Ki‡Z n‡e| 

 

KvR-9: †WUv mU© (Data Sort) Kivi wbqg 

‡WUv Sort Kivi A_© †WUv‡K web¨vm Kiv A_©vr †WUv‡K †QvU ‡_‡K eo (Ascending) Ges eo †_‡K 

†QvU (Descending) Abyhvqx mvRv‡bv|  

 ‡Uwe‡ji †h †Kvb ’̄v‡b †mj c‡q›Uvi †i‡L Data Menu i Sort & Filter-Gi A-Z wK¬K Ki‡j 

Ascending Ges Z-A wK¬K Ki‡j Descending Order G Data Avm‡e| 
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Abykxjb: 

cÖwkÿYv_x©‡`i gvB‡µvmdU G‡·j (Microsoft Excel) Gi IqvK©kx‡U dig¨vU, †cR †mUAvc, wcÖ›U 

wcÖwfD, †WUv mU© BZ¨vw` KvR nv‡Z Kj‡g Abykxjb Kivb| 

Practice ... Practice... Practice ... Practice... Practice ... Practice... 

 
g~j¨vqb: cÖwkÿK Awa‡ekb mgvwßi c~‡e© GwUi Dci cÖwkÿYv_x©‡`i GKwU mswÿß g~j¨vqb Ki‡eb|  

 

cybiv‡jvPbv I Awa‡ek‡bi mgvwß: 

AskMÖnYKvix‡`i ga¨ †_‡K GK ev GKvwaK Rb‡K wbe©vPb K‡i Awa‡ek‡b Kx Kx Av‡jvPbv I KvR n‡q‡Q 

Zv Dc ’̄vcb Ki‡Z ejyb| Awa‡ek‡bi mgvwß Uvbyb| 

 

Awa‡ekb: gvB‡µvmdU G‡·‡j PvU© (Chart) ‰ZwiKiY 

 

cÖZ¨vwkZ wkLbdj 

GB Awa‡ekb †k‡l cÖwkÿYv_x©MY--- 

 gvB‡µvmdU G‡·j (Microsoft Excel) Gi Kjvg PvU© ˆZwi Ki‡Z cvi‡eb| 

 gvB‡µvmdU G‡·j (Microsoft Excel) Gi cvB PvU© ˆZwi Ki‡Z cvi‡eb| 

 gvB‡µvmdU G‡·j (Microsoft Excel) Gi IqvK© kx‡U WvUv Gw›Uª K‡i cixÿvi 

djvdj ˆZwi Ki‡Z cvi‡eb| 

 

Awa‡ek‡bi iƒc‡iLv 

PvU© ‰Zwi Kivi Rb¨ avivevwnKfv‡e KgvÛ¸‡jv Abykxj‡bi gva¨‡g AMÖmi n‡Z n‡e| 

 

Awa‡ek‡bi we¯ÍvwiZ I avivevwnK weeiY 

wb‡Pi kZ©mg~n AskMÖnYKvix‡`i hyw³ Dcjwäi gva¨‡g Abyave‡b mnvqZv Ki‡Z n‡e| 

Pv‡U©i gva¨‡g †h †Kvb ai‡Yi Z_¨vejx mn‡R Zz‡j aiv hvq| G‡·‡j wbwg‡lB †WUv‡K A_©c~Y© Pv‡U©i 

gva¨‡g Dc ’̄vcb Kiv hvq| 

G‡·‡j `yÕfv‡e PvU© ˆZwi Kiv hvq (1) †h mx‡U †WUv bZzb mx‡U PvU© ˆZwi Ki‡Z cvwi| hLb GKB mx‡U 

†WUv I PvU© ˆZwi Kiv n‡e ZLb `yBwU GK mv‡_ †`Lv hv‡e| hLb Ab¨ mx‡U PvU© ˆZwi Kiv n‡e ZLb †WUv 

I PvU© GK mv‡_ †`Lv hv‡e bv| Z‡e cÖ‡qvR‡b Pv‡U© †h †Kvb cwieZ©b Kiv hv‡e| 

 

PvU© w`‡q †Kvb Z_¨ gvjv‡K my›`ifv‡e Dc¯’vc‡bi Abykxjb 

wb‡¤œi b¨vq †WUv¸‡jv IqvK©mx‡U wj‡L Chart1 bv‡g Save Kwi| 

Item's Name 2005 2006 2007 2008 

Jute 56 79 80 90 

Leather 55 65 85 95 

Tea 66 77 59 87 

Garments 70 80 90 96 

 

‡WUv¸‡jv wm‡j± Ki‡Z n‡e ev †WUvi wfZ‡i †h †Kvb ’̄v‡b Kvm©i ivL‡Z n‡e| 
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Column Chart ‰Zwi  

 

Insert Menu n‡Z Chart wK¬K Ki‡j Chart Box Avm‡e| Chart Type wn‡m‡e Column Ges 

Chart Sub-Type Gi wb‡Pi wPÎ¸‡jv †_‡K cÖ_g mvwii cÖ_gwU ev †h †Kvb GKwU wm‡j± Kwi| OK 

evU‡b wK¬K Kwi| 

 ‡iv Ges Kjvg Abyhvqx PvU© ˆZwi Kivi Rb¨ Design menu-i Switch Row/Column Click 

Ki‡Z n‡e| 

 Chart title ‡`Iqvi Rb¨ Layout Menu-i Chart title n‡Z Above Chart Click K‡i 

Title wjL‡Z n‡e| 

 Axis title ‡`Iqvi Rb¨ Layout Menu-i Axis title n‡Z Primary Horizontal axis 

title Ges  Primary Vertical axis title w`‡Z n‡e| 

 Legend ‡`Iqvi Rb¨ Layout Menu-i Legend n‡Z Legend at right Click Ki‡Z n‡e| 

 Data Labels ‡`Iqvi Rb¨ Layout Menu-i Data Lables n‡Z Outside End Click 

Ki‡Z n‡e| 

 Grid Lines ‡`Iqvi Rb¨ Layout Menu-i Grid lines n‡Z Primary Horizontal 

gridlines->Minor Gridlines Click Ki‡Z n‡e| 

 

Pie Chart 

wb‡¤œi ‡WUv¸‡jv IqvK©mx‡U UvBc K‡i Chart2 bv‡g Save Kwi| 

Board Name Percentage of Pass 

Dhaka 82% 

Comilla 88% 

Chittagong 84% 

Rajshahi 77% 

Jessore 75% 

Barisal 80% 

Sylhet 73% 

Dinajpur 70% 

Madrasah 90% 

Technical 83% 

 

‡WUv¸‡jv wm‡j± Ki‡Z n‡e ev †WUvi wfZ‡i †h †Kvb ’̄v‡b Kvimi ivL‡Z n‡e| 
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Insert Menu n‡Z Chart wK¬K Ki‡j Chart Box Avm‡e| 

 

 Chart Type wn‡m‡e Column A_ev Pie Ges Chart Sub-Type Gi wPÎ¸‡jv †_‡K Pie 

Chart Gi wØZxqwU wm‡j± Ki‡Z n‡e| 

 OK evU‡b wK¬K Ki‡Z n‡e| 

 Data Labels ‡`Iqvi Rb¨ Layout Menu-i Data Labels n‡Z Inside End Click Ki‡Z 

n‡e| 

 

Abykxjb: 

cÖwkÿYv_x©‡`i gvB‡µvmdU G‡·j (Microsoft Excel) Gi mvnv‡h¨ PvU© ˆZwi Ki‡Z w`b| 

Practice ... Practice... Practice ... Practice... Practice ... Practice... 
g~j¨vqb: cÖwkÿK Awa‡ekb mgvwßi c~‡e© GwUi Dci cÖwkÿYv_x©‡`i GKwU mswÿß g~j¨vqb Ki‡eb|  

 

cybiv‡jvPbv I Awa‡ek‡bi mgvwß: 

AskMÖnYKvix‡`i ga¨ †_‡K GK ev GKvwaK Rb‡K wbe©vPb K‡i Awa‡ek‡b Kx Kx Av‡jvPbv I KvR n‡q‡Q 

Zv Dc ’̄vcb Ki‡Z ejyb| Awa‡ek‡bi mgvwß Uvbyb| 

 

Awa‡ekb: gvB‡µvmdU G‡·j (Microsoft Excel) Gi gva¨‡g cixÿvi djvdj ˆZwi 

 

cÖZ¨vwkZ wkLbdj 

GB Awa‡ekb †k‡l cÖwkÿYv_x©MY--- 

1|  gvB‡µvmdU G‡·j (Microsoft Excel) Gi IqvK©kx‡U †WUv Gw›Uª K‡i cixÿvi djvdj ˆZwi 

Ki‡Z cvi‡eb| 

Awa‡ek‡bi iƒc‡iLv 

cixÿvi djvdj ˆZwi Kivi Rb¨ avivevwnKfv‡e KgvÛ¸‡jv Abykxj‡bi gva¨‡g AMÖmi n‡Z n‡e| 
 

Awa‡ek‡bi we¯ÍvwiZ I avivevwnK weeiY 
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wb‡Pi kZ©mg~n AskMÖnYKvix‡`i hyw³ Dcjwäi gva¨‡g Abyave‡b mnvqZv Ki‡Z n‡e| 

Grade ‡ei Kivi kZ©mg~n 

 GKRb QvÎ †h †Kvb GKwU wel‡q 33 Gi Kg †c‡j djvdj †dj n‡e 

 welq b¤^i 80 ev Zvi †ewk n‡j †MÖW n‡e A+ 

 welq b¤^i 70 ev Zvi †ewk n‡j †MÖW n‡e A 

 welq b¤^i 60 ev Zvi †ewk n‡j †MÖW n‡e A- 

 welq b¤^i 50 ev Zvi †ewk n‡j †MÖW n‡e B 

 welq b¤^i 40 ev Zvi †ewk n‡j †MÖW n‡e C 

 welq b¤^i 33 ev Zvi †ewk n‡j †MÖW n‡e D 

 welq b¤^i 33 Gi Kg n‡j †MÖW n‡e F 

Grade Point ‡ei Kivi kZ©mg~n 

 welq b¤^i 33 Gi wb‡P n‡j †MÖW c‡q›U n‡e 0 

 welq b¤^i 33 ev Zvi †ewk Ges 40 Gi wb‡P n‡j †MÖW c‡q›U n‡e       1 

 welq b¤^i 40 ev Zvi †ewk Ges 50 Gi wb‡P n‡j †MÖW c‡q›U n‡e       2 

 welq b¤^i 50 ev Zvi †ewk Ges 60 Gi wb‡P n‡j †MÖW c‡q›U n‡e       3 

 welq b¤^i 60 ev Zvi †ewk Ges 70 Gi wb‡P n‡j †MÖW c‡q›U n‡e       3.5 

 welq b¤^i 70 ev Zvi †ewk Ges 80 Gi wb‡P n‡j †MÖW c‡q›U n‡e       4 

 welq b¤^i 80 ev Zvi †ewk n‡j †MÖW n‡e c‡q›U        5 

Total GP ‡ei Kivi kZ©mg~n 

 ‡Kvb wel‡q GP=0 n‡j Total GP="F" n‡e 

 mKj wel‡qi GP- i †hvMdj †ei Ki‡Z n‡e 

 Total GP ‡ei Kivi †ÿ‡Î PZz_© wel‡q cÖvß GP n‡Z 2 we‡qvM n‡e 

Total GP ‡ei Kivi kZ©mg~n 

 Total GP="F" n‡j GPA="F" n‡e 

 Total GP M‡o 5 ev 5 Gi †ewk n‡j GPA=5 n‡e 

 Total GP M‡o 5 Gi Kg n‡j Total GP-i Mo Value n‡e 

 

GP ‡ei Kivi Rb¨ C2 ‡m‡j Kvm©i †i‡L 

=IF(B2<33,0,IF(B2<40,1,IF(B2<50,2,IF(B2<60,3,IF(B2<70,3.5,IF(B2<80,4,5))) 

))) m~Î wj‡L G›Uvi Pvc‡Z n‡e| 

 C2 ‡m‡ji djvdj C7 ‡mj ch©šÍ WªvM Ki‡Z n‡e 

C2 n‡Z C7 Kjvg Kwc K‡i F2, I2, L2 ‡m‡j Paste Ki‡Z n‡e| 
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Grade ‡ei Kivi Rb¨ D2 ‡m‡j Kvm©i †i‡L 

=IF(B2>=80,"A+",IF(B2>=70,"A",IF(B2>=60,"A-

",IF(B2>=50,"B",IF(B2>=40,"C",IF(B2>=33,"D","F")))))) m~Î wj‡L G›Uvi Pvc‡Z n‡e| 

 D2 ‡m‡ji djvdj D7 ‡mj ch©šÍ WªvM Ki‡Z n‡e 

D2 n‡Z D7 Kjvg Kwc K‡i G2, J2, M2 ‡m‡j Paste Ki‡Z n‡e| 

Total GP ‡ei Kivi Rb¨ N2 ‡m‡j Kvm©i †i‡L 

=IF(OR(C2=0,F2=0,12=0),"F",SUM(C2,F2,I2,L2-2)) m~Î wj‡L G›Uvi Pvc‡Z n‡e| 

 N2 ‡m‡ji djvdj N7 ‡mj ch©šÍ WªvM Ki‡Z n‡e 

GPA ‡ei Kivi Rb¨ O2 ‡m‡j Kvm©i †i‡L 

=IF(N2="F","F",IF(N2/3>=5,5N2/3)) m~Î wj‡L G›Uvi Pvc‡Z n‡e| 

 O2 ‡m‡ji djvdj O7 ‡mj ch©šÍ WªvM Ki‡Z n‡e 

Abykxjb: 

cÖwkÿYv_x©‡`i cÖ‡Z¨K‡K beg †kÖwYi GKRb wkÿv_x©i †iRvë wkU ˆZwi Ki‡Z ejyb Ges †mwU‡K †mf 

Ki‡Z ejyb| 

Practice ... Practice... Practice ... Practice... Practice ... Practice... 
g~j¨vqb: cÖwkÿK Awa‡ekb mgvwßi c~‡e© GwUi Dci cÖwkÿYv_x©‡`i GKwU mswÿß g~j¨vqb Ki‡eb|  

cybiv‡jvPbv I Awa‡ek‡bi mgvwß: 

AskMÖnYKvix‡`i ga¨ †_‡K GK ev GKvwaK Rb‡K wbe©vPb K‡i Awa‡ek‡b Kx Kx Av‡jvPbv I KvR n‡q‡Q 

Zv Dc ’̄vcb Ki‡Z ejyb| Awa‡ek‡bi mgvwß Uvbyb| 
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Aa¨vq-9 

G‡WŠwe d‡Uvkc  

Adobe Photoshop 

vkc ïi“ Kivi wbqg 

1. What is Adobe Photoshop? (G‡WŠwe d‡Uvkc wK?) t  

 

Adobe Photoshop (G‡WŠwe d‡Uvkc) n‡”Q GKwU Photo/Picture Editing Software| wb‡Ri g‡bi 

gvayix wgwkªZ K‡i GKwU Picture Edit c~e©K Graphics Design Kivi Rb¨ Photoshop Gi †Kvb weKí 

†bB| Bnv Graphics Software (MÖvwd· md&UIq¨vi) wbg©vZv Rbb Iqvib‡Ki G‡WŠwe wm‡÷g Bb K‡c©v‡iU 

Gi kw³kvjx B‡gR GwWwUs Graphics Program (MÖvwd· †cÖvMÖvg)| Micro Computer Gi Aš—M©Z 

Personal Computer (PC) Gi Operating System (Acv‡iwUs wm‡÷g), Word Processing 

Software (IqvW©cÖ‡mwms md&UIq¨vi), Spreadsheet Analysis Software (†¯cÖWmxU G¨vbvjvBwmm 

md&UIq¨vi), Database Management System Software (†WUv‡eR g¨v‡bR‡g›U wm‡óg md&UIq¨vi), 

Internet Browsing (B›Uvi‡bU eªvDwRs) BZ¨vw` Software wbg©vZv wnmv‡e wej †MU‡mi Mocrosoft 

(gvB‡7vmd&U) Gi AvwacZ¨ †hgb wek¦‡Rvov, Ab¨w`‡K †Zgwb Multimedia, Graphics Design BZ¨vvw` 

Graphics Software wbg©vZv wnmv‡e Adobe (G‡WŠwe) I eZ©gvb we‡k¦ kxl© ’̄vb `Lj K‡i †i‡L‡Q| Photo 

Editing Software wnmv‡e evRvi RvZ K…Z Adobe Photoshop DrcwËi mgq †_‡K Ghver A‡bK¸wj 

Version evRviRvZ K‡i‡Q| Gi me©‡kl Version n‡jv Adobe Photoshop 7.0|  

 

How to use Photoshop in our Work Space (Kvh©‡¶‡Î d‡Uvkc Gi e¨envi) 

 

Adobe Photoshop (G‡WŠwe d‡Uvkc) Gi  kw³kvjx dxPvi e¨envi K‡i B‡gR‡K Editing (ms‡kvab) K‡i 

wewfbœ Color e¨envi K‡i AvKl©bxq me Effect w`‡q Kvw•LZiƒ‡c Dc ’̄vcb Kiv hvq| GwU nj cÖKvkbv, 

I‡qe‡cR, gvwëwgwWqv, Ges AbjvBb MÖvwd· ˆZwii Rb¨ GKwU Abb¨ Graphics Program (MÖwd· †cÖvMÖvg)| 

g¨v‡Ki Rb¨ ˆZwi n‡jI wcwm‡Z GwU mgvbfv‡e Kvh©Ki| GK K_vq ejv P‡j hoto/Picture Editing msµvšZ 

Ggb †Kvb KvR †bB hv Adobe Photoshop Gi gva¨‡g Kiv hvq bv|  

 

Windows (DB‡ÛvR) t AvkvKwi Operating System Windows (DB‡ÛvR) m¤ú‡K© Avcbvi avibv 

Av‡Q| Computer Power Suply On Kivi ci Aí¶‡bi g‡a¨ Operating System Windows 

(DB‡ÛvR) Gi Screen ‡`Lv hvq| ZLb Avgiv Windows Task Bar Gi Start Button ‡`L‡Z cvB| 

hw` Avcwb Operating System Windows (DB‡ÛvR) Gi mv‡_ fvjfv‡e cwiwPZ bv _v‡Kb, Z‡e Avcbvi 

Kg©‡¶‡Î A‡bK iKg mgm¨vi mgvavb Ki‡Z n‡e| ZvB Graphics Program (MÖvwd· †cÖvMÖvg) Adobe 

Photoshop (G‡WŠwe d‡Uvkc) Gi KvR ïi“ Kivi Av‡M wk¶‡Ki wbKU †_‡K Operating System 

Windows (DB‡ÛvR) m¤ú‡K© †R‡b wbb| Zvici  

Click on Start Button, Select on Programs 
Click on Adobe PhotoShop 7.0 (Zvici Aí¶b A‡c¶v Ki‡Z n‡e) 

 

NB t GQvovI wewfbœ c×wZ‡Z Adobe Photoshop (G‡WŠwe d‡Uvkc) Gi Screen Open Kiv hvq|  

 

Opening (A‡cwbs ev GwWwUs) Screen mvaviYZ wbævK…wZ‡Z cÖ`wk©Z n‡e| Opening (A‡cwbs ev GwWwUs) 

Screen mvaviYZ hv hv cÖ`wk©Z nq Zvi m¤ú‡K© mwVK Ávb _vKv cÖ‡qvRb| Kvib †h Screen g‡a¨ Avgiv 

Adobe Photoshop (G‡WŠwe d‡Uvkc) Gi gva¨‡g Graphics Design (MÖvwd· wWRvBb) Gi KvR Kie 

†mB Screen m¤ú‡K© my¯úó avibv bv _vK‡j Graphics Design (MÖvwd· wWRvBb) Gi KvR Kiv m¤¢e b‡n| 

ZvB GB Screen Gi mv‡_ fvjfv‡e cwiwPZ nIqv cÖ‡qvRb| Zvn‡j Avmyb Avgiv wb‡gœ Aw¼Z wP‡Îi gva¨‡g 

Adobe Photoshop (G‡WŠwe d‡Uvkc) cwiwPZ nB: 
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Opening Screen of Adobe PhotoShop 7.0 
 

Gi Screen Gi mv‡_ fvjfv‡e cwiwPZ nB| g‡b ivL‡eb Adobe Photoshop (G‡WŠwe d‡Uvkc) Gi 

Screen Gi mv‡_ hZ fvj m¤úK© _vK‡e ZZB fvj wWRvBb g‡bi B‡”QgZ Ki‡Z cvi‡eb| 

 

Uzjevi / Uzje· Gi cwiwPwZ Ges Kvh©KvixZv 
 

Title Bar 

Menu Bar 

Close Button 

Maximize / Restore 

Minimize Button 

Horizontal Rular 

Vertical Rular 

Palatte (Same) 

Horizontal Scroll Bar 

Vertical Scroll Bar 

Tools Box 

Character Palatte 

Active Document 

Document Close 

Document Maximize 

Document Minimize 

Option Tool Bar 

Status Bar 

Zoom Indicator 
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GZ¶b Avgiv Screen cwiwPwZ wb‡q Av‡jvPbv Kijvg| AvkvKwi Gi gva¨‡g Avcwb Adobe Photoshop 

Screen Gi cÖ‡Z¨KwU bv‡gi mv‡_ cwiwPZ n‡q‡Qb| GB cÖ‡Z¨KwU bv‡gi eY©bv Rvbv wbðqB cÖ‡qvRb| Avmyb G 

wb‡q Av‡jvPbv Kwi| 

 

(1). Title Bar (UvB‡Uj evi) t Avgiv Rvwb Title k‡ãi evsjv A_© n‡jv Dcvwa| †h †Kvb Package 

Program (c¨v‡KR †cÖvMÖvg) Gi Dcvwa A_©vr bvg †h ev‡ii g‡a¨ †`Iqv _v‡K †mwUB n‡jv Title Bar (UvB‡Uj 

evi)| mnR fvlvq Window Gi kxl©‡`k‡K e‡j Title Bar (UvB‡Uj evi)| j¶¨ Ki“b Dc‡iv³ Window 

Gi kxl©‡`‡k A_©vr Dc‡i ‡jLv Av‡Q Adobe Photoshop| GB K_vwU †h Bar (evi) Gi g‡a¨ †jLv Av‡Q 

BnvB Title Bar (UvB‡Uj evi)| 

 

(2). Menu Bar (†gby evi) t Avgiv Rvwb Menu k‡ãi evsjv A_© ZvwjKv| j¶¨ Ki“b Window ‡Z File, 

Edit, …….....Help bvgK bqwU kã we`¨gvb| G¸‡jvi †h †KvbwU‡Z Click Ki‡j GKwU ZvwjKv †`Lv hvq| 

myZivs Avgiv ewj‡Z cvwi G¸‡jv cÖ‡Z¨KwUB GK GKwU Menu (†gby)| Avi Menu (†gby) ¸‡jvi mgwó‡Z †h 

jvBb ev evi †`Lv hvq Zv‡K Menu Bar (†gby evi) ejv nq| 

 

(3). Close Button t Avgiv Rvwb Close k‡ãi A_© eÜ Kiv| Adobe Photoshop Window Gi 

Dc‡i Wvb †Kvbvq Close Button we`¨gvb| GB Button Gi Øviv Adobe Photoshop Window eÜ 

Kiv hvq| 

 

(4). Maximize/Restore Button t Adobe Photoshop Window Gi Dc‡i Wvb †Kvbvq 

Maximize/Restore Button we`¨gvb| GB Button Gi Øviv Window Gi Size ‡K †QvU eo Kiv hvq| 

 

(5). Minimize Button t Adobe Photoshop Window Gi Dc‡i Wvb †Kvbvq Minimize Button 

we`¨gvb| GB Button Gi Øviv m¤ú~b© Window ‡K †QvU K‡i Windows Task Bar G A‡c¶gvb Ae¯’vq 

ivL‡Z cvwi| cieZ©x‡Z hLb cÖ‡qvRb n‡e ZLb Open K‡i KvR Ki‡Z cvwi| 

 

(6). Ruler (†ivjvi) t KvR Kivi mgq  wewfbœ cÖKvi wnmve Kivi cÖ‡qvRb nq| †Kvb Kv‡Ri ˆ`N©, cÖ¯’ BZ¨vw` 

†`Lvi Rb¨ Ruler (†ivjvi) e¨envi Kiv nq| Kw¤úDUvi e¨envi Kivi mgq me©‡¶‡ÎB Wv‡b ev‡g †Kvb wKQy 

‡evSv‡Z n‡j Horizontal Ges Dc‡i wb‡P †evSv‡Z n‡j Vertical ejv nq| myZivs G‡¶‡ÎI †Kvb 

Graphics Gi Dc‡ii w`‡K evg w`K ‡_‡K Wvb w`‡K we`¨gvb †¯‹jwU‡K Horizontal Ruler ejv nq| 

Aciw`‡K †Kvb Graphics Gi evg w`‡K Dci w`K ‡_‡K wbP w`‡K we`¨gvb †¯‹jwU‡K Vertical Ruler ejv 

nq| 

 

(7). Palette (c¨v‡jU) t Picture/Graphics ‡K bvbvfv‡e iƒcvqb I Dc¯’vcbvi Rb¨ wewfbœ Palette 

(c¨v‡jU) Gi mvnvh¨ wb‡Z nq| †cÖvMÖv‡gi wWdë ‡mwUs Abymv‡i A‡bK mgqB DB‡Ûv‡Z †Kvb Palette (c¨v‡jU) 

cÖ`wk©Z nq bv| cÖ‡qvR‡bi †cÖw¶‡Z †gbyevi ’̄ DB‡Ûv †gby †_‡K mswk−ó Palette (c¨v‡jU) †K cÖ`k©b Kiv‡bv 

nq| Dc‡i Aw¼Z ¯OExb cwiwPwZ‡Z Avgiv c¨v‡jU cÖ`wk©Z Ae¯’vqB †`‡LwQ| 

 

(8). Scroll Bar (‡¯OEvj evi) t †Kvb Image Gi PZzw ©̀K †`Lvi Rb¨ †h evi e¨envi Kiv nq Zv‡K Scroll 

Bar e‡j| Kw¤úDUvi e¨envi Kivi mgq me©‡¶‡ÎB Wv‡b ev‡g †Kvb wKQy ‡evSv‡Z n‡j Horizontal Ges Dc‡i 

wb‡P †evSv‡Z n‡j Vertical ejv nq| myZivs G‡¶‡ÎI †Kvb Image Gi Wvb w`K ev evg w`K †`L‡Z n‡j 

wb‡Pi w`‡K we`¨gvb †h eviwU e¨envi Kiv nq Zv‡K Horizontal Scroll Bar ejv nq| Aciw`‡K †Kvb Page 

Gi Dci w`K ev wbP w`K †`L‡Z n‡j Wvb w`‡K we`¨gvb †h eviwU e¨envi Kiv nq Zv‡K Vertical Scroll Bar 
ejv nq| 

 

(9). Tools Box (†Uvj e·) t Adobe Photoshop Gi Window Gi g‡a¨ ev‡g wewfbœ Tools (†Uvj) 

m¤^wjZ GKwU e· †`Lv hvq| hvi bvg Tools Box (†Uvj e·)| wewfboe iK‡gi Ae‡R± ‰Zix, GwWwUs, 
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Dc¯’vcbv, Kvjvi g¨v‡bR‡g›U, WªBs BZ¨vw` Adobe Photoshop Gi cÖavb cÖavb KvR¸‡jv Kivi Rb¨ GB 

Tools Box (†Uvj e·) †_‡K ch©vß my‡hvM myweav AR©b Kiv hvq| GB Tools Box Gi we¯—vwiZ e¨envi 

wk¶‡Ki wbKU †_‡K †R‡b wbb| 

 

(10). Character Palatte (Kv‡i±vi c¨v‡jU) t Type Tool Gi gva¨‡g †Kvb wKQy †jLvi ci †jLv‡K 

wWRvBb Kivi Rb¨ GB Character Palatte Use Kiv n‡q _v‡K|  

 

(11). Active Document (mPj WKz‡g›U) t †h Document wU eZ©gv‡b mvg‡b Av‡Q ev †h Document 

Gi g‡a¨ eZ©gv‡b KvR Kiv n‡”Q Zv‡K Active Document ejv nq| we¯—vwiZ wk¶‡Ki wbKU †_‡K †R‡b 

wbb|  

 

(12). Name of Active Window (Pjgvb DB‡Ûv Gi bvg) t †h Title Bar (UvB‡Uj evi) Gi g‡a¨ †Kvb 

Window eZ©gv‡b Pvjy Av‡Q Dnvi bvg †`Lv hvq Zv‡K Name of Active Window ejv nq| hv‡K Avgiv 

File Name wnmv‡e a‡i †bB| 

 

(13). Document Close Button (Pjgvb WKz‡g›U eÜ Kiv) t Avgiv Rvwb Close k‡ãi A_© eÜ Kiv| 

Adobe Photoshop Active Document Gi Dc‡i Wvb †Kvbvq Document Close Button 

we`¨gvb| GB Button Gi Øviv Active Document Window eÜ Kiv hvq| 

 

(14). Document Maximize/Restore Button t Adobe Photoshop Active Document 

Window Gi Dc‡i Wvb †Kvbvq Maximize/Restore Button we`¨gvb| GB Button Gi Øviv Active 

Document Gi Size ‡K †QvU eo Kiv hvq| 

 

(15). Minimize Button t Adobe Photoshop Active Document Window Gi Dc‡i Wvb 

†Kvbvq Minimize Button we`¨gvb| GB Button Gi Øviv Present Active Window ‡K †QvU K‡i 

Photoshop Screen G A‡c¶gvb Ae ’̄vq ivL‡Z cvwi| cieZ©x‡Z hLb cÖ‡qvRb n‡e ZLb Open K‡i KvR 

Ki‡Z cvwi| 

 

(16). Option Tool Bar t Menu Bar Gi wVK wb‡P Aew¯’Z Tool Bar wUi bvg Option Tool Bar| 

GB Tool Bar Gi g‡a¨ wewfboe Icon ‡`Lv hvq wKš‘ Tool Box Gi g‡a¨ Selected Tool Gi we —̄vwiZ 

†`Lv hvq| 

 

(17). Status Bar (÷¨vUvm evi) t Pjgvb mg‡q †Kvb KvR Kiv n‡”Q, †Kvb Uzj e¨eüZ n‡”Q BZ¨vw` Z_¨ 

AewnZ K‡i GB Status Bar (÷¨vUvm evi)| GQvovI GB Status Bar (÷¨vUvm evi) Gi g‡a¨ Av‡iv wewfbœ 

Z_¨ m¤ú‡K© AeMZ nIqv hvq| GwU GKwU ¸i“Z¡c~b© evi| we¯—vwiZ wk¶‡Ki wbKU †_‡K †R‡b wbb| 

 

(18). Zoom Indicator (Ryg BwÛ‡KUi) t Pjgvb c„ôvq KZ % Ryg we`¨gvb Zvnv GLv‡b †`Lv hvq| Zoom 

Indicator (Ryg BwÛ‡KUi) Status Bar Gi ev‡g Aew¯’Z| GLv‡b wK¬K K‡i wbw`ªó Ryg % UvBc K‡i G›Uvi 

Ki‡j mn‡R wb‡Ri B‡”QgZ wbw`ªó mvB‡R c„ôv Ae‡jvKb Kiv hvq|  

 
Adobe Photoshop Gi gva¨‡g MÖvwd· wWRvBb Kivi mgq GB Toolbar (Uzjevi) / Tool Box (Uzje·) 

Gi KvR¸‡jv Lye fvjfv‡e Ki‡Z n‡e| Kvib GB Toolbar (Uzjevi) / Tool Box (Uzje·) Gi KvR¸‡jv Lye 

fvjfv‡e Ki‡Z bv cvi‡j Ab¨ †Kvb KvRB Kiv m¤¢e bv| Adobe Photoshop (G‡WŠwe d‡Uvkc) Gi 

Screen cwiwPwZ‡Z Avgiv GB Toolbar (Uzjevi) / Tool Box (Uzje·) Gi mv‡_ cwiwPZ n‡qwQ| wKš‘ GB 

Toolbar (Uzjevi) / Tool Box (Uzje·) Gi Awab¯’ wewfbœ Uzj¸‡jvi gva¨‡g wK wK KvR Kiv hvq Ges †Kvb 

Uz‡ji KvR wK Zv Avgiv hw` bv Rvwb Zvn‡j KvR Kie wKfv‡e| Zvn‡j Avmyb Avgiv wbæwjwLZ wPÎ I †jLvi 

gva¨‡g wewfbœ Uz‡ji KvR m¤ú‡K© AeMZ nB| 
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Toolbar (Uzjevi) / Tool Box (Uzje·) cwiwPwZ t 

 

 

 

Rectanglar Marquee Tool (M) Move Tool (V) 

Lasso Tool (L) Magic Wand Tool (W) 

Crop Tool (C) Slice Tool (K) 

Healing Brush Tool (J) Brush Tool (B) 

Clone/Pattern Stamp Tool (S) History Brush Tool (Y) 

Eraser Tool (E) Gradient Tool (G) 

Blur Tool (R) Dodge/Born/Sponge Tool (O) 

Path Selection Tool A) Horizontal Type Tool (T) 

Pen Tool (P) Rectangle Tool (U) 

Notes Tool (N) Eyedropper Tool (I) 

Hand Tool (H) Zoom Tool (Z) 

Set Foreground Color Switch FG & BG Color 

Default Foreground & Backgroung Colors (D) Set Background Color 

Edit to Standard Mode(Q) Edit to QuickMask Mode (Q) 

Standard Screen Mode(F) Full Screen Mode (F) 

Full Screen Mode With Menu Bar (F) Jump to Image Ready 

 

GZ¶b †h Av‡jvPbv Kijvg A_©vr †h wP‡Îi mv‡_ fvjfv‡e cwiwPZ njvg †mB wPÎwU Adobe Photoshop 
(G‡WŠwe d‡Uvkc) c¨v‡K‡R Uzjevi wn‡m‡e cwiwPZ| GwU d‡Uvk‡ci †cÖvMÖvg ïi“ Ki‡j c ©̀vi evg w`‡K wewfboe 

AvBKb evUb m¤^wjZ AvqvZvKvi Dj¤̂ e· wnmv‡e †`Lv hvq| G e‡·i wewfbœ evUb ev Uzj e¨envi K‡i Adobe 

Photoshop (G‡WŠwe d‡Uvkc) Gi wewfbœ KvR m¤úv`b Kiv hvq| 
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Tool Selection (Uzj wbe©vPb) 

 

Toolbox (Uzje·) †_‡K wbæwjwLZ ỳwU c×wZ‡Z Uzj wbe©vPb K‡i KvR Kiv hvq| ‡hgb t 

1. gvDm w`‡q wK¬K K‡i| Ges 2. kU©KvU Kx KgvÛ w`‡q| 

 

NB t G‡¶‡Î me©`v g‡b ivL‡Z n‡e A‡bK¸‡jv UzjB wKš‘ MÖ“c Uzj, GiKg MÖ“c Uzj _vK‡j gvDm c‡q›Uvi wK¬K 

Ki‡j Ab¨ Uzj †`Lv w`‡e Ges gvDm †U‡b Zv wbe©vPb K‡i KvR Kiv hvq| GQvovI, Alt Kx †P‡c a‡i †Kvb MÖ“c 

Uy‡j wK¬K& Ki‡j MÖ“‡ci Ab¨ Uzj wbe©vPb Kiv hvq|  

 

Uzje· A`„k¨ / „̀k¨gvb Kivi wbqg 

Kx-‡ev‡W©i Tab Kx Pvc‡j Uzje· A „̀k¨ n‡q hvq| Avevi Tab Kx Pvc‡j Zv „̀k¨ n‡e| 

 

NB t G‡¶‡Î me©`v g‡b ivL‡Z n‡e †h, Tab Kx Pvc‡j Uzj e· Ges Ab¨vb¨ me †c−U c`©v †_‡K A „̀k¨ n‡q 

hv‡e| wKš‘ Shift Kx †P‡c Zvici Tab Kx Pvc‡j Uzje· Qvov evwK me DB‡ÛvR / ‡c−U A „̀k¨ nq|  

 

Use Of Tools (wewfbœ Uz‡ji e¨envi) 

d‡Uvk‡c ỳB ai‡Yi Uzj i‡q‡Q †hgb t GKK Uzj I MÖ“c Uzj| GKK Uzj¸‡jvi wb‡Pi w`‡K Zxi wPý bvB Ges MÖ“c 

Uzj¸‡jvi wb‡P Zxi wPý i‡q‡Q| GKK Uzj Ges MÖ“c Uzj¸‡jvi e¨envi wbæiƒc| g‡b ivL‡eb Tools ¸‡jvi e¨envi 

m¤ú~b©iƒ‡c e¨envwiK| ZvB Sheet Kg Follow K‡i e¨envwiK wk¶v MÖnb Ki“b| †Kvb Tools Gi e¨envi 

Rvbv bv _vK‡j fvjfv‡e Design Kiv m¤¢e bq|  

 
 (1). Marquee Tool (M) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc t 

 

Rectangular Marquee t PZzfzR©vK…wZi wm‡jKkb Kiv hvq| 

Elliptical Marquee t GwU w`‡q †MvjvKvi wm‡jKkb Kiv hvq| 

Single Column Marquee t GwU w`‡q GK wc‡·j cÖk¯—Zvwewkó Kjvg wm‡j± Kiv hvq| 

Single Row Marquee t GwU w`‡q GK wc‡·j cÖk¯—Zvwewkó †iv wbw`©ó Kiv hvq| 

 

(2). Move Tool (V) t GwU GKwU GKK Uzj| G UzjwU e¨envi K‡i †Kvb †jqvi Ae‡R± A_ev †Kvb B‡g‡Ri 

wbe©vwPZ Ask‡K Wª¨vM K‡i gyf Kiv hvq| e¨envi Kivi c×wZ wk¶‡Ki wbKU †_‡K †R‡b wbb| 

 

(3). Lasso Tool (L) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒct 

 

Lasso Tool t G UzjwUi mvnv‡h¨ B‡g‡Ri †Kvb Ask‡K gy³fv‡e wm‡j± Kiv hvq | 

Polygonal Lasso Tool t G UzjwUi mvnv‡h¨ †mvRv †f‡½ †f‡½ wm‡j± Kiv hvq| 

Magnetic Lasso Tool t G UzjwUi mvnv‡h¨ ¯̂qsw7qfv‡e GKB ai‡bi wc‡·j mn‡R wm‡j± Kiv hvq| 

 

(4). Magic Wand Tool (W) t GwU GKwU GKK Uzj| G UzjwU e¨envi K‡i B‡g‡Ri GKB ai‡bi / A_©vr 

GKB Kvjv‡ii Dci wbf©i K‡i c„_K c„_K Ask‡K mn‡R wbe©vPb Kiv hvq| Gradient Apply c~e©K e¨envi 

K‡i fvjfv‡e KvR Kiv hvq| 

 

(5). Crop Tool (C) t GwU GKwU GKK Uzj| G UzjwU e¨envi K‡i B‡g‡Ri wbw ª̀ó †Kvb Ask‡K †K‡U Avjv`v 

fv‡e cÖ`k©b Kiv hvq| Qwei AevwÂZ Ask gy‡Q †`qvi Rb¨ e¨eüZ nq| Bnv LyeB cÖ‡qvRbxq|  

 

(6). Slice Tool (K) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc t 



125 

wkÿK‡`i AvBwmwU cÖwkÿY g¨vby‡qj 

Slice Tool t GB UzjwU e¨envi K‡i Qwei wewfbœ As‡ki wnmve, cwigvb, BZ¨vw` ivLv hvq| Web Link 

Work Kiv hvq| 

Slice Select Tool t Slice ˆZix Kivi ci Bnv wm‡j± Kivi Kv‡R e¨envi Kiv hvq| 

 

(7). Healing Brush Tool (J) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc t 

 

Healing Brush Tool t G UzjwU e¨envi K‡i B‡g‡Ri Abyiƒc B‡gR ev B‡g‡Ri Ask ˆZix Kiv hvq| 

G‡Z Abyiƒc Kwci Color Gi mv‡_ Background Color Gi Color Mixing nq| e¨envi c×wZ wk¶‡Ki 

wbKU †_‡K †R‡b wbb| 

Patch Tool t G UzjwU e¨envi K‡i B‡g‡Ri wbw`ª©ó Ask AvKvevKv K‡i Select Kiv hvq| Select 

_vKvKvjxb Ae¯’vq †h †Kvb Command Apply Ki‡j ïaygvÎ Selected As‡ki DciB Kvh©Ki nq| e¨envi 

c×wZ wk¶‡Ki wbKU †_‡K †R‡b wbb| 

 

(8). Brush Tool (B) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc t 

 

Brush Tool t G UzjwU wbe©vPb K‡i gy³ fv‡e Wªwqs Kiv hvq| me©̀ v FG Color Apply n‡e| 

Pencil Tool t G UzjwU e¨envi K‡i gy³fv‡e †jLv hvq Ges GB UzjwU e¨envi Kv‡i jvBb AvuKv hvq| 

me©`v FG Color Apply n‡e|  

 

(9). Stamp Tool (S) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc t 

 

Clone Stamp Tool t G UzjwU e¨envi K‡i B‡g‡Ri Abyiƒc B‡gR ev B‡g‡Ri Ask ˆZix Kiv hvq| 

Alt Key e¨envi c~e©K GB Tool Gi KvR Ki‡Z nq|  

 

Pattern Stamp Tool t G UzjwU e¨envi K‡i B‡g‡Ri †h †Kvb Ask‡K c¨vUvb© w`‡q †cB›U Kiv hvq| 

Bnv LyeB gRvi Ges cÖ‡qvRbxq| Rvbv AZ¨vek¨K|  

 

(10). History Brush Tool (Y) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc t 

 

History Brush Tool t G UzjwU e¨envi K‡i wn‡÷vwi c¨v‡j‡U B‡g‡Ri wbe©vwPZ Ae¯’v ev ø¨vckU †cB›U 

Kiv hvq| 

Art History Brush t G UzjwU e¨envi K‡i wbw`ó Kiv wn‡÷vwi †÷U ev ø¨vckU‡K Stylized †÷ªv‡K 

†cB›U Kiv hvq| Gi d‡j B‡gRwU Artistic n‡q hvq| cieZ©x‡Z History Brush Tool Gi Øviv ¯^vfvweK 

Ae¯’vq Avbv hvq| 

 

(11). Eraser Tool (E) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc t 

 

Eraser Tool t G UzjwU e¨envi K‡i †Kvb †jqv‡ii me B‡gR A_ev wbe©vwPZ As‡ki wc‡·j gyQv hvq| 

Background Eraser Tool t G UzjwU e¨envi K‡i mn‡R B‡g‡Ri e¨vKMÖvDÛ gyQv hvq| 

Magic Eraser Tool t G UzjwU e¨envi K‡i †Kvb †jqv‡i wK¬K& Ki‡j ¯^sw7qfv‡e GKB ai‡bi me 

wc‡·j UªvÝcv‡iwÝ‡Z gy‡Q †`q|  

 

(12). Gradient/ PaintBucket Tool (G) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc t 

Gradient Tool t G UzjwU e¨envi K‡i B‡gR Gi Dci Linear Gradient, Radial Gradient, 

Angle Gradient, Reflected Gradient, Diamond Gradient Create Kiv hvq|  
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PaintBucket Tool t G UzjwU wbe©vPb K‡i B‡g‡Ri m¤ú~Y© ev wbe©vwPZ Ask‡K †dviMÖvDÛ Kvjvi w`‡q 

†cB›U Kiv hvq| wewfboe cÖKvi Gradient Create Kivi ci GB KvRwU Ki‡j Lye my›`ifv‡e Design Kiv 

hvq|  

 

(13). Blur / Sharpen / Smudge Tool (R) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc 

t 

 

Blur Tool t GKvwaK Layer ˆZix Kivi ci Gi Boarder Finishing Kiv hvq| 

Sharpen Tool t GKvwaK Layer ˆZix Kivi ci Gi Boarder/Image G Sharpen Filter 

Apply Kiv hvq| g‡b ivL‡Z n‡e Bnv ïaygvÎ Selected Layer Gi Dci Kvh©Ki nq|  

Smudge Tool t GKvwaK Layer ˆZix Kivi ci Layer Color GKwU †_‡K Ab¨wU‡Z Drag c~e©K 

†bqv hvq| 

 

(14). Douge / Burn / Sponge Tool (O) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc t 

 

Douge Tool t Gi gva¨‡g Selected Layer Gi Dci mv`v Lighting Effect ‡`Iqv hvq| 

Burn Tool t Gi gva¨‡g Selected Layer Gi Dci Kv‡jv Lighting Effect ‡`Iqv hvq| 

Sponge Tool t Gi gva¨‡g Selected Layer Gi Dci mv`v I ¯̂vfvweK Lighting Effect ‡`Iqv 

hvq| GB Effect wU A‡bKUv Grayscale Mode Gi g‡Zv|  

 

(15). Path Selection Tool / Direct Selection Tool (A) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi 

eb©bv wbgoeiƒc t 

 

Path Selection Tool t 17 bs Uz‡ji mvnv‡h¨ Path ‰Zix Kivi ci Gi gva¨‡g B‡g‡Ri Path 

Boarder Select K‡i Mouse w`‡q ’̄vbvš—i Kiv hvq| 

Direct Selection Tool t 17 bs Uz‡ji mvnv‡h¨ Path ‰Zix Kivi ci Gi gva¨‡g B‡g‡Ri Path 

mivmwi Select K‡i Mouse w`‡q †QvU eo Kiv hvq| cieZ©x‡Z Select c~e©K Delete Kiv hvq| 

 

(16). Type Tool t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc t 

 

D³ Group Tool Gi g‡a¨ PviwU wfboe wfboe Tool we`¨gvb| G¸‡jvi gva¨‡g ‡Kvb wKQy wjLv hvq| 

D³ Uzj ¸‡jv e¨envi K‡i Horizontally & Vertically Type Kiv hvq| wewfboe c×wZi †jLv wk¶‡Ki 

wbKU †_‡K fvj K‡i †R‡b wbb| 

 

(17). Pen Tool (P) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc t 

 

Pen Tool t G UzjwUi mvnv‡h¨ wewfboe AvKv‡ii cv_ ˆZwi Kiv hvq| 

Freeform Pen Tool t G UzjwUi mvnv‡h¨ †cwÝj w`‡q KvM‡R AvuKvi b¨vq gy³fv‡e cv_ ˆZwi Kiv hvq| 

Add Anchor Point Tool t G UzjwUi mvnv‡h¨ cv‡_ G¨vsKi c‡q›U hy³ Kiv hvq| 

Delete Anchor Point Tool t G UzjwUi mvnv‡h¨ cv‡_ G¨vsKi c‡q›U wehy³ Kiv hvq| 

Convert Point Tool t G UzjwUi mvnv‡h¨ GK ai‡bi G¨vsKi c‡q›U‡K Ab¨ ai‡bi G¨vsKi c‡q‡›U 

KbfvU© Kiv hvq| 

 

(18). Rectangle Tool (U) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc t 

 

Rectangle Tool t G UzjwUi mvnv‡h¨ wewfboe AvKv‡ii PZzf©yR ˆZwi Kiv hvq| 

Round Rectangle Tool t G UzjwUi mvnv‡h¨ wewfboe AvKv‡ii †MvjvKvi PZzf©yR ˆZwi Kiv hvq| 
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Elipse Tool t G UzjwUi mvnv‡h¨ wewfboe AvKv‡ii e„Ë ˆZix Kiv hvq| 

Polygon Tool t G UzjwUi mvnv‡h¨ wewfboe AvKv‡ii cÂf~R ˆZix Kiv hvq| 

Line Tool t G UzjwUi mvnv‡h¨ ‡h †Kvb iKg jvBb A¼b Kiv hvq| 

Custom Shape Tool t G UzjwUi mvnv‡h¨ †MvjvKvi †mBf ˆZix Kiv hvq| GQvovI Option Tool 

bar ‡_‡K wb‡Ri gZ K‡i AvKl©bxq Design Create Kiv hvq| Bnv LyeB my›`i ZvB we —̄vwiZ e¨envi c×wZ 

wk¶‡Ki wbKU †_‡K †R‡b wbb| 

 

(19). Notes Tool (N) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc t 

Notes Tool t GB UzjwUi mvnv‡h¨ †Kvb B‡g‡Ri Dci gš—e¨ Kiv hvq| cieZ©x‡Z Delete Kiv hvq| 

Audio Annotation Tool t GB UzjwUi mvnv‡h¨ †Kvb B‡g‡Ri Dci wfwË K‡i K_v ev Mvb BZ¨vw` 

†iKW© Kiv hvq| 

 

(20). Eye Dropper Tool (T) t GwU GKwU MÖ“c Uzj G MÖ“‡c hv Av‡Q Zvi eb©bv wbgoeiƒc t 

 

Eye Dropper Tool t G UzjwU e¨envi K‡i B‡g‡Ri †Kvb As‡k wK¬K Ki‡j †dviMÖvDÛ wnmv‡e B‡g‡Ri 

H iO wbe©vwPZ n‡e| 

Color Sampler Tool t G UzjwU e¨envi K‡i B‡g‡Ri †Kvb As‡k wK¬K& K‡i H As‡ki i‡Oi †gv‡Wi 

wewfbœ gvÎv (%) Rvbv hvq| hvnv Info Palate Gi g‡a¨ „̀k¨gvb nq|  

Masure Tool t G UzjwU wbe©vPb K‡i B‡g‡Ri GK cÖvš— †_‡K wK¬K& K‡i Av‡iK cÖv‡š— wb‡q ỳB cÖv‡š—i 

ga¨Kvi x, y ¯’vb‡K, †KŠwYK `~iZ¡, D”PZv Ges cÖk¯—Zv BZ¨vw` gvcv hvq| hvnv Info Palate Gi g‡a¨ „̀k¨gvb 

nq| 

 

(21). Hand Tool t G UzjwU e¨envi K‡i †Kvb B‡g‡R‡K Gi DB‡Ûvi wfZ‡i gyf K‡i wewfbœ Ask cÖ`k©b Kiv 

hvq| Qwe †QvU Ae¯’vq _vK‡j wb®cÖ‡qvRb|  

 

(22). Zoom Tool t G Uzj wbe©vPb K‡i B‡g‡R wK¬K& K‡i B‡gR‡K RygBb A_©vr eo K‡i cÖ`k©b Kiv hvq| 

c~bivq †QvU Ki‡Z n‡j Alt Key Gi mvnvh¨ wb‡Z nq|  

 

(23). Foreground & Background Color Tool t G¸‡jv wbæ iƒc t 

 

Foreground Color Tool t GLv‡b †h iO wbe©vwPZ _v‡K †cB›U Ki‡j ev †U·U wjL‡j †jLvi †m i‡Oi 

nq| G Uzj wK¬K& K‡i Kvjvi wcKvi †_‡K †dviMÖvDÛ Kvjvi wbe©vPb Kiv hvq|  

Background Color Tool t †dviMÖvDÛ Kvjvi Uz‡ji b¨vq G Uz‡j wK¬K& K‡i iO wbe©vPb Kiv hvq| 

B‡g‡Ri †Kvb Ask †K‡U wb‡j KvUv Ask e¨vKMÖvDÛ Kvjvi nq|  

 

(24). Standard / Quick Mask Mode t GB ỳBwU Uz‡ji mvnv‡h¨ Kvjv‡ii Mode cwieZ©b Kiv hvq| 

 
Palette Work (wewfbœ c¨v‡j‡Ui KvR) 

 

(25). Screen Mode Button t G¸‡jv wbæ iƒc t 

 

Stander Screen Mode t mvaviYfv‡e G †gvWwU wWdë _v‡K| 

Full Screen Mode With Menubar t G evU‡b wK¬K Ki‡j B‡gRwU m¤ú~Y© c`©v Ry‡o (†gbyevimn) 

cÖ`wk©Z nq| 

Full Screen Mode t G evU‡b wK¬K Ki‡j ïaygvÎ B‡gRwU m¤ú~Y© c`©v Ry‡o cÖ`wk©Z nq| 
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(26). Jump To Image Ready t GB Uz‡ji mvnv‡h¨ Image Ready Program Gi g‡a¨ cÖ‡ek K‡i 

GB †cÖvMÖvg †_‡K wewfbœ iKg mvnvh¨ †bIqv hvq| Adobe Photoshop Program Rvbv _vK‡j D³ 

Program G Lye mn‡R KvR Kiv hvq|  

 

c¨v‡jU wb‡q KvR Kiv t 

Graphics Design (MÖvwd· wWRvBb) Adobe Photoshop (G‡WŠwe d‡Uvkc) c¨v‡K‡R wewfbœ ai‡bi 

WKz‡g›U ˆZixi †¶‡Î B‡gR Ges †U·U mg~n‡K my›`i I AvKl©Yxq fv‡e ˆZixi Rb¨ c¨v‡jU mg~n ¸i“Z¡c~Y© f‚wgKv 

cvjb K‡i _v‡K| †Kbbv c¨v‡jU mg~‡ni mnvqZvq B‡gR ev †U·U mg~‡ni cÖwZwU Ask‡K ¯^í mg‡q my›`i I 

AvKl©Yxq K‡i Dc¯’vcb Kiv hvq| mvaviYfv‡e c`©vq c¨v‡jU ¸‡jv cÖ`wk©Z nq bv| Window †gby †_‡K 

cÖ‡qvRbxq c¨v‡jU wK¬K K‡i Zv cÖ`k©b Kiv hvq| GB c¨v‡jU mgyn wbæiƒc|  

 

1. Navigator Palette 2. Info Palette 3. Color Palette 

4. Swatch Palette 5. Style Palette. 6. History Palette 

7. Actions Palette 8. Tool Presets Palette 9. Layers Palette 

10. Channels Palette 11. Paths Palette 12. Brushes Palette 

13. Character Palette 14. Paragraph Palette. 

 
Navigator Palette t †bwf‡MUi c¨v‡jU e¨envi K‡i A¨vKwUf B‡gR‡K eo-†QvU K‡i †`Lv hvq| 

Info Palette t GB c¨v‡jU wbe©vPb K‡i B‡g‡Ri †h †Kvb Ask gvDm c‡q›U wb‡j i‡Oi wgk‡bi gvb 

cÖ`wk©Z n‡e| 

Color Palette t G c¨v‡jU wbe©vPb K‡i iO Gi KvR Kiv hvq| {F6} 

Swatches Palette t G c¨v‡jUwUI wbe©vPb K‡i iO Gi KvR Kiv hvq| {F4} 

Style Palette t G c¨v‡jU wbe©vPb K‡i wewfbœ cÖKvi Style Apply Kiv hvq| 

History palette t eZ©gvb B‡gR dvB‡j hZ KvR Kiv n‡q‡Q Zvi ZvwjKv cÖ`wk©Z n‡e| GLv‡b wWwm‡j± 

K‡i B‡g‡Ri Dci KvR‡K evwZj Kiv hvq| 

Action Palette t G¨vKkb c¨v‡jU G¨vKkb ev KgvÛ wmwiR ms7vš— KvR Kiv hvq| 

Tool Presets Palette t G c¨v‡jU wbe©vPb K‡i Tool Setting Gi KvR Kiv hvq| 

Layers Palette t G c¨v‡jUwU wbe©vPb K‡i GKwUf B‡g‡Ri †jqvimg~n cÖ`wk©Z n‡e| †hgbt bZzb 

†jqvi ˆZwi, †jqvi gyQv, †jqvi gvR© Kiv, †jqvi gyf Kiv, Kwc Kiv BZ¨vw` KvR Kiv hvq| 

Channels Palette t GB c¨v‡jU wbe©vwPZ B‡g‡Ri Kvjvi †gvW Abymv‡i wewfbœ iO P¨v‡b‡j cÖ`wk©Z nq| 

bZzb P¨v‡bj ˆZwi Kiv, P¨v‡bj gyQv Ges P¨v‡bj ms7vš— Ab¨vb¨ ¸iyZ¡c~Y© KvR Kiv hvq| 

Paths Palette t cv_ c¨v‡j‡Ui wewfboe KgvÛ evUb Ges †gby e¨envi K‡i cv_ ms7vš— wewfboe KvR 

Kiv hvq| 

Brushes Palette t eªvk wbe©vPb Ki‡j †cB›Ueªvk, B‡iRvi, †cwÝj, wn‡÷vwi eªv‡ki AvKvi wbev©wPZ eªvk 

n‡e| {F5} 

Character Palette t Photoshop Package Gi g‡a¨ m¤úvw`Z Image G Text ms‡hvRb 

Kivi Rb¨ GB Palette wU e¨envi Kiv nq| 

Paragraph Palette t Photoshop Package Gi g‡a¨ m¤úvw`Z Image G Paragraph 

Setting Kivi Rb¨ GB Palette wU e¨envi Kiv nq| 

 

AvkvKwi Avcwb Dc‡i D‡j−wLZ Palette (c¨v‡jU) ¸‡jvi mv‡_ fvjfv‡e cwiwPZ n‡Z †c‡i‡Qb| Dc‡iv³ 

Palette (c¨v‡jU) mgy‡ni g‡a¨ AwaKvsk Palette (c¨v‡jU) Window ‡gby‡Z we`¨gvb i‡q‡Q| wKQy 

Palette (c¨v‡jU) Ab¨vb¨ †gby‡ZI _vK‡Z cv‡i| †h Palette (c¨v‡jU) †h †gby‡Z we`¨gvb †mB †gby †_‡K H 

Palette (c¨v‡jU) Show/Hide (†Lvjv/eÜ) Kiv hvq| D³ Palette (c¨v‡jU) ¸‡jvi we¯—vwiZ KvR 

cieZ©x‡Z wk¶‡Ki wbKU †_‡K Rvb‡Z cvi‡eb| BwZg‡a¨ A‡bK¸‡jvi KvR †R‡b‡Qb e‡j Avgvi wek¦vm| 

Palette (c¨v‡jU) mg~n Show/Hide (†Lvjv/eÜ), Move ( ’̄vbvš—i), Maximize/Minimize (†QvU/eo), 

Add/Shaparate (GKwÎZ/Avjv`v) Kiv bv cvi‡j wk¶‡Ki wbKU †_‡K †R‡b wbb| 
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Adobe Photoshop 7.0 (G‡WŠwe d‡Uvkc 7.0) Package Program (c¨v‡KR †cÖvMÖvg) Gi g‡a¨ bqwU 

Menu we`¨gvb| cÖwZwU †gbyi Aax‡b Ackbmg~‡ni Dcw¯’wZ m¤^wjZ †gbyi bvg Pull Down Menu. GB Pull 

Down Menu B mgMÖ †cÖvMÖv‡gi cwi”Qboe Qwe| A_©vr mswk−ó †cÖvMÖv‡g wK wK KvR Kiv hvq Ges mswk­ó 

Kv‡Ri Rb¨ KgvÛ wK Zv GK bR‡i GB Pull Down Menu †Z cvIqv hvq| wb‡æv³ Av‡jvPbv‡Z AeMZ n‡Z 

cvi‡ev Adobe Photoshop 7.0 (G‡WŠwe d‡Uvkc 7.0) †gbymg~‡ni cwiwPwZ Ges †Kvb Kv‡Ri Rb¨ wK 

KgvÛ| GKRb Kw¤úDUvi e¨enviKvixi Kv‡Q †h †Kvb Package Program (c¨v‡KR †cÖvMÖvg) Gi Pull 

Down Menu †_‡K KgvÛ †R‡b wb‡q mswk−ó Package Program (c¨v‡KR †cÖvMÖvg) G KvR Kiv †gv‡UI 

Am¤¢e n‡Z cv‡i bv| Z‡e cÖwZwU Menu (†gby) Gi Awab¯’ Sub Menu mg~‡ni cwiwPwZ ev Kvh©KvwiZv m¤ú‡K© 

mg¨K avibv AR©b Kiv AZ¨vek¨K| GZ`y‡Ï‡k¨ GB Aa¨v‡qi AeZvibv| Adobe Photoshop 7.0 (G‡WŠwe 

d‡Uvkc 7.0) Gi Editting Window ‡Z Ae¯’vbKv‡j †h †Kvb mg‡q †h †Kvb Menu (†gby) Open Kiv 

hvq|  

 
File Menu 
 
1. To Create a New Image (bZzb GKwU B‡gR ˆZix Kiv) 

 

File Click 
New Click Ki‡j New Dialog Box Avm‡e ZLb Name, Image Size, Resolution, 

Mode, Contents Box Gi mewKQy Select K‡i 

Ok Click Ki‡j cQ›`gZ bZzb GKwU Image Create n‡e| 

 

Or t Keyboard Key {Ctrl + N} Press Ki‡j New Dialog Box Avm‡e| cieZ©x‡Z D³ KvR¸‡jv 

GKB c×wZ‡Z Ki‡Z n‡e| 

 

 

 

 

2. To Open a Image/Picture (GKwU B‡gR/Qwe †Lvjv) t 
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File Click 
Open Click Ki‡j Open Dialog Box Avm‡e| GLv‡b Files of Type Gi ¯’‡j Any Picture 

Format wm‡j± Ki‡Z n‡e| d‡j †dvìv‡i msiw¶Z Image/Picture File mg~n †`Lv hv‡e| ZLb †h File wU 

Open Ki‡Z PvB †mB File wU Select K‡i ev File Name Box G File Gi bvgwU wj‡L 

Open Click Ki‡jB Select K„Z Image/Picture File wU Open n‡q cÖ`wk©Z n‡e| 

Or t Keyboard Key {Ctrl + O} Press Ki‡j Open Dialog Box Avm‡e| cieZ©x‡Z GKB c×wZ‡Z 

Ki‡Z n‡e| 

 

3. To Browse a Image/Picture (Ly‡R B‡gR/Qwe †Lvjv)t 

 

†Kvb Image/Picture ‡K Hard Disk ‡_‡K Ly‡R ª̀“ZMwZ‡Z evQvBc~e©K Open Kivi Rb¨ Browse 

Sub Menu wU e¨envi Kiv nq|  

 

4. To Open As a Special Image/Picture (GKwU we‡kl B‡gR/Qwe †Lvjv) t 

Image/Picture Gi g‡a¨ Ggb wKQy Format/Mode Av‡Q †h¸‡jv Open Gi gva¨‡g †Lvjv hvq bv| 

†mB Format / Mode Gi Image/Picture ‡K Open Kivi Rb¨ Open As Sub Menu wU e¨envi 

Kiv n‡q _v‡K| A_©vr †h †Kvb Mode Gi Image/Picture †Lvjvi Rb¨ Bnv e¨envi Kiv n‡q _v‡K| 

 

5. To Open Recent Image/Picture (me©‡kl KvR Kiv B‡gR/Qwe †Lvjv) t 

 

Adobe Photoshop Gi g‡a¨ KvR Kivi mgq me©‡kl KvR Kiv n‡q‡Q Giƒc `kwU Picture/Image 

Location, Open Recent Sub Menu ‡Z †`Lv hvq| cieZ©x‡Z c~bivq Open Kivi Rb¨ 

Open/Open As Use bv K‡i Open Recent Sub Menu ‡_‡K Open Kiv hvq|  

 

6. To Close The Image/Picture (B‡gR/Qwe eÜ Kiv) t 

‡Kvb Image/Picture Open (†Lvjv) _vKve¯’vq 

File Click 
CLose Click Ki‡j Open K…Z Image/Picture eÜ n‡q hv‡e| Z‡e hw` dvB‡ji g‡a¨ ˆZixK…Z 

†Kvb Ask Amsiw¶Z _v‡K Z‡e Adobe Photoshop Dialog Box Avm‡e| ZLb No Click Ki‡j 

Image/Picture wU Amsiw¶Z Ae¯’v‡ZB eÜ n‡e| Aciw`‡K Yes Click Ki‡j Image/Picture wUi 

Amsiw¶b Ask msiw¶Z n‡q eÜ n‡e| 

Or t Keyboard Key {Ctrl+W} Press Ki‡j Open K…Z Image/Picture eÜ n‡q hv‡e| cieZ©x‡Z 

D³ KvR¸‡jv GKB c×wZ‡Z Ki‡Z n‡e| 

 

7. To Save The Image/Picture (B‡gR/Qwe msi¶b Kiv) t 

 

‡Kvb Image/Picture Open & Editing _vKve¯’vq 

File Click 
Save Click Ki‡jB Last Editing Ae¯’vq msiw¶Z n‡e| 

Or t Keyboard Key {Ctrl+S} Press Ki‡jB Last Editing Ae¯’vq msiw¶Z n‡e| 

 

8. Save As (msiw¶Z Qwe Ab¨ †Kvb bv‡g msi¶b Kiv) t 

 

msiw¶Z †h Qwe/B‡gRwU Ab¨ †Kvb bv‡g c~bivq msi¶b Ki‡Z PvB †mB Qwe/B‡gR wU Open K‡i 

File Click, Save As Click Ki‡j Save as Dialog Box Avm‡e ZLb GKwU bvg wj‡L 
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Save Click, Ok Click Ki‡Z n‡e| Or t Keyboard Key { Shift + Ctrl +S} Press Ki‡j 

mv‡_ mv‡_ Save As Dialog Box wU P‡j Avm‡e| cieZ©x‡Z D³ KvR¸‡jv GKB c×wZ‡Z Ki‡Z n‡e| 

 

9. Save for Web (dvBj‡K I‡qe mvB‡W msi¶b Kiv) t 

 

‡Kvb dvBj‡K I‡qe mvB‡W msi¶b Kivi Rb¨ GB Sub Menu wUi mvnvh¨ wb‡Z nq| welqwU bv eyS‡j ev 

KwVb g‡b n‡j wk¶‡Ki wbKU †_‡K we —̄vwiZ †R‡b wbb| Gi Rb¨ Keyboard Key {Alt + Shift + Ctrl 

+S}. 
 
10. To Revert The Image/Picture (B‡gR/Qwei me©‡kl msiw¶Z Ae<’vq hvIqv) t 

 

Adobe Photoshop Gi gva¨‡g Design Kivi mgq, †Kvb Image/Picture Editing Kivi ci 

hw` KLbI g‡b nq KvRwU Kiv wVK nqwb wVK ZLbB mv‡_ mv‡_ me©‡kl msiw¶Z Ae ’̄vq `ª“ZMwZ‡Z P‡j hvIqvi 

Rb¨ GB Sub Menu wU e¨envi Kiv nq|  

 

11. To Place a File From Illustrator (Bjv‡óªUi †_‡K B‡gR <’vcb Kiv) t 

 

Adobe Illustrator Program Gi Øviv ˆZix Kiv *.AI, *.EPS, *.PDF, *.PDP Format Gi 

File ‡K Kv‡Ri Pvwn`vi Dci wfwË K‡i Adobe Photoshop Program G wb‡q Avmvi Rb¨ Place Sub 

Menu wU e¨envi Kiv n‡q _v‡K|  

 

12. To Import Image/Picture (B‡gR/Qwe Avg`vbx Kiv) t 

 

Adobe Illustrator Ges wewfboe Graphics Package Program G ˆZix Kiv File mn 

Scanner, Camera or Another Device ‡_‡K Image/Picture Import (Avg`vbx) Kivi Rb¨ D³ 

Sub Menu wU e¨envi Kiv n‡q _v‡K|  

 
13. To Export Paths to Illustrator (Bjv‡óªU‡i c¨vZ ißvbx Kiv) t 

 

Adobe Photoshop Program Gi Øviv ˆZix Kiv c¨vZ‡K Kv‡Ri Pvwn`vi Dci wfwË K‡i Adobe 

Illustrator Program G ißvbx Kivi Rb¨ D³ Sub Menu wU e¨envi Kiv n‡q _v‡K| GQvovI Pjgvb 

Image/Picture wUi Size, Mode, Quality BZ¨vw` cwieZ©b Kivi Rb¨ Export Gi Awab ’̄ 

ZoomView Sub Menu wU e¨envi Kiv n‡q _v‡K|  

 
14. To Use Workgroup on Web Page (I‡qe †cB‡Ri Rb¨ IqvK©MÖ“c Kiv) t 

 

‡Kvb GKwU Qwe‡K I‡qe †cBR Dc‡hvMx K‡i ˆZix Kivi ci, Lye `ª“ZMwZ‡Z Web Link K‡i ˆZixK…Z 

QwewU‡K I‡qe †cB‡R mshy³ Kivi Rb¨ Workgroup Sub Menu Use Kiv n‡q _v‡K| 

 

15. Automate () t 

Transform Gi e¨envi eûwea t 

Free Transform t 

 

B‡g‡R KvR Kivi mgq wbw`ó †Kvb B‡gR‡K wewfbœ G¨v‡½‡j ¯’vcb Kivi cÖ‡qvRb nq| GQvov e¨enviKvixi 

cÖ‡qvRbvbyhvqx D³ B‡gR mgyn wewfbœ G¨v‡½‡j ¯’vcb, Gi AvKvi n«vm-e„w× KiY BZ¨vw` Kvh©vejx Ki‡Z Free 

Transform AckbwU e¨envi Kiv nq| 

 



132 

wkÿK‡`i AvBwmwU cÖwkÿY g¨vby‡qj 

cÖ‡qvM t 

B‡g‡Ri †h †jqvi†K cÖ‡qvRbg‡Zv G¨v‡½‡j ’̄vcb Ki‡ev †m †jqviwU wba©viY Ki‡Z n‡e 

Edit †gby †_‡K Free Transform AckbwU wbav©iY Ki‡Z n‡e 

Gevi gvDm c‡q›U Øviv wbe©vwPZ B‡gRwU cÖ‡qvRbxq G¨v‡½‡j ¯’vcb Ki‡Z cvi‡ev| 

 
Sacle Ack‡bi e¨envi t 

B‡g‡R KvR mg~n wbw`ó cwigv‡c n«vm-e„w× Ki‡Z GB AckbwU Kvh©Ki| 

cÖ‡qvM t 

‡h †jqviwU n«vm-e„w× Ki‡ev Zv wm‡j± Ki‡Z n‡e| 

Marquee Tool Gi mnvqZvq D‡ËvwjZ †jqv‡ii cÖ‡qvRbxq Ask wba©viY Ki‡Z n‡e| 

Edit †gby †_‡K Transform Scale AckbwU wbe©vPb Ki‡Z n‡e| 

GLb gvDm c‡q›U w`‡q Avgiv cÖ‡qvRb gZ wba©vwiZ AskUzKz n«vm-e„w× Ki‡Z cvi‡ev| 

 

Rotate Ack‡bi e¨envi t 

mvaviYfv‡e Z_¨ mg~‡n wewfboe G¨v‡½‡j mw¾Z Kivi R‡b¨ wewfbœ (900, 1800 BZ¨vw`) wWMÖx‡Z mw¾Z Kiv nq| 

Rotate KgvÛwUi mnvqZvq Z_¨ mg~n cÖ‡qvRbxq G¨v‡½‡j mw¾Z Kiv hvq| 

 

cÖ‡qvM t 

D‡ËvwjZ B‡g‡Ri †h Ask ev Askmg~n Rotate Kiv cÖ‡qvRb †m †jqviwU mPj Ki‡Z n‡e| 

Marquee Tool Gi mnvqZv D‡ËwjZ †jqv‡ii cÖ‡qvRbxq Ask ev Askmg~n wm‡j± Ki‡Z n‡e| 

Click on Edite Select on Transform Click on Rotate. 
GLb wbe©vwPZ AskUzKz gvDm c‡q›U Øviv wbw`ó G¨v‡½‡j mw¾Z Kiv hv‡e | 

 

Skew Ack‡bi e¨envi t 

B‡gR‡K wewfboe AvK…wZ‡Z Dc¯’vc‡bi Rb¨ Skew AckbwU e¨envi Kiv nq| 

 

cÖ‡qvM t 

D‡ËvwjZ B‡g‡Ri †h Ask ev Askmg~n Skew Kiv cÖ‡qvRb †m †jqviwU mPj Ki‡Z n‡e| 

Marquee Tool Gi mnvqZv D‡ËwjZ †jqv‡ii cÖ‡qvRbxq Ask ev Askmg~n wm‡j± Ki‡Z n‡e| 

Click on Edit Select on Transform Click on Skew. 
GLb wbe©vwPZ AskUzKz gvDm c‡q›U Øviv wbw`ó G¨v‡½‡j mw¾Z Kiv hv‡e | 

 
Distoer Ack‡bi e¨venvi t 

B‡gR mg~n wewfboe AvK…wZ‡Z mw¾Z Ki‡Z Distoer Ack†bi fzwgKv LyeB dj`vqK| 

 

cÖ‡qvM t 

D‡ËvwjZ B‡g‡Ri †h Ask ev Askmg~n Distoer Kiv cÖ‡qvRb †m †jqviwU mPj Ki‡Z n‡e| 

Marquee Tool Gi mnvqZv D‡ËwjZ †jqv‡ii cÖ‡qvRbxq Ask ev Askmg~n wm‡j± Ki‡Z n‡e| 

Click on Edite Select on Transform Click on Distoer. 
GLb wbe©vwPZ AskUzKz gvDm c‡q›U Øviv wbw`ó G¨v‡½‡j Distoer Kiv hv‡e | 

 
Perspectove Ack‡bi e¨venvi t 

B‡gR mg~n wewfbœ AvK…wZ‡Z mw¾Z Ki‡Z Perspectove Ack†bi fzwgKv LyeB dj`vqK| 

cÖ‡qvM t 

D‡ËvwjZ B‡g‡Ri †h Ask ev Askmg~n Perspectove Kiv cÖ‡qvRb †m †jqviwU mPj Ki‡Z 

n‡e| 

Marquee Tool Gi mnvqZv D‡ËwjZ †jqv‡ii cÖ‡qvRbxq Ask ev Askmg~n Block/Select 
(wm‡j±) Ki‡Z n‡e| 
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Click on Edite Select on Transform Click on Perspectove. 
GLb wbe©vwPZ AskUzKz Mouse Pointer (gvDm c‡q›Uvi) Øviv wfbœ AvK…wZ‡Z Perspectove Kiv 

hv‡e| 

 
Note t Gfv‡e GKvwaK †jqvi ˆZwi K‡i KvR Kiv hvq 

 

Adobe PhotoShop c¨v‡K‡R †jqvi GKwU AwZe cÖ‡qvRbxq welq| wewfbœ ai‡bi B‡gR ˆZwii †¶‡Î 

ˆZwiK…Z B‡gR mg~‡ni wewfbœ Ask GKGKwU †jqv‡i msiw¶Z _v‡K| d‡j ˆZwiK…Z B‡g‡Ri cÖ‡qvRbxq AskwU wb‡q 

KvR Kiv mnR nq| Ggb wK cÖ‡qvRb †ev‡a †K‡U ev` †`qv hvq| 
 

To Create New Layer (bZzb †jqvi ˆZix) t 

WKz‡g‡›U KvR Kivi †¶‡Î bZzb †Kvb Z_¨ D‡Ëvjb Kiv n‡j D‡ËvwjZ Z_¨ mg~n bZzb GKwU †jqv‡i D‡ËvwjZ nq| 

cieZx©‡Z wbw`ó †jqv‡ii gva¨‡g cÖ‡qvRbxq Kvh©vejx m¤úv`b Ki‡Z nq| Aek¨ WKz‡g‡›U GKvwaKevi †U· 

ms‡hvRb Kiv n‡j cÖwZeviB GKwU K‡i †jqvi ˆZwi nq| GQvovI bZzb †jqvi †Zwi K‡i D³ †jqv‡i cÖ‡qvRbxq 

Kvh©vejx m¤úv`b Ki‡Z nq| 

cÖ‡qvM c×wZ t 

†h WKz‡g‡›U bZzb †jqvi ˆZwi Kiv cÖ‡qvRb †m WKz‡g›UwU‡Z Ae¯’vb Ki‡Z n‡e ; 

Click on Layer Select on new Click on Layer (New Layer Dialogue Box 
wU Avm‡e) Box wU GiKg t 

Name t Gi ’̄‡j bZzb †jqv‡ii bvg UvBc Ki‡Z n‡e| 

Opacity t Ack‡bi gva¨‡g †jqv‡ii NbZ¡ wba©viY Ki‡Z n‡e| 

Mode t Gi Drop-down box †_‡K ˆZwiK…Z †jqviwUi †gvW wba©viY Ki‡Z n‡e| 

cÖ‡qvRbxq Kvh©vejx †k‡l Ok button Click Ki‡Z n‡e| 

 

To See Layer (†jqvi cÖ`k©b Kiv) t 

†Kvb B‡gR‡K I‡cb Ki‡j maviYZ me †jqviB cÖ`wk©Z nq| †Kvb †jqvi hw` cÖ`wk©Z bv nq Z‡e †jqvi DB‡Ûv‡Z 

D³ †jqv‡ii bv‡gi †kl evg cÖv‡š— wcKPvi ev‡i wK¬K K‡i †PvL cÖ`k©b Ki‡j †jqviwU cÖ`k©b n‡e| 

 

To Hide Layer (†jqvi jyKv‡bv) t 

†Kvb †jqvi‡K AcÖ`k©b Ki‡Z PvB‡j A_©vr jyKv‡Z PvB‡j †jqvi DB‡Ûv‡Z D³ †jqv‡ii bv‡gi †k‡l †PvL wcKPvi 

ev‡· wK¬K K‡i †PvLwU AcÖ`k©b Ki‡j †jqviwU Ac`wk©Z n‡e| 

 

‡jqvi Ackb (Layer Options) t 

 

‡jqvi ms7vš—  wewfbœ welq wbw`ó Ki‡Z n‡j ‡jqvi Ackb WvqjM e· cÖ`k©b K‡i Zv‡Z wba©viY Ki‡Z nq| †Kvb 

†jqv‡ii Ackb wbaviY Ki‡Z n‡j †mB †jqv‡i Wvej wK¬K Ki‡Z n‡e A_ev me©Wv‡b evU‡b wK¬K& K‡i cÖ`wk©Z †gby 

†_‡K Layer Options G wK¬K& K‡i ev Layer ‡gby †_‡K Layer Options wK¬K K‡i Zv Kiv hvq| 

‡jqvi gyQv t 

‡Kvb B‡gR dvB‡ji AcÖ‡qvRbxq †jqvi gyQ‡Z n‡j wbæ‡³v Kvh©vejx Aej¤^b Ki‡Z n‡e t 

‡h dvB‡ji †jqvi gyQv `iKvi †mB dvB‡j Ae¯’vb Ki‡Z n‡e ; 

‡jqvi DB‡Ûv (Layer Window) Gi Dci me©Wv‡b GB evU‡b wK¬K K‡i cÖ`wk©Z †gbyi Delete Layer 

AckbwU wbe©vPb Ki‡Z n‡e A_ev, Layer Delete Layer wb‡ ©̀k w`‡Z n‡e A_ev, †jqvi DB‡Ûv (Layer 

Window) Gi wb‡P Wvb w`‡K Delete Current Layer evU‡b Click (wK¬K) Ki‡Z n‡e| 

 

To Create Duplicate Layer (Wywc−‡KU †jqvi ˆZwi Kiv) t 

Kv‡Ri myweav‡_© g~j †jqvi A¶Z †i‡L Ab¨ GKwU Duplicate Layer (Wywc−‡KU †jqvi) mn‡R ˆZwi Kiv hvq| 

‡h †jqviwUi Wywc−‡KU ‰Zwi Ki‡ev †m †jqviwU wbe©vPb Ki‡Z n‡e ; 

‡jqvi ‡c−U †gby †_‡K Duplicate Layer AckbwU wbe©vPb Ki‡ev ; 

A_ev, Layer Duplicate Layer wb‡ ©̀k w`‡Z n‡e| ZLb c ©̀vq Avm‡e t 
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As t ‡U· e‡· Wywc−‡KU †jqv‡ii bvg Ges Documnet G †jqv‡ii Destination wbw`ó Ki‡Z n‡e| Ok 
Ki‡Z n‡e| Gfv‡e Wywc−‡KU †jqvi ˆZwi n‡e| 

Adobe Photoshop (G‡WŠwe d‡Uvkc) Gi †jqvi G‡d‡±i e¨envi LyeB ¸i“Z¡c~Y©| wewfboe G‡d± wbe©vPb 

K‡i †jqv‡ii B‡gR‡K my›`i fv‡e cÖ`k©b Kiv hvq| 

cÖ‡qvM wewa t 

‡h †jqvi G‡d± Kiv n‡e †m †jqvi wbe©vPb Ki‡Z n‡e| 



 
Layer Effects 
 
View ‡`Lv 

+ 

Click on Layer Select on Layer Style d‡j Style wj÷ Avm‡e, ZLb GLvb †_‡K Avgiv †h 

†Kvb Style wb‡q KvR Ki‡Z cvwi|  

Graphics Design Program Adobe Photoshop (G‡WŠwe d‡Uvkc) Gi Preview wb‡q A‡bK KvR 

Kiv hvq| Z‡e G †¶‡Î Ab¨vb¨ †cÖvMÖv‡gi ‡_‡K wfbœZi KvR K‡i| wb‡æ K‡qKwU Point wb‡q Av‡jvPbv Kiv †Mj t 

 
New View t GB AckbwU wb‡j GKvwaK DB‡Ûv‡Z GKB B‡gR dvBj wfD K‡i| 

cÖ‡qvM wewa t 

Click on View Click on New View d‡j bZzb DB‡Ûv P‡j Avm‡e g‡b n‡e †hb Kwc n‡q‡Q| 

Preview t GB AckbwU wb‡j B‡gR dvB‡ji †h PviwU i‡Oi wfwË †hgb- CMYK t Cyan, Magenta, 

Yellow, Black) AvDUcyU n‡q _v‡K| B‡gR hw` CMYK ‡gv‡W bv n‡q Ab¨ †gv‡W (†hgb t RGB) nq 

Zvn‡j CMYK Gi wewfboe i‡O B‡gRwUi Ae¯’v wK iKg n‡e Zv †`Lvi Rb¨ A_©vr cª`k©b ev wcÖwfD Kiv hvq| 

Click on View Click on Preview d‡j GKwU †gby †`Lv w`‡e| GLvb †_‡K wewfbœ Ackb wb‡q 

Avgiv KvR Ki‡ev| 

Zoom In t Kv‡Ri myweav‡_© B‡gR‡K cÖ‡qvR‡b eo Kiv nq| Zoom In w`‡q 1600% ch©š— eo Kiv hvq| 

cÖ‡qvM wewa t 

‡h B‡g‡R KvR Ki‡ev †mwU mPj Ki‡Z n‡e ; 

Clic on View Click on Zoom In 
A_ev, Ctrl + 

A_ev, Uzj e‡· Zoom Tool wbe©vPb K‡i GB KvR mgvavb Kiv hvq| 

 
Ruler cÖ`k©Y/AcÖ`k©Y 

Zoom Out t 

Zoom In Gi wecixZ nj Zoom Out| GB Ackb w`‡q B‡gR‡K B‡”Q gZ †QvU Kiv hvq| 

cÖ‡qvM wewa t 

‡h B‡g‡R KvR Ki‡ev †mwU mPj Ki‡Z n‡e ; 

Clic on View Click on Zoom Out 
A_ev, Ctrl + 

A_ev, Uzj e‡· Alt Kx †P‡c Zoom Tool wbe©vPb K‡i GB KvR Kiv hvq| 

 
Fit on Screen t 
gwbU‡ii c ©̀vi mv‡_ mgš̂q mva‡bi Rb¨ GB Ackb e¨envi Kiv nq| 

Click on View Click on Fit on Screen 
A_ev, Uzj e‡·i Hand Tool G Double Click (Wvej wK¬K) Ki‡Z n‡e| 
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Actual Pixels t B‡gR ‡h Ae¯’v‡ZB cÖ`wk©Z †nvK bv †Kb Gi cÖK…Z Ae¯’v A_©vr 100% cÖ`k©b Kiv‡Z n‡j hv 

Ki‡Z n‡e Zv n‡jv t 

Click on View Click on Actual Pixels ; 
A_ev, Zoom Tool G Double Click (Wvej wK¬K)Ki‡Z n‡e ; 

A_ev, Alt + Ctrl + O Kx-Îq Pvc‡Z n‡e| 

B‡g‡Ri Ask gvcvi (BwÂ/†mtwgt) Rb¨ i“jvi cÖ`k©b K‡i Zv Kiv hvq| †m Rb¨ †h wb‡ ©̀k wbæ iƒc cÖ`k©Y Ki‡Z 

PvB‡j t 

Click 0n View Click on Show Rulers ; 
A_ev, Ctrl + R . AcÖ`k©Y Ki‡Z PvB‡j t 

Click 0n View Click on Hide Rulers ; 
A_ev, Ctrl + R . 

 

Ruler wR‡iv‡Z cwieZ©b Kiv t 

Ruler (i“jvi) Gi gvc `vM wPý 0 †_‡K 1,2,3.... Gfv‡e nq| gv‡ci myweav‡_© B‡g‡Ri †Kvb Ask i“jv‡ii k~b¨ 

Drm (Rulers Zero Origin) ïi“ Kiv hvq| 

 

cÖ‡qvM wewa t 

cÖ‡g B‡gRwU mPj Ki‡Z n‡e ; 

Ruler cÖ`wk©Z bv _vK‡j View wK¬K K‡i Show Rulers wK¬K Ki‡Z n‡e 

 
Guide cÖ`k©Y/AcÖ`k©Y 

 
Color c¨v‡jU wb‡q KvR Kiv 

D‡Ûvi DaŸ© evg †KvYvq nwiR›Uvj Ges fvwU©K¨vj i“jv‡ii †Q` (Intersection) Ae¯’v‡b gvDm c‡q›U 

ivL‡Z n‡e 

gvDm w`‡q Wª̈ vM K‡i B‡g‡Ri †hLvb †_‡K i“jv‡ii k~b¨ Drm ïi“ Ki‡Z Pvb †mLv‡b Avmyb| 

gvD‡mi †evZvg †Q‡o w`b| 

 

Guide cÖ`k©Y t 

d‡Uvkc c¨v‡K‡R Wªwqs myweavi Rb¨ nwiR›Uvj ev fvwU©K¨vj jvBb ¯’vcb K‡i KvR Kiv hvq| 

jvBbMy‡jv cÖ`wk©Z n‡jI Zv wcÖ›U nq bv| G ¸‡jv‡K MvBW ejv nq| 

cÖ‡qvM wewa t 

cÖ‡g B‡gR‡K mPj Ki‡Z n‡e ; 

i“jvi cÖ`wk©Z bv n‡q _vK‡j Zv cÖ`k©b Ki‡Z n‡e ; 

Horizontal Rular (nwiR›Uvj i“jvi) Gi wfZ‡i wK¬K K‡i gvDm w`‡q Wª¨vM K‡i B‡g‡Ri †h ¯’v‡b 

emv‡Z PvB †mLv‡b G‡b †Q‡i w`‡Z n‡e| 

 
Guide AcÖ`k©Y t 

MvBW cÖ`k©Y Ki‡Z bv PvB‡j View wK¬K K‡i Hide Guides wb‡ ©̀k w`‡Z n‡e| 

 
Guide cÖ`k©Y t 

cybivq MvBW cÖ`k©Y Ki‡Z PvB‡j View wK¬K K‡i Show Guides wb‡ ©̀k w`‡Z n‡e| 

 
Guide gyf Kiv t Kv‡Ri myweav‡_© MvBW‡K gyf Kiv cÖ‡qvRb n‡Z cv‡i ; †m Rb¨ 

wb‡ ©̀kbv wbæ iƒc t 

‡h B‡g‡Ri MvBW gyf Kiv `iKvi †mwU wm‡j± Ki‡Z n‡e ; 

MvBW hw` jK Kiv _v‡K Z‡e Zv AvbjK Ki‡Z n‡e ; 

Uzje‡· Move Tool wm‡j± K‡i †h MvBWwU gyf Ki‡Z PvB †mwUi Dci gvDm c‡q›U wb‡Z n‡e 
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GLb Wª¨vM K‡i MvBWwU gyf Ki‡Z n‡e| 

DcwiD³ KvR ¸‡jv Qvov MvBW jK Ges MvBW gy‡Q †`qv BZ¨vw` KvR ¸‡jv View ‡gby †_‡K Kiv hvq| 

 

d‡Uvk‡c Kvjvi c¨v‡jU e¨envi AwZe ¸i“Z¡ c~Y©| Kvjvi c¨v‡jU e¨envi K‡i †dviMÖvDÛ Ges e¨vKMÖvDÛ Kvjvi 

wbe©vPb Kiv hvq| iO e¨envi Kivi Rb¨ AviI †h Uzj Ges e¨vcvi mswk−ó Zv nj 

Uzje‡·i Foreground & Background Kvjvi e· ; 

Gradient wb‡q KvR Kiv 

Eye Dropper tool ; 
Point Backer tool ; 
Gradient tool ; 
 

Kvjvi c¨v‡j‡Ui Dc‡i Wvbw`‡Ki evU‡b wK¬K Ki‡j c ©̀vq Kvjvi c¨v‡jU †gby cÖ`wk©Z n‡e t 

‡gby †_‡K †h †gvW wbe©vPb Kiv n‡e †m †gv‡WB Kvjvi c¨v‡jU cÖ`wk©Z n‡e| †hgb RGB Sliders Ges RGB 

Spectrum wbe©vPb Ki‡j RGB ‡gv‡W Kvjvi c¨v‡jU cÖ`wk©Z n‡e| 

 

Kvjvi c¨v‡jU †_‡K is wbe©vPb Kiv t 

wZb fv‡e iO wbe©vPb Kiv hvq t 

¯−vBWvi e¨envi K‡i ; 

Kvjvi c¨v‡j‡Ui wb‡P cÖ`wk©Z Kvjvi evi †_‡K wK¬K K‡i ; 

¯−vBWv‡ii Wvb cv‡ki †U·U e‡· msL¨v ev gvb ewm‡q | 

 
Foreground & Background Kvjvi t 

me B‡g‡RiB †dviMÖvDÛ (mvg‡bi Ask) Ges e¨vKMÖvDÛ (wcQ‡bi Ask) i‡q‡Q| d‡Uvkc c¨v‡K‡R †dviMÖvDÛ 

Ges e¨vKMÖvDÛ e¨envi Ki‡Z nq wb‡æv³ fv‡e | 

 
Foreground t 

‡cB›U Kiv nq | 

‡Kvb wbe©vwPZ Ask‡K wdj Kiv nq| 

‡÷ªv‡K Ask wb‡j KvUv As‡k cÖ`wk©Z nq| 

 
Background t 

‡MÖwW‡q›U wdj Kivi Rb¨ e¨envi Kiv nq| 

B‡g‡Ri Ask †K‡U wb‡j KvUv As‡k cÖ`wk©Z nq| 

`yB ev Z‡ZvwaK is ïi“ n‡q 7gk wgwkªZ nIqv‡K †MÖwW‡q›U ejv nq| Av‡jvP¨ c¨v‡K‡R Gi e¨envi LyeB 

¸i“Z¡en| cuvP ai‡Yi †MÖwW‡q›U j¶¨ Kiv hvq | †hgb t 

(1). Linear Gradient Tool (2). Radial Gradient Tool (3). Angle Gradient Tool 
(4). Reflected Gradient Tool (5). Diamond Gradient Tool. 
 
To Use Gradient (‡MÖwW‡q›U e¨envi Kiv) t 

d‡Uvk‡c KZ¸‡jv wWdë †MÖwW‡q›U i‡q‡Q| G¸‡jv e¨envi Kiv hvq| Avgviv Transparent Rainbow 

‡MÖwW‡q›U e¨envi wbæiƒ‡c t 

 

bZzb GKwU WKz‡g›U I‡cb Ki‡Z n‡e 

Uzje‡· Rectangular Marquee Tool wU wbe©vPb Ki‡Z n‡e 

Uzje‡¯‹ Linear Gradient Tool wU‡Z Wvej wK¬K& Ki‡Z n‡e| c ©̀vq †MÖwW‡q›U cÖ`wk©Z n‡e| 


 

c¨vUv‡b©i ‰Zwi I e¨envi 

B‡gR wdëviKiY 



137 

wkÿK‡`i AvBwmwU cÖwkÿY g¨vby‡qj 

Wªc WvDb evU‡b wK¬K K‡i ZvwjKv †_‡K †MÖwW‡q›U wm‡j± Ki‡Z n‡e 

wm‡j± e‡·i Dci gvDm c‡q›Uvi w`‡q †cÖm I WªvM Ki‡Z n‡e 

wm‡jKkb AskUzKz †MªwW‡q›U n‡e| 

 
To Delete Gradient (†MÖwW‡q›U gyQv) t 

‰Zwi Kiv me †MÖwW‡q›U †_‡K A‡bK mgq Acª‡qvRbxq †MÖwW‡q›U gyQvi `iKvi n‡Z cv‡i | Zvi Rb¨ wbæ iƒc 

wb‡ ©̀kbv t 

Uzje‡· †MÖwW‡q›U Uz‡j Wvej wK¬K Ki‡Z n‡e ; 

‡MÖwW‡q›U c¨v‡j‡Ui Edit..... evU‡b wK¬K& K‡i †MÖwW‡q›U GwWUi WvqjM e· Open (I‡cb) Ki‡Z n‡e 

‡h †MÖwW‡q›U gyQ‡Z n‡e †mwU wm‡j± Ki‡Z n‡e ; 

Delete evUb wK¬K Ki‡Z n‡e| 

d‡Uvkc c¨v‡K‡R c¨vUvb© ˆZwi K‡i Dnv‡K B‡g‡Ri Background (e¨vKMÖvDÛ) wn‡m‡e e¨envi Kiv hvq| 

cÖ‡qvM wewa t 

d‡Uvkc ïi“ K‡i Sky bv‡g A_ev Ab¨ †h †Kvb bvgK GKwU WKz‡g›U ˆZix Ki‡Z n‡e ; 

bZzb GKwU †jqvi ˆZix Ki‡Z n‡e ( Shift + Ctrl + N) ‡P‡c ; 

Uzje‡·i Paintbrush Tool w`‡q ÒgvÓ AvK‡Z n‡e 

Layer >Effectts >Bevel and Emboss wb‡ ©̀k w`‡Z n‡e Emboss Kivi Rb¨ ; A_ev Ab¨ †h 

†Kvb Qwe ev B‡g‡Ri Ask †K‡U Avb‡Z n‡e ; 

‡Kvb B‡gR dvBj †hgb t Flowers.psd dvBjwU I‡cb Ki‡Z n‡e ; 

Uyje‡·i Marquee Recttanguular Tool w`‡q B‡g‡Ri wKQy Ask wm‡j± Ki‡Z n‡e ; 

Edit >Define Pattern.. wb‡ ©̀k w`‡Z n‡e| 

‡jqvi DB‡ÛvwU c ©̀vq cÖ`wk©Z bv _vK‡j Window >Show Layyers wb‡`©k w`‡Z n‡e ; 

‡jqvi c¨v‡jU †_‡K Background ‡jqviwU wbe©vPb Ki‡Z n‡e ; 

Edit >Define Pattern.. wb‡ ©̀k w`‡Z n‡e ; 

Fill WvqvjM e· Avm‡e GLv‡b Ok wb‡ ©̀k w`‡Z n‡e, d‡j e¨vKMÖvDÛ dz‡ji c¨vUvb© w`‡q c~Y© n‡e| 

 

d‡Uvkc c¨v‡K‡R B‡gR‡K wewfbœfv‡e Kvi“Kvh©gq K‡i Dc¯’vcb Kiv hvq| wkíx †hgb †Kvb B‡gR‡K w`‡bi ci 

w`b cwikªg K‡i Kvi“Kvh©gq K‡i ‡Zgwb d‡Uvk‡c Zv gyû‡Z©B Kiv hvq| ïay ZvB bq B‡gR‡K B‡”QgZ wb‡Ri 

Avw½‡K Dc¯’vcb Kiv hvq| d‡Uvk‡ci wdëvi †gby‡Z wK¬K K‡i †h ‡gby cvIqv hv‡e †mB †gby ¸‡jvi Avevi †ek 

wKQy mve †gby i‡q‡Q †m¸‡jv e¨venvi Kv‡i Avgiv B‡gR‡K mn‡RB Kvi“Kvh©gq K‡i Zzj‡Z cvi‡ev| 

 
Artistic Filter t 
Gi Aax‡b c‡biwU wdëvi i‡q‡Q| G¸‡jv wbe©vPb K‡i B‡gR‡K wkíR‡bvwPZ wewfboe iƒc`vb Ki‡Z cvi‡ev| 

wewfboe Ack‡bi e¨envi wb‡æ †`Lv‡bv n‡jv t 

 
Colored Pencil t GwU e¨env‡i B‡gR‡K iwOb †cwÝj w`‡q N‡l AvKuvi g‡Zv Kiv hv‡e| †hgb 

B‡gR‡K mPj K‡i †jqvi wbe©vPb Ki‡Z n‡e t 

Filter > Artistic > Colored Pencil wb‡ ©̀k w`‡Z n‡e (c`©vq Avm‡e WvqjM e·)| GLv‡b Kv‡Ri 

myweav‡_© c−vm gvBbvm evUb †P‡c B‡gR‡K ‡QvU eo Kiv hv‡e| 

Options Gi Pencil Width Gi †U·U e‡· msL¨v ewm‡q A_ev mij‡iLvi wb‡Pi wÎf~R (¯−vBWvi) 

†K gvDm w`‡q Wª̈ vM K‡i †cwÝ‡ji wb‡ci cÖk¯—Zv wba©viY Ki‡Z n‡e 

Stroke Pressure A_©vr †cwÝj w`‡q wK cwigvb Pvc w`‡q AvuKv n‡e Zv wba©viY Kiv hvq| 

Paper Brightness G B‡gRwUi D¾¡jZv Kg-‡ewk wba©viY Kiv hvq| 1-50 ch©š— gvb wba©viY Kiv 

hvq| gvb †ewk n‡j D¾¡jZv †ewk Ges Kg n‡j D¾¡jZv Kg n‡e| 

Pancil Width 4, Stroke Pressure 9, Paper Brightness 23 wba©viY K‡i OK Ki‡Z n‡e| 

d‡j B‡gRwU †cwÝ‡ji AvKuvi gZ g‡b n‡e| 

 
Cutout wdëvi t 



138 

wkÿK‡`i AvBwmwU cÖwkÿY g¨vby‡qj 

B‡gR‡K Nu‡l Gi Sharpness wehy³ K‡i iƒc `vb Kiv hvq| Gi Rb¨ wbæ iƒc wb ©̀kbv t 

B‡gR‡K mPj Ki‡Z n‡e 

Filter >Arttistic > Cutout... wbe©vPb Ki‡Z n‡e | c`©vq WvqjM e· Avm‡e| 

No of Levels c‡q›U G hZ msL¨v wba©viY Kiv n‡e B‡gRwU‡Z ZZwU †j‡ej cÖ`wk©Z n‡e 

Edge Simplicity Ges Edge Fidelity ‡Z gvb wba©viY K‡i Ok Ki‡Z n‡e| 

 
Dry Brush wdëvi t 

Artistic ‡gby¯’ GB AckbwU wbe©vPb K‡i wbe©vwPZ B‡gR‡K WªvB eªvk iƒc`vb Kiv hv‡e| 

 
Film Grain wdëvi t 

GB AckbwU wbe©vPb K‡i wbe©vwPZ B‡gR‡K `vbv `vbv AvKv‡i iƒc`vb Kiv hvq ; †hgbt 

B‡gR‡K mPj Ki‡Z n‡e 

Click on Filter > Artsitc > Film Grain wb‡ ©̀k w`‡Z n‡e| c ©̀vq WvqjM e· Avm‡e 

e‡· ‡h KvR Ki‡Z n‡e Zv n‡jv t 

1. Grain G 1-20 ch©š— gvb wba©viY Kiv hvq| gvb ‡ewk n‡j B‡gRwU †ewk `vbv `vbv n‡e 

2. Highlight Area ‡Z 0-20 ch©š— gvb wba©viY Kiv hvq| gvb †ewk n‡j B‡g‡Ri AskwU †ewk¾¡j ev 

Av‡jvwKZ n‡e| 

3. Intensity ‡Z 0-10 ch©š— gvb wba©viY Kiv hvq| †ewk gvb wba©viY Ki‡j `vbvi ZxeªZv †ewk n‡e| 

 
Fresco wdëvi t 

GB AckbwU wbe©vPb K‡i B‡gR‡K cÖvPxi Mv‡Î AvKuv wP‡Îi b¨vq iƒc`vb Kiv hvq| 

 
Neon Glow wdëvi t 

GB AckbwU wbe©vPb K‡i B‡R‡K `xwßgq I D¾¡jZv `vb Kiv hvq| 

B‡gR‡K mPj Ki‡Z n‡e ; 

Filter >Artistic > Neon Glow... wbe©vPb Ki‡Z n‡e | c ©̀vq WvqjM e· Avm‡e| 

wc‡·j M−y ev `xwß gq Kivi Rb¨ Glow Size G 24 ch©š— gvb wba©viY Kiv hvq ; 

Glow Brightness G 0-50 ch©š— gvb wba©viY K‡i B‡g‡Ri D¾¡jZv e„w× Kiv hvq; 

Glow Color GB AckbwU wbe©vPb K‡i B‡g‡Ri Pvicv‡k †h Av‡jv D™¢vwmZ n‡e Zvi is wbe©vPb Kiv hvq 

me©‡k‡l Ok Ki‡Z n‡e| 

 
Paint Daubs wdëvi t 

GB AckbwU wbe©vPb K‡i B‡gR‡K is w`‡q cÖ‡jc †`qv hvq| †hgbt 

B‡gR‡K wbe©vPb Ki‡Z n‡e 

Filter >Artistic > Paint Daubs... wbe©vPb Ki‡Z n‡e | c ©̀vq WvqjM e· Avm‡e| 

cÖ`wk©Z †U· ev MÖvwd· mg~‡ni Dc ’̄vcb AvKl©bxq Kivi R‡b¨ Options Gi Aaxb —̄ Brush Size, 

Sharpness BZ¨vw` Ackb mg~‡ni mnvqZvq wdëv‡ii gvÎv wba©viY Ki‡Z n‡e| 

wba©vwiZ MÖvwd· ev †U·U mg~‡ni UvBc wba©viY Kivi R‡b¨ Brush Type : Drop-down Gi mnvqZvq 

wba©viY Ki‡Z n‡e| 

cÖ‡qvRbxq Kvh©vejx m¤úv`‡bi †k‡l OK Button Click Ki‡Z n‡e| 

 
Palette Knife wdëvi t 

GB AckbwU e¨venvi K‡i B‡gR‡K Qywi w`‡q †Qu‡U †Q‡Uu ‰Zwi Kiv cÖwZK…wZi gZ iƒc`vb Kiv hvq| 

cÖ‡qvM wewa t 

B‡gRwU mPj Ki‡Z n‡e 

 
Blur Ackb w`‡q wdëvi 

Filter >Artistic > Palette Knife ... wbe©vPb Ki‡Z n‡e | c ©̀vq WvqjM e· Avm‡e 
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Stroke Size G hZ msL¨v †jLv n‡e cÖwZevi KvUvi mvBR ZZ n‡e 

Stroke Detail G msL¨v wbav©iY (3) 

Softness G msL¨v wba©viY (10) 

me©‡k‡l Ok wba©viY Ki‡Z n‡e| 

 
Plastic Wrap wdëvi t 

G AckbwU wbe©vPb K‡i B‡gR‡K c−vw÷K KvMR w`‡q †Kvb wRwbm‡K gyo‡j †h iKg †`Lvq †m iKg K‡i cÖ`k©Y 

Kiv hvq| 

cÖ‡qvM wewa t 

B‡Rg‡K mPj Ki‡Z n‡e 

Filter >Artistic > Plastic Wrap ... wbe©vPb Ki‡Z n‡e | c ©̀vq WvqjM e· Avm‡e 

Highlight Strength G hZ †ewk gvb †`qv n‡e c−vw÷‡Ki dz‡j DVv †gvov‡bv ZZ ‡ewk n‡e| 

Detail G c−vw÷‡Ki dz‡j DVv fvR KZ n‡e Zv wba©viY Kiv hvq 

Smoothness G c−vw÷K †ccv‡ii gm„YZv wbav©iY Kiv hvq| GLv‡b 1-15 ch©š— wba©viY Kiv hvq 

me©‡k‡l Ok wba©viY Ki‡Z n‡e| 

 
Poster Edge wdëvi t 

GB AckbwU wbe©vPb K‡i wbe©vwPZ †Kvb B‡gR‡K ‡dvUv †dvUv iƒ‡c †cv÷vi GR wdëvi e¨envi Ki‡Z nq| 

 
Rough Pastels wdëvi t 

GB AckbwU wbe©vPb Ki‡j B‡gR‡K iw½b Lwo w`‡q AuvK wP‡Îi gZ iƒc`vb Kiv hvq| 

 
Smudge Stick wdëvi t 

GB AcgbwU wbe©vPb K‡i B‡g‡Ri Dci †bvsiv cÖ‡jc w`‡q iƒc`vb Kiv hvq| 

 
Sponge wdëvi t 

B‡g‡Ri Dci ¯ú‡Äi gZ B‡d± †`qv hvqvi Rb¨ GB AckbwU e¨envi Kiv nq| 

 
Under painting wdëvi t 

GB AckbwU wbe©vPb Ki‡j B‡g‡Ri Dci m`¨ is Kiv n‡”Q Ggb B‡d± †`qv hvq| 

 
Water Color wdëvi t 

GB AckbwU wbe©vPb Ki‡j B‡g‡Ri Dci Rj i‡½i B‡d± †`qv hvq| 

 
Blur wdëvi t 

 
Brush Stroke Ackb w`‡q wdëviKiY 

 
Distort Ackb w`‡q 

GB Ackb w`‡q wbe©vwPZ †Kvb B‡gR‡K Svcmv K‡i cÖ`k©b Kiv hvq| 

cÖ‡qvM wewa t 

B‡gR‡K mPj Ki‡Z n‡e ; 

Filter >Blur> Blur ... wbe©vPb Ki‡Z n‡e | d‡j wbe©vwPZ B‡gRwU e−vi n‡e| 

Blur Avevi K‡qK ai‡Yi i‡q‡Q, DcwiD³ wbqg Abyhvqx Avgiv mKj ai‡Yi e−vi w`‡q wdëvi Ki‡Z cvi‡ev| 

Brush Stroke Ackb mg~n wbe©vPb K‡i B‡gR‡K wewfbœ fv‡e Kvi“Kvh©gq K‡i Dc ’̄vcbv Kiv hvq| 

 
Accented Edges wdëvi t 

GB AckbwU wbe©vPb K‡i wbe©vwPZ B‡gR Gi cÖv‡š—i cÖk¯—Zv, D¾¡jZv I gm„YZv wewfbœ fv‡e Dc¯’vcb Kiv hvq| 
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B‡gR‡K mPj Ki‡Z n‡e ; 

Filter >Brush Strokes> Accented Edges... wbe©vPb Ki‡Z n‡e | c ©̀vq WvqjM e· Avm‡e| 

GLv‡b wewfboe KvR K‡i me©‡k‡l Ok w`‡Z n‡e| 

 
Angled Edges wdëvi t 

GB AckbwU wbe©vPb K‡i wewfboe gvb wbw`©ó K‡i B‡gR‡K wewfbœ fv‡e Dc¯’vcbv Kiv hvq| 

 
Crosshatch wdëvi t 

GB Ackb wbe©vPb K‡i B‡gR‡K 7mn¨vP B‡d± †`qv hvq| 

cÖ‡qvM wewa t c~‡e©i b¨vq| 

 
Dark Strokes wdëvi t 

B‡gR‡K WvK© †÷ªvK Kivi Rb¨ GB AckbwU wbe©vPb Ki‡Z nq| 

 
Ink Outline wdëvi t 

GB AckbwU wbe©vPb K‡i Kvwji AvDU jvBb wewfbœ K‡i B‡gR‡K cÖ`k©b Kiv hvq| 

 
Spatter wdëvi t 

GB AckbwU wbe©vPb K‡i B‡gR‡K BZ —̄tZ Qvov‡bv B‡d± †`qv hvq| 

 
Sparyed Strokes Ges Sumi-e wdëvi t 

GB wdëvi Øq I DcwiD³ wbqg Abyhvqx Ki‡Z n‡e| 

 

wewfboe dvBj di‡gU 

GB †gby ’̄ wewfboe Ackb wbe©vPb K‡i B‡gR‡K wewfboe ˆewPÎgq K‡i Dc¯’vcb Kiv hvq| GB Ackb ¸‡jv 

c~‡e©i gZ Ki‡Z n‡e| G Qvov Filter ‡gbyi mg ’̄ Ackb Ges mve-Ackb c~‡e©i wbqg Abyhvqx Ki‡j Avgiv 

Avgv‡`i B‡gR‡K Kvw•LZ iƒc`vi Ki‡Z cvi‡ev| 

wfboe wfboe di‡gU e¨envi K‡i dvBj †mf Kiv d‡Uvk‡c GKwU ¸i“Z¡c~Y© welq| wb‡æ G wel‡q wb‡q Av‡jvPbv 

Kiv n‡jv t 

 
BNP t 

BNP (Bit Map) nj DOS Ges Windows KgwcwUej KgwcDUv‡ii Rb¨ ÷¨vÛvW© B‡gR di‡gU| BNP 

di‡gU RGB, Indexed Color,Grayscale Ges Bitmap Kvjvi g‡Wj mg_©b K‡i| Avjdv P¨v‡bj 

mg_©b K‡i bv| 

 
DCS t 

DCS (Desktop Color Separation) nj EPS di‡gU ÷¨vÛvW© fvm©b hv †KvqvK© KZ…©K †Wfjc Kiv| 

DCS 2.0 di‡gU gvwëP¨v‡bj Ges CMYK dvBj mg_©b K‡i wms‡Mj Avjdv P¨v‡bj Øviv; DCS 1.0 Avjdv 

P¨v‡bj Qvov CMYK mg_©b K‡i| DCS 1.0 Ges DCS 2.0 Dfq cv_ Clipping mg_©b K‡i| 

 
Photoshop ESP t 

EPS (The Encopsulated Postscript) j¨vs¸‡qR dvBj di‡gU ‡f±i Ges weUg¨vc MÖvwd· Dfq‡K 

wb‡q MwVZ Ges GwU MÖvwd·, Bjv‡÷ªkb Ges †cR †j-AvDU †cÖvMÖvgmg~n‡K mg_©b K‡i| EPS di‡gU 

A¨vwc−‡Kkbmg~‡ni g‡a¨ †cv÷w¯OEÞ j¨vs¸‡qR AvU©IqvK wewbgq Ki‡Z e¨eüZ nq| Ab¨ A¨vwc−‡Kk‡b Kiv 

†f±i B‡gR dvBj‡K I‡cb Ki‡j d‡Uvkc dvBjwU‡K †i÷vivBR K‡i wc‡·j dvB‡j cwiYZ K‡i| EPS di‡gU 

Lab, CMYK, RGB Indexed-Color, duotone, Grayscale Ges Bitmap Color Modes 

mg_©b K‡i wKš‘ Avjdv P¨v‡bj mg_©b K‡i bv| EPS 

Clipping Path mg_©b K‡i bv| 
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Filmstrip t 

Adobe Premier G Øviv ˆZwi RGB G¨vwb‡gkb A_ev gywf dvBjmg~‡ni Rb¨ Filmstrip di‡gU e¨eüZ 

nq| 

 
GIF t 

GIF (Graphic Interchange Format) nj Iqvì© IqvBW I‡qe (W W W) Ges Ab¨vb¨ AbjvBb 

mvwf©‡m †ewk e¨eüZ dvBj di‡gU hv e¨eüZ nq Bb‡W·W Kvjvi MÖvwd· Ges B‡gRmg~n‡K HTML 

(Hypertext Markup Language) G cÖ`k©b Ki‡Z| GIF nj LZW Compressed Format hv 

dvBjmvBR Ges dvBj UªvÝdvi MwZ‡Z b~¨bZg Ki‡Z wWRvBbK…Z| GIF Avjdv P¨v‡bj mg_©b K‡i bv| 

 
JPEG t 

JPEG (Joint Photographic Experts Group) nj W W W Ges Ab¨vb¨ AbjvBb mvwf©‡m †ewk 

e¨en„Z dvBj di‡gU hv d‡UvMÖvd Ges Ab¨vb¨ Continuuouus – tone B‡gR‡K HTML G cÖ`k©b K‡i| 

JPEG di‡gU CMYK,RGB Ges Grayscale Color Modes mg_©b K‡i wKš‘ Avjdv P¨v‡bj‡K mg_©b 

K‡i bv| JPEG B‡gR I‡cb Ki‡j ¯̂qsw7qfv‡e dvBj wWKg‡cÖm nq| JPEG di‡g‡U dvBj dvBj †mf Kivi 

mgq B‡gR †KvqvwjwU Ges Kg‡cÖkm †j‡ej wbw ª̀ó K‡i †`Iqv hvq| JPEG di‡g‡U GKevi †mf Kivi ci Zv‡Z 

GwWU Kiv ev ‡WUv hy³ Kiv hvq bv| ZvB me GwWwUs Ges mshyw³i ci Pzovš—fv‡e JPEG di‡g‡U †mf Ki‡Z 

n‡e| 

 
PCX t 

PCX di‡gU IBM – Compatible Kw¤úDUvi †ewk e¨eüZ dvBj di‡gU| †ewkifvM wcwm md&UIq¨vi 

PCX Gi fvm©b 5 di‡gU mg_©b K‡i| PCX di‡gU RGB, Indexed-color, Grayscale Ges 

Bitmap Color Modes mg_©b K‡i, Avjdv P¨v‡bj mg_©b K‡i bv| PCX, RLE Kg‡cÖkb c×wZ mg_©b 

K‡i| B‡gRmg~n 1,4,8, A_ev 24 Bit depth n‡Z cv‡i| 

 
PDF t 

PDF (Portable Document Format), GWe G‡7v‡eU, GWwei GjKUªwbK cvewjwks md&UIq¨vi e¨en„Z 

nq| PDF dvBjmg~n co‡Z G‡7v‡eU wiWvi mdU&q¨vi e¨eüZ nq| PDF †f±i Ges weUg¨vc MÖvwd· Dfq‡K 

cÖwZwbwaZ¡ K‡i Ges B‡jKUªwbK WKy‡g›U mvP© Ges †bwf‡Mkb wdPvi †hgb B‡jKUªwbK wjsK Aš—f©~³ K‡i 

†cv÷w¯7Þ †cRmg~n‡K GKiƒc Ki‡Z| d‡Uvkc PDF di‡gU RGB, Indexed-color, CMYK, 

Grayscale Bitmap Ges Lab Color Mode mg_©b K‡i wKš‘ Avjdv P¨v‡bj mg_©b K‡i bv | di‡gU 

JPEG Ges ZIP Kg‡cÖkb mg_©b K‡i Bitmap-mpde files e¨ZxZ, hv e¨envi K‡i CCITT group 4 

Compression hLb Photoshop PDF AvKv‡i †mf Kiv nq| Ab¨ A¨vwc−‡Kk‡b Kiv PDF dvBj I‡cb 

Ki‡j d‡Uvkc dvBj‡K †i÷vivBR K‡i| 

 
TIFF t 

TIFF (Tagged-Image File Format) dvBj di‡gU A¨vwc−‡Kkbmg~n Ges KgwcDUvi c−vUd‡g©i g‡a¨ 

dvBj wewbgq Ki‡Z e¨en„Z nq| TIFF nj Flexible weUg¨vc B‡gR di‡gU hv mgw_©Z nq me wcÖ›U, B‡gR 

GwWwUs Ges †cR †j-AvDU A¨vwc−‡Kkbmg~‡n| me †W·Uc ·¨vb K‡i TIFF di‡gU| TIFF di‡gU 

CMYK,RGB Ges Grayscale dvBjmg~‡K Avjvdv P¨v‡bj Qvov mg_©b K‡i Ges Lab, Indexed-color 

Ges Bitmap dvBjmg~n‡K Avjdv P¨v‡bj Qvov mg_©b K‡i| TIFF, LZW Kg‡cÖkb‡KI mg_©b K‡i| GWwe 

d‡Uvkc B‡gR‡K TIFF di‡g‡U †mf Kivi mgq AvBweGg KgwcDwUej bvwK †gwK‡›Uvk di‡gU †mf Kiv n‡e Zv 

wbaviY Kiv hvq| ¯^qsw7qfv‡e dvBj Kg‡cÖm Kivi Rb¨ LZW Compression ‡PK e‡· wK¬K K‡i () 

wbe©vPb Ki‡Z n‡e| TIFF dvB‡ji Kg‡cÖwms Gi dvBj mvBR †QvU K‡i wKš‘ I‡cb Ges †mf Kivi mgq e„w× 

K‡i| 
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‡cR †mU-Avc (Page Setup) Kiv 

wewfboe A¨vwc−‡Kkb wewfboe di‡gU mg_©b K‡i| dvBj †mf Ki‡j wewfboe A¨vwc−‡Kkb wewfboe di‡gU 

dvBj †mf K‡i | †hgbt GgGm Iqv‡W© dvBj †mf Ki‡Z Zv .DOC G·‡Ubkb hy³ n‡q †mf nq| d‡Uvkc 

GKwU kw³kvjx MÖvwd· md&U Iq¨vi| G‡Z G‡gR ˆZwi K‡i wewfboe A¨vwc−‡Kkb Dc‡hvMx wewfboe di‡gU †mf 

Kiv hvq| 

 

cÖ‡qvM wewa t 

‡h B‡gRwU‡K wfboe di‡g‡U †mf Kiv `iKvi †mwU A¨vKwUf Ki‡Z n‡e 

File > Save / File > Save As.. wb‡ ©̀k w`‡Z n‡e ( Save As e· Avm‡e) 

File Name: Gi ’̄‡j bvg Ges Save in: G wW‡i±ix wbw`ó Ki‡Z n‡e 

Save As Gi cv‡ki Wªc-WvDb evUb wK¬K Ki‡Z n‡e| Wªc-WvDb wj÷ Avm‡e 

ZvwjKv †_‡K di‡gU wbe©vPb K‡i Save evU‡b wK¬K K‡i dvBjwU †mf Ki‡Z n‡e| 

d‡Uvk‡c B‡gR ˆZwi K‡i †jRvi wcÖ›Uv‡i KvM‡R AvDUcyU †bqv nq; †hgb t 

File >Page Setup.. wb‡ ©̀k w`‡Z n‡e| d‡j †cR †mU-Avc WvqjM e· Avm‡e 

Bb÷jK…Z wcÖ›Uv‡ii bvg wm‡j± Ki‡Z n‡e 

wc›Uv‡ii wewfboe Ackb wbe©vPb Ki‡Z n‡e 

KvM‡Ri mvBR, †mvm© Ges Dc¯’vcbv BZ¨vw` KvR mgvß K‡i OK evUb wba©viY Ki‡Z n‡e| 
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Aa¨vq-10  
Kw¤úDUvi nvW©Iq¨vi GÛ UªvejmywUs 

Computer Hardware and Troubleshooting 

 

f~wgKv : Kw¤úDUv‡ii †h Ask †`Lv hvq Ges ¯úk© Kiv hvq †mB Ask‡K nvW©Iq¨vi e‡j| Kw¤úDUvi 

KZK¸‡jv hš¿vs‡ki mgš^‡q MwVZ n‡q _v‡K| GB hš¿vsk¸‡jv‡K Kw¤úDUvi nvW©Iq¨vi ejv nq| GB 

hš¿vsk Øviv Kw¤úDUvi ˆZwi n‡jI Dnv mPj Ki‡Z md&UIq¨v‡i cÖ‡qvRb n‡q _v‡K|  
 

Kw¤úDUvi msMV‡bi cÖavb Ask  

 Kw¤úDUvi msMV‡bi cÖavb Ask wZbwU 

1. BbcyU wWfvBm (Input Device) 

2. cÖ‡mwms BDwbU (Processing Unit) 

3. AvDUcyU wWfvBm (Output Device) 
 

Kw¤úDUv‡i nvW©Iq¨vi mgm¨v ej‡Z mvaviYZ Dc‡iv³ wZbwU As‡ki mgm¨v n‡q _v‡K| wZbwU 

Ask m¤ú‡K© avibv _vKv cÖ‡qvRb|  

Kw¤úDUv‡i `yÕai‡bi mgm¨v n‡q _v‡K 

 nvW©Iq¨vi mgm¨v 

 mdU&Iq¨vi mgm¨v 

GKwU Kw¤úDUv‡ii mvaviYZ wbgœewY©Z cÖavb Ask mg~n _v‡K| 

1. System Unit 

2. Display Unit ev gwbUi  

3. Input Unit ev Keyboard, Mouse 

4. Output Unit ev Printer, Plotter etc. 

wm‡÷g BDwbU (System Unit)  

 mvaviYZ wm‡÷g BDwb‡Ui g‡a¨ wbgœewY©Z Ask¸‡jv _v‡K| 

1. Motherboard 

2. Processor 

3. RAM 

4. Hard Disk Drive (HDD) 

5. Power Supply Unit (PSU) 

6. CD/DVD  

7. Various types of card 

8. Various types of  cable (IDE/SATA) 

9. Floppy Disk Driver 

10. CMOS Battery  
 

gv`vi‡evW© (Motherboard) 

 Kw¤úDUv‡ii gv`vi‡evW© me‡P‡q ¸i“Z¡c~Y© Ask| gv`vi‡ev‡W©i Dci cÖ‡mmi, i¨vg, wm‡gvm 

e¨vUvwi, wewfbœ ai‡bi KvW©, gv`vi‡ev‡W©i mv‡_ K¨vej jvMv‡bvi K‡›Uªvjvi BZ¨vw` emv‡bv _v‡K| ZvQvovI 

gv`vi‡ev‡W© Kx‡evW©, gvDm, wcÖ›Uv‡ii †cvU© emv‡bv _v‡K| 
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M 

 gvB‡µvcÖ‡mmi (Micro Processor) 

 cÖ‡mmi‡K A‡bK mgq CPU ev Central Processing Unit ejv nq| Processor ‡K 

Computer Gi Brain wnmv‡e AvL¨vwqZ Kiv nq| wmwcBD AmsL¨ Register Gi mgš^‡q MwVZ n‡q 

_v‡K| GB  Register n‡”Q GK GKwU wd¬c-d¬c hv 8 bit ev 16 bit n‡q _v‡K| eZ©gv‡b evRv‡i B‡›Uj, 

GGgwW cÖ‡mmi mPvivPi cvIqv hvq| Z‡e Avgv‡`i †`‡k 

B‡›Uj cÖ‡mmi eûjfv‡e e¨eüZ n‡q _v‡K| e¨enviKvixi 

myweavi Rb¨ Kg `v‡gi cÖ‡mmi cvIqvi wbwg‡Ë B‡›Uj 

†Kv¤úvbx ‡m‡jiY cÖ‡mmi evRv‡i †Q‡o‡Q| GB cÖ‡mmi 

Øviv mvaviY e¨enviKvix me ai‡bi KvR Ki‡Z cvi‡e| 

Bnv B‡›Uj ‡cw›Uqvg cÖ‡mm‡ii †P‡q `v‡g ‡ek m¯—v | 

wewfbœ MwZ m¤úbœ cÖ‡mmi evRv‡i cvIqv hvq| †hgb : 

2.53 GHz, 2.80 GHz, 3.0 GHz , Doul core, 

Core 2 Duo.  

i¨vg (RAM)   

  i¨vg †mwgKÛv±i cªhyw³‡Z ˆZwi Kw¤úDUv‡ii GKwU 

A ’̄vqx †g‡gvwi| i¨vg‡K KwgDUv‡ii IqvK© †¯úm ejv nq| 

i¨v‡g †h †Kvb mgq †h †Kvb Z_¨ †jLv hvq,cov hvq, 

cÖ‡qvR‡b gyQv hvq| GRb¨ i¨vg‡K wjLb cVb †g‡gvwiI ejv 

nq| Avgiv †h WvUv¸‡jv BbcyU Kwi Zv cÖ_‡g i¨v‡g Rgv 

nq| Gici cÖ‡mmi i¨vg †_‡K ‡WUv wb‡q cÖ‡mm K‡i i¨v‡g 

w`‡q †`q| Gici Avgiv gwbU‡i †`L‡Z cvB| RAM bó 

n‡j gwbU‡i †Kvb wWm‡c­  Avm‡e bv | Uvbv kã w`‡Z cv‡i| 

eZ©gv‡b 256 MB, 512MB, 1 GB ev D”PZi †KcvwmwU 

Gi DDR, DDR-2 i¨vg evRv‡i cvIqv hvq | Kw¤úDUv‡ii 

MwZ A‡bKvs‡k i¨v‡gi cwigv‡bi Dci wbf©i K‡i| 

gwbUi (Monitor)  

 Kw¤úDUv‡ii hveZxq Kvh©µg‡K cÖ`k©‡bi Rb¨ †h c`©v 

e¨envi Kiv nq Zv‡K mnR fvlvq gwbUi e‡j| c`©vq †h Qwe 

cÖ`wk©Z nq Zv ¶z`ª ¶z`ª WU Gi mgvwói cÖwZ”Qwe| GB WU¸‡jv‡K 

wc‡·jm e‡j| cÖhyw³i Dci wbf©i K‡i gwbU‡K `yB fv‡M fvM 
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Kiv nq| 1. K¨v_W iwk¥ wUDe gwbUi  2. d¬vU c¨v‡bj gwbUi| 

wcÖ›Uvi (Printer)   

 wcÖ›Uvi GKwU AvDUcyU wWfvBR, Kw¤úDUv‡i Z_¨ cÖwµqvKi‡Yi djvdj‡K wjwLZ AvKv‡i cvIqvi 

Rb¨ wc›Uvi e¨envi Kiv nh| wcÖ›Uvi `yai‡bi n‡q _v‡K| h_v t 1. 

ms¯úk© (Impact) wcÖ›Uvi 2. Ams¯úk© (Non-impact) wcÖ›Uvi| 

†h wcÖ›Uv‡i wcª›U‡nW KvMR‡K ¯úk© K‡i Zv‡K ms¯úk© wcÖ›Uvi e‡j| 

†hgb t WU g¨vwUª· wcÖ›Uvi, †WBwR ûBj wcÖ›Uvi BZ¨vw`| †h 

wcÖ›Uv‡ii wcÖ›U‡nW KvMR‡K ¯úk© K‡i bv Zv‡K Ams¯úk© wcÖ›Uvi 

e‡j| G wcÖ›Uv‡i Zvc, Av‡jv, Zwor kw³ BZ¨vw`i mvnv‡q¨ KvM‡R 

Kvwji  AvPo dzwU‡q †Zvjv nq| †hgb t †jRvi wcÖ›Uvi, B¼ †RU 

wcÖ›Uvi| 

 

nvW© wW¯‹ (Hard Disk)  

Bnv Kw¤úDUv‡ii GKwU eo †÷v‡iR wWfvBm| Bnvi g‡a¨ A‡bK 

‡WUv ivLv hvq| Kw¤úDUv‡i KvR Kivi ci ‡mf Ki‡j mvavibZt nvW©wW‡¯‹ 

’̄vqxfv‡e Rgv _v‡K| Kw¤úDUvi Ad Ki‡jI nvW©wW‡¯‹ Rgv _vKv Z_¨ gy‡Q 

hvq bv| Gi aviY ¶gZv eZ©gv‡b 80 †_‡K 250 wMMvevBU-Gi Dci ch©š— 

n‡q _‡K| 

cvIqvi mvc­vB BDwbU (Power Supply Unit)  

 cvIqvi mvc­vB DBwbU 220 AC †fvë‡K DC †fv‡ë iƒcvš—wiK K‡i Kw¤úDUv‡ii wewfbœ 

K‡¤úvb¨v‡›U mieivn K‡i| cvIqvi mvc­vB DBwbU mvaviYZt 250 Watt ev Zvi †ewk ¶gZvi n‡q _v‡K| 

cvIqvi mvc­vB DBwb‡Ui mgm¨v †`Lv w`‡j mvaviYZ t wm‡÷g BDwb‡U †Kvb cvIqvi Avm‡e bv, Z‡e ‡Kvb 

†Kvb †¶‡Î wm‡÷g BDwb‡U cvIqvi Avm‡jI gwbU‡i wWm‡c­ n‡e bv|  

 

Kw¤úDUvi nvW©Iq¨v‡ii wKQy mgm¨v I mgvavb wb‡gœ †`qv n‡jv 

mgm¨v :  Drive Not Ready/ Hard Disk Controller Faillure  

mgvavb :  

 ev‡qvm †mUAvc G wW‡U± K‡i‡Q wKbv †`L‡Z n‡e |  

 hw` bv K‡i Zvn‡j nvW©wW‡¯‹i WvUv K¨vejwU Dfq cv‡kB wVKfv‡e jvwM‡q †`Lv †h‡Z cv‡i|  

 WvUv K¨vejwU cwieZ©b K‡i †`Lv †h‡Z cv‡i |  

 gv`vi †ev‡W©i mv‡_ mshy³ nvW©wW‡¯‹i †KejwU K‡›Uªvjvi cwieZ©b K‡i †`Lv †h‡Z cv‡i  

 nvW©wW‡¯‹i cvIqvi K¨vej cwieZ©b K‡i †`Lv †h‡Z cv‡i| 

 nvW©wW¯‹wU cwieZ©b Ki‡Z n‡e | 

mgm¨v : Non System Disk or Disk Error (Only Display C> / Missing Operating  

System)  

mgvavb :  

 Bootable CD  n‡Z  System Kwc K‡i  nvW©wW‡¯‹ w`‡q Kw¤úDUvi Restart K‡i †`Lv †h‡Z 

cv‡i | 

 Hard Disk Detect K‡i †`Lv †h‡Z cv‡i | 

 Hard Disk Format K‡i †`Lv †h‡Z cv‡i |  

 nvW©wW¯‹wU cwieZ©b Ki‡Z n‡Z cv‡i |  
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mgm¨v  Hard Disk Failure / Data Error Reading Drive C:  

mgvavb : 

 nvW©wW¯‹wU Ab¨ †Kvb Kw¤úDUv‡i Scandisk  ev Norton Disk Doctor Øviv  Repair K‡i 

†`Lv †h‡Z cv‡i |  

 Format Kiv †h‡Z cv‡i |  

mgm¨v : wKQy¶Y Kw¤úDUvi Pjvi ci Hang  n‡q hvq  

mgvavb : 

 cÖ‡mm‡ii Dci Kzwjs d¨vbwU wVKfv‡e Nyi‡Q wKbv Zv †`L‡Z n‡e|  

 RAM cwieZ©b K‡i †`Lv †h‡Z cv‡i | 

 cÖ‡mmi cwieZ©b K‡i †`Lv †h‡Z cv‡i |  

 bZzbfv‡e mdUIq¨vi BÝUj K‡i †`Lv †h‡Z cv‡i |  

mgm¨v :  Invalid Media Drive  

mgvavb :  Hard Disk Gi Partition wVK Av‡Q wKbv Zv †`L‡Z n‡e| hw` cvwU©kb bv _v‡K Zvn‡j 

bZzb K‡i cvwU©kb Ki‡Z n‡e |  

mgm¨v : System can not be read from specified drive  

mgvavb : nvW©wW¯‹wU Format K‡i wm‡÷g w`‡q †`Lv †h‡Z cv‡i | 

mgm¨v :  Illegal Operation  

mgvavb :  DB‡ÛvRwU cybivq BÝUj K‡i †`Lv †h‡Z cv‡i |  

mgm¨v : System Regisrty Error 

mgvavb :  DB‡ÛvRwU bZzb K‡i  Install K‡i †`Lv †h‡Z cv‡i |  

mgm¨v :  wcÖ›Uv‡i wcÖ›U †`Iqvi mgq weiwZnxb kã Ki‡Z _v‡K (WU †gwUª· wcÖ›Uv‡ii †¶‡Î)  

mgvavb t   

 wcÖ›Uv‡ii Paper Release Dc‡i †Zvjv _vK‡j Gi“c kã w`‡Z cv‡i | †ccvi wiwjR wcÖ›Uv‡ii 

Wvb cv‡k _v‡K| Bnv Zz‡j KvMR wVK Kiv hvq| ZvB hw` Bnv †Zvjv _v‡K Zvn‡j bvwg‡q w`‡Z 

n‡e| Zvn‡j Avi kã Ki‡e bv| 

mgm¨v :  Printer is not Responding  

mgvavb : 

 cvIqvi Kv‡bKkb †`L‡Z n‡e | 

 K¨vej Lvivc n‡Z cv‡i | 

 †cvU© Lvivc n‡Z cv‡i  |  

 Acv‡iwUs wm‡÷g Lvivc n‡Z cv‡i | 

 wcÖ›Uvi †mUAvc wVKfv‡e bv Kiv _vK‡j| 

mgm¨v : wcÖ›Uv‡i wcÖ›U †`qvi mgq KvMR Uv‡b bv  

mgvavb : 

 wcÖ›Uvi †mUAvc wVKfv‡e bv Kiv _vK‡j| 

 wcÖ›Uv‡ii †mÝ‡ii mgm¨v n‡Z cv‡i |  

 wieb wQu‡o †h‡Z cv‡i ev KvwU©R Gi Kvwj †kl n‡q †h‡Z cv‡i |  

mgm¨v : gvD‡mi c‡q›Uvi wVKfv‡e bovPov K‡i bv   

mgvavb t  
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 gvDmwU Ly‡j Dnvi g‡a¨Kvi ejwU †ei Ki‡Z n‡e | Zvici cwi¯‹vi K‡i wVKfv‡e Avevi jvwM‡q 

†`L‡Z n‡e |  

 gvD‡mi wfZ‡ii i“jvi¸‡jv cwi¯‹vi Ki‡Z n‡e| 

mgm¨v : gwbU‡i cvIqvi Av‡Q wKš— wm‡÷g BDwb‡U Av‡jv bvB (wm‡÷g BDwbU n‡Z gwbU‡i cvIqvi jvBb †`qv 

Av‡Q) 

mgvavb : 

 wm‡÷g BDwb‡Ui cvIqvi mvc­ vB BDwb‡Ui d¨vb wVK fv‡e Nyi‡Q wKbv Zv ‡`L‡Z n‡e |  

 cvIqvi mvc­ vB BDwbU n‡Z cvIqvi Kv‡bKkb gv`vi †ev‡W© wVKfv‡e jvM‡Q wKbv Zv †`L‡Z 

n‡e|  

 wm‡÷g BDwb‡Ui cvIqvi Kv‡bKkb¸‡jv Ly‡j cybvivq jvMv‡q †`Lv †h‡Z cv‡i |  

 cvIqvi mvc­ vB BDwbU cwieZ©b Kiv jvM‡Z cv‡i| 

mgm¨v : gwbUi I wm‡÷g BDwb‡U cvIqvi Av‡Q  A_P †Kvb wKQy †`Lv hvq bv A_©vr †Kvb     

  Display bvB|  

mgvavb : 

 wm‡÷g BDwb‡Ui mv‡_ gwbU‡ii †h Display K¨vej i‡q‡Q Zv Ly‡j wVKfv‡e jvMv‡Z n‡e|  

 Display Card  wU Ly‡j Avevi wVKfv‡e jvMv‡Z n‡e | 

 RAM wU Ly‡j wVKfv‡e jvMv‡Z n‡e | Ab¨ ¯­ ‡U (Slot) jvMv‡bv †h‡Z cv‡i | 

 Display Card I RAM wU cwieZ©b K‡i †`L‡Z n‡e | 

 gwbUiwU cwieeZ©b K‡i †`Lv †h‡Z cv‡i | 

 ZvQvovI gv`vi †evW© I cÖ‡mmi bó n‡j gwbU‡i †Kvb Display Avm‡e bv | 

 cvIqvi mvc­ vB BDwb‡&Ui Kv‡bKkb¸‡jv wVKfv‡e jvMv‡bv Av‡Q wKbv †`L‡Z n‡e| 

mgm¨v : CMOS Battery State Low  

mgvavb :  wm‡gvm e¨vUvwiwU cwieZ©b Ki‡Z n‡e | 

mgm¨v : CD/DVD †_‡K  Audio Mvb ev‡R bv A_P Vedio Gi Mvb ev‡R  

mgvavb : CD/DVD ROM Gi mv‡_ mshy³ AwWI K¨vejwU gv`vi †evW© ev mvDÛ Kv‡W©i mv‡_ 

wVKfv‡e jvMv‡Z n‡e |  

mgm¨v : w¯úKv‡i wVKgZ mvDÛ Av‡m bv  

mgvavb : 

 w¯úKviwU Lvivc n‡Z cv‡i | 

 mvDÛ KvW©wU wVKfv‡e Install K‡i †`Lv †h‡Z cv‡i |  

 Mvb evRv‡bvi Ab¨ ‡Kvb Software Install  K‡i †`Lv †h‡Z cv‡i |  

mgm¨v : wmwW/wWwfwW i‡g wW¯‹ wVKgZ co‡Z cv‡i bv  

mgvavb :  wmwW wK¬bvi w`‡q WªvB‡fi †jÝ cwi¯‹vi K‡i †`Lv †h‡Z cv‡i|  

Scandisk Pvjv‡bvi wbqg  

‰e ỳ¨wZK ev AmveavbZvi mv‡_ Pvjv‡bvi Kvi‡Y KgwcDUv‡ii Harddisk G wKQy jwRK¨vj mgm¨v 

†`Lv w`‡Z cv‡i| hvi d‡j Kw¤úDUv‡ii MwZ ax‡i ax‡i Kg‡Z _v‡K Ges GK ch©v‡q nvW©wW¯‹ bó n‡q 

KgwcDUvi APj n‡q †h‡Z cv‡i | ZvB GB nvW©wW‡· jwRK¨vj mgm¨v mgvavb Kivi Rb¨ wbqwgZ 

Scandisk Program Pvjv‡Z nq | Dnv Pvjv‡bvi wbqg n‡jv  

 Start  Programe           Accessories     System Tools Scandisk 

Click        Drive Select         Start Click Gici GwU †kl n‡j GKwU wi‡cvU© ‡`Lv‡e| Zvici 

†K¬vR Ki‡Z n‡e | GQvovI Ab¨ wbq‡gI Scandisk Program Pvjv‡bv hvq| 
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Defragment Pvjv‡bvi wbqg  

 Kw¤úDUv‡i mPvivPi †h dvBj¸‡j Save (msi¶b) Kiv nq †mB dvBj¸‡jv wewfbœ RvqMvq 

Qwo‡q wQwU‡q _v‡K| d‡j A‡bK w`b ci KgwcDUvi Av‡¯— Av‡¯— Slow n‡q hvq| ZvB GB Ae¯’v n‡Z 

i¶v †c‡Z n‡j wbqwgZ Defragmenter Pvjv‡bv DwPZ| G‡Z KgwcDUv‡ii MwZ e„w× cv‡e| GwU 

Pvjv‡bvi wbqg n‡jv  
 

 Start            Programs            Accessories  System Tools  

Disk Defragmenter            Drive Select             Ok Click Dnv 100% †k‡l Close Click 

Ki‡Z n‡e |  

Anti-Virus Program Pvjv‡bvi wbqg  

 fvBivm GKwU ¶wZKviK †cÖvMÖvg| Gw›U-fvBivm †cÖvMÖvg mdU&Iq¨vi‡K †cÖv‡UKkb †`qvi Rb¨ 

ˆZwi Kiv nq | ZvB †Kvb KgwcDUv‡i †Kvb cÖKvi fvBivm cÖ‡ek Ki‡j Gw›U-fvBivm †cÖvMªvg  Pvwj‡q GwU 

`~i Ki‡Z nq |  

wewfbœ ai‡bi Gw›U -fvBivm †cÖvMÖvg i‡q‡Q| †hgb t 
 

 F-secure Anti-virus Corporate Suit. 

 Symantec Norton Antivirus. 

 Kaspersky. 

 Mcafee 

 Avast antivirous. 

 Grisoft AVG Anti-virus 

 Panda Antivirus  

 PC Cillin Anti Virus. 
 

PC-Cillin Anti Virus Program Pvjv‡bvi wbqg   

 

 Start         Programs  PC-Cillin             PC-Cillin         Drive Select             

Scan now Click  Gici fvBivm Clean Kivi ci GwU Close  Ki‡Z n‡e |  
 

Office-2000 Install Kiv 

  Office-2000 Install Kiv Rb¨ CD/DVD ROM G wW¯‹ cÖ‡ek Kiv‡j wb‡gœi b¨vq  

GKwU WvqvjM e· Avm‡e  

         

                                  

 CD Key Gi 5wU N‡i CD/DVD Gi wba©vwiZ bv¤^vi UvBc Ki‡Z n‡e  
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 Next evU‡b Click Ki‡j Av‡iKwU WvqvjK e· Avm‡e| 

 accept the ...........Agreement Ack‡b Click K‡i Next evU‡b Click Ki‡j wb‡gœi b¨vq 

Av‡iKwU WvqvjK e· Avm‡e| 
 

               

 

  Install New evU‡b Click Ki‡j Ready to Install n‡q hv‡e|  

 Ab¨w`‡K Customize evU‡b Click Ki‡j cÖ‡qvRb Abyhvqx A‡bK wKQz ms‡hvRb A_ev 

we‡qvRb K‡i wb‡gœi c×wZ‡Z Bb÷j Kiv hv‡e| 

 Customize Ges Next evU‡b Click Ki‡j wb‡gœi WvqvjK e· Avm‡e| 

 

              

 Office Tools Ackb Lyj‡Z n‡e| GLvb †_‡K Equation Editor G gvDm c‡q›Uvi †i‡L 

Click Ki‡Z n‡e Ges Rum from my computer Ack‡b Click Ki‡Z n‡e| GKB wbq‡g 

Shortcut Bar Ges Photo Editor wm‡j± Ki‡Z n‡e| 

 Install New evU‡b Click Ki‡Z n‡e| Install †kl bv nIqv ch©š— A‡c¶v Ki‡Z n‡e| 

Install †kl OK evU‡b Click K‡i Office-2000 Setup †kl Ki‡Z n‡e|  

Office/Bijoy-2000 ev Ab¨ †Kvb mdUIq¨vi uninstall Kiv  
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 Start  Settings  Control Panel K‡i ‡h †cÖvMÖvg wW‡jU Ki‡ev Zv 

(Bijoy-2000) wm‡j± K‡i Change/Remove evU‡b Click Ki‡Z n‡e|  

 Yes evU‡b Click Ki‡Z n‡e|  

 OK evU‡b Click Ki‡Z n‡e|          
 

CD/DVD Gi gva¨‡g Bijoy-2000 Setup/Install Kiv  

 CD/DVD ROM G Bijoy-2000 Gi wW¯‹ cÖ‡ek Kiv‡j wb‡gœi b¨vq WvqvjM e· Avm‡e| 

 

            
 

 Install Bijoy-2000 ‡cÖvMÖvg evU‡b wK¬K Ki‡Z n‡e| 

 Next evU‡b wK¬K Ges Yes evU‡b Ki‡j wb‡gœi b¨vq WvqvjM e· Avm‡e| 

 

             
 

 User Information  WvqvjM e‡·i Serial Ack‡b 1111111 GB fv‡e Aš—Z 15wU 1 Type 

Ki‡Z n‡e|  

 Next evU‡b Click Ki‡Z n‡e| cybivq Next Click, Next Click Ki‡Z n‡e| 

 Restart  Kivi Rb¨ Finish evU‡b Click K‡i Setup †kl Ki‡Z n‡e|   
 

Abyi“cfv‡e Bijoy-2000 Installer WvqvjM e‡·i Bijoy-2000 Fonts ‡cÖvMÖvg evU‡b wK¬K 

K‡i d›U Bb÷j Kiv hv‡e| 
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Aa¨vq-11 

 

e-Survey (On-line)form c~i‡Yi wb‡`©wkKv 

1| cÖ_‡g Internet Gi Browser G cÖ‡ek Kiæb| 

2|  www.banbeis.gov.bd/ Web site G cÖ‡ek Kiæb |  

3| Avcbvi mvg‡b Bangladesh Bureau of Educational Information and Statistics 

(BANBEIS) Gi wbgœiƒc Home page cÖ`wk©Z n‡e| 

4| Gevi Dc‡i Wvb †Kvbvq jvj †Mvj wPwýZ e-survey Menu ‡Z Click Kiæb| 

 

 

5| Login/Sign in Page cÖ`wk©Z n‡e| GLv‡b *BAvBAvBGb/BDRvi AvBwW e· G Avcbvi 

cÖwZôv‡bi EIIN b¤̂i wjLyb Ges *cvmIqv‡W©i e‡· 532688 wjLyb Ges mvBb Bb evUb 

G Click Kiæb| 

 

 

6|     bZzb Page Avm‡e| Gevi mivmwi ev AbjvB‡b Z_¨ c~iY, cwieZ©b ev †`Lvi Rb¨ GLv‡b 

Click Kiæb As‡k Click Kiæb| 

e-Survey 

http://www.banbeis.gov.bd/
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7| Gevi Avcbvi cÖwZôv‡b cÖ‡ek K‡i‡Qb wKbv Zv wbwðZ nDb| Dc‡i Wvb †Kvbvq Avcbvi 

cÖwZôv‡bi bvg cÖ`wk©Z n‡e| 
 

8| Avcbvi cÖwZôv‡bi EIIN w`‡q cÖ‡ek Kivi ci wb‡gœ cÖ`wk©Z bgybv mv „̀k¨ wKQy cÖkœ c~iY 

Kiv †`L‡eb| G‡¶‡Î c~iYK„Z Z‡_¨i †Kvb cwieZ©b cÖ‡qvRb n‡j cwieZ©b Kiæb| GQvov 

wKQy cÖkœ Lvwj ev dvuKv †`L‡eb, dvuKv Ask¸‡jv h_vh_fv‡e c~iY Kiæb| 1bs cÖ‡kœi ÕLÕ 

As‡ki  Select one e‡· Click K‡i wefvM, †Rjv, Dc‡Rjv, BDwbqb, †gŠRv Ges MÖvg 

Select Kiæb| cÖwZwU cÖ‡kœi e‡· cÖ‡e‡ki Rb¨ Tab button press Kiæb|wefvM †Rjv, 

Dc‡Rjv, BDwbqb, †gŠRv Ges MÖvg Select bv Ki‡j Data Gw›Uª n‡e bv| 
 

9| cÖ_g Page G cÖ‡hvR¨ ‡WUvmg~n Update Kiv n‡j bx‡Pi w`‡K Save and Go 

Forward Button G Click Kiæb Ges OK w`b| 
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10| Z_¨ mdjfv‡e msiw¶Z n‡q‡Q| cieZx© c„ôv >> /page tab G Click Kiæb | GLb 

wØZxq c„ôvq Xz‡K WvUv Avc‡WU Kiæb|  

 

 

Ges c~‡e©i b¨vq Save and Go Forward wjLvi Dci Click Kiæb Ges Ok w`b| 

 GB c×wZ‡Z me©‡kl c„ôv ch©šÍ †h‡Z n‡e Ges cÖwZ c„ôv †k‡l Save and Go Forward G 

Click Kiæb Ges evwni nIqvi Rb¨ Sign out Button G Click Kiæb|  

11|   me©‡kl cvZvq wk¶K-Kg©Pvix‡`i e¨w³MZ Z_¨Q‡K cÖwZwU wk¶‡Ki ‡WUv nvjbvMv` Kiæb,  

‡Kvb wkÿ‡Ki bvg ev` †`Iqvi cÖ‡qvRb n‡j H wkÿ‡Ki bvghy³ Row Wvbw`‡K (x) 

wPwýZ ¯’v‡b  Click Kiæb A_ev H wkÿ‡Ki bvghy³ Row select K‡i delete Kiæb 

Zvici GKB Row †Z bZzb wkÿ‡Ki bvg UvBc Kiæb|wk¶K‡`i wj½ Kjv‡g cyiæl 

wk¶‡Ki ‡¶‡Î cyiæl  Ges gwnjv wk¶‡Ki ‡¶‡Î gwnjv wbev©Pb Kiæb| †h mg Í̄ wk¶K‡`i 

bvg D³ ZvwjKvq AšÍf~©³ nqwb Zv‡`i Z_¨ Gw›Uª Kivi Rb¨ Add more evU‡b Click 

K‡i bZzb Row create K‡i Gw›Uª Kiæb Ges c~‡e©i b¨vq Save and Go Forward   

wjLvi Dci Click Kiæb| 

12| Avcbvi cÖwZôv‡bi Data Gw›Uªi KvR mgvß n‡j wcÖ›U Kivi Rb¨ me©‡kl c„ôvi bx‡P  Print            

evUb G Click K‡i mKj c„ôv GK mv‡_ wcÖ›U Kiv hv‡e| Awdwmqvj WKz‡g›U wnmv‡e 

cÖwZwU c„ôv wcÖ›U K‡i msi¶Y Kiæb| 

13| KvR Kivi mgq †Kvb KviYekZ we ỳ¨r P‡j †M‡j A_ev AvswkK Data Gw›Uª Kiv _vK‡j 

cybivq EIIN b¤̂i Ges Password w`‡q cÖ‡ek Ki‡Z n‡e|  

14|  Online G Data Gw›Uªi Amyweav ev civg‡k©i Rb¨ †hvMv‡hvM Kiæb †gvevBj : 

01914890508, 01911035297, 01711576333, 01552459071, 

01552339231, 01817095377Ges 8631123| 
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Aa¨vq-12 

Kw¤úDUvi wel‡q eûj e¨eüZ wKQz k‡ãi msw¶ß e¨vL¨v  

‡M­vmvwi (GLOSSARY) 

 

µwgK  ‡M­vmvwi kã ‡M­vmvwi k‡ãi msw¶ß e¨vL¨v 

01 Abacus A¨vevKvm GKwU cÖvPxb MYbhš¿| A‡b‡K G‡K cÖ_g wWwRUvj ev AsK wfwËK 

MYbvhš¿ e‡j g‡b K‡i|  

02 Access ¯§„wZ fvÛv‡i byZb Z_¨ †jLv ev wjwLZ Z_¨ Luy‡R †ei Kivi Rb¨ †g‡gvwi †mj 

¸wji m‡½ ms‡hvM ’̄vcb Kiv|  

03 Address †Kvb we‡kl †g‡gvwi †m‡ji cwiPq ÁvcK b¤^i|  

04 Algorithm Kw¤úDUv‡ii mvnv‡h¨ †Kvb mgm¨v mgvav‡bi ch©vq µwgK wjwLZ avc|  

05 ALU Arithmatic Logic Unit K_vi msw¶ß iƒc| GwU GKwU B‡jKUªwbK mvwK©U 

Ges Gi mvnv‡h¨ Kw¤úDUv‡ii hveZxq MvwYwZK I hyw³g~jK mgm¨v mgvavb 

Kiv nq|  

06 Array GKB ai‡bi †fwi‡qe‡ji g¨vwUª· wn‡m‡e mvRv‡bv mviYx| GB mviYx‡Z 

mvRv‡bv †fwi‡qej¸wj me GKB Bs‡iwR A¶i w`‡q †jLv nq| cÖwZwU 

†fwi‡qej‡K Avjv`v K‡i †Pbvi Rb¨ A¶‡ii m‡½ wewfb mvwd· (Suffix)    

e¨envi Kiv nq| 

07 BASIC Beginers All-Purpose Symbolic Instruction Code K_vwUi msw¶ß 

iƒc| me©vwaK RbwcÖq gvB‡µvKw¤úDUvi G e¨eüZ †cÖvMÖvwgs| nvB †j‡fj 

j¨vs¸‡qR| 

08 Batch 

Processing 

Kw¤úDUvi †cÖvMÖvwgs Gi GKwU wekl c×wZ| GwU GKwU Ad jvBb cÖ‡mwms 

c×wZ | G c×wZ‡Z GKB ai‡bi Z_¨, †hgb evwYwR¨K †jb‡`b cÖf„wZ, GK 

m‡½ cÖ‡mm Kiv nq|   

09 Binary GKwU we‡kl msL¨v c×wZ, hv‡Z gvÎ ỳwU AsK 1 Ges 0 Gi gva¨‡g mg¯— 

msL¨v cÖKvk Kiv nq| wWwRUvj Kw¤úDUvi GB msL¨v c×wZi mvnv‡h¨B MYbv 

Kvh© m¤úbœ K‡i| evBbvwi c×wZi wfwË n‡jv 2| 

10 BIT weU ej‡Z evBbvwi AsK 0 ev 1 A_ev GKwU AsK ivLvi RvqMv eySvq BIT 

kãwU Binary Gi Bi Ges Digit Gi t wb‡q MwVZ|  

11 Block 

Diagram 
‡d¬v-Pv‡U©i GKwU we‡kl iƒc, †hLv‡b †KejgvÎ ¸i“Z¡c~Y© wb‡ ©̀k¸wj 

cÖ`k©b Kiv _v‡K| 

12 BUS Kw¤úDUvi mvwK©‡Ui Z_¨ Ges wb‡ ©̀k cwienbKvix we ỳ¨r cwievnx c_| 

13 Byte AvU weU (Bit) evBbvwi Z_¨ wgwj‡q GK evBU (Byte) Z_¨ ˆZwi nq| 

Kw¤úDUvi ¯§„wZ fvÛv‡ii avib ¶gZv evBU GK‡K cÖKvk Kiv nq| 

 

14 Chip wmwjK‡bi AZ¨š— cvZjv Ges †QvU AvqZ‡¶ÎvKvi UzK‡iv, hvi Dci 

IC, LSI Ges VLSI c×wZ‡Z AwZ ¶z ª̀vwqZ mvwK©U ˆZwi nq| eZ©gv‡b 

mg¯— IC, LSI Ges VLSI-†K wPc e‡j AwfwnZ Kiv nq| 
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bs 
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15 Circuit B‡jKwUªK¨vj Ges B‡jKUªwbK hš¿vsk Ry‡o †Kvb we‡kl Kv‡Ri Rb¨ ˆZwi 

ˆe`y¨wZK eZ©bx| 

16 CMOS Complementary Metal Oxide Semiconductor K_vwUi msw¶ß 

iƒc| GwU IC ˆZwii we‡kl cÖhyw³| Kw¤úDUv‡i hLb we`y¨r cÖevn eÜ _v‡K 

ZLb Kw¤úDUvi hveZxq Setup †K mPj Kivi Rb¨ G e¨vUvwi cÖ‡qvRb| 

17 COBOL Common Business Oriented Language K_vwUi msw¶ß iƒc 

COBOL| GwU e¨emv msµvš— mgm¨v mgvavb Kivi Rb¨ we‡kl fv‡e wjwLZ 

nvB †j‡ej Kw¤úDUvi †cÖvMÖvwgs fvlv| G fvlvq ms‡KZ †_‡K mvavib Bs‡iwR 

k‡ãi e¨envi †ewk, ZvB †cÖvMÖvg c‡o hviv Kw¤úDUvi †cÖvMÖvwgs Av‡`Š Rv‡bb 

bv ZvivI A_© eyS‡Z cv‡ib| 

18 Core d¨vivB‡Ui (GK ai‡bi Pz¤̂K c`v_©) ˆZwi cyuwZ (Bead) 

19 Core Storage d¨ivBU cuywZi Pz¤^K †¶Î cwieZ©b K‡i wWwRUvj Z_¨ Rwg‡q ivLvi e¨e ’̄v| 

20 Compiler GwU GKwU we‡kl Abyev`K mdUIq¨vi †cÖvMÖvg| hv nvB †j‡ej fvlvi Drm 

†cÖvMÖvg‡K Ae‡R± Awi‡q‡›UW †cÖvMÖv‡g Abyev` Kivi KvR K‡i| 

21 Computer GwU GKwU B‡jKUªwbK hš¿, hv‡Z wb‡`©k Ges Z_¨ BbcyU w`‡j †mwU †Kvb 

we‡kl mgm¨vi mgvavb K‡i djvdj Rvwb‡q †`q| 

22 Cursor Vedio Display Output (VDO) ¯Œx‡bi †h RvqMvq Kw¤úDUvi bZzb 

K¨v‡i±vi dzwU‡q Zzj‡e, †mB ’̄vb wb‡`©kKvix µgvMZ R¡j‡Z wbf‡Z _vKv †QvU 

AvqZ‡¶ÎvKvi Av‡jvK wPý| 

23 Data Kw¤úDUvi MYbv Kv‡h©i Rb¨ cÖ‡qvRbxq Z‡_¨i KuvPvgvj| GwU †cÖvMÖvwgs Gi 

mgq Kw¤úDUv‡i XywK‡q †`qv nq A_ev MYbv Kvh© PjvKvjxb †hvMvb †`Iqv 

nq| 

24 Data 

Processing 

Kw¤úDUv‡ii mvnv‡h¨ Z_¨ MÖnY Ges we‡k­lY K‡i djvdj e‡j †`Iqvi 

c×wZ| 

25 Decimal Bnv `kwgK msL¨v c×wZ| G c×wZ‡Z `kwU g~j msL¨v Av‡Q (0 †_‡K 9 

Aewa) 

26 Digital (1) msL¨vi mvnv‡h¨ KvR K‡i Ggb hš¿ ev c×wZ| 

(2) evBbvwi msL¨vi mvnv‡h¨ KvR K‡i Ggb hš¿ ev c×wZ| 

27 Diskette Floppy Disk Gi Aci bvg|  

28 Display cÖvMÖvg, wb‡`©k Ges Z_¨‡K Pv¶zm fv‡e dzwU‡q †Zvjvi hš¿, †hgb LED   

wW‡m‡c­, VDUL, CD BZ¨vw`| 

29 DOS Disk Operating System K_vwUi msw¶ß iƒc| Bnv GKwU eY©wfwËK 

Acv‡iwUs wm‡÷g| 

30 Drive wiW/ivBU †n‡Wi mvg‡b w`‡q Pz¤^K wd‡Z‡K †U‡b wb‡q hvevi hvwš¿K e¨e¯’v| 

31 Edit †cÖvMÖv‡gi welqe¯‘ cwieZ©b ev m¤úv`bv Kiv| 

 

32 Enter Kw¤úDUv‡i GKwU Kvh© wbe©v‡ni Rb¨ wb‡`©k cÖ`vb K‡i|  

33 False ‡Kvb DËi ev Ae ’̄v, †hwU Kw¤úDUvi KZ©„K wg_¨v e‡j we‡ewPZ| G‡K evBbvwi 

0 Øviv cÖKvk Kiv nq| 
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34 File ci¯úi m¤^wÜZ Z‡_¨i mgwó| 

35 Firmware ’̄vqx ROM ¯§„wZ fvÛv‡i XywK‡q †`Iqv †cÖvMÖvg (Software) †K eySvq| 

36 Flip Flop we‡kl B‡jKwUªK mvwK©U, hv B”Qv gZ evBbvwi 1 wK¤v̂ evBbvwi 0 Ae ’̄vq †i‡L 

†`Iqv hvq| GB mvwK©U‡K RAM ¯§„wZ fvÛv‡ii ¯§„wZ †Kvl wnmv‡e e¨envi 

Kiv nq| 

37 Floppy Disk Pz¤K̂ c`v‡_©i cÖ‡jc jvMv‡bv cvZjv wW¯‹, 45 RPM †iK‡W©i g‡Zv c­vwó‡Ki 

‡PŠ‡Kv Lv‡c fiv _v‡K| G wW‡· Kw¤úDUv‡ii Z_¨ I †cÖvMÖvg †iKW© Kiv nq| 

38 Flow Chart ‡Kvb we‡kl mgm¨v hyw³ MÖvn¨ c_ a‡i mgvavb Kivi mwPÎ weeiY| 

39 Function GwU GKwU cÖwµqv, hv‡Z Kw¤úDUvi †Kej gvÎ GK ev GKvwaK MvwYwZK gvb 

MÖnY K‡i Zvi mvnv‡h¨ GKwU MvwYwZK wµqv m¤úbœ K‡i Ges DËi e‡j †`q| 

40 Gate evBbvwi AsK Klvi Kv‡R e¨eüZ we‡kl myBwPs B‡jKwUªK mvwK©U| 

41 Graphics Kw¤úDUv‡ii mvnv‡h¨ Qwe AvKvi e¨e¯’v| 

42 Hard Copy wcÖ›Uv‡ii KvM‡R Qvcv‡bv welqe ‘̄| 

43 Hardware Kw¤úDUvi Ges Zvi m‡½ jvMv‡bv `„k¨gvb mg¯— iKg hvwš¿K mshyw³| 

44 IBM International Business Machines c„w_exi e„nËg Kw¤úDUvi wbg©vYKvix 

cÖwZôvb|  

45 Impact 

Printer 

‡h mg¯— Kw¤úDUvi wcÖ›Uv‡i wcÖ›U †nW KvMR‡K av°v w`‡q wcÖ›U K‡i|   

46 Ink Jet 

Printer/Bubb

le Tet Printer 

KvM‡Ri Dci Kvwji †dvqvivi mvnv‡h¨ dzUwK Gu‡K Gu‡K †jLv Qvcv‡bvi hš¿| 

  

47 Input ‡cÖvMÖvg, wb‡`©k ev Z_¨‡K BbcyU wWfvBm wK¤v̂ evowZ ¯§„wZ fvÛvi †_‡K      

Af¨š—ixY ¯§„wZ fvÛv‡i cvVv‡bvi cÖwµqv|  

48 Instruction Kw¤úDUvi‡K †Kvb we‡kl KvR Ki‡Z ejvi mvs‡KwZK wb‡`©k (Keyword)| 

49 Integer c~Y© msL¨v †hgb 47, 8, 3, 1 BZ¨vw`| 

50 I/O Input/Output K_vwUi msw¶ß iƒc| 

51 Joystick wfwWI †Mg †Ljv‡Z †L‡jvqv‡oi Ae¯’vb wbqš¿‡Yi Rb¨ e¨eüZ wjfvi jvMv‡bv 

B‡jKUªwbK hš¿| 

52 Key-Board UvBc ivBUv‡ii gZ †`L‡Z wewfbœ K¨v‡i±vi Ges KgvÛ †jLvi GKwU wWfvBm 

Gi †evZvg wU‡c Kw¤úDUv‡i KvR Ki‡Z nq| 

53 Language Kw¤úDUvi †cÖvMÖvg Kivi fvlv| 

54 Line Printer ‡h wcÖ›Uv‡i GKev‡i GKwU cy‡iv jvBb Qvcv nq| 

55 Logic ‡Kvb ỳwU NUbvi g‡a¨ hyw³ MÖvn¨ m¤úK© ’̄vcb| 

56 Load evowZ ¯§„wZ fvÛvi †_‡K cÖavb ¯§„wZ‡Z †cÖvMÖvg ev Z_¨ D‡Ëvj‡bi KvR| 

57 Loop ‡cÖvMÖv‡gi GKwU Ask, hv‡K `yB ev Z‡ZvwaKevi cvjb Kiv nq| 

58 Machine 

Code 

Kw¤úDUv‡ii CPU †h fvlvq wb‡`©k eyS‡Z cv‡i| 

 

59 Memory ¯§„wZ fvÛvi| 

60 Merge `yB ev Z‡ZvwaK dvBj‡K GKwÎZ Kiv| 
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61 Micro 

Computer 

‡h Kw¤úDUvi GKwU gvB‡µv‡cÖv‡mmi (CPU) Ges ROM, RAM I I/O 

B›Uvi‡dm wPc Øviv MwVZ Zv‡K Micro Computer e‡j| 

62 Microproces

sor 
Very Large Scale Integration (VLSI) cÖhyw³i mvnv‡h¨ wbwg©Z wekvj 

RwUj mvwK©U Gi AwZ ¶z`ªvwqZ iƒc| †Kvb Kw¤úDUv‡i mg¯— IC GKwU gvÎ 

CPU wP‡c _vK‡j †mB wPc‡K Microprocessor e‡j| 

63 Mini 

Computer 

gvB‡µv Ges †gBb‡d«g Kw¤úDUv‡ii Aš—e©Zx© †kªYxi Kw¤úDUvi| 

  

 

64 Nemonic ‡gwkb j¨vs¸‡q‡R †cÖvMÖvg Kivi mgq e¨eüZ mvs‡KwZK kã, hvi mvnv‡h¨ 

†cÖvMÖvg mn‡R eyS‡Z cv‡i ev g‡b ivL‡Z cv‡i Kw¤úDUvi‡K wK wb‡`©k †`Iqv 

n‡”Q D”PvibwU n‡jv †b‡gvwbK| 

65 MODEM Modulator Ges Demodulator kã `yÕwUi msw¶ß iƒc| GB hš¿wU 

Kw¤úDUv‡ii wWwRUvj ms‡KZ‡K G¨vbvjM Ges G¨vbvjM ms‡KZ‡K wWwRUv‡j 

iƒcvš—i Ki‡Z cv‡i| Kw¤úDUv‡ii m‡½ g‡Wg jvwM‡q Kw¤úDUv‡ii Z_¨ 

mvaviY †Uwj‡dvb jvB‡bi gva¨‡g †hLv‡b Lywk cvVv‡bv hvq| Internet-Gi 

mv‡_ mshy³ nIqv hvq| 

66 Mouse B‡jKUªwb· hš¿ we‡kl| GwU GKwU Input wWfvDm| Gi mvnv‡h¨ Kw¤úDUv‡i 

wewfbœ wb‡`©kbv cÖ`vb Kiv hvq|   

67 NAND NOT Ges AND K_vwUi msw¶ß iƒc| GwU GKwU mve©Rbxb wWwRUvj jwRK 

†MU| 

 

68 Nano Second GK †m‡K‡Ûi GK kZ ‡KvwU fv‡Mi GK fvM (10
-9
 †m‡KÛ)| 

69 Network Kw¤úDUvi †_‡K Kw¤úDUv‡i †hvMv‡hvM ’̄vcb e¨e¯’v| 

70 NOR NOT Ges OR  K_vwUi msw¶ß| GwU GKwU mve©Rbxb wWwRUvj jwRK †MU| 

71 NOT wWwRUvj †MU we‡kl (Inverter) | 

72 OCR Optical Character Recognition K_vwUi msw¶ß iƒc| GKwU we‡kl 

BbcyU e¨e ’̄v †hwU Qvcv‡bv A¶i wK¤v̂ nv‡Zi †jLv co‡Z cv‡i| 

73 Octal 8 (Eight) i¨vwW· hy³ msL¨v c×wZ G‡Z †gvU AvUwU msL¨v Av‡Q 0, 1, 2, 

3, 4, 5, 5, 6, 7 Kw¤úDUvi †cÖvMÖvg †jLvi mgq A‡bK †¶‡Î e¨envi Kiv 

nq| G c×wZi wfwË 8| 

74| On line CPU Øviv wbqwš¿Z me©`v mPj hš¿ msµvš— e¨vcvi| GK Kw¤úDUv‡ii mv‡_ 

Ab¨ Kw¤úDUvi mshy³ _vKv ev Internet-Gi mv‡_ mshy³ _vKv‡K eySvq| 

75 Operating 

System 
mvgwMÖKfv‡e Kw¤úDUv‡ii KvR Kg© wbqš¿YKvix Software ev †cÖvMÖvg| 

 

76 OR GwU GKwU ‡gŠwjK jwRK †MU| 

77 Output Kw¤úDUv‡ii KvR Kivi c‡i hv cvIqv hvq| 

78 Output 

Device 

‡h h‡š¿i gva¨‡g Kw¤úDUv‡ii Kv‡Ri djvdj cvIqv hvq| 
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79 PASCAL nvB †j‡fj †cÖvMÖvwgs fvlv| weL¨vZ divmx MwYZÁ †e­ BR c¨vmKvj Gi 

bvgvbymv‡i Gi bvgKiY| 1970 mv‡j myBRvij¨v‡Û wb‡Kvjvm wi_ G fvlv 

ˆZwi K‡ib| FORTRAN Gi Zzjbvq mnR Avi BASIC Gi Zzjbvq 

kw³kvjx G msw¶ß †cÖvMÖvwgs fvlv wgwb Kw¤úDUv‡i †ewk e¨envi Kiv nq| 

80 Password dvB‡ji wbivcËvi Rb¨ e¨eüZ nq| ¯§„wZ fvÛv‡i msiw¶Z dvBj †_‡K Z_¨ 

covi Av‡M †m ms‡KZ evZ©v Kw¤úDUvi‡K Rvb‡Z nq| 

81 Path ‡Kvb †cÖvMÖvg Abymv‡i KvR Kivi mgq Kw¤úDUvi †h hyw³ MÖvn¨ c_ a‡i 

G‡Mvq| 

82 Plotter Kw¤úDUvi MÖvwd· Qvcvi Rb¨ e¨eüZ we‡kl ai‡bi wcÖ›Uvi| 

83 Port Kw¤úDUv‡ii m‡½ wewfbœ †cwi‡divjm jvMv‡bvi ev hy³ Kivi Q‡KU| 

84 Printer Kw¤úDUv‡ii Qvcvevi hš¿| 

85 Program KZ¸‡jv wb‡`©‡ki mgwó, hv Kw¤úDUv‡ii CPU †K †Kvb GKwU we‡kl KvR ev 

mgm¨v mvgvav‡bi Dcvq e‡j †`q| 

86 Programmer whwb Kw¤úDUv‡ii †cÖvMÖvg ˆZwi K‡ib|  

87 Language Kw¤úDUvi †cÖvMvg †jLvi Rb¨ ‡h fvlv e¨envi Ki‡Z nq| 

88 PROM Programmable Read Only Memory K_vwUi msw¶ß iƒc| GwU GKwU 

B‡jKUªwbK ’̄vqx ¯§„wZ e¨e ’̄v| 

89 RAM Random Access Memory K_vwUi msw¶ß iƒc| GwU n‡jv B‡jKwUªK 

A ’̄vqx ¯§„wZ e¨e¯’v| 

90 Range ‡Kvb †fwi‡qej ev dvsk‡bi mKj m¤¢ve¨ gvb| 

91 Register CPU Gi Aš—M©Z †QvU A ’̄vqx RAM ¯§„wZ fvÛvi| 

92 Resolution Kw¤úDUvi MÖvwd‡· my¶è welq e ‘̄ AvuKvi ¶gZv| 

93 Robot Kw¤úDUvi wbqwš¿Z Pjv‡div Ges hvwš¿K nv‡Zi mvnv‡h¨ wewfbœ wRwbm GK 

RvqMv †_‡K Ab¨ RvqMvq mwi‡q ivLvi ¶gZv m¤úbœ hš¿| 

94 ROM Read Only Memory K_vi msw¶ß iƒc| GwU GKwU ’̄vqx B‡jKUªwbK 

¯§„wZ fvÛvi| 

95 Save Kw¤úDUv‡ii Af¨š—ixY A ’̄vqx ¯§„wZ fvÛv‡i iw¶Z Z_¨‡K evowZ ¯§„wZ 

fvÛv‡i ’̄vqx fv‡e msi¶Y| 

96 Sequence GKvwaK Z_¨‡K mwVK µ‡g mvRv‡bv|  

97 Software Kw¤úDUvi †h mKj wb‡`©kbvi gva¨‡g cwiPvwjZ nq| Kw¤úDUv‡ii mKj 

†cÖvMÖvg, †cÖvMÖvg ˆZwii wbqg, †cÖvMÖvg‡K gvby‡li fvlv †_‡K Kw¤úDUv‡ii 

fvlvq Abyev` GB me wKQz‡K GK m‡½ Software e‡j| (ROM Ges 

Ab¨vb¨ ’̄vqx ¯§„wZ‡Z wjwce× †cÖvMÖvg‡K Software ejv nq)|   

98 Space ‡cÖvMÖv‡g wjL‡Z  `yÕwU K¨v‡i±vi ev kã‡K Avjv`v K‡i †`Lv‡bvi Rb¨ †h duvKv 

ivLv nq| 

99 Special 

Character 
nid ev msL¨v Qvov Kw¤úDUv‡ii †eva¨ Ab¨vb¨ K¨v‡i±vi| †hgb *, /, ?, !, &  

BZ¨vw`|  

100 Storage Kw¤úDUv‡i Z_¨ Rwg‡q ivLvi †h †Kvb ¯§„wZ fvÛvi| 

101 String ‡Kv‡Uvkb wP‡ýi g‡a¨ wjwLZ GKvwaK nid ev K¨v‡i±v‡ii mgwó| 

102 Tag ‡Kvb Z_¨ hv‡K wb‡`©wkKv (Marker) wK¤v̂ †j‡ej (Label) wnmv‡e e¨envi 

Kiv nq| 
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µwgK 

bs 

‡M­vmvwi kã ‡M­vmvwi k‡ãi msw¶ß e¨vL¨v 

103 Tape KvM‡Ri ˆZwi wd‡Z, hv‡Z wQ`ª K‡i †cÖvMÖvg †jLv nq| 

104 Time-

Sharing 

GKB CPUGi gva¨‡g GKB mg‡q GKvwaK Terminal Gi mvnv‡h¨ m¤ú~Y© 

Avjv`v †cÖvMÖvg Pvjv‡bvi e¨e ’̄v| GB e¨e ’̄vq GKvwaK Kw¤úDUvi e¨enviKvix 

GKwU `ª“Z MYbv m¶g CPU Gi m‡½ Multiplexing Kvq`vq mshy³ 

_v‡K| Kw¤úDUvi e¨enviKvix cÖwZ K‡qK †m‡K‡Û K‡qK wgwj †m‡K‡Ûi Rb¨ 

g~j CPU Gi m‡½ mshy³ nb| CPU wU AZ¨š— `ª“Z MYbv Ki‡Z cv‡i e‡j 

H mvgvb¨ mg‡qi g‡a¨B mshy³ Uvwg©bvj †_‡K AvMZ Z_¨ c‡o wb‡q we‡k­ lY 

K‡i DËi e‡j †`q| d‡j Kw¤úDUvi e¨enviKvixi g‡b nq †hb wZwb mvi¶YB 

g~j Kw¤úDUv‡ii m‡½ mshy³ Av‡Qb| 

105 True ‡Kvb DËi ev Ae ’̄v †hwU Kw¤úDUvi KZ©„K mZ¨ e‡j we‡ewPZ| G‡K evBbvwi 

1 Øviv wPwýZ Kiv nq| 

106 Update evowZ ¯§„wZ fvÛv‡i iw¶Z dvB‡ji (Data File) cyi‡bv Z_¨ gy‡Q 

mv¤cÖwZKZg Z_¨ †jLv| 

107 UPC Universal Product Code K_vwUi msw¶ß iƒc| 

108 Word GwU m¤ú~Y© Z_¨ ev wb‡`©k| 

109 Word 

Processing 

Kx-†evW©, gwbUi, Kw¤úDUvi Ges wcÖ›Uv‡ii mvnv‡h¨ †Kvb iPbv ev †jLv‡K 

Qvcv‡bv, ms‡kvab Kiv A_ev c~Y©web¨vm Kiv| 

110 Working 

Storage 

MYbv Kv‡h©i mgq Aš—e©Zx© DËi‡K A ’̄vqx fv‡e msi¶‡Yi Rb¨ RAM ¯§„wZ 

fvÛvi|  
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Kw¤úDUvi-Gi ms‡¶c-c~Y© kãvejx (Computer Terminology) 
  

µwgK  Kw¤úDUv‡ii 

ms‡¶c kã 

Kw¤úDUv‡ii ms‡¶c k‡ãi cy‡iv bvg 

01| AC Alternating Current 

02| ADP Automatic Data Processing  

03| ADT Abstract Data Type 

04| ALU Arithmetic and Logic Unit 

05| ANSI American National Standard Institute 

06| APT Automatically Programmed Tools 

07| APM Advanced Power Manager 

08| ASCC Atomistic Sequence Controlled Calculator  

09| ASCII American Standard Code for Information Interchange 

10| AT Advance Technology  

11| ATM Adobe Type Manager 

12| BASIC Beginner’s All Purpose Symbolic Instruction Code  

13| BCD Binary Coded Decimal 

14| BIOS Basic Input Output System 

15| BCS Bangladesh Computer Society  

16| BOTM Beginning of Tape Marker  

17| BWF Best Web Face 

18| CD Compact Disk   

19| CCITT Consultative Committee International Telegraph and 

Telephone  

20| CBT Computer Based Training 

21| CGA Color Graphics Adapter 

22| CMOS Complimentary Metal Oxide Semiconductor 

23| CPU Central Processing Unit 

24| CPS Character Per Sound 

25| COBOL Common Business Oriented Language  

26| CRT Cathode Ray Tube 



161 

wkÿK‡`i AvBwmwU cÖwkÿY g¨vby‡qj 

 

µwgK 

bs 

Kw¤úDUv‡ii 

ms‡¶c kã 

Kw¤úDUv‡ii ms‡¶c k‡ãi cy‡iv bvg 

27| CU Control Unit  

28| DBMS Database Management System   

29| DC Direct Current 

30| DCE Data Communication Equipment  

31| DOS Disk Operating System 

32| ECP Enhanced Capability Port 

33| Email Electronic Mail 

34| ESC Escape 

35| EPROM Erasable Programmable Read Only Memory  

36| EGA Enhanced Graphic Adapter 

37| EIA Electronic Industries Association 

38| FAT File Allocation Table 

39| FDD Floppy Disk Drive 

40| FTP File Transfer Protocol  

41| GB Giga Byte  

42| HDC Hard Disk Controller  

43| HDD Hard Disk Drive 

44| HMA High Memory Area 

45| HP Hewlett Packard 

46| HTML Hyper Text Markup Language  

47| Hz Hertz 

48| I/O Input/Output 

49| IBM International Business Machine 

50| IC Integrated Circuit 

51| IDE Integrated Drive Electronic  

52| IOS Interworking Operating System 

53| IP Internet Protocol  
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µwgK 

bs 

Kw¤úDUv‡ii 

ms‡¶c kã 

Kw¤úDUv‡ii ms‡¶c k‡ãi cy‡iv bvg 

54| ISP Internet Service Provider  

55| IPS Instant Power Supply  

56| IT Information Technology  

57| KB Kilobyte 

58| KBPS Kilobyte Per Second 

59| LAN Local Area Network 

60| LPM Line Per Minute  

61| LANE Local Area Network Emulation  

62| LCD Liquid Crystal Display 

63| LED Light Emitting Diode 

64| LIM-EMS Lotus-Intel Microsoft Expanded Memory Specification  

65| LSI Large Scale Integration 

66| MAN Metropolitan Area Network  

67| MB Mega Byte 

68| MHZ Mega Hertz 

69| MDA Monochrome Display Adapter 

70| MS-DOS Microsoft Disk Operating System 

71| MODEM Modulator and Demodulator  

72| MPEG Motion Picture Expert Group   

73| NIC Network Interface Card  

74| NOS Network Operating System  

75| OCR Optical Character Reader 

76| OMR Optical Mark Reader 

77| OS Operating System 

78| PC Personal Computer  

79| PCB Printed Circuit Board 

80| PCMCIA Personal Computer Memory Card International Association 
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µwgK 

bs 

Kw¤úDUv‡ii 

ms‡¶c kã 

Kw¤úDUv‡ii ms‡¶c k‡ãi cy‡iv bvg 

82| PSN Packet Switching Network  

83| PPM Page Per Minute 

84| PCI Protocol Control Information  

85| PIXEL Picture Element  

86| PROM Programmable Read Only Memory  

87| RAM Random Access Memory 

88| RDBMS Relational Database Management System  

89| RFI Radio Frequency Interference 

90| RGB Red, Green, Blue 

91| ROM Read Only Memory 

92| RTC Real Time Clock 

93| SCR Sequence Control Register  

94| SIMM Single In-line Memory Module 

95| SIO Serial Input/Output 

96| SQL Structured Query Language 

97| SRAM Static Random Access Memory 

98| SCSI Small Computer System Interface  

99| SVGA Super Video Graphics Adapter 

100| TCP Transmission Control Protocol  

101| TFT Thin-film Transistor 

102| UMA Upper Memory Area 

103| UMB Upper Memory Block 

104| UPC Universal Product Code  

105| UPS Uninterruptible Power Supply  

106| VGA Video Graphics Adapter 

107| WAN Wide Area Network  

108| WWW World Wide Web (W3) 

 


